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3 1. Overzicht

Systeemconfiguratie

UWP-D21 
UWP-D22 
UWP-D26 
Draadloos 
microfoonpakket

URX-P03D 
Draadloze micro-
foonontvanger

SMAD-P3D 
Multi-interface  
schoenadapter

SMAD-P5 
Multi-interface-
schoenadapter

LA-EA3 
LA-EA4 
A-bevestigingsadapter

Objectief met 
E-bevestiging

ECM-VG1 
ECM-MS2 
Microfoon

RM-30BP 
Afstandsbedieningsunit

MCX-500 
Multi Camera Live 
Producer

Afstandsbedieningsgreep 
(meegeleverd)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

XLR-K2M 
XLR-K3M 
XLR-adapterset

HVL-LBPC 
Videolamp

CFexpress Type A  
Geheugenkaarten

SDXC  
Geheugenkaarten

BC-CU1  
Acculader 
(meegeleverd)

BP-U35, BP-U60, 
BP‑U60T, BP-U70, 
BP‑U90, BP-U100 
Accuset

Netadapter 
(meegeleverd)

CFexpress Type A-kaartlezer/  
SD-kaartlezer

BC-U1A, BC-U2A 
Acculader

ECM-B1M 
Rechtuit-microfoon
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Plaats en functie van onderdelen

Linkerkant en voorkant
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1.	 Meetlinthaak
De meetlinthaak zit op dezelfde hoogte 
als de beeldsensor. Gebruik deze haak als 
referentiepunt om de afstand tussen de 
camcorder en het onderwerp nauwkeurig te 
meten. U kunt het uiteinde van een meetlint 
aan de haak bevestigen om de afstand vanaf 
het onderwerp te meten.

2.	 Zoekeraansluiting (pagina 19)

3.	 Ventilatie-opening

[Opmerking]
Bedek de ventilatie-opening niet.

4.	 Keuzeschakelaar TC IN/OUT (pagina 35, 
116)

5.	 Aansluiting afstandsbedieningsgreep 
(pagina 21)

6.	  (N-teken) (pagina 60)
ˎˎ Raak met een smartphone die is uitgerust 
met de NFC-functie het apparaat aan, om 
een draadloze verbinding tot stand te 
brengen.  
Sommige smartphones die draadloze 
betalingssystemen ondersteunen 
ondersteunden mogelijk geen 
NFC. Raadpleeg voor details de 
gebruiksaanwijzing van de smartphone.
ˎˎ NFC (Near Field Communication) is een 
internationaal communicatieprotocol voor 
draadloze communicatie tussen objecten 
die zich dicht bij elkaar bevinden.

7.	 Bevestiging afstandsbedieningsgreep 
(pagina 21)

8.	 Vrijgaveknop voor de 
afstandsbedieningsgreep (pagina 21)

9.	 Wifi-antenne

10.	Opname/tally-lampje (voorkant) 
(pagina 34)

Knippert als de resterende capaciteit van de 
opnamemedia of accu laag is.

11.	FOCUS-schakelaar (pagina 37)

12.	Beeldsensor

13.	Knop PUSH AUTO FOCUS (pagina 41)

14.	Signaalcontacten objectief

[Opmerking]
Niet direct met uw handen aanraken.

15.	Knop WB SET (witbalansinstelling) 
(pagina 46)

16.	Vrijgaveknop objectief (pagina 22)
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Rechterkant (voorkant/bovenkant/onderkant)
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1.	 Knop Clipvlaggen (pagina 53, 70)

2.	 HOLD-schakelaar (pagina 100)

3.	 Knop Record START/STOP (pagina 34)
Druk op de knop START/STOP om te starten 
met opnemen. De LED brandt tijdens opname.

4.	 Regelaar ND VARIABLE (pagina 44)

5.	 Schakelaar ND PRESET/VARIABLE 
(pagina 44)

6.	 Omhoog/omlaag-knoppen ND FILTER 
POSITION (pagina 44)

7.	 Indicator ND CLEAR (pagina 44)

8.	 Knop ND VARIABLE AUTO (pagina 44)
Druk op de knop ND VARIABLE AUTO om 
automatische dichtheidsaanpassing van het 
ND filter te starten. De LED brandt groen als dit 
is ingeschakeld.

9.	 Multifunctionele regelaar (pagina 49)
Indrukken tijdens het bekijken van het beeld in 
de zoeker om het directmenu weer te geven 
en te bedienen.
Draai de multifunctionele regelaar als er een 
menu in de zoeker wordt weergegeven om 
de cursor omhoog/omlaag te verplaatsen 
om menu-onderdelen of instellingen te 
selecteren. Indrukken om het geselecteerde 
onderdeel toe te passen.
Op momenten dat het menu niet wordt 
weergegeven kan de regelaar ook 
functioneren als een toewijsbare regelaar.

10.	Functieknop IRIS (pagina 43)

11.	Knop CANCEL/BACK (pagina 69)

12.	Knop THUMBNAIL (pagina 68)

13.	Knop MENU (pagina 10, 73)
Druk op de knop MENU om het statusscherm 
weer te geven. Houd de knop MENU ingedrukt 
om het hoofdmenuscherm weer te geven. 
Druk op de knop tijdens weergave van het 
statusscherm of hoofdmenuscherm om naar 
de vorige schermweergave te gaan.

14.	Functieknop ISO/GAIN (pagina 43)

15.	Schakelaar ISO/GAIN 
(versterkingsselectie) (pagina 43)

16.	Functieknop WHT BAL (witbalans) 
(pagina 46)

17.	Schakelaar WHT BAL (geheugenselectie 
witbalans) (pagina 46)

18.	Functieknop SHUTTER (pagina 44)

19.	Hoofdtelefoonaansluiting (pagina 34)

20.	POWER-schakelaar (pagina 34)

Rechterkant (achter) 
(pagina 6)
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Rechterkant en kaartsleuf

10

8

123

7

6
5

4

11

9

12

15

13

14

1.	 Wifi-antenne

2.	 Regelaar AUDIO LEVEL (CH1) 
(pagina 47)

3.	 Schakelaar CH1 (AUTO/MAN) 
(pagina 47)

4.	 ASSIGN (toewijsbaar) knoppen 1 t/m 3 
(pagina 49)

5.	 Interne microfoon (pagina 47)
Spraakmicrofoon voor opname van 
omgevingsgeluid. 

[Tip]
Deze microfoon wordt uitgeschakeld als de draaggreep 
wordt bevestigd en de interne microfoon van de 
draaggreep actief wordt (pagina 7).

6.	 Knop DISPLAY (pagina 11)

7.	 Interne luidspreker (pagina 34)

8.	 POWER-indicator (pagina 34)

9.	 Knop SLOT SELECT (selectie 
geheugenkaartsleuf (A)/(B)) 
(pagina 34)

10.	Schakelaar CH2 (AUTO/MAN) 
(pagina 47)

11.	Regelaar AUDIO LEVEL (CH2) 
(pagina 47)

12.	Toegangsindicator A (pagina 26)

13.	CFexpress Type A/SD kaartsleuf (A) 
(pagina 26)

14.	CFexpress Type A/SD kaartsleuf (B) 
(pagina 26)

15.	Toegangsindicator B (pagina 26)
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Draaggreep, achterkant en aansluitblok

11

10

8
7
6
5

4 3 2 1

21

16

10

10

10

9
17
18
19

22

23

20

24
25
26

14

13
12

15
20

1.	 HOLD-schakelaar draaggreep 
(pagina 100)

Gebruiken om de bediening van 
bedieningselementen op de draaggreep uit te 
schakelen.

[Tip]
U kunt dit ook instellen voor alleen de knop Record 

START/STOP op de draaggreep.

2.	 Knop draaggreep opname START/STOP

3.	 Interne microfoon draaggreep

4.	 Multi-interfaceschoen

Neem voor details over de accessoires 
die worden ondersteund door de multi-
interfaceschoen contact op met uw 
verkoopvertegenwoordiger.

5.	 Toewijsbare regelaar draaggreep 
(pagina 49)

6.	 Zoomregelaar draaggreep (pagina 101)

7.	 ASSIGN (toewijsbare) knoppen 7 t/m 8 
(pagina 49)

8.	 Keuzeschakelaar (8-voudig D-pad en 
toepassingsknop)

9.	 Accessoireschoen (pagina 7)

10.	Schroefgaten bevestiging accessoires (1/4 
inch)

Compatibel met 1/4-20 UNC-schroeven (lengte 
van 6 mm of minder).

[Opmerking]
Gebruik van schroeven die langer zijn dan 6 mm kan 
schade aan externe onderdelen veroorzaken.

11.	Opname/tally-lampje (achterkant) 
(pagina 34)

12.	Knop BATT RELEASE (pagina 17)

13.	Luchtinlaat

[Opmerking]
Bedek de luchtinlaat niet.

14.	Accuset aansluitopening (pagina 17)

15.	USB-C-aansluiting (pagina 63)

16.	Aansluiting INPUT2 (audio-ingang 2) 
(pagina 47)

17.	Aansluiting INPUT1 (audio-ingang 1) 
(pagina 47)

18.	Schakelaar INPUT2 (LINE/MIC/MIC+48V) 
(pagina 47)

19.	Schakelaar INPUT1 (LINE/MIC/MIC+48V) 
(pagina 47)

20.	Schroefgaten voor externe apparaten
Compatibel met M3-schroeven (lengte van 
4 mm of minder).

[Opmerking]
Gebruik van schroeven die langer zijn dan 4 mm kan 
schade aan het externe oppervlak veroorzaken.

21.	HDMI OUT-aansluiting (pagina 115)

22.	SDI OUT-aansluiting (pagina 115)

23.	Aansluiting TC IN/TC OUT (tijdcode in/uit) 
(pagina 116)

24.	REMOTE-aansluiting
Aansluiten op algemene LANC jack-accessoire.

25.	USB/multi-aansluiting (pagina 117)

26.	DC-IN-aansluiting (standaard DC-stekker) 
(pagina 18)

De accessoireschoen bevestigen

1	 Til de voorste rand van de schoenveer 
omhoog en trek de veer in 
tegenovergestelde richting van de pijl die 
op de veer is gegraveerd.

Schoenveer

Accessoireschoen

1

2	 Plaats de accessoireschoen op de 
accessoireschoenbevestiging, lijn de 
uitsteeksels op de schoen uit met de 
corresponderende punten op de 
bevestiging en draai de vier schroeven 
vast.
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3	 Zet de schoenveer er in de richting van de 
pijl in, zodat het U-vormige gedeelte op 
het eind van de accessoireschoen past.

Schoenveer

Accessoireschoen

2 32 3

De accessoireschoen verwijderen

Verwijder de schoenveer zoals beschreven in 
stap 1 in "De accessoireschoen bevestigen", 
schroef de vier schroeven los en verwijder de 
accessoireschoen.

De draaggreep bevestigen

Plaats de draaggreep zo dat de 
draaggreepaansluiting en schroefgaten op 
elkaar zijn uitgelijnd. Druk in en draai de 
bevestigingsschroeven van de draaggreep 
naar rechts om de draaggreep aan het 
apparaat te bevestigen.
U kunt ook de bevestigingsschroeven van de 
twee draaggrepen vastmaken door deze naar 
rechts te draaien met een inbussleutel (4 mm).

[Opmerking]
Zorg dat de twee bevestigingsschroeven van de 
draaggreep goed zijn vastgemaakt, alvorens de 
draaggreep te gebruiken. De hendel kan van de 
camcorder afvallen als de schroeven niet stevig zijn 
vastgemaakt.

De draaggreep verwijderen

Verwijderen in de omgekeerde volgorde als 
van de bevestigingsprocedure.

De beschermkap voor de 
draaggreepaansluiting (meegeleverd) 
bevestigen

Als de camcorder wordt gebruikt zonder de 
draaggreep, bescherm dan de aansluiting met 
de meegeleverde beschermkap.

[Tip]
Als de draaggreep wordt bevestigd, berg dan de 
beschermkap op aan de onderkant van de draaggreep.

De fysieke aansluitingen beschermen

Bevestig de kap voor niet gebruikte 
aansluitingen om de chassisdelen te 
beschermen.

Bovenkant

1

2 2

2

2

1.	 Aansluiting draaggreep

2.	 Schroefgaten bevestiging accessoires (1/4 
inch)

Compatibel met 1/4-20 UNC-schroeven (lengte 
van 6 mm of minder).

[Opmerking]
Gebruik van schroeven die langer zijn dan 6 mm kan 
schade aan externe onderdelen veroorzaken.



1. Overzicht: Plaats en functie van onderdelen9

Onderkant

1 2
1.	 Schroefgaten statief (1/4 inch, 3/8 inch)
Compatibel met 1/4-20 UNC-schroeven 
en 3/8-16 UNC-schroeven. Bevestigen op 
een statief (optie, schroeflengte 5,5 mm of 
minder).

2.	 Luchtuitlaat

[Opmerking]
Bedek de luchtuitlaat niet.

Zoeker

Zie voor details over bevestiging van de 
zoeker (meegeleverd) pagina 19.

1
2
3

4 5

1.	 Knop PEAKING

2.	 Knop ZEBRA

3.	 Knop ASSIGN (toewijsbaar) 9 
(pagina 49)

4.	 Aanraakscherm
Aanraakbediening kan worden uitgeschakeld 
met een toewijsbare knop of in het menu 
(pagina 10).

5.	 Schakelaar MIRROR

Afstandsbedieningsgreep

Zie voor details over bevestiging van de 
(meegeleverde) afstandsbedieningsgreep 
pagina 21.

4

3
2

1

7
8

6
5

1.	 Zoomregelaar

2.	 Knop ASSIGN (toewijsbaar) 4 
(pagina 49)

3.	 Afstandsbedieningsgreep toewijsbare 
regelaar (pagina 49)

4.	 Knop ASSIGN (toewijsbaar) 6 
(pagina 49)

5.	 Rotatieregelaar afstandsbedieningsgreep 
(pagina 21)

6.	 Knop Record START/STOP

7.	 Keuzeschakelaar (8-voudig D-pad en 
toepassingsknop)

8.	 Knop ASSIGN (toewijsbaar) 5 
(pagina 49)
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Het aanraakscherm gebruiken

Voorzorgsmaatregelen voor 
gebruik van het aanraakscherm

De zoeker van het apparaat is een 
aanraakscherm, dat u bedient met directe 
aanraking met uw vinger.
ˎˎ Het aanraakscherm is ontworpen om licht 
met uw vinger te worden aangeraakt. Oefen 
geen kracht uit op het scherm en raak het 
niet aan met voorwerpen met scherpe 
randen of punten (nagel, balpen, sleutel 
etc.)
ˎˎ Het aanraakscherm reageert mogelijk niet 
bij aanraking in de volgende situaties. Let 
op, hierdoor kan ook een defect veroorzaakt 
worden.
ˎˎ 	Bediening met het uiteinde van 
vingernagels
ˎˎ 	Bediening terwijl andere objecten 
contact maken met het oppervlak
ˎˎ 	Bediening met een aangebrachte 
beschermfolie of sticker
ˎˎ 	Bediening met waterdruppels of 
condens op het display
ˎˎ 	Bediening met natte of bezwete vingers

Aanraakscherm bewegingen

Tik
Raak een onderdeel, zoals een pictogram of 
een menu-onderdeel, licht aan met uw vinger 
en verwijder uw vinger direct weer.

Sleep
Raak het scherm aan en sleep uw vinger 
naar de gewenste positie op het scherm, en 
verwijder vervolgens uw vinger.

Korte of lange veeg
Raak het scherm aan en veeg uw vinger snel 
omhoog, omlaag, naar links of naar rechts.

[Tip]
Als de displayinhoud doorloopt buiten de randen van 
het scherm, kunt u de displayinhoud met vegen laten 
verschuiven.

Het aanraakscherm configureren

Bediening van het aanraakscherm kan worden 
ingeschakeld of uitgeschakeld met het 
onderdeel Touch Operation (pagina 100) in 
het menu Technical.
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Schermdisplay
Tijdens filmen (opnemen/standby) en afspelen worden de status en instellingen van de 
camcorder geprojecteerd op het beeld dat in de zoeker wordt weergegeven.
U kunt de informatie weergeven/verbergen met de knop DISPLAY. Zelfs indien verborgen, 
verschijnt dit bij het uitvoeren van handelingen in het directmenu (pagina 49).
U kunt ook kiezen om elk onderdeel afzonderlijk weer te geven of te verbergen (pagina 94).

Informatie weergegeven op het scherm tijdens filmen
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1.	 Indicator netwerkstatus (pagina 13)
Geeft de netwerkverbindingsstatus weer als 
pictogram.

2.	 Indicator upload/resterende bestanden 
(pagina 65)

3.	 Indicator scherpstellingsgebied 
(pagina 38)

Geeft het scherpstellingsgebied voor 
automatische scherpstelling weer.

4.	 Opnamemodus, sleuf A/B, Interval Rec 
opname-intervalindicator (pagina 50)

Weergave Betekenis

Rec Opnemen

Stby Opnemen stand-by

5.	 Indicator scherptediepte

6.	 Indicator scanmodus beeldsensor 
(pagina 24)

Er wordt een -markering weergegeven 
als zich een verkeerde combinatie voordoet 
tussen de beeldcirkelomvang van het objectief 
en de effectieve scanmodusinstelling van de 
beeldgrootte van de beeldsensor.
Als Imager Scan Mode is ingesteld op FF, 
wordt een "C"-markering weergegeven in 
modi met smallere hoek of beeldweergave 
(bijgesneden).
Bijsnijden vindt plaats in de volgende modi.
ˎˎ Als de opname-indeling 3840×2160 is 
en S&Q Motion beeldsnelheid 100 fps of 
120 fps
ˎˎ Als Codec is ingesteld op RAW of RAW 
& XAVC-I en het RAW uitgangsformaat 
3840×2160 is

7.	 Uitvoerindicator voor RAW 
werkingsstatus (pagina 59)

Geeft de uitvoerstatus van het RAW-signaal 
weer.

8.	 Statusindicator UWP-D serie 
(pagina 13)

Geeft de signaalsterkte van het RF-signaal 
weer als een pictogram als er een apparaat 
uit de UWP-D-serie is aangesloten op de 
MI-schoen die is geconfigureerd voor digitale 
audio-overdracht.

9.	 Beeldsnelheidindicator voor Slow & Quick 
Motion filmen (pagina 50)

10.	Indicator resterende accucapaciteit/DC IN 
voltage (pagina 17)

11.	 Indicator scherpstellingsmodus 
(pagina 41)

Betekenis Weergave

Modus vasthouden 
scherpstelling

Focus Hold

MF-modus MF

AF-modus AF

Modus AF volgen in echttijd

Gezichts/ogendetectie AF (AF/ /Only/ / )

Pictogram gezichts/
ogendetectie

Pictogram gezichts/
ogendetectie AF

Only

Pictogram Opgeslagen 
gezicht voor volgen

AF gepauzeerd tijdens 
gezichts/ogendetectie 
AF1)

1)	 Wordt weergegeven als er geen gezicht is opgeslagen 
voor volgen en er geen gezicht is gedetecteerd, of als 
er een gezicht is opgeslagen voor volgen maar het 
gezicht voor volgen niet is gedetecteerd.

12.	Indicator scherpstellingsgebied
Geeft het scherpstellingsgebied weer.

13.	Indicator zoompositie (pagina 36)
Geeft de zoompositie weer binnen het bereik 
van 0 (brede hoek) tot 99 (telefoto) (als er een 
objectief is bevestigd dat weergave van de 
zoominstelling ondersteunt).
De weergave kan worden gewijzigd naar 
een balkweergave of afstandsindicator voor 
scherpstelling (pagina 102).
De volgende onderdelen worden aan het 
display toegevoegd als Clear Image Zoom is 
ingeschakeld.

Weergave Betekenis

Clear Image Zoom is 
ingeschakeld

Vergrotings-
waarde

Bij gebruik van Clear Image 
Zoom

14.	Indicator beeldstabilisatiemodus

15.	Indicator SDI output/HDMI output Rec 
Control status (pagina 115)

Geeft de uitvoerstatus van het REC 
besturingssignaal weer.

16.	Indicator scherpstelling (pagina 37)

17.	 Indicator resterende mediacapaciteit

Weergave Betekenis

Montage/montagestatus 
(medium A)

Montage/montagestatus 
(medium B)

Montage/montagestatus 
(medium B)1)

(knippert)

Montagestatus (kan niet 
opnemen) 
(medium B)1) 2)

1)	 Alleen opname van proxygegevens
2)	Mediumfout, medium vol of andere fout opgetreden 

bij start van opname of tijdens opname.

Er verschijnt een -pictogram als de 
geheugenkaart schrijfbeveiligd is.



1. Overzicht: Schermdisplay12

18.	Indicator witbalansmodus

Weergave Betekenis

Automodus

 Hold Automodus gepauzeerd

W:P Presetmodus

W:A Modus geheugen A

W:B Modus geheugen B

19.	Indicator externe vergrendeling tijdcode/
weergave tijd en datum (pagina 35)

Geeft "EXT-LK" aan bij vergrendeling aan de 
tijdcode van een extern apparaat.

20.	Indicator ND filter (pagina 44)

Weergave Betekenis

Automodus

Modus Bokeh Control 
(pagina 53)

21.	Indicator scenebestand (pagina 56)

22.	Indicator diafragma
Geeft de diafragmapositie (F-waarde) weer 
(als er een objectief is bevestigd dat weergave 
van de diafragma-instelling ondersteunt).

23.	Indicator waarschuwing videoniveau

24.	Indicator versterking (pagina 43)
Geeft de EI-waarde weer in Cine EI-modus 
(pagina 24).

Weergave Betekenis

Automodus

H Preset H-modus

M Preset M-modus

L Preset L-modus

Tijdelijke 
aanpassingsmodus

Modus Bokeh Control 
(pagina 53)

25.	Weergave clipnaam (pagina 93)
Geeft de naam weer van de clip die wordt 
opgenomen of gaat worden opgenomen.

26.	Sluiterindicator (pagina 44)

27.	Indicator AE-modus/AE-niveau 
(pagina 43)

28.	Waterpasindicator
Geeft het horizontale niveau weer in stappen 
van ±1° tot en met ±15°.

29.	Audioniveaumeter
Geeft het audioniveau van CH1 naar CH4 weer.

30.	Videosignaalmonitor (pagina 52)
Geeft een golfvorm, vectorscoop en histogram 
weer.
De oranje lijn geeft de ingestelde waarde van 
het zebrapatroonniveau weer.
In de modus Cine EI (pagina 24) geeft dit 
het LUT-type weer van het signaal dat wordt 
gemonitord.

31.	Indicator basisgevoeligheid/Basis-ISO 
(pagina 43)

In de modus Custom (pagina 24) geeft 
dit de basisgevoeligheid weer bij gebruik 
van Base ISO/Sensitivity op het scherm Main 
Status of ISO/Gain/EI >Base Sensitivity in het 
menu Shooting van het hoofdmenu.
In de modus Cine EI (pagina 24) geeft dit 
de Base ISO-gevoeligheid weer bij gebruik 
van Base ISO/Sensitivity van het scherm Main 
Status of ISO/Gain/EI >Base ISO in het menu 
Shooting van het hoofdmenu.

32.	Indicator Gammaweergave-assistent/
monitor LUT

Geeft de status weer van de 
gammaweergave-assistent. De functie 
gammaweergave-assistent kan worden 
in- of uitgeschakeld door Gamma Display 
Assist toe te wijzen aan een toewijsbare knop 
(pagina 49).

In de modus Cine EI (pagina 24) geeft 
dit LUT-instelling van de monitor weer 
(pagina 81).

33.	Indicator basisuiterlijk (pagina 56)
Geeft de instelling voor basisuiterlijk weer.
In de modus Cine EI (pagina 24) geeft dit 
het videosignaal weer dat wordt opgenomen 
op de geheugenkaarten (pagina 81).

34.	Indicator proxy-status

Weergave Betekenis

Proxy-opname aan

Proxy-opname

 
(knippert)

Proxy-opname niet gereed

Proxy-segmentopname aan

Proxy-segmentopname

 
(knippert)

Proxy- segmentopname niet 
gereed

35.	Indicator opname-indeling (codec) 
(pagina 83)

Geeft de naam weer van de opname-indeling 
op de geheugenkaarten.

36.	Indicator opname-indeling 
(beeldsnelheid en scanmethode)

37.	Indicator opname-indeling (beeldgrootte) 
(pagina 83)

Geeft de beeldgrootte weer voor opname op 
de geheugenkaarten.

38.	Knop Stop AF volgen in echttijd 
(pagina 42)
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Informatie die wordt weergegeven op het scherm tijdens afspelen

De volgende informatie wordt geprojecteerd op het afspeelbeeld.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1.	 Indicator netwerkstatus

2.	 Uploadindicator/indicator resterende 
bestanden

3.	 Clipnummer/totaal aantal clips

4.	 Indicator afspeelstatus

5.	 Indicator afspeelindeling (beeldsnelheid 
en scanmethode)

6.	 Indicator afspeelindeling (beeldgrootte)

7.	 Indicator resterende accucapaciteit/DC IN 
voltage

8.	 Indicator afspeelindeling (codec)

9.	 Mediaindicator
Er verschijnt een -pictogram als de 
geheugenkaart schrijfbeveiligd is.

10.	Weergave tijd/datum

11.	Weergave clipnaam

12.	Indicator gammaweergave-assistent

13.	Audioniveaumeter
Geeft het audio-afspeelniveau weer.

14.	Indicator basisuiterlijk

Pictogramweergave

Pictogramweergave netwerkverbinding

Netwerkmodus Verbindingsstatus Pictogram

Toegangspuntmodus Werkend als toegangspunt

Toegangspunt fout

Stationmodus Wifiverbinding
Pictogram wijzigt naargelang de 
signaalsterkte (4 stappen)

   

Wifi ontkoppeld

Wifi verbindingsfout

USB-tethering USB-tethering verbonden

USB-tethering losgekoppeld

USB-tetheringfout

Pictogramweergave UWP-D-serie

Verzendingsstatus Ontvangststatus Pictogram

Uitgeschakeld Geen ontvangst

Normale verzendingsstatus Ontvangend
 –   

(ontvangstniveau (4 stappen))

Dempingsstatus Ontvangen (gedempt)

Waarschuwingsstatus resterende 
accucapaciteit

Ontvangend
 (Pictogram knippert)

Dempen en waarschuwingsstatus 
resterende accucapaciteit

Ontvangend
 (Pictogram knippert)
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Statusscherm

U kunt de status en instellingen van de 
camcorder controleren op het statusscherm. 
De instellingen van onderdelen die zijn 
gemarkeerd met een asterisk (*) kunnen 
worden gewijzigd.
Het statusscherm ondersteunt 
aanraakbediening.

Het statusscherm weergeven
ˎˎ Druk op de knop MENU.

[Tip]
U kunt de verschillende statusschermen weergeven of 
verbergen met Menu Page On/Off (pagina 101) in het 
menu Technical.

Het statusscherm omschakelen
ˎˎ Draai aan de multifunctionele regelaar.
ˎˎ Druk de keuzeschakelaar omhoog/omlaag
ˎˎ Veeg het statusscherm omhoog/omlaag.

Het statusscherm verbergen
ˎˎ Druk op de knop MENU.

Een instellingen wijzigen
Druk als het statusscherm wordt weergegeven 
op de multifunctionele regelaar of 
keuzeschakelaar om selectie van een 
configuratieonderdeel op een pagina mogelijk 
te maken. Selecteer een paginanummer en 
druk vervolgens om pagina's om te schakelen.
U kunt ook direct onderdelen selecteren met 
aanraakbediening.

[Opmerking]
U kunt wijzigingen vanaf het statusscherm uitschakelen 
door Menu Settings >User Menu Only (pagina 101) 
in het menu Technical van het hoofdmenu op On in te 
stellen.

Scherm Main Status

Geeft de hoofdfuncties van de camera en de 
vrije ruimte op de media weer.

Displayonderdeel Beschrijving

S&Q Frame Rate* Instellingen voor opnemen 
in Slow & Quick Motion en 
framesnelheid

Frequency/Scan* Systeemfrequentie en 
instellingen scanmethode

Imager Scan* Scanmodus van de 
beeldsensor

Media Remain 
(A)

Resterende vrije ruimte op 
media in sleuf A

ND Filter Instelling ND-filter

ISO/Gain/EI Instelling ISO/versterking/
belichtingsindex

Base ISO/
Sensitivity*

Instelling basis-ISO/
basisgevoeligheid

Codec* Instelling codec voor 
opname

Media Remain (B) Resterende vrije ruimte op 
media in sleuf B

Scene File* Scenebestand in gebruik en 
de instelling voor bestand-
ID

Base Look/LUT* Basisuiterlijk/LUT-instelling

Shutter Instelling sluitertijd of 
sluiterhoek

Iris Diafragma-instelling

Video Format* Beeldgrootte voor opnamen 
op geheugenkaarten

RAW Output 
Format*

Beeldgrootte van RAW 
uitvoer

White Balance Instelling witbalans

Scherm Camera Status

Geeft de status van verschillende presets van 
de camera weer.

Displayonderdeel Beschrijving

White Switch<B> Instelling witbalans 
geheugen B

White Switch<A> Instelling witbalans 
geheugen A

White Switch<P> Instelling preset wit

ND<Preset> Instellingen ND-filter Preset1 
t/m 3

ISO / Gain1)<L>* Instelling ISO/Gain1)<L>

ISO / Gain1)<M>* Instelling ISO/Gain1)<M>

ISO / Gain1)<H>* Instelling ISO/Gain1)<H>

Base ISO/
Sensitivity*

Instelling basis-ISO/
basisgevoeligheid

Zebra1* Instelling en niveau Zebra1 
aan/uit

Zebra2* Instelling en niveau Zebra2 
aan/uit

VF Gamma/
Gamma

Gamma categorie en curve

Scene File* Scenebestand in gebruik en 
de instelling voor bestand-
ID

1)	 Exposure Index als Shooting Mode is ingesteld Cine 
EI.

Scherm Audio Status

Geeft de ingangsinstelling, audioniveaumeter 
en volumemonitorinstelling voor elk kanaal 
weer.

Displayonderdeel Beschrijving

CH1 Level 
Control

Aan/uit-status van auto-
aanpassing

Level Meter Audioniveaumeter

Source* Ingangsbron

Ref./Sens.* Ingangsreferentieniveau

Wind 
Filter*

Instelling windruisreductie 
microfoon

CH2 Level 
Control

Aan/uit-status van auto-
aanpassing

Level Meter Audioniveaumeter

Source* Ingangsbron

Ref./Sens.* Ingangsreferentieniveau

Wind 
Filter*

Instelling windruisreductie 
microfoon

CH3 Level 
Control*

Aan/uit-status van auto-
aanpassing

Level 
Meter*

Audioniveaumeter

Source* Ingangsbron

Ref./Sens.* Ingangsreferentieniveau

Wind 
Filter*

Instelling windruisreductie 
microfoon

CH4 Level 
Control*

Aan/uit-status van auto-
aanpassing

Level 
Meter*

Audioniveaumeter

Source* Ingangsbron

Ref./Sens.* Ingangsreferentieniveau

Wind 
Filter*

Instelling windruisreductie 
microfoon

Audio Input 
Level*

Instelling audio-
ingangsniveau 
(mastervolume)

HDMI Output CH* Instelling HDMI-uitvoer 
audiokanaal



1. Overzicht: Schermdisplay15

Displayonderdeel Beschrijving

Volume* Volume-instelling 
hoofdtelefoon/interne 
luidspreker

Monitor CH* Instelling monitorkanaal

Statusscherm Project

Geeft de basisinstellingen weer met 
betrekking tot het filmproject.

Displayonderdeel Beschrijving

Frequency/Scan* Systeemfrequentie en 
instellingen scanmethode

Codec* Instelling codec voor 
opname

Rec Function* Aan-uitinstelling voor 
speciale opnamefunctie en 
hoofdinstellingen

Simul Rec* Status simultane 
opnamefunctie 2 
kaartsleuven aan-uit en 
instelling

Title Prefix Titeldeel van de clipnaam

Imager Scan* Scanmodus van de 
beeldsensor

Video Format* Beeldgrootte voor opnamen 
op geheugenkaarten

Picture Cache 
Rec*

Opnamefunctie voor 
beelden aan-uit en instelling 
voor cachegrootte

Number Numeriek achtervoegsel van 
de clipnaam

Shooting Mode* Instellingen opnamemodus

RAW Output 
Format*

Beeldgrootte van RAW 
uitvoer

Proxy Rec* Instelling Proxy-
opnamefunctie aan-uit

Scherm Monitoring Status

Geeft de SDI en HDMI-uitvoerinstellingen 
weer.

Displayonderdeel Beschrijving

SDI Signal* Beeldgrootte uitvoer

Info. 
Disp.*

Aan/uit-instelling 
uitvoerdisplay

Color 
Gamut*

Instelling kleurbereik/
Monitor LUT-status

HDMI Signal* Beeldgrootte uitvoer

Info. 
Disp.*

Aan/uit-instelling 
uitvoerdisplay

Color 
Gamut*

Instelling kleurbereik/
Monitor LUT-status

Stream Signal Beeldgrootte uitvoer

Info. 
Disp.

Uitvoerdisplay (uit (vast))

Color 
Gamut*

Instelling kleurbereik/
Monitor LUT-status

VF Color 
Gamut*

Instelling gammaweergave-
assistent/instelling Color 
space/status Monitor LUT

Base Look/LUT* Basisuiterlijk/LUT-instelling

Gamma Display 
Assist*

Gammaweergave-assistent 
instelling aan/uit

Scherm Assignable Button Status

Geeft de functies weer die aan de toewijsbare 
knoppen zijn toegewezen.

Displayonderdeel Beschrijving

1 Functie toegewezen aan de 
knop ASSIGN 1

2 Functie toegewezen aan de 
knop ASSIGN 2

3 Functie toegewezen aan de 
knop ASSIGN 3

4 Functie toegewezen aan de 
knop ASSIGN 4

5 Functie toegewezen aan de 
knop ASSIGN 5

6 Functie toegewezen aan de 
knop ASSIGN 6

7 Functie toegewezen aan de 
knop ASSIGN 7

8 Functie toegewezen aan de 
knop ASSIGN 8

9 Functie toegewezen aan de 
knop ASSIGN 9

Focus Hold 
Button

Functie toegewezen aan de 
knop Focus Hold van het 
objectief

Multi Function 
Dial

Functie toegewezen aan de 
multifunctionele regelaar

Grip Dial Functie toegewezen aan de 
toewijsbare regelaar van de 
handgreep

Handle Dial Functie toegewezen aan de 
toewijsbare regelaar van de 
draaggreep

Scherm Battery Status

Geeft informatie weer over de accu en de 
netstroombron (DC IN).

Displayonderdeel Beschrijving

Detected Battery Type accu

Remaining Resterende capaciteit (%)

Charge Count Aantal laadcycli

Capacity Resterende capaciteit (Ah)

Voltage Accuvoltage (V)

Manufacture 
Date

Fabricagedatum accu

Video Light 
Remaining

Geeft de resterende 
capaciteit van de 
videolampaccu weer.

Power Source Voedingsbron

Supplied Voltage Geleverd voedingsvoltage
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Scherm Media Status

Geeft de resterende capaciteit en resterende 
opnametijd van opnamemedia weer.

Displayonderdeel Beschrijving

Media A 
informatie

Geeft het mediapictogram 
weer als opnamemedia is 
geplaatst in sleuf A.

Media A meter 
resterende 
capaciteit

Geeft de resterende 
capaciteit weer van 
opnamemedia geplaatst in 
sleuf A, uitgedrukt als een 
percentage op een 
balkgrafiek.

Media A 
resterende 
opnametijd

Geeft een schatting weer 
van de resterende 
opnametijd van het 
opnamemedium geplaatst 
in sleuf A in 
minuteneenheden onder de 
huidige opnamecondities.

Media B 
informatie

Geeft het mediapictogram 
weer als opnamemedia is 
geplaatst in sleuf B.

Media B meter 
resterende 
capaciteit

Geeft de resterende 
capaciteit weer van 
opnamemedia geplaatst in 
sleuf B, uitgedrukt als een 
percentage op een 
balkgrafiek.

Media B 
resterende 
opnametijd

Geeft een schatting weer 
van de resterende 
opnametijd van 
opnamemedia geplaatst in 
sleuf B in minuteneenheden 
onder de huidige 
opnamecondities.

Scherm Network Status

Geeft de netwerkverbindingsstatus weer.

Displayonderdeel Beschrijving

Wireless LAN Draadloze netwerkinstelling 
en verbindingsstatus

Wired LAN Bekabelde LAN-
netwerkinstelling en 
verbindingsstatus

Modem Draadloze netwerkinstelling 
en verbindingsstatus van 
USB-tethering

Scherm File Transfer Status

Geeft bestandsoverdrachtinformatie weer.

Displayonderdeel Beschrijving

Auto Upload Aan-uitstatus van de functie 
Auto Upload

Auto Upload 
(Proxy)

Aan-uit-segmentstatus van 
de functie Auto Upload 
(Proxy)

Total Transfer 
Progress

Overdrachtsvoorgang van 
alle taken

Default Upload 
Server

Naam van Auto Upload 
(Proxy) bestemmingsserver

Job Status 
(Remain / Total)

Resterend aantal taken en 
totaal aantal taken

Current File 
Transfer Progress

Overdrachtsvoortgang van 
de huidige 
bestandsoverdracht

Current 
Transferring File 
Name

Naam van het bestand dat 
momenteel wordt 
overgedragen

Server Address Adres van transmissie-
bestemmingsserver

Destination 
Directory

Bestemmingsdirectory voor 
transmissiebestemmings-
server

Gebruik van aanraakschermen voor instellen

Schermindeling

Onderdeel

Markering die de huidige 
instelling aangeeft

Set-toets (toepassen)

Selectiecursor voor 
instellen 
(oranje kader)

Naam onderdeel

Selectie-opties

Bediening

1	 Tik op een configuratie-onderdeel.

Tik

De selectieopties voor de waarde 
verschijnen.

2	 Sleep naar of tik op een instelling om de 
waarde te selecteren.

Aantikken

3	 Tik op de toets Set of de 
waardeselectiecursor.
De waarde wordt toegepast en het 
display keert terug naar het vorige 
scherm.

[Tips]
ˎˎ Druk op de knop CANCEL/BACK om naar de vorige 

waarde te gaan.
ˎˎ U kunt ook de multifunctionele regelaar of 

keuzeschakelaar gebruiken.
ˎˎ Aanraakbediening kan ook worden uitgeschakeld 

(pagina 100).
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Stroomvoorziening
U kunt een accuset gebruiken of netstroom via 
een netadapter.
Gebruik voor uw veiligheid alleen de hieronder 
vermelde Sony accusets en netadapters.

Lithium-ion accusets
BP-U35 (meegeleverd)
BP-U60
BP-U60T
BP-U70
BP-U90
BP-U100

Acculaders
BC-CU1 (meegeleverd)
BC-U1A
BC-U2A

Netadapter (meegeleverd)
[LET OP]

Bewaar accusets niet op plaatsen die 
blootstaan aan direct zonlicht, open vuur of 
hoge temperaturen.

[Opmerkingen]
ˎˎ Gebruik bij werken op een locatie met netstroombron 

de meegeleverde netadapter.
ˎˎ Zet de POWER-schakelaar altijd in de stand Off 

voordat u een accu of netadapter aansluit. Als de 
aansluiting plaatsvindt terwijl de POWER-schakelaar 
op On staat, kan de camcorder in sommige gevallen 
mogelijk niet starten. Als de camcorder niet kan 
worden gestart, zet de POWER-schakelaar dan in 
de Off-stand en maak de accuset of de netadapter 
tijdelijk los, en wacht vervolgens 30 seconden 
alvorens opnieuw aan te sluiten. (Als de netadapter 
is aangesloten terwijl de camcorder werkt op 
de accuset, kan deze zonder problemen worden 
aangesloten met de POWER-schakelaar in de aan-
stand).

Een accuset gebruiken

Om een accuset aan te sluiten steekt u 
deze zo ver mogelijk in de aansluitopening 
(pagina 7) en schuift u deze daarna 
omlaag om de set vast op zijn plaats te 
vergrendelen.

Om een accuset te verwijderen houdt u de 
knop BATT RELEASE (pagina 7) ingedrukt, 
schuift u de accuset omhoog en trekt deze 
vervolgens uit de aansluitopening.

Knop BATT 
RELEASE

[Opmerkingen]
ˎˎ Laad voor het bevestigen van een accuset de accu 

op met de speciale accu-opladers BC‑CU1, BC-U1A, of 
BC‑U2A.
ˎˎ Opladen van een accuset als deze nog warm is 

(bijvoorbeeld direct na gebruik) kan resulteren in het 
niet volledig opladen van de accu.

De resterende capaciteit controleren

Bij het filmen/afspelen bij gebruik van een 
accuset wordt de resterende accucapaciteit 
weergegeven in de zoeker (pagina 11).

Pictogram Betekenis

91% t/m 100%

71% t/m 90%

51% t/m 70%

31% t/m 50%

11% t/m 30%

0% t/m 10%

De camcorder geeft de resterende capaciteit 
aan door de beschikbare tijd met de accuset 
te berekenen als de werking wordt voortgezet 
met het huidige energieverbruik.

Als de acculading minder wordt

Als de resterende acculading tijdens gebruik 
onder een bepaald niveau daalt (status Low 
Battery), verschijnt er een bericht dat de accu 
bijna leeg is en begint het opname/tally-
lampje te knipperen om u te waarschuwen.
Als de resterende acculading onder het niveau 
komt waarop verder werken niet mogelijk is 
(status Battery Empty) verschijnt een melding 
dat de accu leeg is.
Vervangen door een opgeladen accuset.

De waarschuwingsniveaus wijzigen

Vanuit de fabriek is het niveau Low Battery 
ingesteld op 10% van de volledige acculading 
en het niveau Battery Empty op 3%. U kunt het 
waarschuwingsniveau instellen met Camera 
Battery Alarm (pagina 102) in het menu 
Technical van het hoofmenu.

De accuset opladen met behulp van de 
meegeleverde acculader (BC-CU1)

1	 Sluit de netadapter (meegeleverd) aan op 
de acculader en sluit het netsnoer 
(meegeleverd) aan op de netstroombron.

2	 Duw de accu erin en schuif deze in de 
richting van de pijl.
De CHARGE-lamp gaat oranje branden en 
het opladen begint.

CHARGE-lamp

Netadapter

Netsnoer

CHARGE-lamp (oranje)
Brandt: �Laadt op
Knippert: �Oplaadfout, of de temperatuur 

bevindt zich buiten 
bedrijfstemperatuur en het opladen 
wordt gepauzeerd.

ˎˎ De CHARGE-lamp van de acculader.
ˎˎ Gebruik altijd originele Sony-accu's.
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Laadtijd
Geschatte tijd (in minuten) die vereist is om 
een volledig ontlade accuset op te laden.

Accuset Volledige laadtijd

BP-U35 120 minuten

[Opmerking]
Als de netadapter wordt losgekoppeld van de acculader 
en de accu blijft aangesloten op de acculader, gaat de 
accu zich ontladen.

Netstroom gebruiken

Als de camcorder op de netstroom wordt 
aangesloten is gebruik zonder zorgen over het 
opladen van de accuset mogelijk.

Netstroomingang

Netadapter

Netsnoer

Sluit de netadapter aan op de DC IN-
aansluiting op de camcorder en sluit 
het netsnoer (meegeleverd) aan op de 
netstroombron.

Als het uitgangsvoltage van de 
netadapter laag wordt

Als het uitgangsvoltage van de netadapter 
tijdens bedrijf onder een bepaald niveau komt 
(status DC Low Voltage1), verschijnt er een 
melding dat het voltage van de netadapter 
is gedaald en gaat het opname/tally-lampje 
gaat knipperen.
Als het uitgangsvoltage van de netadapter 
tijdens bedrijf onder het niveau komt waarop 
gebruik niet meer mogelijk is (status DC Low 
Voltage2) verschijnt er een melding dat het 
voltage van de netadapter te laag is.
Als dit gebeurt kan de netadapter defect zijn. 
Controleer de netadapter, zoals vereist.

De waarschuwingsvoltages wijzigen

Het niveau van DC Low Voltage1 is vanuit 
de fabriek ingesteld op 16,5 V en het niveau 
van DC Low Voltage2 op 15,5 V. U kunt de 
waarschuwingsniveaus instellen met Camera 
DC IN Alarm (pagina 102) in het menu 
Technical.

Netadapter

ˎˎ Sluit een netadapter niet aan of gebruik 
deze in een krappe ruimte, zoals tussen een 
muur en meubels.
ˎˎ Steek de netadapter in het dichtstbijzijnde 
stopcontact. Als er zich tijdens het 
werken een probleem voordoet, trek 
dan onmiddellijk het netsnoer uit het 
stopcontact.
ˎˎ Maak geen kortsluiting met de metalen 
onderdelen van de stekker van de 
netadapter. Dit heeft een defect tot gevolg.
ˎˎ De accu kan niet worden opgeladen als 
deze aan de camcorder is bevestigd, zelfs 
als de netadapter is aangesloten.
ˎˎ Pak bij het loskoppelen van de netadapter 
de stekker rechtstreeks vast en trek deze 
recht uit het stopcontact. Trekken aan de 
kabel kan een defect veroorzaken.



2. Voorbereiding19

Apparaten aansluiten

De microfoon aansluiten (apart 
aanschaffen)

1	 Plaats de microfoon in de 
microfoonhouder.

2	 Sluit de microfoonkabel aan op de 
aansluitingen INPUT1 of INPUT2.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Microfoon

Microfoonhouder

INPUT1 INPUT2

3	 Plaats de microfoonkabel in de 
kabelhouder, zoals in de afbeelding wordt 
weergegeven.

Kabelhouder

[Tips]
ˎˎ Als de microfoon niet stabiel kan worden bevestigd, 

gebruik dan de afstandhouder die bij de microfoon 
wordt geleverd.
ˎˎ Afhankelijk van het bevestigde objectief kan het 

uiteinde van de microfoon zichtbaar zijn in het 
camcorderbeeld. Pas de positie van de microfoon aan.

De zoeker bevestigen

[Opmerking]
Bevestig/verwijder de zoeker als de camcorder is 
uitgeschakeld.

De zoeker aan de voorkant van de 
draaggreep bevestigen

1	 Plaats de montageklemadapter van de 
zoeker in de zoekerbevestiging van de 
draaggreep () en draai de schroef 
(meegeleverd) naar rechts om de adapter 
op zijn plaats te fixeren ().
De montageklemadapter kan vrij worden 
bevestigd in stappen van 45°, maar de 
positie waarbij het bevestigingspunt zich 
direct boven de schroef bevindt, wordt 
geadviseerd.

Schroef
Montageklemadapter 
van de zoeker

2	 Monteer de zoekerklem op de 
montageklemadapter van de zoeker () 
en draai de vergrendelknop naar rechts 
om de adapter op zijn plaats te fixeren 
().

[Opmerking]
Zorg dat de vergrendelknop bij gebruik van de 
zoeker stevig vast zit. De zoeker kan eraf vallen als de 
vergrendelknop niet stevig vastgedraaid is.

3	 Lijn de -markering op de camcorder uit 
met de -markering op de 
zoekeraansluiting, en bevestig de kabel.
Zorg dat de -markering zich aan de 
buitenzijde bevindt, alvorens de stekker te 
plaatsen.

4	 Plaats het snoer in de snoerhouder, zoals 
weergegeven in de afbeelding.

Kabelhouder
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De zoeker aan de achterkant van de 
draaggreep bevestigen

Er zijn twee bevestigingspunten, aan de 
achterkant van de draaggreep () en aan de 
achterkant van de camcorder () voor het 
bevestigen van de zoeker. Bevestig de zoeker 
op dezelfde manier als beschreven in "De 
zoeker aan de voorkant van de draaggreep 
bevestigen".

De positie van de zoeker aanpassen

Kantel de zoeker omhoog/omlaag/vooruit/
achteruit om de hoek van de zoeker aan te 
passen.
U kunt de MIRROR-schakelaar gebruiken om 
het beeld om te draaien als u bijvoorbeeld 
vanaf de voorkant van de camcorder kijkt.

[Tip]
Als het apparaat niet wordt gebruikt of wordt 
getransporteerd, wordt geadviseerd de zoeker in een 
positie te plaatsen zoals in de volgende afbeelding, om 
de zoeker te beschermen.

De zoeker verwijderen

Maak de vergrendelknop van de zoeker los en 
voer de handelingen voor het bevestigen van 
de zoeker in de omgekeerde volgorde uit.

De zoekerkap bevestigen

1	 Open de metalen clips op de zoekerkap.

2	 Bevestig de metalen beugel aan de 
bovenkant van de zoekerkap aan de haak 
aan de bovenkant van de zoeker en 
bevestig de metalen clip aan de 
onderkant van de zoekerkap aan de haak 
aan de onderkant van de zoeker.

Bevestigingshaken

3	 Duw de vergrendelplaat aan de onderkant 
van de zoekerkap in de richting van de pijl 
om de zoeker in kappositie te 
vergrendelen.

Vergrendelingsplaat

De zoekerkap openen

Trek de middenonderkant van de zoekerkap 
uit naar u toe, en duw vervolgens omhoog om 
de kap te openen.

[Opmerking]
Houd bij het verplaatsen van de zoeker de body van 
de zoeker vast als u verplaatst. Niet vastpakken aan de 
zoekerkap.

De zoekerkap verwijderen

Maak de klem van de zoekerkapvergrendeling 
los en verwijder de zoekerkap van de zoeker.
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De afstandsbedieningsgreep 
bevestigen

[Opmerking]
Bevestig of verwijder de afstandsbedieningsgreep 
terwijl de camcorder is uitgeschakeld.

1	 Sluit de kabel aan op de aansluiting van 
de afstandsbedieningsgreep.

2	 Breng de bevestiging van de 
afstandsbedieningsgreep van de 
camcorder en de montagemarkering op 
de greep op één lijn (), bevestig de 
greep aan de camcorder en draai deze 
langzaam naar links ().
U hoort een klikgeluid als de greep in 
positie vergrendelt.

Indexmarkering

[Opmerking]
Als correcte bevestiging niet lukt, bevestig 
dan opnieuw zonder overmatige kracht op de 
afstandsbedieningsgreep of op de camcorder uit te 
oefenen.

3	 Steek de in stap twee aangesloten kabel 
onder de sleuf van de 
afstandsbedieningsgreep, zoals in de 
afbeelding wordt weergegeven.

[Opmerking]
Als de kabel niet onder de sleuf wordt geplaatst kan het 
wijzigen van de hoekbevestiging overmatig veel kracht 
uitoefenen op de kabel, of de kabel kan klem komen te 
zitten in het draaimechanisme.

De hoek van de 
afstandsbedieningsgreep aanpassen

U kunt de hoek van de 
afstandsbedieningsgreep aanpassen over 
een bereik zoals weergegeven in de volgende 
afbeelding, om deze aan te passen aan uw 
stijl van filmen.

Standaardpositie

Naar het objectief gedraaid (90° max.)

Naar de achterkant gedraaid (83° max.)

1	 Beweeg de rotatieregelaar op de 
draaggreep naar de in de afbeelding 
weergegeven stand, en draai de greep 
terwijl u de regelaar ingedrukt houdt.

2	 Haal uw vinger van de rotatieregelaar op 
de draaggreep bij de gewenste stand.

3	 Verplaats de greep enigszins tot u een 
klikgeluid hoort, wat aangeeft dat de 
greep op zijn plaats is vergrendeld.
Als de draaggreep is gezekerd, keert de 
rotatieregelaar terug naar de 
oorspronkelijke stand.

[Opmerkingen]
ˎˎ Controleer na het wijzigen van de stand altijd of de 

greep stabiel is geplaatst.
ˎˎ De hoek kan niet verder worden aangepast dan 

binnen het aanpassingsbereik. Gebruik geen 
overmatige kracht bij het draaien van de greep.
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De greep vasthouden (geadviseerde 
methode)

Er zijn geen regels voor het vasthouden van 
de greep, maar het volgende voorbeeld toont 
een manier voor makkelijke bediening van de 
greep.

Bij gebruik van de knop ASSIGN 5 of 
keuzeschakelaar

A: Bedien de toewijsbare regelaar van de 
handgreep met uw wijsvinger.
B: Bedien de keuzeschakelaar en de knop 
ASSIGN 5 met uw duim.
C: Houd de handgreep stevig vast met uw 
middelvinger, ringvinger en pink.

Bij bedienen van de Zoom

A: bedien de zoomregelaar met uw wijsvinger 
en middelvinger.
B: Houd de greep stevig vast met uw duim.
C: Houd de greep stevig vast met uw 
ringvinger en pink.

De greep verwijderen

[Opmerking]
Plaats bij het verwijderen van de greep de camcorder op 
een vlak oppervlak, zoals een bureau.

1	 Maak de kabel los van de aansluiting van 
de afstandsbedieningsgreep.

2	 Houd de vrijgaveknop voor de 
afstandsbedieningsgreep op de 
camcorder ingedrukt en draai de greep 
naar rechts tot deze loskomt.

Vrijgaveknop voor de 
afstandsbedieningsgreep

[Tip]
Er kan een rozet worden bevestigd aan zowel het 
greepbevestigingspunt op het apparaat als het 
bijbehorende bevestigingspunt op de greep.
Neem voor details over het aanschaffen van rozetten 
contact op met uw Sony-dealer.
–– Camcorderzijde: 4-546-932- (optie)
–– Greepzijde: 4-547-089- (optie)
–– Bevestigingsschroeven* 

Camcorderzijde: 7-627-556- (optie) 
Greepzijde: 7-627-556- (optie)

*	 Voor elke rozet zijn vier schroeven vereist 
(schroefgaten worden aangegeven door de cirkels 
in de volgende afbeelding). Gebruik van andere 
schroeven dan vermeld kan schade aan externe 
onderdelen veroorzaken.

Camcorderzijde Greepzijde

Een objectief bevestigen

[LET OP]
Laat het objectief niet met de lens in de 
zon liggen. Direct zonlicht kan de lens 
binnendringen, een brandpunt vormen in de 
camcorder en zo brand veroorzaken.

[Opmerkingen]
ˎˎ Bevestig/verwijder een objectief als de camcorder is 

uitgeschakeld.
ˎˎ Een objectief is een precisiecomponent. Plaats 

het objectief niet op een oppervlak met de 
objectiefbevestiging omlaag. Bevestig de 
meegeleverde objectiefbevestigingsdop.

[Tip]
Neem voor details over objectieven die door de 
camcorder worden ondersteund contact op met uw 
Sony servicevertegenwoordiging.

Een objectief met E-bevestiging 
bevestigen

1	 Verwijder de lensdop en kap van de 
camcorder en het objectief.

2	 Lijn de objectiefmontagemarkering (wit) 
uit met de camcorder, plaats het objectief 
en draai het daarna naar rechts.
U hoort een klikgeluid als de greep in 
positie vergrendelt.

Bevestigingsmarkeringen (wit)

[Opmerking]
Druk niet op de objectiefvrijgaveknop bij het bevestigen 
van het objectief.

Een objectief met A-bevestiging 
bevestigen

Om een objectief met A-bevestiging te 
gebruiken bevestigt u een objectiefadapter 
(optie) en bevestigt u vervolgens het objectief 
met A-bevestiging.

[Opmerking]
Bij gebruik van een objectief met A-bevestiging 
wordt het diafragma handmatig ingesteld en is de 
scherpstelling ingesteld op MF.

Een objectief verwijderen

Verwijder een objectief met de volgende 
procedure.

1	 Houd de objectiefvrijgaveknop ingedrukt 
en draai het objectief naar links terwijl u 
het ondersteunt.

2	 Trek het objectief er in voorwaartse 
richting uit.
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[Opmerkingen]
ˎˎ Lijn bij het verwijderen van een objectief 

de bevestigingsmarkering op de 
objectiefvergrendelingsring uit met de 
bevestigingsmarkering op de camcorder.
ˎˎ Pak het objectief stevig vast, zodat het niet kan vallen.
ˎˎ Als er niet direct een ander objectief wordt bevestigd, 

bevestig dan altijd de bodydop.

Diafragma-aanpassingen voor 
objectieven met Auto Iris-schakelaar

ˎˎ Als de Auto Iris van het objectief is ingesteld 
op AUTO, wordt het diafragma automatisch 
aangepast, maar kan ook handmatig vanaf 
de camcorder worden ingesteld.
ˎˎ Als de Auto Iris van het objectief is ingesteld 
op MANUAL, kan het diafragma alleen 
worden aangepast met de objectiefring. 
Bediening van het diafragma vanaf de 
camcorder heeft geen effect.

Scherpstellingsaanpassingen voor 
objectieven met scherpstellingsschakelaar

ˎˎ Als de scherpstellingsschakelaar voor het 
objectief is ingesteld op AF/MF of AF, wordt 
de scherpstelling automatisch aangepast 
en kan ook handmatig worden aangepast 
vanaf een afstandsbediening.
ˎˎ Als de scherpstellingsschakelaar van 
het objectief is ingesteld op MF, wordt 
de scherpstelling aangepast met de 
objectiefring en kan ook handmatig worden 
aangepast vanaf een afstandsbediening.

	 [Opmerking]
Bij gebruik van een objectief met A-bevestiging is 
handmatige aanpassing vanaf een afstandsbediening 
mogelijk niet beschikbaar.

ˎˎ Als de scherpstellingsschakelaar van een 
objectief is ingesteld op Full MF, kan de 
scherpstelling alleen worden aangepast met de 
objectiefring. Bediening van de scherpstelling 
op de camcorder heeft geen effect.

Een statief bevestigen
Gebruik de schroefopening op de camcorder 
voor het bevestigen van een statief. Gebruik 
van de statiefbevestiging op het objectief kan 
schade veroorzaken.
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Basisbediening van de camcorder configureren
De eerste keer dat de camcorder wordt 
ingeschakeld of als de back-upaccu volledig 
is ontladen verschijnt het beginscherm voor 
instellingen in de zoeker.
Stel in dit scherm de datum en tijd van de 
interne klok in.

Time Zone
Time Zone stelt het tijdsverschil in met UTC 
(Coordinated Universal Time). Wijzig zo nodig 
de instelling.

De datum en tijd instellen

Gebruik de keuzeschakelaar (pagina 7) of 
de multifunctionele regelaar (pagina 5) 
om onderdelen en instellingen te selecteren 
en druk vervolgens op de toepassingsknop 
van de keuzeschakelaar om de instellingen toe 
te passen en het lopen van de klok te starten.
Zodra het instelscherm is gesloten kunt u de 
datum, tijd en tijdzone-instelling wijzigen 
met Clock Set (pagina 107) in het menu 
Maintenance.

[Opmerkingen]
ˎˎ Als de klokinstelling verloren gaat omdat de back-

up-batterij leeg is vanwege gedurende langere 
tijd geen aangesloten voeding (geen accuset en 
geen DC IN stroombron), wordt het oorspronkelijke 
instellingenscherm weergegeven als u de camcorder 
weer inschakelt.
ˎˎ Terwijl het beginscherm voor instellingen wordt 

weergegeven is er geen andere bediening mogelijk, 
behalve het apparaat in- of uitschakelen, totdat u de 
instellingen in dit scherm heeft afgerond.
ˎˎ De camcorder heeft een ingebouwde oplaadbare 

batterij voor het opslaan van datum, tijd en 
andere instellingen, zelfs als de camcorder wordt 
uitgeschakeld.

Configureer voor het filmen de voor de 
toepassing geschikte basisbediening van de 
camcorder op het scherm status Project.

Opnamemodus

U kunt de opnamemodus schakelen tussen 
"modus Custom" om flexibel op locatie 
beelden te maken en "Cine EI-modus" 
(waarbij de camcorder op dezelfde manier 
wordt bediend als een filmcamera, met 
beeldmateriaal ontwikkeld in postproductie).
Stel de opnamemodus in met Shooting Mode 
(pagina 15) op het scherm status Project.

[Tip]
U kunt ook de opnamemodus instellen met Base Setting 
>Shooting Mode (pagina 83) in het menu Project van 
het hoofdmenu.

Custom modus

In de Custom filmmodus kunt u de 
videostandaard selecteren.
U kunt de videostandaard instellen met Base 
Setting >Target Display (pagina 83) in het 
menu Project van het hoofdmenu.
ˎˎ SDR(BT.709): Filmen volgens HD broadcast-
norm
ˎˎ HDR(HLG): Filmen volgens de nieuwe 
generatie 4K broadcast-norm

Zie voor details pagina 56.

Cine EI-modus

Als de opnamemodus is ingesteld op 
de modus Cine EI, selecteer dan het 
basiskleurbereik voor het opnamesignaal 
en uitgangssignaal. Het hier geselecteerde 
kleurbereik is het kleurbereik van de video-
uitvoer als MLUT is ingesteld op Off.
U kunt het kleurbereik instellen met Cine EI 
Setting >Color Gamut (pagina 84) in het 
menu Project van het hoofdmenu.
ˎˎ S-Gamut3.Cine/SLog3: Makkelijk voor het 
aanpassen van kleurbereik voor digitale 
cinema (DCI-P3).
ˎˎ S-Gamut3/SLog3: breed Sony kleurbereik 
dat het ITU-R BT.2020 kleurbereik omvat.

Zie voor details pagina 58.

[Opmerkingen]
ˎˎ Cine EI-modus heeft de volgende beperkingen.

ˎˎ Functies die niet automatisch kunnen worden 
aangepast (tracking)
–– Witbalans
–– Versterking
–– Sluiter

ˎˎ Functies die niet kunnen worden geconfigureerd
–– ISO gevoeligheid/versterking (ingesteld op 

basis-ISO-gevoeligheid (vast))
–– Menu-instellingen Paint/Look (exclusief Base 

Look)
–– Scene File (uitgeschakeld)

ˎˎ De volgende functies zijn alleen beschikbaar in de 
modus Cine EI (pagina 58).

ˎˎ Exposure Index
ˎˎ Monitor LUT

Systeemfrequentie

Stel de systeemfrequentie in met Frequency/
Scan (pagina 15) op het scherm status 
Project. De camcorder kan mogelijk 
automatisch herstarten na overschakeling, 
afhankelijk van de geselecteerde waarde.

[Tip]
U kunt de systeemfrequentie ook instellen met Rec 
Format >Frequency (pagina 83) in het menu Project 
van het hoofdmenu.

[Opmerking]
U kunt de systeemfrequentie niet overschakelen tijdens 
opnemen of afspelen.

Scanmodus beeldsensor

U kunt de effectieve beeldgrootte en resolutie 
van de beeldsensor instellen.
Stel de scanmodus in met Imager Scan 
(pagina 15) op het scherm status Project.
ˎˎ FF: volledige kadergrootte.
ˎˎ S35: Super 35mm size.

[Tip]
U kunt de scan modus ook instellen met Rec Format 
>Imager Scan Mode (pagina 83) in het menu Project 
van het hoofdmenu.

[Opmerkingen]
ˎˎ De scanmodus van de beeldsensor kan niet worden 

omgeschakeld tijdens opnemen of afspelen.
ˎˎ Indien ingesteld op S35 is het videoformaat beperkt 

tot 1920×1080.

Codec

Stel de codec in met Codec (pagina 15) op 
het scherm status Project.

[Tip]
U kunt de codec ook instellen met Rec Format >Codec 
(pagina 83) in het menu Project van het hoofdmenu.

[Opmerking]
U kunt de codec niet omschakelen tijdens opnemen of 
afspelen.
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Video-indeling

U kunt de video-indeling voor opnemen 
instellen. Stel de video-indeling in met Video 
Format (pagina 15) op het scherm status 
Project.

[Tip]
U kunt de video-indeling ook instellen met Rec Format 
>Video Format (pagina 83) in het menu Project van 
het hoofdmenu.

[Opmerkingen]
ˎˎ U kunt de video-indeling niet omschakelen tijdens 

opnemen of afspelen.
ˎˎ Er kunnen beperkingen gelden voor het signaal van 

de aansluitingen SDI OUT en HDMI OUT, afhankelijk 
van de instelling voor video-indeling.
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De camcorder neemt audio en video op CFexpress Type A geheugenkaarten (apart verkrijgbaar) 
op of op SDXC geheugenkaarten (apart verkrijgbaar) die in kaartsleuven zijn geplaatst. De 
geheugenkaarten worden ook gebruikt voor proxy-opname, het opslaan/laden van instellingen 
en tijdens upgraden (software-update).

Over CFexpress Type A geheugenkaarten

Gebruik in de camcorder de Sony CFexpress Type A geheugenkaarten* vermeld in “Aanbevolen 
media” (pagina 27).
Raadpleeg voor details over werken met media van andere fabrikanten de gebruiksaanwijzing 
voor de media of de informatie van de producent.
* �In dit document aangeduid als "CFexpress geheugenkaarten".

Over SDXC-geheugenkaarten

Gebruik in de camcorder de SDXC geheugenkaarten* vermeld in “Aanbevolen media” 
(pagina 27).
* �In dit document aangeduid als "SD-kaarten".

Geheugenkaarten gebruiken
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Aanbevolen media

De gegarandeerde functioneringscondities variëren afhankelijk van de instellingen voor Rec Format en Recording.
Ja: Functioneren wordt ondersteund
Nee: Normaal functioneren niet gegarandeerd

Opname-indeling CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096×2160
Class300

Normale modus 59.94P Ja Nee Nee Nee Nee Nee Nee Ja

50P Ja Nee Nee Nee Nee Nee Nee Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

24P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Ja Ja

3840×2160
Class300

Normale modus 59.94P Ja Nee Nee Nee Nee Nee Nee Ja

50P Ja Nee Nee Nee Nee Nee Nee Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Ja Ja

S&Q (60fps of minder) 59.94P Ja Nee Nee Nee Nee Nee Nee Ja

50P Ja Nee Nee Nee Nee Nee Nee Ja

29.97P Ja Nee Nee Nee Nee Nee Nee Ja

25P Ja Nee Nee Nee Nee Nee Nee Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Ja

S&Q (100fps, 120fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Nee

50P Ja Nee Nee Nee Nee Nee Nee Nee

29.97P Ja Nee Nee Nee Nee Nee Nee Nee

25P Ja Nee Nee Nee Nee Nee Nee Nee

23.98P Ja Nee Nee Nee Nee Nee Nee Nee
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Opname-indeling CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Normale modus 59.94P Ja Nee Nee Nee Nee Nee Nee Ja

50P Ja Nee Nee Nee Nee Nee Nee Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

24P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Ja Ja

S&Q (60fps of minder) 59.94P Ja Nee Nee Nee Nee Nee Nee Ja

50P Ja Nee Nee Nee Nee Nee Nee Ja

29.97P Ja Nee Nee Nee Nee Nee Nee Ja

25P Ja Nee Nee Nee Nee Nee Nee Ja

24P Ja Nee Nee Nee Nee Nee Nee Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Ja

3840×2160
Class300 

Normale modus 59.94P Ja Nee Nee Nee Nee Nee Nee Ja

50P Ja Nee Nee Nee Nee Nee Nee Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Ja Ja

S&Q (60fps of minder) 59.94P Ja Nee Nee Nee Nee Nee Nee Ja

50P Ja Nee Nee Nee Nee Nee Nee Ja

29.97P Ja Nee Nee Nee Nee Nee Nee Ja

25P Ja Nee Nee Nee Nee Nee Nee Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Ja

S&Q (100fps, 120fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Nee

50P Ja Nee Nee Nee Nee Nee Nee Nee

29.97P Ja Nee Nee Nee Nee Nee Nee Nee

25P Ja Nee Nee Nee Nee Nee Nee Nee

23.98P Ja Nee Nee Nee Nee Nee Nee Nee
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Opname-indeling CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Normale modus 59.94P Ja Nee Nee Nee Nee Nee Ja Ja

50P Ja Nee Nee Nee Nee Nee Ja Ja

29.97P Ja Nee Nee Ja Nee Ja Ja Ja

25P Ja Nee Nee Ja Nee Ja Ja Ja

23.98P Ja Nee Nee Ja Nee Ja Ja Ja

S&Q (60fps of minder) 59.94P Ja Nee Nee Nee Nee Nee Ja Ja

50P Ja Nee Nee Nee Nee Nee Ja Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Ja Ja

S&Q (100fps, 120fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Ja

50P Ja Nee Nee Nee Nee Nee Nee Ja

29.97P Ja Nee Nee Nee Nee Nee Nee Ja

25P Ja Nee Nee Nee Nee Nee Nee Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Ja

S&Q (150fps, 180fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Nee

50P Ja Nee Nee Nee Nee Nee Nee Nee

29.97P Ja Nee Nee Nee Nee Nee Nee Nee

25P Ja Nee Nee Nee Nee Nee Nee Nee

23.98P Ja Nee Nee Nee Nee Nee Nee Nee

S&Q (200fps, 240fps) 59.94P Ja Nee Nee Nee Nee Nee Nee Nee

50P Ja Nee Nee Nee Nee Nee Nee Nee

29.97P Ja Nee Nee Nee Nee Nee Nee Nee

25P Ja Nee Nee Nee Nee Nee Nee Nee

23.98P Ja Nee Nee Nee Nee Nee Nee Nee
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Opname-indeling CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Normale modus 59.94P Ja Nee Nee Ja Nee Ja Ja Ja

50P Ja Nee Nee Ja Nee Ja Ja Ja

29.97P Ja Nee Nee Ja Nee Ja Ja Ja

25P Ja Nee Nee Ja Nee Ja Ja Ja

23.98P Ja Nee Nee Ja Nee Ja Ja Ja

S&Q (60fps of minder) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja

50P Ja Nee Nee Ja Nee Ja Ja Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Ja

S&Q (100fps, 120fps) 59.94P Ja Nee Nee Nee Nee Nee Ja Ja

50P Ja Nee Nee Nee Nee Nee Ja Ja

29.97P Ja Nee Nee Nee Nee Nee Nee Ja

25P Ja Nee Nee Nee Nee Nee Nee Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Nee

1920×1080
HD50

Normale modus 59.94P Ja Nee Nee Ja Nee Ja Ja Ja

50P Ja Nee Nee Ja Nee Ja Ja Ja

29.97P Ja Nee Nee Ja Nee Ja Ja Ja

25P Ja Nee Nee Ja Nee Ja Ja Ja

23.98P Ja Nee Nee Ja Nee Ja Ja Ja

S&Q (60fps of minder) 59.94P Ja Ja Ja Ja Ja Ja Ja Ja

50P Ja Ja Ja Ja Ja Ja Ja Ja

29.97P Ja Nee Nee Ja Nee Ja Ja Ja

25P Ja Nee Nee Ja Nee Ja Ja Ja

23.98P Ja Nee Nee Ja Nee Ja Ja Ja

S&Q (100fps, 120fps) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja

50P Ja Nee Nee Ja Nee Ja Ja Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Ja Ja
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Opname-indeling CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150fps, 180fps) 59.94P Ja Nee Nee Nee Nee Nee Ja Ja

50P Ja Nee Nee Nee Nee Nee Ja Ja

29.97P Ja Nee Nee Nee Nee Nee Nee Ja

25P Ja Nee Nee Nee Nee Nee Nee Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Ja

S&Q (200fps, 240fps) 59.94P Ja Nee Nee Nee Nee Nee Ja Ja

50P Ja Nee Nee Nee Nee Nee Ja Ja

29.97P Ja Nee Nee Nee Nee Nee Nee Ja

25P Ja Nee Nee Nee Nee Nee Nee Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Ja

1920×1080
HD35

Normale modus 59.94P Ja Ja Ja Ja Ja Ja Ja Ja

50P Ja Ja Ja Ja Ja Ja Ja Ja

29.97P Ja Ja Ja Ja Ja Ja Ja Ja

25P Ja Ja Ja Ja Ja Ja Ja Ja

23.98P Ja Ja Ja Ja Ja Ja Ja Ja

S&Q (60fps of minder) 59.94P Ja Ja Ja Ja Ja Ja Ja Ja

50P Ja Ja Ja Ja Ja Ja Ja Ja

29.97P Ja Nee Nee Ja Nee Ja Ja Ja

25P Ja Nee Nee Ja Nee Ja Ja Ja

23.98P Ja Nee Nee Ja Nee Ja Ja Ja

S&Q (100fps, 120fps) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja

50P Ja Nee Nee Ja Nee Ja Ja Ja

29.97P Ja Nee Nee Ja Nee Ja Ja Ja

25P Ja Nee Nee Ja Nee Ja Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Ja Ja

S&Q (150fps, 180fps) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja

50P Ja Nee Nee Ja Nee Ja Ja Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Ja Ja

S&Q (200fps, 240fps) 59.94P Ja Nee Nee Ja Nee Ja Ja Ja

50P Ja Nee Nee Ja Nee Ja Ja Ja

29.97P Ja Nee Nee Nee Nee Nee Ja Ja

25P Ja Nee Nee Nee Nee Nee Ja Ja

23.98P Ja Nee Nee Nee Nee Nee Nee Ja
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Een geheugenkaart plaatsen

1	 Open de mediaklep van het 
kaartsleufgedeelte.

2	 Plaats een geheugenkaart.
ˎˎ Bij CFexpress-kaarten wijst het etiket 
naar links.

Etiket

ˎˎ Voor SD-kaarten wijst het etiket naar 
rechts met de schuin afgeplatte hoek 
aan de onderkant.

Afgeschuinde hoek

De toegangsindicator (pagina 6) 
brandt rood, en gaat branden als de kaart 
onbruikbaar is.

[Opmerking]
Als de toegangsindicator doorlopend rood knippert 
en niet groen wordt, schakel de camcorder dan 
tijdelijk uit, verwijder de geheugenkaart en zet deze 
er weer opnieuw in.

3	 Sluit de mediaklep.

[Opmerkingen]
ˎˎ De geheugenkaart, de geheugenkaartsleuf en 

beeldgegevens op de geheugenkaart kunnen 
beschadigd raken als de kaart geforceerd verkeerd 
om in de sleuf wordt geplaatst.
ˎˎ Gebruik bij opnemen op media die zijn geplaatst 

in zowel CFexpress Type A/SD-kaartsleuven A als B 
media die worden geadviseerd voor gebruik met de 
gebruikte opname-indeling in beide sleuven.

Een geheugenkaart uitwerpen

Open de mediaklep van het kaartgedeelte en 
druk de geheugenkaart voorzichtig een klein 
stukje naar binnen om de kaart uit te werpen.

[Opmerkingen]
ˎˎ Als de camcorder is uitgeschakeld of als de 

geheugenkaart wordt verwijderd terwijl er gegevens 
worden uitgewisseld kan de integriteit van de 
gegevens op de kaart niet worden gegarandeerd. 
Alle gegevens op de kaart kunnen verloren gaan. 
Controleer altijd of de toegangsindicator groen is of 
niet brandt, alvorens de camcorder uit te schakelen of 
de geheugenkaart te verwijderen.
ˎˎ Als een geheugenkaart direct na beëindiging van een 

opname wordt verwijderd kan deze heet zijn, maar dit 
duidt niet op een probleem.

Geheugenkaarten formatteren 
(initialiseren)

Als een niet geformatteerde geheugenkaart 
of een geheugenkaart wordt geplaatst die 
is geformatteerd met andere specificaties, 

verschijnt in de zoeker de melding "Media 
Needs to be Formatted".
Formatteer de kaart met de volgende 
procedure.

1	 Selecteer Format Media (pagina 93) in 
het menu TC/Media van het hoofdmenu.

2	 Selecteer Media(A) (sleuf A) of Media(B) 
(sleuf B) en kies de formatteerwijze, (Full 
Format of Quick Format).
Er verschijnt een bevestigingsmelding.
ˎˎ Full Format: Initialiseert de media 
volledig, inclusief de dataregio en 
databeheerinformatie.
ˎˎ Quick Format: Initialiseert alleen de 
databeheerinformatie van de media.

3	 Selecteer Execute.
Er verschijnt een melding terwijl het 
formatteren bezig is en de 
toegangsindicator brandt rood.
Als het formatteren is voltooid, verschijnt 
hiervan een melding. Druk op de 
multifunctionele regelaar om de melding 
te verwijderen.

[Opmerkingen]
ˎˎ Het formatteren van een geheugenkaart wist alle 

gegevens, inclusief opgenomen videogegevens en 
configuratiebestanden.
ˎˎ Er kunnen meldingen verschijnen tijdens de 

uitvoering, afhankelijk van de duur van het 
formatteringsproces.

Als het formatteren mislukt

Geheugenkaarten die niet worden 
ondersteund door de camcorder kunnen niet 
worden geformatteerd.
Er verschijnt een waarschuwingsmelding. Volg 
de instructies voor het vervangen van de kaart 
door een ondersteunde geheugenkaart.

Een op de camcorder geformatteerde 
kaart gebruiken in de sleuf van een 
ander apparaat

Maak eerst een back-up van de kaart en 
formatteer vervolgens de kaart in het apparaat 
dat wordt gebruikt.

De resterende opnametijd 
controleren

Bij het filmen (opnemen/stand-by) kunt u de 
resterende capaciteit van de geheugenkaart 
in elke sleuf monitoren met de sleuf A/B 
resterende media-indicators in de zoeker 
(pagina 11).
De resterende opnametijd wordt berekend 
met de resterende capaciteit van de 
media in elke sleuf en de huidige video-
indeling (opname-bitrate), en wordt in 
minuteneenheden weergegeven.

Geheugenkaart vervangingstiming

ˎˎ Wanneer de totale resterende opnametijd 
op de twee geheugenkaarten minder dan 
5 minuten wordt, verschijnt het bericht 
"Media Near Full", begint het opname/tally-
lampje te knipperen en zal een pieptoon 
(hoofdtelefoonuitgang) u waarschuwen.  
Vervangen door media met vrije ruimte.
ˎˎ Als u doorgaat met opnemen tot de totale 
resterende opnametijd nul bereikt, wordt 
de melding gewijzigd naar "Media Full" en 
stopt de opname.

[Opmerking]
Op een geheugenkaart kunnen ongeveer 600 clips 
worden opgenomen.
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Geheugenkaarten herstellen

Als er zich om bepaalde redenen een fout 
zou voordoen in een geheugenkaart, moet de 
kaart vóór gebruik worden hersteld.
Als u een geheugenkaart laadt die moet 
worden hersteld, verschijnt een melding op 
het zoekerscherm of u de kaart wilt herstellen.

Een kaart herstellen

Draai aan de multifunctionele regelaar 
(pagina 5) om Execute te selecteren 
en druk vervolgens op de multifunctionele 
regelaar.
Er worden een melding en voortgangsstatus 
(%) weergegeven tijdens het formatteren en 
de toegangsindicator brandt rood.
Als het herstellen is voltooid, verschijnt 
hiervan een melding.

Als herstellen mislukt

ˎˎ Geheugenkaarten waarop geheugenfouten 
hebben plaatsgevonden kunnen niet 
worden hersteld. Er verschijnt een 
waarschuwingsmelding. Volg de instructies 
om de kaart te vervangen.
ˎˎ Geheugenkaarten waarop geheugenfouten 
hebben plaatsgevonden worden mogelijk 
onbruikbaar als ze worden geformatteerd.
ˎˎ In sommige gevallen kunnen clips worden 
hersteld en andere niet. De herstelde clips 
kunnen normaal worden afgespeeld.

[Opmerkingen]
ˎˎ Herstel media die zijn opgenomen met deze 

camcorder ook met deze camcorder.
ˎˎ Media die zijn opgenomen met een ander apparaat 

dan deze camcorder of met een andere (soft- of 
firmware)versie van deze camcorder (ook al is het 
hetzelfde model) mogen niet met deze camcorder 
worden hersteld.
ˎˎ Clips die korter zijn dan 2 seconden kunnen niet 

worden hersteld.
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Basisbediening
Eenvoudig filmen wordt als volgt uitgevoerd.

1	 Bevestig de vereiste apparaten en 
controleer of er stroom beschikbaar is.

2	 Plaats de geheugenkaart(en).

3	 Zet de POWER-schakelaar in de stand on.
De POWER-indicator gaat aan en het 
camerabeeld verschijnt in de zoeker.

4	 Druk op de knop START/STOP 
(pagina 5).
Het opname/tally-lampje brandt en de 
opname begint.

5	 Om het opnemen te stoppen drukt u weer 
op de knop START/STOP.
Het opnemen stopt en de camcorder 
schakelt over op STBY (standby-modus).

[Opmerking]
Als de knop START/STOP voor opname binnen enkele 
seconden na het inschakelen van de camcorder wordt 
ingedrukt, gaat de opname/tally-lamp branden om aan 
te geven dat de eenheid zich in opnamemodus bevindt, 
maar opnemen op media kan nog enkele seconden op 
zich laten wachten, afhankelijk van de geselecteerde 
opname-indeling.

Overschakelen tussen 
geheugenkaarten

Als er twee geheugenkaarten zijn geplaatst, 
druk dan op de knop SLOT SELECT 
(pagina 6) om van kaart te wisselen.
Opnemen schakelt automatisch over naar 
de tweede geheugenkaart, vlak voordat de 
capaciteit van de eerste kaart nul wordt (relay-
opname). U kunt ononderbroken doorgaan 
met opnemen bij het overschakelen van 
geheugenkaart door de volle geheugenkaart 
te verwisselen voor een nieuwe 
geheugenkaart.

[Opmerkingen]
ˎˎ Tijdens afspelen kan niet worden overgeschakeld 

tussen geheugenkaarten. Ook het ononderbroken 
afspelen van een clip waarvan de media zich op twee 
geheugenkaarten bevinden is niet mogelijk.
ˎˎ Wanneer een beschrijfbare geheugenkaart is 

geplaatst in de tweede geheugenkaartsleuf, 
worden de geheugenkaarten niet omgeschakeld als 
alleen proxygegevens worden opgenomen op die 
geheugenkaart.

Clips (opgenomen gegevens)
Als u stopt met opnemen worden de video, de 
audio en bijbehorende gegevens van start tot 
eind van de opname opgeslagen als één "clip" 
op een geheugenkaart.

Clipnamen
De naam van elke door de camcorder 
opgenomen clip wordt automatisch 
toegewezen volgens de indeling die is 
ingesteld in Clip Name Format (pagina 93) 
van het menu TC/Media van het hoofdfmenu.

Maximale cliplengte
Maximaal 6 uur per clip.
De maximale duur van continue opname 
is hetzelfde als de maximale duur van een 
clip. Als de opnametijd de maximale duur 
van een clip overschrijdt, wordt automatisch 
een nieuwe clip aangemaakt en gaat het 

opnemen door. De nieuwe clip verschijnt als 
afzonderlijke clip op het pictogrammenscherm.

Meerder clips worden achter elkaar 
opgenomen tijdens relay-opname, maar het 
opnemen stopt automatisch na ongeveer 24 
uur.

[Opmerkingen]
ˎˎ Verwijder geen geheugenkaart tijdens het opnemen 

als erop wordt opgenomen. Vervang tijdens het 
opnemen alleen geheugenkaarten in sleuven 
waarvan de sleuftoegangsindicator niet brandt.
ˎˎ Als de resterende capaciteit op de geheugenkaart 

waarop wordt opgenomen minder dan een minuut 
wordt en een beschrijfbare geheugenkaart in de 
andere sleuf wordt geplaatst, verschijnt het bericht 
"Will Switch Slots Soon". De melding verdwijnt nadat 
er is gewisseld van geheugenkaartsleuf.
ˎˎ Relay-opname werkt mogelijk niet als het opnemen 

is gestart als de resterende capaciteit van de 
geheugenkaart minder dan een minuut is. Controleer 
voor correcte relay-opname of de capaciteit van de 
geheugenkaart meer dan een minuut is, voordat het 
opnemen wordt gestart.
ˎˎ Video die is gemaakt met de relay-functie van de 

camcorder kan niet naadloos worden afgespeeld op 
de camcorder.
ˎˎ Gebruik om video te combineren die is gemaakt 

met de relay-functie van de camcorder de software 
"Catalyst Browse".

Audio monitoren

U kunt de audio die wordt opgenomen 
monitoren met een hoofdtelefoon.
Als u een hoofdtelefoon op 
de hoofdtelefoonaansluiting 
(pagina 5) aansluit, kunt u de audio die 
wordt opgenomen monitoren. U kunt ook de 
afgespeelde audio monitoren (pagina 69) 
met de ingebouwde luidspreker (pagina 6) 
of hoofdtelefoon.
U kunt het geluidsvolume van de te monitoren 
audio aanpassen met Volume (pagina 14) 
op het scherm Audio Status of Audio Output 
>Volume (pagina 98) in het menu Audio 
van het hoofdmenu.

U kunt het te monitoren kanaal selecteren 
met Monitor CH (pagina 14) op het scherm 
Audio Status of Audio Output >Monitor CH 
(pagina 98) in het menu Audio van het 
hoofdmenu.
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Tijdgegevens instellen

De tijdcode instellen

Stel de tijdcode in die moet worden 
opgenomen met Timecode (pagina 92) in 
het menu TC/Media van het hoofdmenu.

Userbits instellen

U kunt een 8-bits hexadecimaal getal aan het 
opgenomen beeld als userbits toevoegen. 
U kunt de userbits ook op de huidige tijd 
instellen. Instellen met Users Bit (pagina 92) 
in het menu TC/Media.

Tijdgegevens weergeven

Stel de tijdcode die moet worden 
weergegeven in met TC Display (pagina 92) 
>Display Select in het menu TC/Media.
Indrukken van een toewijsbare knop 
(pagina 49) waaraan DURATION/TC/U-BIT 
is toegewezen, schakelt de weergave cyclisch 
om tussen tijdcode, userbits en tijdsduur.

De tijdcode invoer/uitvoer omschakelen

U kunt omschakelen tussen tijdcode invoer/
uitvoer met de keuzeschakelaar TC IN/OUT 
(pagina 4).
Zie voor details pagina 116.

Een opname controleren (Rec 
Review)

U kunt de laatst opgenomen clip op het 
scherm controleren (opname controleren).

[Opmerking]
Rec Review wordt niet ondersteund als de video-
indeling is gewijzigd na het opnemen van de clip.

Methode voor opname controleren

Wijs eerst Rec Review toe aan een van de 
toewijsbare knoppen.
Druk na het stoppen van de opname op de 
toewijsbare knop (pagina 49) waaraan Rec 
Review is toegekend. Het afspelen van de 
laatste opgenomen clip begint.
De clip wordt tot het eind afgespeeld, Rec 
Review wordt beëindigd en de camcorder 
gaat terug naar de modus STBY (standby).

Rec Review stoppen

Druk op de toewijsbare knop waaraan Rec 
Review is toegewezen of druk op de knop 
CANCEL/BACK.

Instellingen voor opname controleren

U kunt de startpositie voor afspelen aan een 
van de volgende posities toewijzen met de 
instelling Rec Review (pagina 100) in het 
menu Technical.
ˎˎ Laatste 3 seconden van de clip
ˎˎ Laatste 10 seconden van de clip
ˎˎ Begin van de clip

[Tip]
Als u een specifieke clip wilt controleren na het 
opnemen van meerdere clips, druk dan op de knop 
THUMBNAIL om het pictogrammenscherm weer te 
geven en selecteer de gewenste clip om deze af te 
spelen.
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U kunt de zoom aanpassen volgens de 
condities waarin wordt gefilmd.

Als er een power-zoomobjectief is bevestigd, 
kunt u de zoom aanpassen met de 
zoomregelaar op de afstandsbedieningsgreep 
of de draaggreep. De zoomsnelheid varieert 
met de druk die op de regelaar wordt 
uitgeoefend.
De camcorder is uitgerust met een 
zoomfunctie die gebruik maakt van het 
beeldsignaalverwerking met de naam 
Clear Image Zoom. Als Clear Image Zoom is 
ingeschakeld wordt zoom ondersteund, zelfs 
voor objectieven met vaste brandpuntsafstand 
(prime). Het kan ook worden gebruikt om het 
bereik te vergroten buiten het optische bereik 
op een powerzoom-objectief.
De maximale zoomverhouding bij gebruik van 
Clear Image Zoom varieert, afhankelijk van de 
opnameresolutie.
ˎˎ Voor QFHD/4K-opnameresolutie: 1,5×
ˎˎ Voor HD-opnameresolutie: 2×

Het type zoom selecteren

Stel het zoomtype in met Zoom >Zoom Type 
(pagina 100) in het menu Technical van het 
hoofdmenu.
Het type zoom varieert afhankelijk van het 
type objectief dat is bevestigd.

Bevestigd 
objectief

Instelling Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Prime 
objectief/
handmatig 
zoomobjectief

Zoombediening 
met de regelaar 
wordt niet 
ondersteund.

Clear Image 
Zoom wordt 
ondersteund.

Bevestigd 
objectief

Instelling Zoom Type

Optical Zoom 
Only

On(Clear Image 
Zoom)

Power-
zoomobjectief

Alleen optische 
zoom

Optische zoom 
en Clear Image 
Zoom worden 
ondersteund.

[Opmerkingen]
ˎˎ Clear Image Zoom is niet beschikbaar in de volgende 

gevallen.
–– Als S&Q Motion >Frame Rate (pagina 81) in het 

menu Shooting van het hoofmenu hoger is dan 
60fps

–– Als Rec Format >Codec (pagina 83) in het menu 
Project van het hoofdmenu is ingesteld op RAW of 
een optie die RAW bevat.

ˎˎ Het bedienen van de selectieschakelaar SERVO/
MANUAL op een objectief reset de vergroting van 
Clear Image Zoom naar 1×. 
ˎˎ Wanneer automatisch scherpstellen door indrukken 

(AF-S) wordt uitgevoerd tijdens Clear Image Zoom, 
geeft de AF voorrang aan het gebied midden in het 
scherm.

Zoom van de draaggreep instellen

Stel de zoominstelling van de draaggreep in 
met Handle Zoom (pagina 101) in het menu 
Technical van het hoofdmenu.

De richting van de zoomring 
instellen

Op sommige objectieven met E-bevestiging 
kan de draairichting van de zoomring worden 
omgedraaid.
Stel de draairichting in met Lens >Zoom Ring 
Direction (pagina 101) in het menu Technical 
van het hoofdmenu.

De Zoom aanpassen
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De scherpstelling aanpassen
U kunt de scherpstelling automatisch of 
handmatig aanpassen, afhankelijk van de 
condities waarin wordt gefilmd.

De scherpstelling handmatig 
aanpassen (Handmatig 
scherpstellen)

Om de scherpstelling handmatig aan te 
passen zet u de knop FOCUS (pagina 4) op 
de stand "MAN".
Hiermee kunt u de scherpte handmatig 
aanpassen volgens de condities waarin wordt 
gefilmd.
Handmatig scherpstellen is nuttig voor de 
volgende onderwerpen.
ˎˎ Onderwerpen aan de zijkant van een 
venster die zijn bedekt met waterdruppels
ˎˎ Onderwerpen met weinig contrast tegen 
een achtergrond
ˎˎ Onderwerpen die zich verder weg bevinden 
dan de onderwerpen op de voorgrond

[Tip]
U kunt in de volgende gevallen automatische 
scherpstelling ook gebruiken, als handmatige 
aanpassing de hoofdmethode voor bediening is.
ˎˎ Als de AF-gevoeligheid voor objectverplaatsing is 

ingesteld op 1(Locked)
ˎˎ Als de schakelaar FOCUS is ingesteld op de stand "AF"
ˎˎ Bij het bedienen van de scherpstellingsring (AF Assist 

pagina 40)

Scherpstellen door aanraken (Spot 
Focus)

In handmatige scherpstelmodus kunt u de 
plek aangeven waarop u wilt scherpstellen 
door deze aan te raken.
Wilt u Spot Focus gebruiken, stel dan Focus > 
Touch Function in MF (pagina 81) in het 
menu Shooting in op Spot Focus.

Een markering voor Spot Focus wordt 
weergegeven wanneer u op de plek tikt 
waarop u wilt scherpstellen.

[Tips]
ˎˎ In de modus Spot Focus kunt u drukken op een 

toewijsbare knop (pagina 49) die is toegewezen 
aan Push AF/Push MF om tijdelijk Spot Focus te 
stoppen en automatisch scherpstellen inschakelen 
voor zolang als u de knop ingedrukt houdt. 
De scherpstelling gaat terug naar handmatige 
scherpstelling als u de knop loslaat.
ˎˎ De functie Spot Focus werkt niet als het objectief is 

ingesteld op handmatige scherpstelling.
ˎˎ U kunt de plaats voor Spot Focus niet opgeven als de 

scherpstelling is vergroot of wanneer Touch Operation 
(pagina 100) in het menu Technical is ingesteld op 
Off.

Automatische scherpstelling tijdelijk 
gebruiken (Push Auto Focus (AF))

Als Focus >Push AF Mode (pagina 81) in 
het menu Shooting van het hoofdmenu is 
ingesteld op AF, druk dan op de knop PUSH 
AUTO FOCUS (pagina 4) in de modus 
handmatig scherpstellen om automatisch 
scherp te stellen als de knop wordt ingedrukt.
Scherpstellen vindt plaats binnen het 
scherpstellingsgebied dat is ingesteld met 
Focus >Focus Area (pagina 81) in het menu 
Shooting van het hoofdmenu.
De scherpstelling gaat terug naar handmatige 
scherpstelling als u de knop loslaat.
Dit is nuttig als u de scherpstelling langzaam 
van het ene naar het andere onderwerp wilt 
verplaatsen tijdens handmatige scherpstelling.

[Tip]
Dezelfde werking wordt ondersteund bij gebruik van 
een toewijsbare knop (pagina 49) toegewezen aan 
Push AF/Push MF.

[Opmerking]
De functie Push Auto Focus werkt niet als het objectief is 
ingesteld op handmatige scherpstelling.

Eenmalig automatische scherpstelling 
gebruiken (Push Auto Focus (AF-S))

Stel Focus >Push AF Mode (pagina 81) in 
het menu Shooting van het hoofdmenu in 
op Single-shot AF(AF-S) en stel vervolgens 
het scherpstellingsgebied in met Focus 
>Focus Area(AF-S) (pagina 81) in het menu 
Shooting van het hoofdmenu.
Druk in de modus handmatige scherpstelling 
op de knop PUSH AUTO FOCUS om 
automatisch met hoge snelheid scherp te 
stellen. Het scherpstellen stopt zodra u de 
toets loslaat.
De scherpstellingsstatus wordt aangegeven 
door de scherpstellingsindicator.
ˎˎ Aan: de scherpstelling is gefixeerd op de 
scherpstellingspositie.
ˎˎ Knipperend: onscherp. Omdat scherpstellen 
niet automatisch plaatsvindt, wijzigt u de 
compositie en scherpstellingsinstellingen 
om scherpstelling te bereiken.

De scherpstelling gaat terug naar handmatige 
scherpstelling als u de knop loslaat.
Dit is nuttig als u snel op een onderwerp wilt 
scherpstellen voordat u begint met filmen.

[Tips]
ˎˎ Dezelfde werking wordt ondersteund bij gebruik van 

een toewijsbare knop (pagina 49) toegewezen aan 
Push AF/Push MF.
ˎˎ U kunt ook de functie Push AF Mode toewijzen aan 

een toewijsbare knop (pagina 49).
ˎˎ U kunt ook de Focus Area(AF-S) toewijzen aan een 

toewijsbare knop (pagina 49).
ˎˎ U kunt het scherpstellingskader weergeven of 

verbergen met Display On/Off > Focus Area Ind. 
(AF-S) (pagina 94) in het menu Monitoring van het 
hoofdmenu.

ˎˎ Tijdens scherpstellingsvergroting wordt de 
scherpstelling aangepast om in de vergrote 
weergavepositie te passen.

[Opmerkingen]
ˎˎ De functie Push Auto Focus werkt niet als het 

objectief is ingesteld op handmatige scherpstelling.
ˎˎ Het scherpstellingskader is niet verborgen als de 

knop DISPLAY wordt gebruikt.
ˎˎ 	Tijdens Clear Image Zoom kunt u de kaderpositie 

voor Focus Area(AF-S) niet instellen. Tijdens Push 
AF-S geeft AF voorrang aan het gebied midden in het 
scherm.

Scherpstellen met behulp van vergrote 
weergave (Focus Magnifier)

Volgens de standaard fabrieksinstellingen 
is de functie Focus Magnifier ×3/×6 
toegewezen aan de knop ASSIGN 4 op 
de afstandsbedieningsgreep en de knop 
ASSIGN 7 op de draaggreep (pagina 49).
Druk op de knop ASSIGN 4 of ASSIGN 7 om 
de zoeker over te schakelen naar het scherm 
scherpstellingsvergroting, waar het midden 
ongeveer drie keer wordt vergroot. Druk 
nogmaals op de knop om de vergroting 
ongeveer zes keer te maken. Deze functie is 
nuttig om de scherpstelling te controleren.
Druk nogmaals op de knop om terug te gaan 
naar het normale scherm.
U kunt de positie die moet worden vergroot 
tijdens scherpstellingsvergroting verplaatsen 
met de keuzeschakelaar (pagina 7). 
Indrukken van de keuzeschakelaar gaat terug 
naar het midden van het beeld.
Als scherpstellen (AF) plaatsvindt binnen het 
scherpstellingsgebied dat is ingesteld met 
Focus >Focus Area (pagina 81) in het menu 
Shooting van het hoofdmenu.
Als scherpstelling door knop indrukken 
(AF-S) wordt gebruikt tijdens 
scherpstellingsvergroting, wordt de 
scherpstelling aangepast aan de vergrote 
weergavepositie.
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[Opmerkingen]
ˎˎ Het opgenomen beeld of het SDI/HDMI-uitvoerbeeld 

wordt niet vergroot als de scherpstelling wordt 
vergroot.
ˎˎ Tijdens scherpstellingsvergroting zijn de knop MENU 

en andere bedieningssubroutines uitgeschakeld.
ˎˎ De vergrote positie gaat terug naar het midden van 

het scherm als de camcorder wordt uitgeschakeld.

De scherpstelling automatisch 
aanpassen (Autofocus)

De camcorder gebruikt fasedetectie AF 
voor scherpstelling op hoge snelheid en 
contrast AF voor scherpstelling met hoge 
nauwkeurigheid.
De combinatie van deze twee AF-methodes 
zorgt voor automatische scherpstelling met 
hoge snelheid en hoge nauwkeurigheid.
Om de scherpstelling automatisch aan 
te passen zet u de schakelaar FOCUS 
(pagina 4) van de camcorder op de stand 
"AUTO". Als het objectief is uitgerust met een 
focus-keuzeschakelaar, zet de schakelaar dan 
op de stand "AF/MF" of "AF". Als de schakelaar 
is ingesteld op de stand "Full MF" of "MF", 
kan het scherpstellen van het objectief 
niet worden bediend vanaf de camcorder 
(pagina 23).

[Tip]
Als Focus >AF Assist (pagina 81) in het menu Shooting 
van het hoofdmenu is ingesteld op On, kunt u de 
scherpstellingsring tijdens automatische scherpstelling 
nog steeds gebruiken om de scherpstelling aan te 
passen.

[Opmerkingen]
ˎˎ Een objectief dat automatische scherpstelling 

ondersteunt is vereist.
ˎˎ Nauwkeurigheid kan mogelijk niet worden bereikt, 

afhankelijk van de condities waarin wordt gefilmd.
ˎˎ De scherpstelling kan niet automatisch worden 

aangepast op een objectief met A-bevestiging.

Het gebied of de positie van 
automatische scherpstelling instellen 
(Focus Area)

U kunt het doelgebied voor automatische 
scherpstelling instellen met Focus >Focus Area 
(pagina 81) in het menu Shooting van het 
hoofdmenu.

Flexible Spot:
Richt zich op een specifieke positie op het 
beeld.
Als dit is geselecteerd, geef dan de positie aan 
met de keuzeschakelaar (pagina 7).
U kunt terugkeren naar de middenpositie door 
de keuzeschakelaar vast te houden.

Zone:
Zoekt automatisch een scherpstellingspositie 
binnen de opgegeven zone.
Als dit is geselecteerd, geef dan de positie aan 
met de keuzeschakelaar (pagina 7).
U kunt terugkeren naar de middenpositie door 
de keuzeschakelaar vast te houden.

Wide:
Zoekt bij scherpstellen naar een onderwerp 
in een brede hoek in het beeld. Er wordt geen 
kader weergegeven.

[Tip]
Dezelfde bediening wordt ondersteund bij het gebruik 
van een toewijsbare knop (pagina 49) die is 
toegewezen aan Focus Area.
U kunt het scherpstellingskader weergeven of verbergen 
met Display On/Off >Focus Area Indicator (pagina 94) 
in het menu Monitoring van het hoofdmenu.

[Opmerking]
Het scherpstellingskader is niet verborgen als de knop 
DISPLAY wordt gebruikt.

Het scherpstellingsgebied snel wijzigen 
(Focus Setting)

U kunt de positie en de grootte van het 
automatische scherpstellingsgebied snel 
wijzigen tijdens het filmen door Focus Setting 
aan een toewijsbare knop toe te wijzen 
(pagina 49).
De werking varieert afhankelijk van de 
instelling voor het scherpstellingsgebied.

Als Focus >Focus Area (pagina 81) in het 
menu Shooting van het hoofdmenu is 
ingesteld op Flexible Spot of Zone
U kunt de positie van het 
scherpstellingsgebied wijzigen door op 
een toewijsbare knop te drukken die is 
toegewezen aan Focus Setting en aanpassen 
met de keuzeschakelaar (pagina 7).
U kunt de positie van het 
scherpstellingsgebied naar het midden 
terugbrengen tijdens het aanpassen van 
de positie door op de keuzeschakelaar te 
drukken.
U kunt de grootte van het 
scherpstellingsgebied wijzigen door een 
toewijsbare knop vast te houden die is 
toegewezen aan de Focus Setting.
Na het wijzigen van de grootte bevestigt u de 
positie van het scherpstellingsgebied door op 
de keuzeschakelaar te drukken.
Druk na voltooiing op de toewijsbare knop die 
is toegewezen aan de Focus Setting om naar 
het oorspronkelijke scherm terug te keren.

Als Focus >Focus Area (pagina 81) in het 
menu Shooting van het hoofdmenu is 
ingesteld op Wide
U kunt de grootte van het 
scherpstellingsgebied alleen wijzigen door 
een toewijsbare knop vast te houden die is 
toegewezen aan de Focus Setting. De positie 
kan ook worden gewijzigd door eerst het type 
te veranderen naar Flexible Spot of Zone.

[Tips]
ˎˎ Als zowel Focus >Push AF Mode (pagina 81) in 

het menu Shooting van het hoofdmenu is ingesteld 
op Single-shot AF(AF-S) en de schakelaar FOCUS 
(pagina 4) in de stand MF staat, kunt u de stand 
van de Focus Area(AF-S) (pagina 81) wijzigen.
ˎˎ Het scherpstellingskader wordt oranje weergegeven 

als de positie van het scherpstellingsgebied kan 
worden gewijzigd.



3. Filmen: De scherpstelling aanpassen39

Het scherpstellingskader verplaatsen 
met aanraakbediening (aanraakgebied 
scherpstelling)

U kunt de positie van het 
scherpstellingsgebied wijzigen door op een 
toewijsbare knop (pagina 49) te drukken 
die is toegewezen aan Focus Setting om de 
weergave van het scherpstellingsgebied 
te wijzigen in oranje en vervolgens te 
verplaatsen met aanraakbediening.
Tip op het scherm om het 
scherpstellingsgebied te verplaatsen met de 
scherpstelling gecentreerd op de aangetikte 
positie. Sleep over het scherm om het 
scherpstellingsgebied te verplaatsen naar de 
positie die uw vinger volgt (pagina 10).

[Tip]
U kunt aanraakbediening voor scherpstellingsbediening 
in- of uitschakelen op het schooting-scherm met een 
toewijsbare knop toegewezen aan Focus Setting.

Tik op een willekeurige plaats

Het scherpstellingsgebied verplaatst zich met 
het scherpstellingsgebied gecentreerd op de 
aangetikte positie.

Sleep om het scherpstellingsgebied te 
verplaatsen, waarbij het uw vingerpositie 
volgt.

[Opmerkingen]
ˎˎ Als u op een plaats tikt of het scherpstellingsgebied 

naar een positie sleept die buiten het instelbereik 
ligt, wordt het scherpstellingsgebied ingesteld op 
de boven-/onder-/linker of rechterkant van het 
instelbereik.
ˎˎ Deze functie is niet beschikbaar in de volgende 

gevallen.
–– Als Touch Operation (pagina 100) in het menu 

Technical van het hoofdmenu is ingesteld op Off.
–– Als het scherpstellingsgebied grijs wordt 

weergegeven of helemaal niet wordt 
weergegeven.

De automatische scherpstellingsactie 
aanpassen (AF-overgangssnelheid, 
AF-gevoeligheid 
onderwerpverplaatsing)

AF-overgangssnelheid
U kunt de snelheid van de 
scherpstellingsaandrijving voor als het 
onderwerp verandert instellen met Focus >AF 
Transition Speed (pagina 80) in het menu 
Shooting van het hoofdmenu.
Als dit is ingesteld op lage snelheid, verandert 
de scherpstelling langzaam als het scherp 
te stellen onderwerp wijzigt, waardoor 
indrukwekkende beelden kunnen worden 
gemaakt.
Als dit is ingesteld op hoge snelheid wisselt 
de scherpstelling tussen onderwerpen snel. 
Er wordt onmiddellijk scherpgesteld op 
het onderwerp dat het frame binnenkomt, 
waardoor dit ideaal is voor het filmen van 
documentaires, waarbij snel scherpstellen 
vereist is.

Tijdens de wijziging:
1(Slow): Scherpstelling werkt 
langzaam
.
.
.
7(Fast): Scherpstelling werkt 
snel

Scherpgesteld op een onderwerp verder weg

Scherpgesteld op een onderwerp dichterbij



3. Filmen: De scherpstelling aanpassen40

AF-gevoeligheid voor objectverplaatsing
U kunt de gevoeligheid voor het 
overschakelen tussen onderwerpen instellen 
met Focus >AF Subj. Shift Sens. (pagina 80) 
in het menu Shooting van het hoofdmenu.
Ingesteld op een lage gevoeligheid verandert 
de scherpte niet direct, zelfs als er een 
ander onderwerp vóór het scherpgestelde 
onderwerp komt. Ingesteld op een hoge 
gevoeligheid reageert de scherpstelling direct 
op het onderwerp dat naar de voorgrond gaat.

[Tip]
Als AF Speed/Sens. is toegewezen aan een toewijsbare 
knop, worden de niveausegmenten voor instellen 
van waarden in de volgende volgorde weergegeven, 
elke keer als de knop wordt ingedrukt. Hiermee kunt 
u de instellingen voor AF overgangssnelheid en AF 
gevoeligheid voor objectverplaatsing wijzigen.
AF-overgangssnelheid  AF-gevoeligheid voor 
objectverplaatsing  Geen weergave …

AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

Langzaam scherpstellen op een ander 
onderwerp

Snel scherpstellen op een ander onderwerp

Het onderwerp voor scherpstelling 
handmatig wijzigen (AF assist)

Als Focus >AF Assist (pagina 81) in het 
menu Shooting van het hoofdmenu is 
ingesteld op On, kunt u de scherpstellingsring 
op het objectief tijdens automatische 
scherpstelling nog steeds gebruiken om 
scherp te stellen op het onderwerp.
Als u stopt met gebruik van de 
scherpstellingsring, gaat automatische 
scherpstelling door met scherpstellen op het 
onderwerp waarop werd scherpgesteld met 
de scherpstellingsring (AF assistentiestaat).
Na het bedienen van de scherpstellingsring 
is het verplaatsen van de scherpstelling naar 
een ander onderwerp iets moeilijker, ongeacht 
Focus >AF Subj. Shift Sens. (pagina 80) 
instelling in het menu Shooting van het 
hoofmenu.
De AF assistentiestaat wordt geannuleerd 
door het volgende.
ˎˎ Als het onderwerp waarop met de 
scherpstellingsring is scherpgesteld niet 
langer zichtbaar is
ˎˎ Bij het overschakelen naar handmatige 
scherpstelling
ˎˎ Wanneer AF volgen in echttijd is gestart

[Tips]
ˎˎ De AF assistentiestaat kan snel worden geannuleerd 

door een toewijsbare knop (pagina 49) te 
gebruiken die is toegewezen aan Push AF/Push MF.
ˎˎ AF volgen in echttijd stopt wanneer u de 

scherpstelring gebruikt.
ˎˎ In de modus Face/Eye Only AF, stelt automatische 

scherpstelling scherp op het gezicht dat zich 
het dichts bij de scherpstellingspositie van de 
scherpstellingsring bevindt.
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Handmatige scherpstelling tijdelijk 
gebruiken (Push Manual Focus)

Druk op de knop PUSH AUTO FOCUS 
(pagina 4) in de modus automatische 
scherpstelling als u handmatig wilt 
scherpstellen terwijl de knop is ingedrukt.
De scherpstelling gaat terug naar 
automatische scherpstelling als u de knop 
loslaat.
Hiermee kunt u tijdelijk automatische 
scherpstelling stoppen en handmatig 
scherpstellen als er iets anders dan het 
onderwerp van het filmen voor het onderwerp 
passeert.

[Tip]
Dezelfde werking wordt ondersteund bij gebruik van 
een toewijsbare knop (pagina 49) toegewezen aan 
Push AF/Push MF.

Volgen met behulp van gezichts- 
en ogendetectie (Face/Eye 
Detection AF)

De camcorder kan gezichten en ogen 
van mensen detecteren als volgobject en 
vervolgens de scherpstelling aanpassen 
op de gezichten en ogen binnen het 
scherpstellingsgebied.
Deze functie is alleen beschikbaar als de 
AF-modus als scherpstellingsmodus wordt 
gebruikt of tijdens scherpstelling door knop 
indrukken.
Als er gezichten worden gedetecteerd, 
worden grijze gezicht/ogen-detectiekaders 
weergegeven. Als automatisch scherpstellen 
mogelijk is, worden de kaders wit en start het 
volgen. Als er ogen worden gedetecteerd en 
de scherpstelling wordt aangepast, wordt het 
gezicht/ogen-detectiekader weergegeven op 
de ogen. Als er meerdere personen worden 
gedetecteerd, wordt het hoofdonderwerp 
automatisch bepaald.

[Tips]
ˎˎ Als het scherpstellingsgebied is ingesteld op Zone of 

Flexible Spot en gezichten of ogen overlappen in het 
specifieke scherpstellingsgebied, worden de gezicht/
ogen-detectiekaders wit en stelt de camcorder scherp 
op deze gezichten/ogen.
ˎˎ Als scherpstelling door knop indrukken (AF-S) wordt 

gebruikt, worden de gezicht/ogen-detectiekaders 
groen voor de gezichten en ogen waarop is 
scherpgesteld.

Stel de AF-actie voor gezichts/ogendetectie 
in met Focus >Face/Eye Detection AF 
(pagina 81) in het menu Shooting.

Face/Eye Only AF:
De camera detecteert de gezichten/ogen 
van onderwerpen (mensen) en volgt en stelt 
scherp op alleen hun gezichten/ogen. Als 
er geen gezicht of oog wordt gedetecteerd, 
wordt AF tijdelijk gestopt en wordt het 
pictogram   (modus Face/Eye Only AF-
modus voor automatische scherpstelling 
gepauzeerd) (pagina 11) weergegeven. 
Deze modus is effectief als u alleen wilt volgen 
en scherpstellen op gezichten/ogen.

Face/Eye Priority AF:
De camera detecteert de gezichten/ogen van 
onderwerpen (mensen) en geeft voorrang aan 
het volgen/scherpstellen op de gezichten/
ogen. Als er geen gezicht of oog wordt 
gedetecteerd, vindt scherpstellen plaats in AF-
modus (standaardinstelling).

Off:
De functie gezichts/ogendetectie AF is 
uitgeschakeld.

[Opmerkingen]
ˎˎ Tijdens werking van scherpstelling door knop 

indrukken wordt Face/Eye Priority AF geactiveerd, 
zelfs als Face/Eye Only AF momenteel is geselecteerd.
ˎˎ Als de schakelaar FOCUS is ingesteld op MAN, is face/

eye detection AF uitgeschakeld (behalve tijdens 
scherpstelling door knop indrukken).
ˎˎ Als u de camcorder uitschakelt terwijl Face/Eye Only 

AF is geselecteerd, schakelt de modus automatisch 
over naar Face/Eye Priority AF als de camcorder de 
volgende keer weer wordt ingeschakeld.

Gezicht/ogen-detectiekaders verbergen

U kunt de gezicht/ogen-detectiekaders 
weergeven of verbergen met Display On/Off 
>Face/Eye Detection Frame (pagina 94) in 
het menu Monitoring van het hoofdmenu.

[Opmerking]
Groene gezicht/ogen-detectiekaders worden 
weergegeven voor gezichten en ogen die zijn 
scherpgesteld met scherpstelling door knop indrukken 
(AF-S) en niet zijn verborgen met de knop DISPLAY of als 
Face/Eye Detection Frame is ingesteld op Off.

De werking van gezichts/ogen-detectie AF 
in- of uitschakelen met een toewijsbare knop

Wijs Face/Eye Detection AF toe aan een 
toewijsbare knop (pagina 49). U kunt dan met 
elke druk op de knop de werking van gezichts/
oogdetectie AF omschakelen in de volgorde 
Face/Eye Priority AF, Face/Eye Only AF en Off.

Instellen in het hoofdmenu

U kunt ook de werking van gezichts/ogen-
detectie AF instellen in het hoofdmenu 
(pagina 49).
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Een bepaald onderwerp volgen 
(AF volgen in echttijd)

U kunt blijven scherpstellen op een 
onderwerp door het onderwerp op te geven 
door aanraken of door een kader voor 
gezichtsherkenning te selecteren.
Wanneer een onderwerp is geselecteerd, 
wordt een wit kader weergegeven en start het 
volgen.

[Tips]
ˎˎ Het volgen gebeurt over het hele beeldgebied, 

ongeacht de instelling voor automatisch 
scherpstellen.
ˎˎ Wanneer Focus >Touch Function in MF (pagina 81) 

in het menu Shooting is ingesteld op Tracking AF, 
wordt AF volgen in echttijd ondersteund, zelfs als MF-
modus de scherpstelmodus is.

De volgende handelingen worden uitgevoerd 
op het volgobject, afhankelijk van de modus 
voor AF met gezichts-/ogendetectie.

Face/Eye Only AF, Face/Eye Priority AF:
Gebruik dit om op een bepaald onderwerp 
scherp te stellen en dit te volgen.
Als het volgobject een persoon is en een 
gezicht of ogen worden gedetecteerd, stelt de 
camera scherp op dat gezicht / die ogen.
Wanneer een gezicht/ogen voor volgen wordt 
gedetecteerd, wordt het gezicht voor volgen 
opgeslagen. Eenmaal opgeslagen, wordt  
(pictogram Opgeslagen gezicht voor volgen) 
(pagina 11) weergegeven.

[Opmerking]
Als u AF volgen start tijdens handmatig scherpstellen, 
wordt het gezicht voor volgen niet opgeslagen.

Off:
Het opgegeven onderwerp wordt gevolgd en 
er wordt op scherpgesteld.
Gezicht/ogen worden niet gedetecteerd, zelfs 
niet als het volgobject een persoon is.

[Opmerking]
De functie AF volgen in echttijd werkt niet als het 
objectief is ingesteld op handmatige scherpstelling.

AF volgen in echttijd starten

Wanneer u een bepaald onderwerp hebt 
aangegeven als volgobject, start het volgen 
van dat onderwerp.

Opgeven door aanraken
Tik op het volgobject om het te volgen in een 
van de volgende situaties:
ˎˎ Wanneer de scherpstelmodus MF is of 
tijdens handmatig scherpstellen door 
indrukken en Focus >Touch Function in 
MF (pagina 81) in het menu Shooting is 
ingesteld op Tracking AF
ˎˎ Wanneer de AF-modus als 
scherpstellingsmodus wordt gebruikt of 
tijdens scherpstelling door knop indrukken 
(AF)

[Opmerking]
U kunt geen doel opgeven door aanraken wanneer 
Touch Operation (pagina 100) in het menu Technical is 
ingesteld op Off.

Opgeven door selectie van een kader voor 
gezichtsherkenning
Verplaats de gezichtsselectiecursor (oranje 
onderstreept) met de keuzeschakelaar 
(pagina 7) naar het volgobject en druk op 
de keuzeschakelaar.

Andere gezichtsdetectiekaders 
(grijs) Volgkader

Gezichtsselectiekader (oranje)

[Tips]
ˎˎ U kunt het volgobject ook wijzigen om dit te volgen 

tijdens AF volgen in echttijd.
ˎˎ Als u op een toewijsbare knop (pagina 49) 

drukt die is toegewezen aan de functie Focus 
Magnifier tijdens AF volgen in echttijd, wordt de 
volgstatus behouden en wordt het scherpstelgebied 
vergroot. U kunt echter geen doel opgeven tijdens 
scherpstellingsvergroting.

[Opmerking]
Tijdens handmatig scherpstellen kunt u het volgen 
niet starten door een kader voor gezichtsherkenning te 
selecteren.

AF volgen in echttijd stoppen

Stoppen door aanraken
Tik op de knop  (AF volgen in echttijd 
stoppen) die linksboven op het aanraakscherm 
wordt weergegeven.

[Tips]
ˎˎ AF volgen in echttijd stopt in de volgende gevallen:

–– Wanneer u de schakelaar FOCUS of de knop AUTO/
MAN op het objectief gebruikt

–– Wanneer u de scherpstelmodus wijzigt
–– Wanneer u assistentie voor automatisch 

scherpstellen gebruikt

–– Wanneer u de instelling voor het 
scherpstellingsgebied of de handeling voor 
gezichts-/ogendetectie met AF wijzigt

–– Wanneer u een toewijsbare knop indrukt die is 
toegewezen aan Push AF/Push MF

–– Wanneer het volgobject zich niet binnen het 
opnamevenster bevindt of wanneer het onderwerp 
meerdere seconden lang onscherp is

ˎˎ Wanneer u een gezicht voor volgen opslaat (wanneer 
het pictogram “ ” (opgeslagen gezicht voor volgen) 
wordt weergegeven), gaat AF volgen in echttijd weer 
verder wanneer het opgeslagen gezicht voor volgen 
weer in het beeldgebied komt. U wist het gezicht voor 
volgen door AF volgen in echttijd te stoppen, zoals 
hierboven is beschreven.
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De helderheid aanpassen

B

C
D
E

F
H

I

A

U kunt de helderheid aanpassen door het 
diafragma, versterking en sluitertijd in te 
stellen en het lichtniveau met ND-filters 
te beïnvloeden. U kunt ook automatisch 
aanpassingen maken.
Het doelniveau voor automatische 
helderheidsaanpassing wordt ingesteld met 
Auto Exposure (pagina 78) >Level in het 
menu Shooting van het hoofdmenu. U kunt 
ook Auto Exposure Level toewijzen aan een 
toewijsbare knop of toewijsbare regelaar 
(pagina 49).

[Opmerking]
De versterking kan niet worden aangepast in de modus 
Cine EI. De basisgevoeligheid is vast. De helderheid 
kan dus niet automatisch met de sluitertijd worden 
aangepast. Automatische helderheidsaanpassing met 
het diafragma en ND-Filter wordt ondersteund.

De basisgevoeligheid selecteren

U kunt op de camcorder twee typen 
basisgevoeligheid selecteren.
In Custom-modus kunt u de basisgevoeligheid 
instellen op High of Low met Base ISO/
Sensitivity op het scherm Main Status 
(pagina 14), het scherm Camera Status 
(pagina 14), of ISO/Gain/EI >Base 
Sensitivity (pagina 77) in het menu 
Shooting van het hoofdmenu. 
In modus Cine EI kunt u de basis-ISO 
instellen op ISO 12800 of ISO 800 met Base 
ISO/Sensitivity op het scherm Main Status 
(pagina 14), het scherm Camera Status 
(pagina 14) of ISO/Gain/EI >Base ISO 
(pagina 77) in het menu Shooting van het 
hoofdmenu.
Geadviseerd wordt om Low of ISO 800 onder 
normale lichtcondities en High of ISO 12800 
onder zwakke lichtcondities te selecteren.

*	 Kan ook worden geconfigureerd op het statusscherm.

[Tip]
U kunt Base ISO/Sensitivity ook aan een toewijsbare 
knop toewijzen (pagina 49).

Het diafragma aanpassen

U kunt het diafragma zo instellen dat het 
automatisch de helderheid aanpast.

Het diafragma automatisch aanpassen

Deze functie past de helderheid aan, aan de 
hand van het onderwerp. Een objectief dat 
autodiafragma ondersteunt is vereist.

1	 Als er een objectief is bevestigd met een 
Auto Iris-schakelaar, zet de schakelaar dan 
op AUTO.

2	 Houd de functieknop IRIS (E) ingedrukt 
om het directmenu weer te geven 
(pagina 49) en selecteer Auto.

	 [Tip]
U kunt Auto Iris ook toewijzen aan een toewijsbare 
knop (pagina 49).

	 [Opmerking]
Het diafragma kan niet automatisch worden 
aangepast op een objectief met A-bevestiging.

Het diafragma handmatig aanpassen

1	 Houd de functieknop IRIS (E) ingedrukt 
om het directmenu weer te geven 
(pagina 49) en selecteer Manual.

2	 Druk op de functieknop IRIS (E), zodat de 
diafragmawaarde wordt weergegeven op 
een witte achtergrond.

3	 Draai aan de multifunctionele regelaar om 
de waarde aan te passen.

	 [Tips]
ˎˎ U kunt ook de multifunctionele regelaar 

bedienen als een IRIS-regelaar (pagina 49) 
door de functie IRIS aan de multifunctionele 
regelaar toe te wijzen.
ˎˎ U kunt ook de functie IRIS toewijzen aan een 

toewijsbare regelaar (pagina 49).

Tijdelijk automatisch aanpassen

Druk op de toewijsbare knop (pagina 49) 
die is toegewezen aan de functie Push Auto 
Iris om automatisch het diafragma tijdelijk aan 
te passen zolang de knop wordt ingedrukt.
Het diafragma gaat terug naar de vorige 
instelling als u de knop loslaat.

[Opmerkingen]
ˎˎ Als de schakelaar Auto Iris van het objectief is 

ingesteld op MANUAL, hebben de functies Auto 
Iris en Push Auto Iris van de camcorder geen effect. 
Handmatige aanpassingen van het diafragma op de 
camcorder hebben ook geen effect.

ˎˎ Push Auto Iris is niet mogelijk wanneer Iris > Bokeh 
Control (pagina 78) in het menu Shooting is 
ingesteld op On.

De versterking aanpassen

In Custom-modus kunt u de versterking 
aanpassen om de helderheid aan te passen.

De versterking automatisch aanpassen

Houd de functieknop ISO/GAIN (H) 
ingedrukt om het directmenu weer te geven 
(pagina 49) en selecteer Auto.

[Tips]
ˎˎ U kunt dezelfde actie ook uitvoeren door Auto 

Exposure (pagina 78) >AGC in het menu Shooting 
op On in te stellen.
ˎˎ U kunt ook AGC aan een toewijsbare knop toewijzen 

(pagina 49).

Versterking handmatig aanpassen

U kunt de versterking regelen als u de 
belichting wilt aanpassen bij gebruik van 
een vaste diafragma-instelling of als u extra 
versterking wilt voorkomen als gevolg van 
AGC.

1	 Houd de functieknop ISO/GAIN (H) 
ingedrukt om het directmenu weer te 
geven (pagina 49) en selecteer Manual.

2	 Stel de schakelaar ISO/GAIN switch (I) in 
op H, M of L.
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[Tips]
ˎˎ U kunt de presetwaarde van de verschillende 

schakelaarstanden wijzigen met ISO/Gain<L>/<M>/ 
<H> (pagina 14) op het scherm Camera Status of 
ISO/Gain/EI > ISO/Gain<H>/<M>/<L> (pagina 77) in 
het menu Shooting van het hoofdmenu.
ˎˎ U kunt ook Push AGC aan een toewijsbare knop 

toewijzen en AGC tijdelijk inschakelen door de knop 
vast te houden.

[Opmerking]
Push AGC is niet mogelijk wanneer Iris > Bokeh Control 
(pagina 78) in het menu Shooting in het hoofdmenu 
is ingesteld op On.

De versterking regelen (fijnafstelling)

1	 Druk op de functieknop ISO/GAIN (H), 
zodat de versterkingswaarde wordt 
weergegeven op een witte achtergrond.

2	 Draai aan de multifunctionele regelaar om 
de waarde aan te passen.

[Tip]
Wijzig de versterkingspresetwaarde volgens de 
instelling van de ISO/GAIN-schakelaar (I).

De versterking tijdelijk regelen 
(fijnafstelling)

Draai aan de toewijsbare regelaar 
(pagina 49) die is toegewezen 
aan de functie ISO/Gain/EI, om de 
versterkingswaarde aan te passen die is 
ingesteld met de schakelaar ISO/GAIN (I).
Dit is nuttig als u de belichting met een stap 
wilt aanpassen zonder de scherptediepte te 
wijzigen.
De aangepaste versterkingswaarde wordt 
geannuleerd door het omschakelen van 
de schakelaar ISO/Gain (I), wijzigen van de 
basisgevoeligheid, AGC op On instellen of de 
stroom uitschakelen.

[Tips]
ˎˎ U kunt deze functie ook toewijzen aan de 

multifunctionele regelaar (pagina 49).
ˎˎ U kunt ook Push AGC aan een toewijsbare knop 

toewijzen en AGC tijdelijk inschakelen door de knop 
vast te houden.

[Opmerking]
Push AGC is niet mogelijk wanneer Iris > Bokeh Control 
(pagina 78) in het menu Shooting in het hoofdmenu 
is ingesteld op On.

De belichtingsindex aanpassen

In de modus Cine EI wordt ervan uitgegaan 
dat videouitvoer met MLUT ingesteld op 
Off wordt opgenomen als het hoofdsignaal. 
Door de helderheid van het beeld met MLUT 
On te wijzigen om overeen te komen met 
de EI-waarde, kunt u tijdens het filmen het 
resultaat van post-productieaanpassing van 
belichtingsgevoeligheid controleren.
U kunt de EI-waarde wijzigen door de ISO/
GAIN-schakelaar (I) in te stellen op H, M of L.

[Tip]
U kunt de EI-waarde van elke stand wijzigen met 
ISO/Gain/EI (pagina 14) op het scherm Camera 
Status of ISO/Gain/EI >Exposure Index<H>/<M>/<L> 
(pagina 77) in het menu Shooting van het 
hoofdmenu.

Fijnafstelling van de belichtingsindex

1	 Druk op de functieknop ISO/GAIN (H), 
zodat de EI-waarde wordt weergegeven 
op een witte achtergrond.

2	 Draai aan de multifunctionele regelaar om 
de waarde aan te passen.

[Tip]
Wijzig de EI-presetwaarde volgens de instelling van de 
ISO/GAIN-schakelaar (I).

De sluiter aanpassen

U kunt de sluiter aanpassen, zodat deze de 
helderheid aanpast.

De sluiter automatisch aanpassen

Houd de functieknop SHUTTER (F) ingedrukt 
om het directmenu (pagina 49) weer te 
geven en selecteer Auto om automatisch de 
sluitertijd of sluiterhoek aan te passen als 
reactie op de beeldhelderheid.

[Tip]
U kunt dezelfde actie ook uitvoeren door Auto Exposure 
>Auto Shutter (pagina 79) in het menu Shooting van 
het hoofdmenu op On in te stellen.

De sluiter handmatig aanpassen

1	 Houd de functieknop SHUTTER (F) 
ingedrukt om het directmenu 
(pagina 49) weer te geven en selecteer 
Speed of Angle.

2	 Druk op de functieknop SHUTTER (F), 
zodat de sluiterwaarde wordt 
weergegeven op een witte achtergrond.

3	 Draai aan de multifunctionele regelaar om 
de sluitertijd aan te passen.

[Tips]
ˎˎ Selecteer Off in stap 1 om de belichtingstijd aan te 

passen aan het frame-interval.
ˎˎ U kunt ook de hoek instellen en de frequentie 

aanpassen (pagina 77).

Het lichtniveau aanpassen (ND-
Filter)

Onder condities waarin het licht te helder 
is, kunt u de juiste helderheid instellen door 
wijziging van het ND-filter.
De camcorder heeft twee ND-filter-modi. U 
kunt tussen de twee modi overschakelen met 
de schakelaar ND PRESET/VARIABLE.

De presetmodus aanpassen

Zet de schakelaar ND PRESET/VARIABLE (A) in 
de stand PRESET en zet de omhoog/omlaag-
knoppen ND FILTER POSITION (B) op een van 
de volgende instellingen.
Clear: geen ND-filter
1: Lichtdoorlatendheid ingesteld met ND Filter 
>Preset1 (pagina 77) in het menu Shooting 
van het hoofdmenu.
2: Lichtdoorlatendheid ingesteld met ND Filter 
>Preset2 (pagina 77) in het menu Shooting 
van het hoofdmenu.
3: Lichtdoorlatendheid ingesteld met ND Filter 
>Preset3 (pagina 77) in het menu Shooting 
van het hoofdmenu.

Aanpassen in variabele modus

Zet de schakelaar ND PRESET/VARIABLE (A) 
in de stand VARIABLE. Schakel de omhoog/
omlaag-knoppen ND FILTER POSITION (B) om 
tussen CLEAR en On.
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Het lichtniveau automatisch aanpassen
U kunt Auto ND Filter op On instellen om 
automatische belichtingsaanpassing met het 
ND-filter in te schakelen.

1	 Druk op de [+]-knop van de omhoog/
omlaag-knoppen ND FILTER POSITION (B) 
om de werking van het ND-filter in te 
schakelen.

2	 Houd de knop ND VARIABLE AUTO (C) 
ingedrukt tot Auto is geselecteerd.

Het lichtniveau handmatig aanpassen

1	 Druk op de [+]-knop van de omhoog/
omlaag-knoppen ND FILTER POSITION (B) 
om de werking van het ND-filter in te 
schakelen.

2	 Houd de knop ND VARIABLE AUTO (C) 
ingedrukt tot Manual is geselecteerd.

3	 Draai aan de regelaar ND VARIABLE (D) 
om de lichtdoorlatendheid van het filter 
aan te passen.

[Tip]
U kunt ook de functie ND Filter toewijzen aan een 
toewijsbare regelaar (pagina 49).

Tijdelijk automatisch aanpassen
U kunt Push Auto ND aan een toewijsbare 
knop aanpassen (pagina 49) en tijdelijk 
Auto ND Filter inschakelen door de knop vast 
te houden. De knop loslaten schakelt Auto ND 
Filter weer uit.
Druk op de [+]-knop van de omhoog/omlaag-
knoppen ND FILTER POSITION (B) om de 
werking van het ND-filter in te schakelen.

[Opmerkingen]
ˎˎ Als het ND-filter wordt overgeschakeld van of 

naar CLEAR tijdens het filmen, wordt het ND-
filterkader weergegeven op het beeld en wordt het 
bedieningsgeluid opgenomen in de audio.

ˎˎ Push Auto ND is niet mogelijk wanneer Iris > Bokeh 
Control (pagina 78) in het menu Shooting is 
ingesteld op On.

[Tips]
ˎˎ U kunt overschakelen naar CLEAR door de regelaar 

ND VARIABLE (D) omlaag te draaien van ND1/4. De 
regelaar omhoog draaien vanaf CLEAR stelt ND1/4 in. 
U kunt deze actie uitschakelen met ND Dial >CLEAR 
with Dial (pagina 100) in het menu Technical van het 
hoofdmenu.
ˎˎ U kunt ND Filter Position toewijzen aan een 

toewijsbare knop (pagina 49) en deze knop 
indrukken in plaats van de knoppen ND FILTER 
POSITION omhoog/omlaag te gebruiken om deze 
instelling te wijzigen.  
Presetmodus: Clear  Preset1  Preset2  Preset3 
 Clear… 
Variabele modus: Clear  On  Clear…
ˎˎ U kunt ook Auto ND Filter toewijzen aan een 

toewijsbare knop (pagina 49) en de knop 
indrukken om over te schakelen tussen Auto ND filter 
On en Off.
ˎˎ Bij het filmen van een helder verlicht onderwerp 

kan het dichtdraaien van het diafragma 
diffractievervaging veroorzaken, wat een beeld 
produceert dat onscherp begint te worden (en 
typisch verschijnsel in videocamera's). U kunt dit 
effect onderdrukken voor betere videoresultaten met 
behulp van het ND-filter.
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U kunt de aanpassingsmodus instellen die 
geschikt is voor de condities waarin wordt 
gefilmd.

ATW (automatische witbalans)

Deze functie past de witbalans automatisch 
aan tot een geschikt niveau.
De witbalans wordt automatisch aangepast 
als de kleurtemperatuur van de lichtbron zich 
wijzigt.
Houd de functieknop WHT BAL (G) 
ingedrukt om het directmenu weer te geven 
(pagina 49) en selecteer ATW.
U kunt de aanpassingssnelheid (vijf stappen) 
selecteren met White Setting >ATW Speed 
(pagina 80) in het menu Shooting van het 
hoofdmenu.

[Tip]
U kunt de huidige witbalansinstelling bevriezen door 
de ATW Hold-functie toe te wijzen aan een toewijsbare 
knop (pagina 49) en de toewijsbare knop in te 
drukken om de ATW-modus tijdelijk te pauzeren.

[Opmerkingen]
ˎˎ ATW kan niet worden gebruikt in de modus Cine EI.
ˎˎ De juiste kleur kan mogelijk niet worden aangepast 

met ATW, afhankelijk van de condities van het licht en 
het onderwerp.  
Voorbeelden:
–– Als het onderwerp wordt gedomineerd door één 

kleur, zoals lucht, zee, aarde of bloemen.
–– Als de kleurtemperatuur extreem hoog of extreem 

laag is.
	 Als het adequate effect niet kan worden bereikt 

omdat de ATW autotracking-snelheid laag is of om 
andere redenen, voer dan automatische witbalans uit.

De witbalans handmatig 
aanpassen

1	 Als witbalans is ingesteld op ATW-modus, 
houd dan de functieknop WHT BAL (G) 
ingedrukt om het directmenu weer te 
geven (pagina 49) en selecteer W:P, 
W:A, of W:B.

2	 Selecteer B, A of PRESET met de WHT 
BAL-schakelaar (J).
B: modus geheugen B
A: modus geheugen A
PRESET: Presetmodus

[Tip]
ATW kan worden uitgeschakeld voor geheugen B door 
White Setting >White Switch<B> (pagina 80) in het 
menu Shooting van het hoofdmenu in te stellen op ATW.

Modus geheugen A/geheugen B
Deze modus als de witbalans aan naar de 
instelling die is opgeslagen in geheugen A of 
B.

Presetmodus
Deze modus past de kleurtemperatuur 
aan tot een presetwaarde (standaard 
fabrieksinstellingen is 3200K).

De standaard presetwaarde wijzigen

In presetmodus kunt u een bestaande 
presetwaarde rechtstreeks veranderen.
Houd de functieknop WHT BAL (G) ingedrukt 
en selecteer een van de volgende opties in het 
directmenu.
Modus Custom:  3200K,  4300K, 

 5600K,  6300K
Modus Cine EI:  3200K,  4300K, 

 5500K

[Tip]
U kunt ook Preset White Select aan een toewijsbare 
knop toewijzen (pagina 49) en de knop indrukken om 
de instelling te wijzigen.
Modus Custom: 3200K  4300K  5600K  6300K  
 3200K…

Modus Cine EI: 3200K  4300K  5500K  3200K…

De kleurtemperatuur wijzigen

1	 Druk op de functieknop WHT BAL (G), 
zodat de kleurtemperatuurwaarde wordt 
weergegeven op een witte achtergrond.

2	 Draai aan de multifunctionele regelaar om 
de waarde aan te passen.

[Tips]
ˎˎ In presetmodus kunt u de waarde instellen in stappen 

van 100K.
ˎˎ In geheugenmodus kunt u de waarde instellen in 

stappen van 20K binnen het bereik van 2000K tot 
5600K. Waarden boven 5600K kunnen worden 
ingesteld in intervallen die overeenkomen met de 
hoeveelheid kleurwijziging (Mired) van 5580K tot 
5600K. U kunt ook de tintwaarde aanpassen met 
White (pagina 79) >Tint in het menu Shooting van 
het hoofdmenu.

Automatische witbalans uitvoeren

De witbalans die wordt opgeslagen in de 
modus geheugen A/geheugen B wordt 
automatisch geconfigureerd.

1	 Selecteer de modus geheugen A of 
geheugen B.

2	 Plaats een wit papier (of object) op een 
plaats met dezelfde lichtbron en condities 
als het onderwerp en zoom vervolgens in 
op het papier om wit op het scherm weer 
te geven.

3	 Pas de helderheid aan.
Pas het diafragma aan volgens de 
procedure in “Het diafragma handmatig 
aanpassen” (pagina 43).

4	 Druk op de knop WB SET (pagina 4).
ˎˎ Als automatische witbalans wordt 
uitgevoerd in de geheugenmodus 
wordt het resultaat van de automatische 
aanpassing opgeslagen in het geheugen 
(A of B) dat in stap 1 is geselecteerd.
ˎˎ Als automatische witbalans wordt 
uitgevoerd in ATW-modus, blijft het 
resultaat behouden en gaat ATW verder 
wanneer de automatische aanpassing 
stopt. Dit is handig als u de witbalans 
snel wilt aanpassen, ongeacht de 
instelling voor ATW Speed.

[Opmerking]
Als de aanpassing niet is gelukt, verschijnt gedurende 
ongeveer 3 seconden een foutmelding op het scherm. 
Als de foutmelding aanhoudt na herhaalde pogingen 
voor het instellen van de witbalans, neem dan contact 
op met uw Sony servicevertegenwoordiger.

Aanpassing voor natuurlijke kleuren (witbalans)
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U kunt de audio die moet worden opgenomen 
instellen met de ingangsaansluitingen, 
schakelaars en regelaars op de camcorder.

Externe ingangen audio en 
selectieschakelaars

Aansluiting INPUT1 (pagina 7)
Aansluiting INPUT2 (pagina 7)
Multi-interfaceschoen (pagina 7)
Schakelaar INPUT1 (LINE/MIC/MIC+48V) 
(pagina 7)
Schakelaar INPUT2 (LINE/MIC/MIC+48V) 
(pagina 7)

Schakelaars voor instellen van het 
audioniveau

Schakelaar CH1 (AUTO/MAN) (pagina 6)
Schakelaar CH2 (AUTO/MAN) (pagina 6)
Regelaar AUDIO LEVEL (CH1) (pagina 6)
Regelaar AUDIO LEVEL (CH2) (pagina 6)

Scherm Audio Status

Het audio-invoerapparaat 
selecteren

1	 Stel de audio-ingang in met CH1/CH2/
CH3/CH4>Source (pagina 14) op het 
scherm Audio Status of Audio Input >CH1 
Input Select t/m CH4 Input Select 
(pagina 97) in het menu Audio van het 
hoofdmenu.
Als u een microfoon of XLR-adapter 
gebruikt met de multi-interfaceschoen, 
geef dan Shoe CH1 of Shoe CH2 op. Zie 
voor details over de XLR-adapter “Audio-
ingangen toevoegen” (pagina 48).

	 [Opmerkingen]
ˎˎ Audio wordt niet opgenomen in de Interval Rec 

mode of Slow & Quick Motion.
ˎˎ De camcorder heeft een ingebouwde 

spraakmicrofoon voor het opnemen van 
omgevingsgeluid. Deze kan worden gebruikt 
voor het synchroniseren van de timing met 
andere apparatuur. Specificeer in dergelijke 
gevallen Internal MIC.
ˎˎ De interne microfoon van de draaggreep 

(pagina 7) wordt alleen actief voor het 
opnemen van audio als de draaggreep is 
bevestigd. Als de draaggreep niet is bevestigd 
kan de spraakmicrofoon (pagina 6) voor het 
opnemen van omgevingsgeluid worden gebruikt.
ˎˎ Als CH1 Input Select en CH2 Input Select zijn 

ingesteld op Internal MIC, wordt het audio-
opnameniveau van zowel CH1 als CH2 aangepast 
met de regelaar AUDIO LEVEL(CH1) (pagina 6). 
Als CH3 Input Select en CH4 Input Select zijn 
ingesteld op Internal MIC, wordt het audio-
opnameniveau van zowel CH3 als CH4 aangepast 
met CH3 Input Level (pagina 97).

2	 De audio-ingangsbron selecteren.
Stel de schakelaars INPUT1/INPUT2 (LINE/
MIC/MIC+48V) in op de apparaten die zijn 
aangesloten op de ingangen INPUT1/
INPUT2.

Aangesloten apparaat Schakelaar-
stand

Externe audiobron 
(bijvoorbeeld een 
mengpaneel)

LINE

Dynamische microfoon, 
microfoon met batterij

MIC

+48 V fantoomvoeding 
microfoon

MIC+48V

ˎˎ Het selecteren van MIC+48V en 
een microfoon aansluiten die niet 
compatibel is met +48V kan het 
aangesloten apparaat beschadigen. 
Controleer de instelling, alvorens het 
apparaat aan te sluiten.
ˎˎ Als ruis een probleem is bij ingangen 
waarop geen apparaat is aangesloten, 
zet de betreffende schakelaars voor 
INPUT1/INPUT2 (LINE/MIC/MIC+48V) dan 
op LINE.

Het audio-opnameniveau 
automatisch aanpassen

Zet de schakelaars CH1/CH2 (AUTO/MAN) 
op AUTO om de kanalen automatisch aan te 
passen.
Stel voor CH3/CH4 de audioniveauregeling 
in op Auto op het scherm Audio Status 
(pagina 14) of bij Audio Input >CH3 Level 
Control en CH4 Level Control in het menu 
Audio van het hoofdmenu (pagina 97).

Het audio-opnameniveau 
handmatig aanpassen

Gebruik de volgende procedure om het audio-
opnameniveau voor CH1/CH2 aan te passen.

1	 Zet de schakelaars CH1/CH2 (AUTO/MAN) 
voor de kanalen op MAN om handmatig 
aan te passen.

2	 Draai tijdens het filmen aan de regelaars 
AUDIO LEVEL (CH1)/(CH2) van de 
betreffende kanalen om het audioniveau 
aan te passen.
ˎˎ Stel voor CH3/CH4 de 
audioniveauregeling met behulp van 
CH3/CH4 (pagina 14) op het scherm 
Audio Status of Audio Input >CH3 Level 
Control of CH4 Level Control in het 
menu Audio van het hoofdmenu in op 
Manual en stel vervolgens het audio-
opnameniveau in met behulp van CH3 
Input Level of CH4 Input level.
ˎˎ U kunt de niveaus voor CH1 t/m CH4 
als groep aanpassen. U kunt het 
opnameniveau aanpassen met een 
toewijsbare knop (pagina 49) die is 
toegewezen aan het functie Audio Input 
Level, het scherm Audio Status, of Audio 
Input >Audio Input Level het menu 
Audio of het hoofdmenu.

[Tip]
Het scherm Audio Status is handig om het audio-
ingangsniveau te controleren (pagina 14).

[Opmerkingen]
ˎˎ De instellingen voor Audio Input Level zijn mogelijk 

uitgeschakeld, afhankelijk van de combinatie van 
instellingen in het menu Audio. Zie voor details het 
schema op pagina 134.
ˎˎ De camcorder ondersteunt combinaties van 

diverse instellingen. Zie voor details het schema op 
pagina 134.

De audio voor opname instellen
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Audio-ingangen toevoegen

U kunt maximaal vier kanalen met XLR-
audioapparatuur tegelijk aansluiten op de 
camcorder met de XLR-K2M XLR-adapter (niet 
meegeleverd) of de XLR-K3M XLR adapter 
(niet meegeleverd).
Bevestig de XLR-adapter aan de 
multifunctionele interfaceschoen en stel 
CH3 >Source in op Shoe CH1 en CH4 >Source 
op Shoe CH2 op het scherm Audio Status in 
(pagina 14). Of stel Audio Input> CH3 Input 
Select in op Shoe CH1 en CH4 Input Select 
op Shoe CH2 in het menu Audio van het 
hoofdmenu.
Camcorderfuncties die overlappen worden 
uitgeschakeld voor kanalen waarop de XLR-
adapter als ingang is geselecteerd. Gebruik 
de schakelaar en regelaars op de XLR-adapter 
voor aanpassingen.

[Opmerkingen]
ˎˎ De camcorder ondersteunt de 2-kanaals digitale 

audio-interface van de XLR-K3M.
ˎˎ Als Audio Input >CH3 Level en CH4 Level in het menu 

Audio zijn ingesteld op Audio Input Level, dan wordt 
Audio Input Level op de camcorder vermenigvuldigd 
met het aangepaste niveau op de XLR-adapter.  
Audio Input Level wordt ook ingeschakeld als de 
schakelaar op de XLR-adapter is ingesteld op AUTO.  
Als "Through" is opgegeven, wordt audio opgenomen 
op het niveau dat is ingesteld met de XLR-adapter 
(pagina 135).
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Handige functies

Handelingen directmenu

U kunt de status en instellingen van 
de camcorder controleren die worden 
weergegeven op het zoekerscherm en direct 
instellingen selecteren en wijzigen.
De volgende onderdelen kunnen worden 
geconfigureerd.
ˎˎ Face/Eye Detection AF
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ Exposure Index Value
ˎˎ Auto Shutter / ECS
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1	 Druk op de multifunctionele regelaar of 
een toewijsbare knop die is toegewezen 
met de functie Direct Menu.
Alleen de onderdelen op het scherm die 
kunnen worden geconfigureerd met het 
directmenu kunnen worden geselecteerd 
met de oranje cursor.

2	 Draai aan de multifunctionele regelaar om 
de cursor te verplaatsen naar het menu-
onderdeel dat moet worden bewerkt en 
druk vervolgens op de multifunctionele 
regelaar.
Er wordt een menu weergegeven of het 
onderdeel wordt weergegeven op een 
witte achtergrond.

3	 Draai aan de multifunctionele regelaar om 
een instelling te selecteren en druk 
vervolgens op de multifunctionele 
regelaar.
Het menu of de witte achtergrond 
verdwijnt en de nieuwe instelling wordt 
weergegeven met een oranje cursor.
Druk nogmaals op de toewijsbare knop 
die is toegewezen aan Direct Menu of 
wacht 3 seconden zonder een handeling 
uit te voeren om het directmenu te 
verlaten.

	 [Tips]
ˎˎ Directe instellingen kunnen ook worden 

geconfigureerd door indrukken en vasthouden 
van de verschillende functieknoppen 
(pagina 5).
ˎˎ Als onderdelen worden weergegeven op een 

witte achtergrond kan de multifunctionele 
regelaar worden gebruikt als een toewijsbare 
regelaar.
ˎˎ De keuzeschakelaar (pagina 9) kan ook 

worden gebruikt voor het selecteren van 
handelingen.

Toewijsbare knoppen/regelaars

Er bevinden zich negen toewijsbare knoppen 
(pagina 6, 7, 9) op de camcorder 
waar u functies aan kunt toewijzen.
U kunt ook functies toewijzen aan de 
multifunctionele regelaar op de camcorder 
(pagina 5), de toewijsbare regelaar op de 
draaggreep (pagina 7) en de toewijsbare 
regelaar op de afstandsbedieningsgreep 
(pagina 9).

De functie van een knop wijzigen

Gebruik Assignable Button (pagina 86) in 
het menu Project van het hoofdmenu.
U kunt de toegewezen functies op het scherm 
Assignable Button Status zien (pagina 15).

De functies die standaard vanuit de fabriek 
zijn toegewezen aan de toewijsbare knoppen
Knop 1	 S&Q Motion
Knop 2	 AF Speed/Sens.
Knop 3	 Focus Setting
Knop 4	 Focus Magnifier x3/x6
Knop 5	 Direct Menu
Knop 6	 Off
Knop 7	 Focus Magnifier x3/x6
Knop 8	 Direct Menu
Knop 9	 Video Signal Monitor
Knop Hold button	 Focus Hold

Toewijsbare functies
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Bokeh Control
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot

ˎˎ Rec
ˎˎ Picture Cache Rec
ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Volume
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

De functie van de regelaar veranderen

U kunt de functie wijzigen van de 
multifunctionele regelaar op de camcorder, de 
toewijsbare regelaar op de handgreep en de 
toewijsbare regelaar op de draaggreep.

Gebruik voor het instellen van de 
multifunctionele regelaar Multi Function Dial 
(pagina 89) >Default Function in het menu 
Project.
Vanuit de fabriek is Off toegewezen.
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Functies toewijsbare aan de multifunctionele 
regelaar
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Opmerking]
De instelling is uitgeschakeld als het menu wordt 
weergegeven.

Gebruik voor de toewijsbare regelaar 
Assignable Dial (pagina 88) in het menu 
Project of het hoofdmenu.
Standaard vanuit de fabriek is IRIS aan alle 
knoppen toegekend.

[Tip]
De toewijsbare regelaar van de RM-30BP 
(optie) volgt de instelling van de handgreep/
afstandsbedieningsregelaar.

Toewijsbare functies aan de toewijsbare 
regelaar op de draaggreep/handgreep
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

U kunt de toegewezen functies op het scherm 
Assignable Button Status zien (pagina 15).

Slow & Quick Motion

Als de opname-indeling (pagina 83) is ingesteld op de volgende waarden, kunt u 
verschillende waarden opgeven voor de beeldsnelheid waarmee wordt gefilmd en de 
beeldsnelheid waarmee wordt afgespeeld.

Opname-indeling Beeldsnelheid

Systeemfrequentie Scanmodus 
beeldsensor

Codec Video-indeling

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I 4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

XAVC-L 3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

S35 XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF XAVC-I 4096×2160P 1–60

U kunt de modus Slow & Quick Motion 
in- of uitschakelen door het indrukken van 
een toewijsbare knop (pagina 49) die is 
toegewezen aan de functie S&Q Motion.
U kunt de beeldsnelheid voor opname 
instellen door de knop vast te houden.

[Tip]
U kunt de modus ook instellen met S&Q Frame 
Rate in het scherm Main Status, Rec Function in het 
statusscherm Project, en S&Q Motion in het menu 
Shooting van het hoofdmenu.

[Opmerkingen]
ˎˎ Slow & Quick Motion kan niet worden 

ingesteld tijdens opname, afspelen of als het 
pictogrammenscherm wordt weergegeven.
ˎˎ Audio opname wordt niet ondersteund in de modus 

Slow & Quick Motion.
ˎˎ De functies automatisch scherpstellen, 

autodiafragma, en automatische sluitertijd worden 
in de modus Slow & Quick Motion uitgeschakeld. De 
functie automatische scherpstelling kan wel worden 
gebruikt als de beeldsnelheid als volgt is ingesteld.

Systeemfrequentie Beeldsnelheid

59.94/29.97/23.98 30, 60, 120, 240

50/25 25, 50, 100, 200

ˎˎ Zie voor details over RAW-uitvoer pagina 59.

Intervalopname (Interval Rec)

Met de functie Interval Rec van de camcorder 
kunt u time-lapse-video's vastleggen in het 
interne geheugen van de camcorder. Dit is een 
effectieve manier om langzaam bewegende 
onderwerpen te filmen.
Als de opname wordt gestart, neemt de 
camcorder automatisch een vastgesteld aantal 
frames binnen een specifiek tijdsinterval op.

Filminterval (Interval Time)

Aantal frames in één take
(Number of Frames)

Als Interval Rec is ingeschakeld, gaat de 
HVL-LBPC (optie) videolamp automatisch 
aan voordat de opname begint, waardoor 
u foto's kunt maken onder stabiele licht- en 
kleurtemperatuuromstandigheden (functie 
voorverlichting).

[Opmerkingen]
ˎˎ Er kan slechts één speciale opnamefunctie, zoals 

Interval Rec, tegelijk worden gebruikt.
ˎˎ Als er een andere speciale opnamemodus actief 

wordt terwijl Interval Rec in gebruik is, wordt Interval 
Rec automatisch uitgeschakeld.
ˎˎ De modus Interval Rec wordt automatisch 

uitgeschakeld na het wijzigen van 
systeeminstellingen, zoals de video-indeling.
ˎˎ De instellingen voor Interval Rec kunnen niet worden 

gewijzigd tijdens opnemen of afspelen, of als het 
pictogrammenscherm wordt weergegeven.
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Interval Rec instellen

Selecteer Rec Function >Interval Rec in het 
statusscherm Project en configureer de 
instellingen Number of Frames en Interval 
Time.
Stel bij gebruik van de HVL-LBPC videolamp 
(optie) het vereiste tijdsinterval in voor het 
inschakelen van de videolamp, voordat de 
opname start met Interval Rec >Pre-Lighting in 
het menu Project.

[Tip]
U kunt de modus ook instellen met Interval Rec 
(pagina 85) in het menu Project van het hoofdmenu.

[Opmerkingen]
ˎˎ Als u de videolamp wilt inschakelen voor het begin 

van de opname, zet de videolampschakelaar dan 
op AUTO. De videolamp gaat automatisch aan 
en uit volgens de instelling van Video Light Set 
(pagina 102) in het menu Technical.
ˎˎ Als u de videolampschakelaar op aan zet, is de 

videolamp altijd aan (en gaat de videobelichting niet 
automatisch aan en uit).
ˎˎ Als de videolamp zo wordt geconfigureerd dat deze 

5 seconden of korter wordt uitgeschakeld, gaat de 
videolamp helemaal niet uit.

De camcorder verlaat de modus Interval 
Rec als hij wordt uitgeschakeld, maar de 
instellingen voor Number of Frames, Interval 
Time en Pre-Lighting blijven behouden. De 
volgende keer als u gaat opnemen in de 
modus Interval Rec hoeft u deze niet meer in 
te stellen.

Filmen met Interval Rec

Druk op de knop START/STOP om te starten 
met opnemen. "Int Rec" en "Int Stby" 
verschijnen afwisselend in de zoeker.
Als u de voorverlichtingfunctie gebruikt, gaat 
de videolamp aan voordat de opname begint.

Stoppen met filmen

Stop het filmen.
Als het filmen wordt gestopt worden de in het 
geheugen opgeslagen videogegevens tot dat 
punt opgeslagen op de media.

De modus Interval Rec verlaten

Voer een van de volgende handelingen uit.
ˎˎ Zet de POWER-schakelaar op Off.
ˎˎ In opname-stand-bymodus stelt u in het 
statusscherm Project de optie Rec Function 
in op een andere instelling dan Interval Rec.

De modus Interval Rec wordt ook automatisch 
uitgeschakeld als de camcorder opnieuw 
wordt opgestart.

Beperkingen tijdens opname

ˎˎ Audio wordt niet opgenomen.
ˎˎ Een opname controleren (Rec Review) is niet 
mogelijk.

Als de camcorder wordt uitgeschakeld 
tijdens opname

ˎˎ Als de POWER-schakelaar op de camcorder 
in de Off-stand staat, wordt het medium 
gedurende enkele seconden gebruikt om de 
beelden op te slaan die tot dat moment in 
het geheugen zijn opgeslagen, waarna het 
apparaat automatisch wordt uitgeschakeld.
ˎˎ Als de stroom uitvalt omdat de accu is 
verwijderd, het netsnoer is losgekoppeld 
of de stroom van de netadapter is 
uitgeschakeld, gaan de tot dan toe 
opgenomen video- en audiogegevens 
mogelijk verloren (maximaal 10 seconden). 
Bij het vervangen van de accu moet u 
voorzichtig te werk gaan.

Beelden in cache opnemen 
(Picture Cache Rec)

Met de functie Picture Cache Rec kunt u video 
achteraf vastleggen wanneer u een opname 
start door een intern cachegeheugen bij te 
houden met een bepaalde duur.
Stel Picture Cache Rec in op On in het 
statusscherm Project en stel vervolgens de 
cachegrootte in.

Instelling Cache 
Size

Cache-tijd (ongeveer)

Short 5 seconden

Medium 10 seconden

Long 20 seconden

Max Maximale waarde van de 
betreffende opname-
indeling

[Tips]
ˎˎ De cachetijd kan korter zijn, afhankelijk van de 

opnamebeeldsnelheid en de opname-indeling. Let op 
de weergave rechtsonder van het instellingenscherm 
voor de cachegrootte.
ˎˎ U kunt de modus ook instellen met Picture Cache 

Rec (pagina 85) in het menu Project van het 
hoofdmenu.
ˎˎ U kunt ook Picture Cache Rec schakelen tussen On en 

Off met een toewijsbare knop (pagina 49).

[Opmerkingen]
ˎˎ U kunt Picture Cache Rec niet gebruiken in combinatie 

met Interval Rec, simultane opnamefunctie met 2 
kaartsleuven of proxy-opname. Wanneer Picture 
Cache Rec is ingesteld op On, worden deze andere 
opnamefuncties geforceerd uitgeschakeld.
ˎˎ De modus Picture Cache Rec kan niet worden 

geselecteerd tijdens het opnemen of wanneer Rec 
Review bezig is.
ˎˎ Wanneer Picture Cache Rec is ingesteld op On, wordt 

de tijdcode vastgelegd in de modus Free Run, zelfs als 
dit is ingesteld op Regen of Rec Run (pagina 92).
ˎˎ De instelling Output Format kan misschien niet 

worden geconfigureerd tijdens de modus Picture 
Cache Rec. Als dat gebeurt, schakel dan Picture Cache 
Rec tijdelijk uit en wijzig vervolgens de instelling.

Picture Cache Rec starten

Wanneer Picture Cache Rec is ingesteld op On, 
verschijnt “Cache” ( is groen) in de zoeker.
Wanneer u op de knop START/STOP drukt, 
start de opname en wordt video naar de 
geheugenkaarten geschreven, te beginnen 
met de video die in het cachegeheugen is 
opgeslagen.

Picture Cache Rec annuleren

Stel Picture Cache Rec in op Off in het 
statusscherm Project of druk op een 
toewijsbare knop die u de functie Picture 
Cache Rec hebt toegewezen.

[Opmerkingen]
ˎˎ Door de opname-indeling of het basisuiterlijk te 

wijzigen, wist u de video die tot dan toe in het 
cachegeheugen is opgeslagen. Vervolgens wordt 
nieuwe video naar de cache geschreven. Daardoor is 
het opnemen in de beeldcache van beelden van voor 
het wijzigen van de indeling niet mogelijk, ook niet 
als u onmiddellijk met opnemen begint nadat u de 
indeling hebt gewijzigd.
ˎˎ Als u onmiddellijk nadat u een geheugenkaart hebt 

geplaatst Picture Cache Rec instelt op On of Off, 
worden cachegegevens misschien niet op de kaart 
opgenomen.
ˎˎ Video wordt in het cachegeheugen opgeslagen als de 

functie Picture Cache Rec is ingesteld op On. Video 
van voor u de functie instelde op On wordt niet in de 
cache opgenomen.
ˎˎ Video wordt niet in het cachegeheugen opgeslagen 

wanneer een geheugenkaart bezet is, zoals 
bij afspelen, Rec Review of weergave van het 
pictogrammenscherm. Op die momenten is opnemen 
naar de beeldcache van video niet mogelijk.
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Opnemen op geheugenkaart A en 
B tegelijkertijd (2-slot Simul Rec)

U kunt opnemen op zowel geheugenkaart 
A als geheugenkaart B tegelijkertijd door 
Simul Rec (pagina 15) op het scherm status 
Project of Simul Rec >Setting (pagina 85) 
in het menu Project van het hoofdmenu in te 
stellen op On.

Afzonderlijk naar geheugenkaart A en 
geheugenkaart B opnemen

U kunt het opnemen naar de verschillende 
geheugenkaarten onafhankelijk in- en 
uitschakelen met de knoppen Record START/
STOP op de camcorder en de draaggreep.
Standaard zijn beide knoppen ingesteld op 
gelijktijdig starten en stoppen met opnemen 
naar beide geheugenkaarten A en B.
ˎˎ “Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB]”

Wanneer de knoppen zijn ingesteld 
voor opnemen naar verschillende 
geheugenkaarten, volgt de opnamestart-
stopregeling van de SDI/HDMI Rec Control 
(pagina 86) de opnamestatus van sleuf A.

De instelling wijzigen

Selecteer Simul Rec >Rec Button Set 
(pagina 85) in het menu Project.

Rec Button Set Knoppen en 
geheugenkaarten

"Rec Button:[SlotA 
SlotB] Handle Rec 
Button:[SlotA SlotB]"

Start en stopt 
gelijktijdig opnemen 
naar de 
geheugenkaarten A en 
B door middel van 
beide knoppen.

"Rec Button:[SlotA] 
Handle Rec Button: 
[SlotB]"

De knop Record 
START/STOP start-
stopt het opnemen 
naar geheugenkaart A, 
en de knop Record 
START/STOP op de 
draaggreep start-stopt 
het opnemen naar 
geheugenkaart B.

"Rec Button:[SlotB] 
Handle Rec 
Button:[SlotA]"

De knop Record 
START/STOP start-
stopt het opnemen 
naar geheugenkaart B, 
en de knop Record 
START/STOP op de 
draaggreep start-stopt 
het opnemen naar 
geheugenkaart A.

[Tip]
De opnameknop op de afstandsbedieningsgreep of 
LANC-afstandsbediening werkt hetzelfde als de knop 
Record START/STOP op het apparaat.

Per ongeluk gebruiken van de knop 
Record START/STOP op de draaggreep 
voorkomen

Zet de HOLD-schakelaar op de draaggreep in 
de stand HOLD.

[Opmerking]
De schakelaar HOLD op de draaggreep werkt niet 
wanneer HOLD Switch Setting (pagina 100) >with Rec 
Button is ingesteld op Off in het menu Technical van het 
hoofdmenu. Als dit is ingesteld op On, stel dan Handle 
HOLD Switch in op Rec Button Only.

Wilt u de zoomregelaar en de overige 
knoppen behalve de knop Record START/STOP 
op de draaggreep inschakelen, stel dan HOLD 
Switch Setting >Handle HOLD Switch in op Rec 
Button Only.

Videosignaalmonitor

U kunt het type videosignaal instellen dat 
op het zoekerscherm wordt weergegeven 
als golfvorm, vectorscoop of historogram 
met Display On/Off >Video Signal Monitor 
(pagina 95) in het menu Monitoring.
De oranje lijn geeft de ingestelde waarde van 
het zebrapatroonniveau weer.
U kunt ook de functie Video Signal Monitor 
toewijzen aan een toewijsbare knop 
(pagina 49).

Doelweergave voor monitoring

In de modus Cine EI wordt de informatie voor 
kleurbereikinstelling (pagina 24) of monitor-
LUT-instelling (pagina 81) rechts boven in 
de videosignaalmonitor weergegeven om het 
doel van de monitoring aan te geven.

De functie Gamma Display Assist

Wanneer Target Display in de modus Custom 
is ingesteld op HDR(HLG) (pagina 24), stel 
dan Gamma Display Assist* op het scherm 
Monitoring Status in op On voor een weergave 
met hulp in de zoeker waarmee het opnemen 
in HDR makkelijker wordt.
*	 U kunt de functie ook instellen met Gamma Display 

Assist >Setting (pagina 96) in het menu Monitoring 
van het hoofdmenu.

De zoekerweergave selecteren wanneer 
de functie Gamma Display Assist is 
ingeschakeld

Er zijn twee weergavemethoden beschikbaar 
voor het weergeven van HDR-beelden in de 
zoeker wanneer de functie Gamma Display 
Assist is ingeschakeld.

HDR weergeven met behoud van contrast 
tussen gebieden met lage helderheid en 
gebieden met hoge helderheid
Deze methode maakt gebruik van de 
expressieve mogelijkheden van HDR en geeft 
het beeld in de zoeker weer zonder extra 
zwarte of overdreven lichte gebieden, zelfs als 
u opneemt met heldere of donkere belichting. 
Het contrast is echter wat minder.
Wilt u deze weergavemethode gebruiken, 
stel dan HDR Setting >VF SDR Preview 
(pagina 85) in op Off in het menu Project 
van het hoofdmenu.
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SDR weergeven door eenvoudige conversie 
van HDR naar SDR
Met deze methode kunt u de camera 
bedienen met hetzelfde gevoel als bij 
conventionele SDR.
U kunt de helderheid van het HDR-beeld 
aanpassen door het verschil in versterking 
tussen HDR en SDR in te stellen met SDR Gain.
Om deze weergavemethode te kunnen 
gebruiken, configureert u op de volgende 
manier.

1	 Stel HDR Setting >VF SDR Preview 
(pagina 85) in op On in het menu 
Project van het hoofdmenu.

2	 Pas de SDR-versterking in HDR-modus 
aan met HDR Setting >SDR Gain 
(pagina 85) in het menu Project van het 
hoofdmenu.

[Tip]
Wanneer u na het opnemen HDR-beeld naar SDR 
converteert met SR Live Metadata, wordt SDR Gain 
toegepast op de conversie zodat het SDR-beeld 
dezelfde belichting heeft als te zien was in de zoeker 
toen u de opname maakte.

Clipvlaggen

U kunt een OK-clipvlag aan de clip toevoegen 
door op de Knop Clipvlaggen (pagina 5) te 
drukken en Add OK te selecteren.
U kunt een OK Clip-vlag wissen door twee keer 
op de knop te drukken en Delete Clip Flag te 
selecteren.

[Tips]
ˎˎ U kunt ook een toewijsbare knop gebruiken die is 

toegewezen aan de clipvlagfunctie om clipvlaggen 
toe te voegen (pagina 49).
ˎˎ U kunt ook een clipvlag toevoegen met Set Clip 

Flag (pagina 99) in het menu Thumbnail van het 
hoofdmenu (pagina 70).

ˎˎ Het pictogrammenscherm kan worden weergegeven, 
gesorteerd op clipvlagtype (gefilterd clip-
pictogrammenscherm). Zie voor details “Clipfuncties” 
(pagina 70).

Ademcompensatie

U kunt kiezen voor ademcompensatie voor het 
objectief met Lens >Breathing Compensation 
(pagina 101) in het menu Technical van het 
hoofdmenu.
Deze functie corrigeert voor het fenomeen 
waarbij de kijkhoek verandert wanneer de 
scherpstelpositie verandert.
Wanneer ademcompensatie wordt 
toegepast, wordt een deel van het beeld 
elektronisch afgesneden zodat een constante 
kijkhoek wordt aangehouden zodat het 
ademfenomeen niet optreedt.

[Opmerkingen]
ˎˎ Wanneer ademcompensatie is ingeschakeld, kunnen 

de kijkhoek en beeldkwaliteit enigszins afwijken.
ˎˎ Afhankelijk van het objectief kan het zijn dat u de 

verandering in kijkhoek niet kunt corrigeren wanneer 
ademcompensatie is ingeschakeld.
ˎˎ Compensatie is niet mogelijk wanneer u een objectief 

hebt gemonteerd dat ademcompensatie niet 
ondersteunt.
ˎˎ Deze functie is in de volgende gevallen ingesteld op 

Off (vast).
–– Wanneer Lens >Distortion Comp. is ingesteld op 

Off in het menu Technical
–– Wanneer S&Q Motion >Setting in het menu 

Shooting is ingesteld op On
–– Wanneer Rec Format >Codec in het menu Project is 

ingesteld op RAW of een optie die RAW bevat

Bokeh aanpassen (functie Bokeh 
Control)

U kunt het bokeh-niveau gemakkelijk 
aanpassen door het ND-filter en de 
versterking te koppelen aan de bediening van 
het diafragma.

De functie Bokeh Control in-uitschakelen

Deze functie kan alleen worden ingeschakeld 
als u de belichting handmatig aanpast. Stel 
het ND-filter in op variabele modus, stel dan 
het diafragma, de versterking, de sluiter en het 
ND-filter in op handmatige bediening.
U kunt de functie Bokeh Control in-
uitschakelen met Iris > Bokeh Control 
(pagina 78) in het menu Shooting van het 
hoofdmenu.
Wanneer de functie Bokeh Control is 
ingeschakeld, verschijnt het pictogram   op 
het ND-filter en de versterkingsindicatoren. 

[Tip]
U kunt de functie Bokeh Control ook toewijzen aan een 
toewijsbare knop (pagina 49) en de functie Bokeh 
Control in- en uitschakelen met de knop.

Het bokeh-niveau aanpassen

1	 Stel de functie Bokeh Control in op On.

2	 Pas het ND-filter en de versterking aan om 
de belichting in te stellen.

3	 Pas het diafragma aan.
Het bokeh-niveau verandert.

[Tips]
ˎˎ Wanneer de functie Bokeh Control is ingesteld op 

On, werken het ND-filter en de versterking samen en 
compenseren ze wijzigingen in de belichting door 
aanpassing van het diafragma. Zo kunt u het bokeh-
niveau aanpassen.

ˎˎ De Bokeh Control wordt eerst gekoppeld aan het 
ND-filter in reactie op het gebruik van het diafragma. 
Wanneer het ND-filter niet meer gewijzigd kan 
worden, wordt de versterking gekoppeld.
ˎˎ In MF-modus kunt u het beste eerst het diafragma 

openen en vervolgens scherpstellen.
ˎˎ Wanneer u het automatische ND-filter gebruikt in 

plaats van de functie Bokeh Control, volgt het ND-
filter de wijzigingen in helderheid van het onderwerp.

Weergave tijdens koppelen van 
versterking

Wanneer de functie Bokeh Control is ingesteld 
op On, kan de versterking wijzigen als het 
diafragma wordt aangepast.
Wanneer de versterking is gekoppeld en deze 
wijzigt, verschijnt er een melding bovenin het 
scherm en knippert het pictogram   op de 
versterkingsindicator. 

[Opmerkingen]
ˎˎ Deze functie is alleen ingeschakeld op objectieven 

met E-bevestiging die kunnen communiceren met het 
apparaat.
ˎˎ Het maximale effect van deze functie wordt bereikt 

door de diafragmaring op een objectief met 
E-bevestiging van Sony te gebruiken.
ˎˎ Hoe dit eruit ziet, hangt af van de gebruikssnelheid, 

lens, opname-instellingen en het onderwerp; ook de 
helderheid kan veranderen. U kunt het beste eerst 
een cameratest uitvoeren voor u gaat opnemen.
ˎˎ De helderheid kan veranderen wanneer de richting 

van het diafragmagebruik wijzigt, bijvoorbeeld 
wanneer u het diafragma opent nadat u het eerder 
had gesloten of wanneer u het diafragma sluit na het 
te openen. In dat geval past u iets verder aan dan 
nodig en neemt u vervolgens iets terug. Controleer de 
helderheid en begin dan met opnemen.  
Als u bijvoorbeeld het diafragma wilt openen naar 
F8 en de achtergrond wilt vervagen, open dan het 
diafragma eerst verder dan F8 en neem vervolgens 
terug tot F8. Controleer vervolgens de helderheid en 
begin met opnemen.
ˎˎ Voer bedieningsfuncties aan de bokeh langzaam uit. 

Als u sneller wilt werken, probeer dan geleidelijk aan 
te passen terwijl u de wijzigingen in het beeld in de 
gaten houdt.
ˎˎ De kwaliteit van het beeld met Bokeh Control is niet 

gegarandeerd onder alle opnameomstandigheden.
ˎˎ De functie Bokeh Control wordt uitgeschakeld in elk 

van de volgende gevallen.
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–– Wanneer u de camcorder uitschakelt
–– Wanneer diafragma, versterking, sluiter of ND-filter 

is ingesteld op automatisch
–– Wanneer u de opnamemodus wijzigt
–– Wanneer het ND-filter is ingesteld op wissen of een 

presetmodus
–– Wanneer u het objectief verwijdert
–– Wanneer het apparaat opnieuw opstart, 

bijvoorbeeld na een wijziging in frequentie
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Proxy-opname
Met deze functie kunt u tegelijkertijd 
proxydata op lage resolutie opnemen, samen 
met originele videodata op hoge resolutie.
Proxygegevens kunnen automatisch met korte 
tussenpozen in segmenten worden verdeeld 
en de bestanden kunnen worden verzonden 
nog voor de opname is voltooid.

Zie “Geheugenkaarten gebruiken” (pagina 26) 
voor details over ondersteunende geheugenkaarten, 
formatteren van geheugenkaarten en controleren van de 
resterende capaciteit.

Configureren vóór filmen

1	 Stel Proxy Rec (pagina 15) op het 
scherm status Project of Proxy Rec 
>Setting (pagina 85) in het menu 
Project van het hoofdmenu in op On.

2	 Plaats een geheugenkaart in een 
CFexpress Type A/SD-kaartsleuf 
(pagina 6).
ˎˎ Bij CFexpress-kaarten wijst het etiket 
naar links.
ˎˎ Voor SD-kaarten wijst het etiket naar 
rechts met de schuin afgeplatte hoek 
aan de onderkant.

[Opmerking]
Proxy Rec kan niet tegelijk worden ingeschakeld met 
S&Q Motion of Interval Rec. Als Proxy Rec is ingesteld 
op On, worden deze andere opnamemodi geforceerd 
uitgeschakeld.

Een proxy opnemen

Druk op de knop START/STOP om het 
opnemen te starten na het maken van de 
juiste instelling voor het filmen.

[Opmerkingen]
ˎˎ Als de camcorder is uitgeschakeld of als de 

geheugenkaart wordt verwijderd terwijl er gegevens 
worden uitgewisseld kan de integriteit van de 
gegevens op de kaart niet worden gegarandeerd. 
Alle gegevens op de geheugenkaart kunnen verloren 
gaan. Controleer altijd of de toegangsindicator van de 
geheugenkaart niet brandt, alvorens de camcorder uit 
te schakelen of de geheugenkaart te verwijderen.
ˎˎ Zorg dat de geheugenkaart er niet uitspringt bij het 

plaatsen of verwijderen.

Om te verlaten stopt u de opname.

De audiokanalen voor proxy-
opname instellen

Selecteer Proxy Rec >Audio Channel 
(pagina 85) in het menu Project van het 
hoofdmenu, en stel het audiokanaal in voor 
proxydata-opname.

Een proxybestand in segmenten 
opnemen en uploaden

Wanneer de instelling Automatisch uploaden 
is ingesteld op Chunk en een proxybestand 
wordt opgenomen in segmenten, kan het 
proxybestand worden geüpload terwijl de 
hoofdopname bezig is.
Voor nadere gegevens over het uploaden 
van een proxybestand dat is opgenomen 
in segmenten raadpleegt u “Bestanden 

automatisch uploaden” (pagina 66) en “De 
app C3 Portal App gebruiken” (pagina 67).

1	 Selecteer Proxy Rec >Chunk (pagina 85) 
in het menu Project en selecteer het 
opname-interval voor segmenten.
30s: neem een proxybestand op in 
segmenten van 30 seconden 
(standaardinstelling).
1min: neem een proxybestand op in 
segmenten van 1 minuut.
2min: neem een proxybestand op in 
segmenten van 2 minuut.

2	 Stel File Transfer >Auto Upload (Proxy) 
(pagina 106) in het menu Network in op 
Chunk.
Het originele bestand wordt opgenomen 
op het medium in sleuf A en het 
proxybestand wordt in segmenten 
opgenomen op het medium in sleuf B.

3	 Start de proxy-opname.
Het proxybestand wordt in segmenten 
opgenomen met het opgegeven interval 
en alle segmenten worden in de takenlijst 
vastgelegd als overdrachtstaak.

[Opmerkingen]
ˎˎ Wanneer Auto Upload (Proxy) niet is ingesteld op 

Chunk, wordt geen proxy-opname in segmenten 
uitgevoerd.
ˎˎ Het medium in sleuf B is bedoeld voor het opnemen 

van proxybestanden in segmenten, daarom worden 
relay-opname en gelijktijdig opnemen op 2 sleuven 
niet ondersteund.

Over het opgenomen bestand

De bestandsnaamextensie is ".mp4".
De tijdcode wordt tegelijkertijd opgenomen.

Opslagbestemming van het 
opgenomen bestand

Het opgenomen bestand wordt opgeslagen in 
de volgende map.

Opnamemedia Map naar pad

SDXC /PRIVATE/XDROOT/
GENERAL/PXTMP

CFexpress Type A /XDROOT/GENERAL/
PXTMP

Over de bestandsnaam

De bestandsnaam bestaat uit de clipnaam 
die is opgenomen op de geheugenkaart, met 
“S03” als achtervoegsel. De bestandsnaam 
van een proxybestand dat is opgenomen 
in segmenten voor uploaden bestaat 
uit de originele bestandsnaam plus het 
segmentnummer en “S03” als achtervoegsel.
Zie voor details over clipnamen Clip Name 
Format (pagina 93) in het menu TC/Media 
van het hoofdmenu.
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Filmen met het gewenste uiterlijk
Als de camcorder zich in Custom-modus 
bevindt, kunt u wijzigingen aanbrengen in de 
zwart, matrix en andere parameters om een 
"look" (uiterlijk) te creëren gebaseerd op het 
basisuiterlijk.

：

Uiterlijk

Matrix

Zwart

Basisuiterlijk

U kunt ook snel een ander uiterlijk selecteren 
door verschillende combinaties van 
instellingen in scene-bestanden op te slaan.
De camcorder wordt geleverd met in totaal zes 
presets voor uiterlijk.

Een uiterlijk selecteren

1	 Druk op de multifunctionele regelaar als 
het scherm shooting wordt weergegeven.

2	 Selecteer het pictogram   
(scènebestand).

3	 Druk op de multifunctionele regelaar.

4	 Selecteer het gewenste uiterlijk in het 
menu en druk op de multifunctionele 
regelaar.

[Tips]
ˎˎ De volgende presets zijn standaard vanuit de fabriek 

geconfigureerd.

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Scènebestand 1 S-Cinetone HLG Live

Scènebestand 2 Standard HLG Natural

Scènebestand 3 Still (Niet 
geregistreerd)

Scènebestand 4 ITU709 (Niet 
geregistreerd)

Scènebestanden  
5 t/m 16

(Niet geregistreerd) (Niet 
geregistreerd)

ˎˎ U kunt ook een uiterlijk selecteren met Scene File 
(pagina 14) op het scherm Main Status of Scene 
File >Recall (pagina 90) in het menu Paint/Look 
van het hoofdmenu. U kunt ook een presetuiterlijk 
oproepen met Scene File >Preset Recall.

Een gewenst basisuiterlijk 
importeren

U kunt een 3D LUT-bestand dat op een 
computer of een ander apparaat is gemaakt, 
importeren als basisuiterlijk vanaf een 
geheugenkaart of clouddienst. Er kunnen 
maximaal 16 bestanden worden geïmporteerd.
ˎˎ Bestandsindeling: CUBE-bestand  (*.cube) 
voor een 17-punt of 33-punt 3D LUT 
gemaakt met Catalyst Browse, RAW Viewer, 
of DaVinci Resolve* (van Blackmagic Design 
Pty. Ltd.).
*	 Gecontroleerd met Resolve V9.0, V10.0 en V11.0.

ˎˎ Invoerkleurbereik/Gamma: S-Gamut3.
Cine/S-Log3 of S-Gamut3/S-Log3

Importeren vanaf een geheugenkaart

U kunt een 3D LUT-bestand importeren vanaf 
een geheugenkaart.

1	 Sla het 3D LUT-bestand op de computer of 
andere apparaat in de gespecificeerde 
map of het opnamemedium op.

Opnamemedia Map naar pad

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress 
Type A

/SONY/PRO/LUT/

2	 Plaats het opnamemedium waarop 3D 
LUT-bestanden zijn opgeslagen in de 
kaartsleuf CFexpress Type A/SD Card (B).

3	 Selecteer Base Look >Import from 
Media(B) (pagina 90) in het menu 
Paint/Look van het hoofdmenu.

4	 Selecteer een importbestemming.

5	 Selecteer een 3D LUT-bestand om te 
importeren.
Volg de instructies op het scherm. De 
camcorder behandelt een 3D LUT-bestand 
als een basisuiterlijk.

6	 Selecteer het geïmporteerde 3D LUT-
bestand met Base Look >Select 
(pagina 90) in het menu Paint/Look van 
het hoofdmenu.

7	 Configureer Base Look >Input en Output 
(pagina 90) in het menu Paint/Look van 
het hoofdmenu om de attributen aan te 
passen aan het geïmporteerde 3D LUT-
bestand.

Importeren vanuit een clouddienst

U kunt een 3D LUT-bestand importeren vanuit 
een clouddienst.

1	 Maak verbinding met het apparaat vanuit 
de smartphone-app “C3 Portal App” 
(pagina 67).

2	 Selecteer Base Look >Import from 
Cloud(Private) of Import from 
Cloud(Share) (pagina 90) in het menu 
Paint/Look van het hoofdmenu.

3	 Selecteer een importbestemming.

4	 Selecteer een 3D LUT-bestand om te 
importeren.
Volg de instructies op het scherm. De 
camcorder behandelt een 3D LUT-bestand 
als een basisuiterlijk.

5	 Selecteer het geïmporteerde 3D LUT-
bestand met Base Look >Select 
(pagina 90) in het menu Paint/Look van 
het hoofdmenu.
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6	 Configureer Base Look >Input en Output 
(pagina 90) in het menu Paint/Look van 
het hoofdmenu om de attributen aan te 
passen aan het geïmporteerde 3D LUT-
bestand.

Aanpassen voor onderbelichting

Als er een tendens voor onderbelichting is als 
automatische belichting is geselecteerd bij 
gebruik van het geïmporteerde basisuiterlijk, 
pas dan Base Look >AE Level Offset 
(pagina 90) in het menu Paint/Look aan.

[Opmerkingen]
ˎˎ Het zojuist geïmporteerde 3D LUT-bestand verandert 

het beeld niet. Laad het geïmporteerde 3D LUT-
bestand met Base Look >Select (pagina 90) in het 
menu Paint/Look van het hoofdmenu.
ˎˎ Als Input niet correct is ingesteld, wordt het juiste 

uiterlijk niet bereikt.
ˎˎ De instellingen van de menu-onderdelen Input, 

Output en AE Level Offset worden toegepast op 
het geselecteerde basisuiterlijk met Select. Als er 
meerdere 3D LUT-bestanden zijn geïmporteerd, 
selecteer dan Select voor elk 3D LUT-bestand en 
configureer Input, Output en AE Level Offset voor elk 
bestand afzonderlijk.
ˎˎ De geconfigureerde instellingen voor Input, Output 

en AE Level Offset worden voor elk 3D LUT-bestand 
opgeslagen.
ˎˎ De basisuiterlijk/LUT selectie-opties voor 

geïmporteerde 3D LUT-bestanden zijn gebruikelijk 
voor SDR(BT.709)/HDR(HLG)/Cine EI-modi, maar 
kleurbereik- en gammaconversie worden niet 
uitgevoerd volgens deze modi.
ˎˎ 3D LUT-bestanden worden niet gewist als All Reset > 

Reset wordt uitgevoerd in het menu Maintenance van 

het hoofdmenu.

Een uiterlijk aanpassen

U kunt het uiterlijk aanpassen gebaseerd op 
het basisuiterlijk met de Matrix en andere 
configuratie-onderdelen in het menu Paint/
Look van het hoofdmenu. Zie voor details over 
elk configuratieonderdeel pagina 90.
Sluit uw camcorder aan op een tv of monitor 
en pas de beeldkwaliteit aan terwijl u het 
beeld bekijkt op de tv of het monitorscherm.

[Opmerking]
Als u een 3D LUT-bestand importeert en op het beeld 
toepast, wordt het gewenste beeld dat in het 3D 
LUT-bestand is gedefinieerd niet bereikt als Matrix en 
andere instellingen dan die van het basisbeeld in het 
menu Paint/Look zijn gewijzigd. U kunt alle aangepaste 
instellingen resetten met Reset Paint Settings >Reset 
without Base Look (pagina 90) in het menu Paint/
Look van het hoofdmenu.

Een uiterlijk opslaan

U kunt het huidige uiterlijk opslaan als een 
scene-bestand in het interne geheugen met 
Scene File >Store (pagina 90) in het menu 
Paint/Look van het hoofdmenu.
U kunt snel opslaan met handelingen in het 
directmenu vanaf het filmscherm.

[Opmerkingen]
ˎˎ Als u een ander uiterlijk selecteert zonder het huidige 

uiterlijk op te slaan, wordt het huidige uiterlijk 
verworpen.
ˎˎ Scènebestanden worden niet gewist als All Reset > 

Reset (pagina 107) wordt uitgevoerd in het menu 
Maintenance van het hoofdmenu.

[Tip]
U kunt de preset scene-bestanden overschrijven.
Om een preset scene-bestand te herstellen, laadt u 
het uiterlijk dat moet worden hersteld met Scene File 
>Preset Recall (pagina 90) in het menu Paint/Look 
van het hoofdmenu en slaat u de scene vervolgens op 
met Scene File >Store.

Een opgeslagen uiterlijk verwijderen

U kunt een scene-bestand verwijderen dat 
in het interne geheugen is opgeslagen met 
Scene File >Delete (pagina 90) in het menu 
Paint/Look van het hoofdmenu.

[Tip]
Na wissen wordt het niet langer weergegeven in het 
directmenu.

Een basisuiterlijk verwijderen

U kunt een geïmporteerd 3D LUT-bestand 
verwijderen met Base Look >Delete 
(pagina 90) in het menu Paint/Look van het 
hoofdmenu.
U kunt alle geïmporteerde 3D LUT-bestanden 
verwijderen met Base Look >Delete All 
(pagina 90) in het menu Paint/Look van het 
hoofdmenu.

[Opmerkingen]
ˎˎ Controleer voor het verwijderen of het basisuiterlijk 

niet wordt gebruikt in een scene-bestand. Als een 
basisuiterlijk wordt verwijderd dat in gebruik is, wordt 
het uiterlijk van de betreffende scene-bestanden 
incorrect.
ˎˎ Geïmporteerde 3D LUT-bestanden worden niet gewist 

als All Reset >Reset (pagina 107) wordt geselecteerd 
in het menu Maintenance.
ˎˎ Een verwijderd basisuiterlijk kan niet langer 

worden gebruikt als een LUT in de modus Cine EI 
(pagina 58).
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Filmen met uiterlijkaanpassing in postproductie
Door de camcorder in Cine EI-modus te 
gebruiken en gradaties gelijkmatig op te 
nemen van donkere gebieden naar lichte 
gebieden, kunt u fijnaanpassingen maken, 
zoals het lokaal herstellen van de gradaties 
van donkere gebieden en lichte gebieden, in 
postproductie.
Echter, bij het bekijken van de opgenomen 
beelden op een conventionele monitor 
is het algehele contrast laag, waardoor 
scherpstellings- en belichtingsaanpassingen 
moeilijk worden.
U kunt een LUT toepassen op een 
monitordoel op de camcorder om te helpen 
bij verschillende aanpassingen tijdens het 
filmen. U kunt ook een LUT toepassen op de 
afspeelvideo om het voltooide resultaat te 
controleren.
LUTs worden toegepast door de volgende 
systemen. Maar er kan slechts één LUT 
worden toegepast.
ˎˎ SDI-uitgang en HDMI-uitgang
ˎˎ Zoeker en proxy-beelden, streaming
ˎˎ Video opgenomen op opnamemedia

Een LUT toepassen op het 
zoekerbeeld

1	 Druk op de knop MENU om het scherm 
Monitoring Status weer te geven.

2	 Selecteer de kolom Gamut/Gamma in de 
rij VF.

3	 Selecteer On of Off.

[Opmerkingen]
ˎˎ De instelling LUT On/Off van VF wordt ook toegepast 

op proxy file en streaming video.
ˎˎ Gammaweergave-assistent is beschikbaar tijdens 

gebruik van scherpstellingsvergroting.

[Tips]
ˎˎ U kunt ook instellen met LUT On/Off >VF/Proxy/

Stream (pagina 81) in het menu Shooting van het 
hoofdmenu.
ˎˎ SDI/HDMI kan identiek aan VF worden ingesteld.
ˎˎ Voor video op opnamemedia kunt u LUT On/Off 

>Internal Rec (pagina 81) in het menu Shooting van 
het hoofdmenu instellen.

Een LUT wijzigen

1	 Druk op de knop MENU om het scherm 
Monitoring Status weer te geven.

2	 Selecteer het veld Base Look/LUT.

3	 Selecteer de LUT in de basisuiterlijklijst die 
moet worden toegepast.

[Tips]
ˎˎ Het apparaat biedt s709, 709(800%) en S-Log3 als 

vooraf ingestelde LUT's.
ˎˎ U kunt ook een 3D LUT-bestand importeren en 

toepassen. Zie voor details “Een gewenst basisuiterlijk 
importeren” (pagina 56) en “Een basisuiterlijk 
verwijderen” (pagina 57).
ˎˎ Het basisuiterlijk kan ook worden ingesteld met Base 

Look >Select (pagina 90) in het menu Paint/Look 
van het hoofdmenu.

De verdeling van donkere en lichte 
gebieden in opgenomen video 
wijzigen

U kunt de verdeling van donkere gebieden en 
lichte gebieden wijzigen, bijvoorbeeld als u 
prioriteit wilt geven aan de toon van donkere 
gebieden boven lichte gebieden, door de 
Exposure Index te wijzigen ten opzichte van 
de basisgevoeligheid.

1	 Pas een LUT toe op het zoekerbeeld 
(pagina 58).

2	 Druk op de knop MENU om het scherm 
Camera Status weer te geven.

3	 Stel de velden L/M/H van Eposure index 
in.
De afzonderlijke instellingen worden 
toegewezen aan de L/M/H-posities van 
de schakelaar ISO/GAIN (pagina 5).

4	 Selecteer de waarde voor Exposure index 
die moet worden toegepast met de 
schakelaar ISO/GAIN.

5	 Pas de belichting van het zoekerbeeld op 
de juiste manier aan.

[Opmerking]
Gammaweergave-assistent is beschikbaar tijdens 
gebruik van scherpstellingsvergroting. De instelling 
voor Exposure Index wordt niet toegepast op de 
gammaweergave-assistent.

[Tips]
ˎˎ De belichting kan ook worden aangepast met ISO/

Gain/EI >Exposure Index (pagina 77) in het menu 
Shooting van het hoofdmenu.
ˎˎ De tweede numerieke waarde van de instelling 

geeft aan hoeveel stappen helderheidinformatie zijn 
toegewezen voor lichte gebieden (helderheid hoger 
dan 18% grijs). Gebieden die lichter zijn dan dat, zijn 
overbelicht.  
Voorbeeld: In "400EI/5.0E" zijn 5,0 stappen 
toegewezen aan de lichte zijde.
ˎˎ U kunt dit ook als een leidraad gebruiken om de toon 

van donkere en lichte gebieden tijdens het filmen 
te controleren. Bijvoorbeeld, als de M-positie de 
basisgevoeligheid is, L-positie is min 2 stappen en 
H-positie is plus 2 stappen, kunt u controleren door 
de ISO/GAIN om te schakelen. Vergeet niet terug te 
gaan naar de M-positie na het controleren van de 
belichting.
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U kunt het RAW-video-uitgangssignaal van 
de SDI OUT- of HDMI OUT-aansluiting van 
de camcorder opnemen naar een externe 
recorder die wordt ondersteund.

Opnemen vanaf de SDI OUT-
aansluiting

1	 Sluit een externe RAW recorder aan op de 
SDI OUT-aansluiting van de camcorder.

2	 Stel de filmmodus in het scherm status 
Project (pagina 15) of Base Setting 
>Shooting Mode (pagina 83) in het 
menu Project van het hoofdmenu in op 
Cine EI.

3	 Stel de scanmodus (alleen FF) in met 
Imager Scan op het scherm status Project 
of Rec Format >Imager Scan Mode 
(pagina 83) in het menu Project van het 
hoofdmenu.

4	 Stel een codec in die RAW ondersteunt 
met het scherm status Project of Rec 
Format >Codec (pagina 83) in het menu 
Project van het hoofdmenu.
Als u RAW & XAVC-I selecteert, wordt 
tegelijkertijd video naar de externe RAW-
recorder opgenomen en naar de 
geheugenkaarten in de camcorder.

5	 Stel de resolutie in met het scherm status 
Project of Rec Format >RAW Output 
Format (pagina 83) in het menu Project 
van het hoofdmenu.

6	 Controleer of de externe recorder is 
ingeschakeld, en druk dan op de 
opnameknop START/STOP op de 
camcorder.

	 [Opmerking]
Als de opname is gestart op de externe recorder, 
zonder gebruik te maken van de opnameknop 
START/STOP op de camcorder, worden de clips 
mogelijk niet goed opgenomen.

De ondersteunde RAW uitvoerindelingen 
worden hieronder weergegeven.

Systeem-
frequentie

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & XAVC-I 4096×2160

3840×2160

24 RAW 4096×2160

RAW & XAVC-I 4096×2160

Opnemen vanaf de HDMI OUT-
aansluiting

1	 Sluit een externe RAW recorder aan op de 
HDMI OUT-aansluiting van de camcorder.

2	 Stel de filmmodus in het scherm status 
Project (pagina 15) of Base Setting 
>Shooting Mode (pagina 83) in het 
menu Project van het hoofdmenu in op 
Cine EI.

3	 Stel de scanmodus (alleen FF) in met 
Imager Scan op het scherm status Project 
of Rec Format >Imager Scan Mode 
(pagina 83) in het menu Project van het 
hoofdmenu.

4	 Stel de codec in op RAW(HDMI) met het 
scherm status Project of Rec Format > 
Codec (pagina 83) in het menu Project 
van het hoofdmenu.
Als u RAW(HDMI) & XAVC-I selecteert, 
wordt tegelijkertijd video naar de externe 
RAW-recorder opgenomen en naar de 
geheugenkaarten in de camcorder.

5	 Controleer of de externe recorder is 
ingeschakeld, en druk dan op de 
opnameknop START/STOP op de 
camcorder.

[Opmerking]
Als de opname is gestart op de externe recorder, zonder 
gebruik te maken van de opnameknop START/STOP 
op de camcorder, worden de clips mogelijk niet goed 
opgenomen.

De ondersteunde RAW uitvoerindelingen 
worden hieronder weergegeven.

Systeem-
frequentie

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW(HDMI) 4240×2392

RAW(HDMI) & 
XAVC-I

4240×2392

Indicator opnamestatus

Als Display On/Off (pagina 94) >RAW 
Output Control Status in het menu Monitoring 
van het hoofdmenu is ingesteld op On, wordt 
de RAW-opnamestatus aangegeven door een 
pictogram in de zoeker.

[Opmerking]
Het opnameregelsignaal wordt verzonden via de SDI 
OUT-aansluiting van de camcorder, maar het is niet 
mogelijk om de status van de externe recorder op te 
vragen. Als gevolg hiervan kan de camcorder aangeven 
dat RAW video-opname loopt als de externe recorder 
eigenlijk niet opneemt. Controleer de indicator op de 
externe recorder voor de correcte functioneringsstatus.

[Tip]
De instelling voor RAW Output Format wordt ook 
weergegeven.

Slow & Quick Motion-opname

Als S&Q Motion >Setting in het menu 
Shooting is op On ingesteld, wordt RAW 
video opgenomen in de modus Slow & Quick 
Motion.
Zie voor details over de ondersteunde 
beeldsnelheden pagina 50.

[Opmerking]
Opnemen van Slow & Quick Motion vanaf de HDMI OUT-
aansluiting wordt niet ondersteund.

RAW video opnemen
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Verbinding maken met andere apparaten via LAN
De camcorder kan verbinding maken met 
smartphones, tablets en andere apparaten via 
een LAN-verbinding.
Na het tot stand brengen van een LAN-
verbinding tussen een apparaat en de 
camcorder is met de app “Content Browser 
Mobile” het volgende mogelijk.
ˎˎ Bediening op afstand 
U kunt de camcorder bedienen vanaf een 
smartphone of tablet die is verbonden met 
de camcorder via een LAN.
ˎˎ Bestandsoverdracht 
U kunt een proxy-bestand (lage resolutie) of 
een origineel bestand (hoge resolutie) dat 
is opgenomen op een geheugenkaart in de 
camcorder verzenden naar de server via een 
LAN.
ˎˎ Videocontrole 
U kunt het camerabeeld of de afgespeelde 
video van de camcorder volgen met de app 
“Content Browser Mobile” op een apparaat.

	 [Opmerking]
	 Monitoren van de video wordt niet ondersteund bij de 

volgende instellingen.
–– Slow & Quick Motion-modus
–– Systeemfrequentie 24
–– Interval Rec-modus

Toepassing "Content Browser Mobile"

U kunt de camcorder op afstand bedienen 
op het scherm van het apparaat terwijl u de 
video van de camcorder bekijkt en u kunt de 
instellingen van de camcorder configureren 
met de toepassing "Content Browser Mobile".

Neem voor details over de app "Content Browser Mobile" 
contact op met uw Sony verkoopvertegenwoordiging.

Gebruikersnaam en wachtwoord 
instellen

Stel de gebruikersnaam en het wachtwoord 
van de camcorder in om de netwerkfunctie te 
gebruiken.

1	 Stel Access Authentication >User Name 
(pagina 103) in het menu Network van 
het hoofdmenu in.

2	 Stel Access Authentication >Input 
Password (pagina 103) in het menu 
Network van het hoofdmenu in.

	 [Tips]
ˎˎ U kunt ook automatisch een wachtwoord laten 

genereren. Voer Generate Password uit in plaats 
van Input Password.
ˎˎ De gebruikersnaam, het wachtwoord, de tekst en 

de QR-code kunnen zichtbaar worden gemaakt 
met Show Settings.

	 [Opmerking]
Let erop dat andere mensen de QR-code en het 
wachtwoord niet kunnen zien.

Verbinding tot stand brengen in 
draadloze LAN-toegangspuntmodus

De camcorder werkt als een toegangspunt en 
maakt verbinding met een apparaat via een 
draadloos LAN.

Smartphone/tablet

Verbinding maken met een NFC-
compatibel apparaat via één druk op de 
knop

Met apparaten die NFC (verbinding via één 
druk op de knop) ondersteunen kan via 
herkenning op korte afstand (NFC) verbinding 
worden gemaakt.

1	 Open [Settings] op het apparaat, selecteer 
[More] en plaats een vinkje in het 
selectievakje NFC.

2	 Schakel de camcorder in.

3	 Activeer de NFC-functie.
Houd (gedurende 3 seconden) een 
toewijsbare knop ingedrukt die is 
toegewezen aan NFC of selecteer Wireless 
LAN >NFC in het menu Network om de 
NFC verbindingsmodus te activeren.
De NFC-functie is alleen beschikbaar als 

 op het scherm verschijnt.

4	 Raak de camcorder aan met het apparaat.
Het apparaat maakt verbinding met de 
camcorder en "Content Browser Mobile" 
wordt gestart.

	 [Opmerkingen]
ˎˎ Schakel ook eerst slaapmodus en 

schermvergrendeling uit.
ˎˎ Houd het apparaat stil en laat het contact maken 

tot de app "Content Browser Mobile" start (1 tot 
2 seconden).
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Verbinding maken met een WPS-
compatibel apparaat

Apparaten die WPS ondersteunen kunnen 
verbinding maken met behulp van WPS.

1	 Selecteer Wireless LAN >Setting >Access 
Point Mode in het menu Network van het 
hoofdmenu.

2	 Selecteer Wireless LAN >WPS >Execute in 
het menu Network van het hoofdmenu.

3	 Open de netwerkinstellingen of wifi-
instellingen van het apparaat en schakel 
wifi in.

4	 Selecteer de SSID van de camcorder in de 
SSID-lijst in Wi-Fi Network op het apparaat 
en selecteer vervolgens WPS drukknop in 
de opties van het apparaat dat moet 
worden verbonden.

	 [Opmerkingen]
ˎˎ De werkwijze verschilt, afhankelijk van het 

apparaat.
ˎˎ Controleer voor de SSID en het wachtwoord van 

de camcorder AP Mode Settings >Camera SSID 
& Password (pagina 103) in het menu Network 
van het hoofdmenu.

5	 Verbinding maken met de app Content 
Browser Mobile.

	 [Tip]
U kunt de gegevens die nodig zijn om de camcorder 
te verbinden bekijken met Access Authentication > 
Show Settings (pagina 103) in het menu Network 
van het hoofdmenu.

Verbinding maken door invoeren van 
een SSID en wachtwoord op een 
apparaat

U kunt de camcorderverbinding laten maken 
met een ander apparaat door de SSID en het 
wachtwoord van de camcorder in te voeren.

1	 Selecteer Wireless LAN >Setting >Access 
Point Mode in het menu Network van het 
hoofdmenu.

2	 Open de netwerkinstellingen of wifi-
instellingen van het apparaat en schakel 
wifi in.

3	 Breng de verbinding tussen het apparaat 
en de camcorder tot stand door de SSID 
van de camcorder te selecteren in de lijst 
in Wi-Fi Network en het wachtwoord in te 
voeren.
Controleer voor de SSID en het 
wachtwoord van de camcorder AP Mode 
Settings >Camera SSID & Password 
(pagina 103) in het menu Network.

	 [Opmerking]
De werkwijze verschilt, afhankelijk van het 
apparaat.

4	 Verbinding maken met de app Content 
Browser Mobile.

	 [Tip]
U kunt de gegevens die nodig zijn om de camcorder 
te verbinden bekijken met Access Authentication > 
Show Settings (pagina 103) in het menu Network 
van het hoofdmenu.

Verbinding maken met behulp 
van draadloos LAN in 
stationmodus

De camcorder maakt verbinding met een 
bestaand toegangspunt op het draadloos LAN 
als een client. De camcorder en het apparaat 
maken verbinding via het toegangspunt.
De 10 toegangspunten waarmee het laatst 
verbinding is gemaakt worden weergegeven 
in de geschiedenis.
De verbindingsgeschiedenis wordt 
opgeslagen in een ALL-bestand, maar 
de toegangswachtwoorden worden niet 
opgeslagen. Na het laden van het ALL-bestand 
is bij het tot stand brengen van de volgende 
verbinding wachtwoordinvoer vereist.

Smartphone/
tablet

Toegangspunt

Computer

Verbinding maken met een 
toegangspunt met behulp van WPS

Als het toegangspunt compatibel is met de 
WPS-functie, kunt u verbinding maken met het 
toegangspunt met eenvoudige instellingen.

1	 Schakel het toegangspunt in.

2	 Schakel de camcorder in.

3	 Selecteer Wireless LAN >Setting > Station 
Mode in het menu Network van het 
hoofdmenu.

4	 Selecteer ST Mode Settings >Camera 
Remote Control (pagina 104) >Enable in 
het menu Network van het hoofdmenu.

5	 Selecteer Wireless LAN >WPS >Execute in 
het menu Network van het hoofdmenu.

6	 Druk op de WPS-knop op het 
toegangspunt.
Raadpleeg voor details over de werking 
van de WPS-knop de gebruiksaanwijzing 
van het toegangspunt.
Als de verbinding is gelukt, geeft het 
pictogram indicator netwerkstatus een 
sterkte van 1 of hoger weer op het 
zoekerscherm.

	 [Opmerking]
Als de verbinding mislukt, voer de stappen vanaf 
stap 1 dan opnieuw uit.

7	 Maak met het apparaat verbinding met 
het toegangspunt.
Raadpleeg voor details over verbinden de 
gebruiksaanwijzing van het apparaat.

8	 Start de app “Content Browser Mobile” op 
een apparaat en selecteer de camcorder.
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	 [Tip]
U kunt de gegevens die nodig zijn om de camcorder 
te verbinden bekijken met Access Authentication > 
Show Settings (pagina 103) in het menu Network 
van het hoofdmenu.

Verbinding maken met de automatische 
detectiefunctie voor toegangspunten

1	 Voer de stappen 1 t/m 3 uit in “Verbinding 
maken met een toegangspunt met 
behulp van WPS” (pagina 61).

2	 Selecteer ST Mode Settings >Scan 
Networks (pagina 104) >Execute in het 
menu Network van het hoofdmenu.
De camcorder start detectie van 
verbindingsbestemmingen.
Mogelijke gevonden bestemmingen 
worden weergegeven in een lijst.

3	 Kies een bestemming uit de lijst.
Het netwerkdetailscherm (toegangspunt) 
verschijnt. De geselecteerde verbinding 
wordt weergegeven in SSID.

4	 Selecteer Password en voer het 
wachtwoord voor het toegangspunt in op 
het wachtwoordinvoerscherm om 
verbinding te maken.
Het selecteren van een SSID in de 
verbindingsgeschiedenis configureert 
automatisch de instellingen, waaronder 
het wachtwoord.
Stel het wachtwoord in om naar het 
netwerkdetailscherm (toegangspunt) 
terug te gaan.

5	 Configureer de volgende 
verbindingsinstellingen.
ˎˎ DHCP 
Stel DHCP in.  
Als dit is ingesteld op On wordt het 
IP-adres automatisch aan de camcorder 
toegewezen.  

Op Off instellen om het IP-adres 
handmatig aan de camcorder toe te 
wijzen.
ˎˎ IP Address 
Voer het IP-adres van het apparaat in.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.
ˎˎ Subnet Mask 
Voer het subnetmasker in voor het 
apparaat.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.
ˎˎ Gateway 
Voer de gateway voor het toegangspunt 
in.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.
ˎˎ DNS Auto 
Stelt in of DNS automatisch moet 
worden verkregen.  
Als dit is ingesteld op On wordt het 
DNS-adres automatisch verkregen. Deze 
instelling is alleen beschikbaar als DHCP 
is ingesteld op On.
ˎˎ Primary DNS Server 
Voer de primaire DNS-server voor het 
toegangspunt in.  
Deze instelling is alleen beschikbaar als 
DNS Auto is ingesteld op Off.
ˎˎ Secondary DNS Server 
Voer de secundaire DNS-server voor het 
toegangspunt in.  
Deze instelling is alleen beschikbaar als 
DNS Auto is ingesteld op Off.

6	 Selecteer na voltooiing Connect om 
verbinding te maken met het 
toegangspunt.

7	 Maak met het apparaat verbinding met 
het toegangspunt.
Raadpleeg voor details over verbinden de 
gebruiksaanwijzing van het apparaat.

8	 Start de app “Content Browser Mobile” op 
een apparaat en selecteer de camcorder.

	 [Tip]
U kunt de gegevens die nodig zijn om de camcorder 
te verbinden bekijken met Access Authentication > 
Show Settings (pagina 103) in het menu Network 
van het hoofdmenu.

Handmatig verbinding maken door de 
gegevens van het toegangspunt in te 
voeren

1	 Voer de stappen 1 t/m 3 uit in “Verbinding 
maken met een toegangspunt met 
behulp van WPS” (pagina 61).

2	 Selecteer ST Mode Settings >Manual 
Register (pagina 105) >Execute in het 
menu Network van het hoofdmenu.
Het netwerkdetailscherm (toegangspunt) 
verschijnt kort.

3	 Configureer de volgende 
verbindingsinstellingen.
ˎˎ SSID 
Voer de SSID in voor het 
verbindingstoegangspunt.
ˎˎ Security 
Geselecteerde versleutelingsmethode.
ˎˎ Password 
Voer het wachtwoord in voor de 
verbinding met het toegangspunt.
ˎˎ DHCP 
Stel DHCP in.  
Als dit is ingesteld op On wordt het 
IP-adres automatisch aan de camcorder 
toegewezen.  
Op Off instellen om het IP-adres 
handmatig aan de camcorder toe te 
wijzen.
ˎˎ IP Address 
Voer het IP-adres van het apparaat in.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.

ˎˎ Subnet Mask 
Voer het subnetmasker in voor het 
apparaat.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.
ˎˎ Gateway 
Voer het adres in van de gateway.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.
ˎˎ DNS Auto 
Stelt in of DNS automatisch moet 
worden verkregen.  
Als dit is ingesteld op On wordt het 
DNS-adres automatisch verkregen. Deze 
instelling is alleen beschikbaar als DHCP 
is ingesteld op On.
ˎˎ Primary DNS Server 
Voer het adres in van de primaire DNS-
server.  
Deze instelling is alleen beschikbaar als 
DNS Auto is ingesteld op Off.
ˎˎ Secondary DNS Server 
Voer het adres in van de secondaire 
DNS-server.  
Deze instelling is alleen beschikbaar als 
DNS Auto is ingesteld op Off.

4	 Selecteer na voltooiing Connect om 
verbinding te maken met het 
toegangspunt.

5	 Maak met het apparaat verbinding met 
het toegangspunt.
Raadpleeg voor details over verbinden de 
gebruiksaanwijzing van het apparaat.

6	 Start de app “Content Browser Mobile” op 
een apparaat en selecteer de camcorder.

	 [Tip]
U kunt de gegevens die nodig zijn om de camcorder 
te verbinden bekijken met Access Authentication > 
Show Settings (pagina 103) in het menu Network 
van het hoofdmenu.
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U kunt met de camcorder verbinding maken 
met internet met behulp van USB-tethering, 
bekabeld LAN of draadloos LAN.
Stel van tevoren de gebruikersnaam 
en het wachtwoord van de camcorder 
in (pagina 60).

Verbinding maken met USB-tethering

U kunt met het apparaat verbinding maken 
met een smartphone via een USB-kabel en 
vervolgens met de smartphone verbinding 
maken met internet.

Smartphone-communicatie configureren

Schakel tethering-communicatie in op de 
smartphone.
Raadpleeg voor details de gebruiksaanwijzing 
van de smartphone.

Een smartphone op de camcorder 
aansluiten

Sluit een USB-kabel aan op de USB-C-
aansluiting (pagina 7) van de camcorder 
en sluit deze kabel vervolgens aan op de 
smartphone.

[Opmerkingen]
ˎˎ Sluit de smartphone alleen aan of koppel deze los als 

de camcorder is uitgeschakeld.
ˎˎ USB-tethering kan niet worden gebruikt als de 

smartphone is verbonden via een USB-hub.
ˎˎ USB-tethering kan niet worden gebruikt als een 

computer is verbonden met de USB/multi-aansluiting 
(pagina 7).

Verbinding maken met een netwerk

1	 Schakel de camcorder in.

2	 Stel Modem >Setting (pagina 105) in het 
menu Network van het hoofdmenu in op 
On.

Werking van de smartphone activeren

U kunt de camcorder op afstand bedienen 
met de app “Content Browser Mobile” op een 
smartphone die is aangesloten met een USB-
kabel.

1	 Stel Modem >Camera Remote 
Control (pagina 105) in op Enable in het 
menu Network van het hoofdmenu.

2	 Start de app “Content Browser Mobile” op 
een smartphone en selecteer de 
camcorder.

	 [Tip]
U kunt de gegevens die nodig zijn om de camcorder 
te verbinden met de app Content Browser Mobile 
bekijken met Access Authentication >Show 
Settings (pagina 103) in het menu Network van 
het hoofdmenu.

Verbinding maken met behulp 
van draadloze LAN-stationmodus 
(wifi-stationmodus)

U kunt met de camcorder verbinding met 
het internet maken in wifi-stationmodus 
door middel van een optionele wifi-router 
of door wifi-tethering te gebruiken op een 
smartphone.
Maak verbinding met de wifi-router of het 
apparaat zoals beschreven in “Verbinding 
maken met behulp van draadloos LAN in 
stationmodus” (pagina 61).

Smartphone/
tablet

Wifi-router

Computer

Internet

Smartphone/
tablet

Internet

Verbinding maken behulp van een 
LAN-kabel

U kunt verbinding maken met internet door de 
bekabelde LAN-aansluiting van een bekabelde 
LAN-adapter (optie) verbonden met de USB-
C-aansluiting (pagina 7) van de camcorder 
met een LAN-kabel aan te sluiten op een wifi-
router (optie).

Smartphone/
tablet

Computer

Wifi-router

Adapter voor 
bekabeld LAN

Internet

Verbinding met internet



4. Netwerkfuncties: Verbinding met internet64

LAN-kabelverbindingen en instellingen 
bekabeld LAN

1	 Sluit een bekabelde LAN-adapter aan op 
de USB-C-aansluiting van de camcorder.

2	 Sluit de bekabelde LAN-aansluiting van de 
bekabelde LAN-adapter aan op een 
wifi-router met een LAN-kabel.

3	 Schakel de camcorder in.

4	 Stel Wired LAN >Setting (pagina 105) in 
het menu Network van het hoofdmenu in 
op On.

5	 Configureer verbindingsinstellingen met 
Wired LAN >Detail Settings (pagina 105) 
in het menu Netwerk.
ˎˎ DHCP 
Stel DHCP in.  
Als dit is ingesteld op On wordt het 
IP-adres automatisch aan de camcorder 
toegewezen.  
Op Off instellen om het IP-adres 
handmatig aan de camcorder toe te 
wijzen.
ˎˎ IP Address 
Voer het IP-adres van het apparaat in.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.
ˎˎ Subnet Mask 
Voer het subnetmasker in voor het 
apparaat.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.
ˎˎ Gateway 
Voer het adres in van de gateway.  
Deze instelling is alleen beschikbaar als 
DHCP is ingesteld op Off.

ˎˎ DNS Auto 
Stelt in of DNS automatisch moet 
worden verkregen.  
Als dit is ingesteld op On wordt het 
DNS-adres automatisch verkregen. Deze 
instelling is alleen beschikbaar als DHCP 
is ingesteld op On.
ˎˎ Primary DNS Server 
Voer het adres in van de primaire DNS-
server.  
Deze instelling is alleen beschikbaar als 
DNS Auto is ingesteld op Off.
ˎˎ Secondary DNS Server 
Voer het adres in van de secondaire 
DNS-server.  
Deze instelling is alleen beschikbaar als 
DNS Auto is ingesteld op Off.

6	 Klik na voltooiing op Set om de 
instellingen toe te passen.

[Opmerkingen]
ˎˎ Selecteer altijd Set naar het wijzigen van 

verbindingsinstellingen. De instellingen worden niet 
toegepast als Set niet is geselecteerd.
ˎˎ Gebruik een bekabelde LAN-adapter van het type 

USB C. Gebruik van een adapter die compatibel is 
met Gigabit Ethernet wordt geadviseerd. Correcte 
werking met alle apparaten kan echter niet worden 
gegarandeerd.
ˎˎ Een bekabelde USB-LAN-adapter (optie) kan niet 

worden gebruikt als een computer is verbonden met 
de USB/multi-aansluiting (pagina 7).
ˎˎ De ingebouwde wifi-communicatiefunctie kan 

worden beïnvloed, afhankelijk van het model van de 
bekabelde LAN-adapter (optie).

Bediening met een smartphone 
inschakelen via een bekabeld LAN

Om de camcorder op afstand te kunnen 
gebruiken met de app Content Browser Mobile 
op een smartphone via wifi over een wifi-
router die is aangesloten via een bekabeld 
LAN, stelt u Wired LAN >Camera Remote 
Control (pagina 105) in het menu Network 
van het hoofdmenu in op Enable.
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Bestanden uploaden
U kunt een proxy-bestand of een origineel 
bestand dat is opgenomen op de camcorder 
uploaden naar een server op internet, of 
een server op een lokaal netwerk, via een 
smartphone of toegangspunt.

Voorbereidingen

Verbinding maken met een netwerk

Breng verbinding van de camcorder met 
internet of een lokaal netwerk tot stand zoals 
beschreven in “Verbinding met internet” 
(pagina 63) of “Verbinding maken met 
andere apparaten via LAN” (pagina 60).

Een bestemming van een 
bestandsoverdracht registreren

Registreer eerst de server voor het uploaden.

1	 Selecteer File Transfer >Server Settings1 
(of Server Settings2, Server Settings3) in 
het menu Network van het hoofdmenu.
Het configuratiescherm 
overdrachtsbestemming verschijnt.

2	 Stel alle items in op het 
configuratiescherm 
overdrachtsbestemming.
Display Name
Voer de naam van de server in die moet 
worden weergegeven in de 
overdrachtsbestemmingslijst.
Service
Geeft het servertype weer.
"FTP": FTP-server
Host Name
Voer het adres van de server in.

Port
Voer het poortnummer van de server in 
waarmee verbinding moet worden 
gemaakt.
User Name
Voer de gebruikersnaam in.
Password
Voer het wachtwoord in.
Passive Mode
Schakel passieve modus in of uit.
Destination Directory
Voer de naam van de map op de 
bestemmingsserver in.

	 [Opmerkingen]
ˎˎ De originele bestanden worden geüpload naar 

de map “Main” binnen de opgegeven map van 
de overdrachtsbestemming.
ˎˎ Tijdens bewerking geeft "" tekens aan die niet 

kunnen worden gewijzigd. Als deze tekens in een 
mapnaam worden gebruikt kan correcte werking 
niet worden gegarandeerd.  
Als u wilt bewerken, verwijder dan alle tekens en 
voer opnieuw een waarde in.
ˎˎ Als er voor de Destination Directory op de 

bestemmingsserver tekens worden ingevoerd die 
ongeldig zijn, worden bestanden verzonden naar 
de hoofdmap van de gebruiker. Welke tekens 
ongeldig zijn verschilt, afhankelijk van de server.

Using Secure Protocol
Stel in of veilig FTP-uploaden moet 
worden gebruikt.
Root Certificate
Laad/wis een certificaat.
ˎˎ Load 
Selecteer Set in stap 3 om een CA-
certificaat te importeren.

*	 Het certificaat dat moet worden geladen moet 
de PEM-indeling hebben met de bestandsnaam 
"certification.pem", en moet worden opgeslagen 
in de hoofdmap van de geheugenkaart die is 
geplaatst in de CFexpress Type A/SD-kaartsleuf 
(B).

ˎˎ Clear 
Selecteer Set in step 3 om een CA-
certificaat te wissen.
ˎˎ None 
Geen certificaat laden of wissen.

	 [Opmerkingen]
ˎˎ Stel de klok van de camcorder in op de juiste tijd, 

alvorens een CA-certificaat te importeren.
ˎˎ Bij opnemen in XAVC-I 4096×2160P/ 

3840×2160P 59.94/50P, kan Load niet worden 
geselecteerd.
ˎˎ Bij weinig stroom kan Load/Clear niet worden 

geselecteerd voor een CA-certificaat.

Root Certificate Status
Geeft de laadstatus van het certificaat 
weer.
Reset
Herstel de instellingen van Server Settings 
naar de standaardwaarden.

3	 Klik na voltooiing op Set om de 
instellingen toe te passen.
Selecteer altijd Set na het wijzigen van de 
instellingen. De instellingen worden niet 
toegepast als Set niet is geselecteerd.

Een bestand selecteren en 
uploaden

U kunt voor overdracht naar de server proxy-
bestanden of originele bestanden die zijn 
opgenomen op geheugenkaarten selecteren.

[Opmerking]
Proxybestanden die zijn opgenomen in segmenten zijn 
bestanden die bedoeld zijn voor automatisch uploaden. 
Ze kunnen niet handmatig worden geselecteerd en 
geüpload.

Een proxy-bestand op een 
geheugenkaart uit het 
pictogrammenscherm uploaden

1	 Maak verbinding tussen de camcorder en 
apparaat met een LAN-verbinding 
(pagina 60).

2	 Selecteer Transfer Clip (Proxy) >Select Clip 
in het menu Thumbnail van het 
hoofdmenu.
De weergave schakelt over van het 
hoofdmenu naar het 
pictogrammenscherm.
Clips kunnen worden verzonden vanuit 
het pictogrammenscherm of het 
pictogrammenscherm met gefilterde clips.

3	 Selecteer de clip die u wilt verzenden en 
druk op de toets MENU.
Er verschijn een bevestigingsscherm voor 
de overdracht.
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4	 Selecteer Execute.
Het proxy-bestand dat overeenkomt met 
het geselecteerde bestand wordt 
geregistreerd als een overdrachtsopdracht 
en het uploaden begint.
Als de overdrachtsopdracht succesvol is 
geregistreerd verschijnt het 
resultaatscherm voor de overdracht.

5	 Select OK.

Alle bestanden uploaden
Kies in stap 2 All Clips in plaats van Select Clip 
om de proxy-bestanden te verzenden die 
corresponderen met alle bestanden.

[Opmerking]
Er kunnen maximaal 200 bestanden worden verzonden.

Een origineel bestand op een 
geheugenkaart vanuit het 
pictogrammenscherm uploaden

[Opmerking]
De originele bestanden worden geüpload naar 
de map “Main” binnen de opgegeven map van de 
overdrachtsbestemming.

1	 Maak verbinding tussen de camcorder en 
apparaat met een LAN-verbinding 
(pagina 60).

2	 Selecteer Transfer Clip >Select Clip in het 
menu Thumbnail van het hoofdmenu.
De weergave schakelt over van het 
hoofdmenu naar het 
pictogrammenscherm.
Clips kunnen worden verzonden vanuit 
het pictogrammenscherm of het 
pictogrammenscherm met gefilterde clips.

3	 Selecteer de clip die u wilt verzenden en 
druk op de toets MENU.
Er verschijn een bevestigingsscherm voor 
de overdracht.

4	 Selecteer Execute.
Het geselecteerde bestand wordt 
geregistreerd als een overdrachtsopdracht 
en het uploaden begint.
Als de overdrachtsopdracht succesvol is 
geregistreerd verschijnt het 
resultaatscherm voor de overdracht.

5	 Select OK.

Alle bestanden uploaden
Kies All Clips in plaats van Select Clip in stap 2 
om alle bestanden te verzenden.

[Opmerking]
Er kunnen maximaal 200 bestanden worden verzonden.

De bestandsoverdracht controleren

U kunt de status van de bestandsoverdracht 
controleren door selecteren van File Transfer 
>View Job List (pagina 106) in het menu 
Network van het hoofdmenu.
U kunt ook de status van bestandsoverdracht 
controleren vanuit het scherm van de app 
Content Browser Mobile.

[Tip]
Als File Transfer >Auto Upload (pagina 106) of Auto 
Upload (Proxy) (pagina 106) in het menu Network 
van het hoofdmenu is ingesteld op On en er een 
netwerkverbinding bestaat, worden de originele 
bestanden en proxy-bestanden automatisch geüpload 
naar de server die is opgegeven bij Default Upload 
Server (pagina 106) als de opname wordt beëindigd. 
Als zowel de originele bestanden als de proxybestanden 
zijn geconfigureerd voor automatisch uploaden, 
heeft het automatisch uploaden van proxybestanden 
voorrang.

[Opmerkingen]
ˎˎ Er kunnen maximaal 200 overdrachtstaken worden 

geregistreerd.
ˎˎ De joblijst wordt bewaard als de camcorder wordt 

uitgeschakeld, maar maximaal 10 minuten van de 
laatste voortgangsinformatie kan verloren gaan als de 
accuset wordt verwijderd of als de camcorder wordt 
uitgeschakeld zonder dat de POWER-schakelaar eerst 
op STANDBY wordt gezet.
ˎˎ Opdrachten die zijn toegevoegd na het weergeven 

van een lage-stroommelding.
ˎˎ Als er een fout optreedt tijdens de 

bestandsoverdracht, wordt de overdracht van een 
clip met dezelfde naam als een overgedragen clip 
mogelijk niet hervat, afhankelijk van de instellingen 
en status van de bestemmingsserver voor overdracht. 
Controleer in dit geval de instelling en status van de 
transmissiebestemmingsserver.

Bestanden automatisch uploaden

Een origineel bestand automatisch 
uploaden

Originele bestanden kunnen na afloop van de 
opname worden geüpload naar de opgegeven 
server. Wilt u deze functie gebruiken, stel dan 
File Transfer >Auto Upload (pagina 106) in op 
On in het menu Network van het hoofdmenu.

Een proxybestand automatisch 
uploaden

Proxybestanden kunnen na afloop van de 
opname worden geüpload naar de opgegeven 
server. Wilt u deze functie gebruiken, stel 
dan File Transfer >Auto Upload (Proxy) 
(pagina 106) in op On in het menu Network 
van het hoofdmenu.
Als Auto Upload (Proxy) is ingesteld op 
Chunk kunt u ook een proxybestand in 
segmenten opnemen en in segmenten 
uploaden naar een opgegeven server terwijl 

het opnemen doorgaat. Het uploaden van 
een proxybestand dat is opgenomen in 
segmenten heeft voorrang boven andere 
bestandsoverdrachten.
Zie voor details over configuratie “Een 
proxybestand in segmenten opnemen en 
uploaden” (pagina 55).

Uploaden met veilige FTP

U kunt bestanden uploaden met versleuteling 
met behulp van FTPS in Explicit mode 
(FTPES) voor de verbinding met de 
bestemmingsbestandsserver.

Veilige FTP-overdracht instellen

Voor veilige FTP-overdracht zet u Using Secure 
Protocol op de bestemmingsbestandsserver 
op ON en importeert u een certificaat.
Zie voor details over configuratie “Een 
bestemming van een bestandsoverdracht 
registreren” (pagina 65).
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De app C3 Portal App gebruiken
U kunt gemakkelijk bestanden overbrengen 
naar de C3 Portal-cloud door het apparaat te 
koppelen met de smartphone-app “C3 Portal 
App”.
Maak eerst een C3 Portal-account en installeer 
C3 Portal App op een smartphone.
Voor details over het maken van een C3 Portal-
clouddienstaccount neemt u contact op met 
de systeembeheerder van uw organisatie.

[Opmerkingen]
ˎˎ De dienst is misschien niet beschikbaar, afhankelijk 

van de regio waar u verblijft.
ˎˎ Voor details over het gebruik van de app C3 Portal 

App raadpleegt u de Help-gids bij C3 Portal App.

Bestanden uploaden naar C3 
Portal

1	 Selecteer Setup for Mobile App >Setup 
(pagina 93) in het menu Network.
Er verschijnt een bevestigingsscherm voor 
onderdelen die automatisch worden 
bijgewerkt.
De volgende instellingen in het menu 
Network worden automatisch 
geselecteerd.
ˎˎ Wired LAN >Setting: Off
ˎˎ Modem >Setting: On
ˎˎ Modem >Camera Remote Control: 
Enable
ˎˎ Access Authentication >Input Password: 
(automatisch gegenereerd indien niet 
opgegeven)

2	 Controleer de instellingen en selecteer 
OK.
De configuratie begint. De melding “Now 
changing” verschijnt terwijl de 
configuratie bezig is.

Wanneer de configuratie klaar is, 
verschijnt het volgende scherm in de 
zoeker.

De volgende informatie voor 
toegangsverificatie wordt weergegeven.
Gebruikersnaam, wachtwoord, 
vingerafdruk, naam van camcordermodel, 
serienummer

	 [Tip]
Dit scherm wordt niet uitgevoerd naar de video-
uitgang.

	 [Opmerking]
Let erop dat andere mensen het wachtwoord niet 
kunnen zien en de QR-code niet kunnen kopiëren.

3	 Start de app C3 Portal App op de 
smartphone en meld u aan bij de 
clouddienst.

4	 Verbind de smartphone via een USB-kabel 
met de USB-C-aansluiting van het 
apparaat.

5	 Schakel USB-tethering in op het scherm 
van de smartphone.
Zie voor details over configuratie 
“Verbinding maken met USB-tethering” 
(pagina 63).
De bediening verschilt, afhankelijk van uw 
smartphone. Raadpleeg de handleiding 
van de smartphone.

6	 Scan de QR-code die in de zoeker wordt 
weergegeven volgens de aanwijzingen op 
het scherm van C3 Portal App.

Installatie-informatie over 
bestandsoverdracht wordt vanaf de 
smartphone naar het apparaat verzonden 
en de volgende melding verschijnt.

7	 Select OK.
De installatie-informatie wordt geladen.
Wanneer de installatie-informatie is 
geladen, verschijnt de melding “Network 
File loaded.”.

[Opmerkingen]
ˎˎ De app C3 Portal App overschrijft de instelling File 

Transfer (pagina 106) in het menu Network van het 
apparaat.
ˎˎ Root Certificate kan niet automatisch worden 

ingesteld. Configureer dit handmatig.

Een origineel bestand uploaden

Stel File Transfer >Auto Upload (pagina 106) 
in het menu Network in op On om uploaden 
van originele bestanden naar het C3 Portal in 
te schakelen.
Wanneer een opname wordt beëindigd, wordt 
een bestand geüpload naar de locatie die is 
gekoppeld aan uw C3 Portal-account.

Een proxybestand uploaden

Stel File Transfer >Auto Upload (Proxy) 
(pagina 106) in het menu Network in op On 
om uploaden van proxybestanden naar het C3 
Portal in te schakelen.
Wanneer een opname wordt beëindigd, wordt 
een bestand geüpload naar de locatie die is 
gekoppeld aan uw C3 Portal-account.
Wanneer Auto Upload (Proxy) is ingesteld op 
Chunk, wordt het proxybestand onderverdeeld 
in segmenten en worden deze vanaf het 
begin van de opname met vaste tussenpozen 
geüpload. Zie voor details over configuratie 

“Een proxybestand in segmenten opnemen en 
uploaden” (pagina 55).

Willekeurig bestanden uploaden

Zie “Een bestand selecteren en uploaden” 
(pagina 65).

[Tips]
ˎˎ Bestanden die worden verzonden door het 

apparaat worden gecached in C3 Portal App en 
overgebracht naar het C3 Portal. De statusweergave 
voor bestandsoverdracht op het apparaat geeft de 
overdrachtsstatus naar C3 Portal App aan.
ˎˎ Wanneer de bestandsoverdracht van het apparaat 

naar C3 Portal App op de smartphone is voltooid, 
kunt u het apparaat uitschakelen, maar let op dat 
de bestandsoverdracht vanaf de smartphone nog 
bezig kan zijn. Houd rekening met de resterende 
batterijlading van de smartphone.

Overige functies die C3 Portal 
gebruiken

3D LUT-bestanden beheren

U kunt 3D LUT-bestanden die zijn opgeslagen 
in C3 Portal naar het apparaat importeren. 
Zie “Importeren vanuit een clouddienst” 
(pagina 56).

ALL-bestanden beheren

U kunt een ALL-bestand dat is gemaakt op 
het apparaat opslaan in C3 Portal en een 
ALL-bestand vanuit C3 Portal laden. Zie “Een 
ALL-bestand opslaan naar een clouddienst” 
(pagina 113) en “Een ALL-bestand laden van 
een clouddienst” (pagina 114).
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Pictogrammenscherm
Als u op de knop THUMBNAIL (pagina 5) drukt, worden de clips die zijn opgenomen op de geheugenkaart weergegeven als pictogrammen op het scherm.
U kunt een clip op het pictogrammenscherm selecteren en het afspelen van die clip starten. Het afspeelbeeld kan worden weergegeven in de zoeker of op een externe monitor.
Nogmaals op de knop THUMBNAIL drukken sluit het pictogrammenscherm weer en gaat terug naar het camerabeeld.

[Opmerking]
Alleen de clips die zijn opgenomen in de momenteel geselecteerde opname-indeling worden weergegeven op het pictogrammenscherm. Als een verwachte opgenomen clip niet wordt weergegeven, controleer dan de opname-indeling. Let 
hier speciaal op vóór het formatteren (initialiseren) van media.

Schermindeling

Informatie over de clip op de cursorpositie wordt weergegeven aan de onderkant van het scherm.

4 5

6

3

1

2

Indicator momenteel geselecteerde geheugenkaart
(Er verschijnt een hangslot-pictogram als de card is 
beveiligd.)

Cursor (geel)

Clipnummer/totaal aantal clips

1.	 Pictogram (indexafbeelding)
Geeft de indexafbeelding van de clip weer. 
Als een clip wordt opgenomen, wordt het 
eerste frame automatisch ingesteld als 
indexafbeelding.
Clip/frame-informatie wordt weergegeven 
onder het pictogram. U kunt de weergegeven 
informatie wijzigen met Customize View 

(pagina 99) >Thumbnail Caption in het 
menu Thumbnail van het hoofdmenu.

2.	 Clipnaam
Geeft de naam van de geselecteerde clip 
weer.

3.	 Video-opname-indeling
Geeft de bestandindeling van de 
geselecteerde clip weer.

4.	 Speciale opname-informatie
Geeft de opname-indeling alleen weer 
als de clip is opgenomen in een speciale 
opnamemodus.
Voor Slow & Quick Motion-clips wordt 
de beeldsnelheid aan de rechterkant 
weergegeven.

5.	 Clipduur

6.	 Aanmaakdatum
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Clips afspelen

Opgenomen clips afspelen

U kunt opgenomen clips afspelen als de 
camcorder in opnamestand-by (Stby) staat.

1	 Plaats de geheugenkaart om af te spelen.

2	 Druk op de knop THUMBNAIL.

3	 Gebruik de keuzeschakelaar 
(pagina 7) of multifunctionele 
regelaar (pagina 5) om de cursor te 
verplaatsen naar het pictogram voor de 
gewenste clip.

4	 Druk op de toepassingsknop van de 
keuzeschakelaar of multifunctionele 
regelaar.
Afspelen begint vanaf het begin van de 
geselecteerde clip.

Afspelen kan worden bediend met de 
volgende knoppen.
Druk op de toepassingsknop van de 

keuzeschakelaar of de multifunctionele 
regelaar: 
afspelen pauzeren.  
Nogmaals indrukken om terug te gaan 
naar normaal afspelen.

Druk op de linker/rechter knop van de 
keuzeschakelaar: 
Springt naar het begin van de clip of de 
vorige/volgende clip.

De linker/rechter knop indrukken en 
vasthouden: 
vooruit/achteruit spoelen.  
Na het loslaten van de knop wordt 
normaal afspelen hervat.

Knop CANCEL/BACK: 
Stopt afspelen en gaat terug naar de 
modus opname-stand-by.

[Opmerkingen]
ˎˎ Er kan zich een tijdelijke onderbreking van het beeld 

of stilstaand beeld voordoen bij de overgang tussen 
clips. U kunt de camcorder niet tegelijk gebruiken.
ˎˎ Als u een clip selecteert in het pictogrammenscherm 

en afspelen start, kan er zich een tijdelijke 
onderbreking van het beeld bij de start van de 
clip voordoen. Om het begin van de clip zonder 
onderbreking te bekijken zet u de camcorder in de 
modus afspelen, pauze, en gebruikt u de linker knop 
van de keuzeschakelaar om naar het begin van de clip 
terug te gaan. Start daarna het afspelen opnieuw.
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In het pictogrammenscherm kunt u de clips 
bedienen of clipeigenschappen controleren in 
het menu Thumbnail van het hoofdmenu.
Het menu Thumbnail (pagina 99) verschijnt 
als u de knop MENU ingedrukt houdt en 
Thumbnail selecteert.

Functies in het menu Thumbnail

Gebruik de keuzeschakelaar (pagina 7) of 
de multifunctionele regelaar (pagina 5) 
om een functie te selecteren, en druk 
vervolgens op de toepassingsknop van de 
keuzeschakelaar of de multifunctionele 
regelaar.
Druk op de knop CANCEL/BACK (pagina 5) 
om naar het vorige scherm te gaan.

[Opmerking]
Sommige onderdelen kunnen niet worden geselecteerd, 
afhankelijk van de staat waarin het menu werd 
weergegeven.

Menu-onderdelen voor 
clipfuncties

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

Zie voor details over menu-onderdelen 
voor clipfuncties het menu Thumbnail 
(pagina 99).

Clipeigenschappen weergeven

Selecteer Display Clip Properties 
(pagina 99) in het menu Thumbnail om het 
scherm clipeigenschappen weer te geven.
Druk op de keuzeschakelaar links-rechts om 
naar de vorige/volgende clip te springen.

Clipvlaggen toevoegen

U kunt clipvlaggen (OK-, NG- of KP-
markeringen) aan clips toevoegen om 
de weergave te filteren op clips die zijn 
gebaseerd op de clipvlaggen.
Selecteer het pictogram voor de clip waar 
u een vlag aan wilt toevoegen en selecteer 
vervolgens de clipvlag met Set Clip Flag 
(pagina 99) in het menu Thumbnail van het 
hoofdmenu.

Instelling Toegevoegde clipvlag

Add OK OK

Add NG NG

Add KEEP KP

[Tips]
ˎˎ U kunt ook een toewijsbare knop gebruiken die is 

toegewezen aan de clipvlagfunctie om clipvlaggen 
toe te voegen (pagina 49).
ˎˎ U kunt een OK-clipvlag (pagina 53) aan het 

pictogram van de geselecteerde clip toevoegen door 
op de knop Clip Flag (pagina 5) te drukken.

Weergeven van het gefilterde clip-
pictogrammenscherm

Selecteer Filter Clips (pagina 99) in het 
menu Thumbnail van het hoofdmenu en 
selecteer een type clipvlag om alleen de clips 
met die specifieke vlag weer te geven.
Selecteer All om alle clips weer te geven.

[Tip]
Met de knop DISPLAY kunt u de filters ook 
opeenvolgend doorlopen.

Clips verwijderen

U kunt clips van een geheugenkaart 
verwijderen.
Selecteer Delete Clip >Select Clip of All Clips in 
het menu Thumbnail van het hoofdmenu.
Select Clip: 

verwijdert de geselecteerde clip. Er 
kunnen meerdere clips tegelijk worden 
geselecteerd.

All Clips: 
verwijdert alle weergegeven clips.

Wijzigen van de op het 
pictogrammenscherm weergegeven 
informatie

U kunt de weergegeven clip/frame-informatie 
onder het pictogram wijzigen.
Selecteer Customize View >Thumbnail Caption 
in het menu Thumbnail van het hoofdmenu 
en selecteer de informatie die moet worden 
weergegeven.

Date Time: 
geeft de datum en de tijd weer waarop de 
clip is gemaakt en het laatst is gewijzigd.

Time Code: 
geeft de tijdcode weer.

Duration: 
geeft de duur van de clip weer.

Sequential Number: 
geeft een opeenvolgend getal weer voor 
elk pictogram.

Clipfuncties
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Configuratie en hiërarchie hoofdmenu
Houd de knop MENU ingedrukt om het 
hoofdmenu in de zoeker weer te geven en 
om diverse onderdelen te specificeren voor 
filmen, opnemen en afspelen (het menu kan 
ook worden weergegeven op een externe 
monitor). Het hoofdmenu bestaat uit de 
volgende menu's.

Menuconfiguratie

Menu User
Bevat menu-onderdelen die zijn 
geconfigureerd door de gebruiker met 
Edit User Menu.

Menu Edit User
Bevat menu-onderdelen voor bewerking 
van het User-menu.

Menu Shooting
Bevat instellingen met betrekking tot 
filmen.

Menu Project
Bevat basisinstellingen voor projecten.

Menu Paint/Look
Bevat instellingen met betrekking tot 
beeldkwaliteit.

Menu TC/Media
Bevat instellingen met betrekking tot 
tijdcodes en opnamemedia.

Menu Monitoring
Bevat instellingen met betrekking tot 
video-uitvoer en het zoekerscherm.

Menu Audio
Bevat instellingen met betrekking tot 
audio.

Menu Thumbnail
Bevat instellingen met betrekking tot 
weergave van pictogrammen.

Menu Technical
Bevat instellingen voor technische 
onderdelen.

Menu Network
Bevat instellingen met betrekking tot 
netwerken.

Menu Maintenance
Bevat apparaatinstellingen, zoals de klok 
en taal.

Hiërarchie hoofdmenu

User 
(Fabrieks- 
instellingen)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

VF Setting

Zebra

Zoom

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project Base Setting

Rec Format

Cine EI Setting

HDR Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output

Thumbnail Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical Color Bars

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Menu Page On/Off

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm
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Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Handelingen hoofdmenu
Houd de knop MENU ingedrukt om het 
hoofdmenu in de zoeker weer te geven om 
specifieke instellingen te maken (het menu 
kan ook worden weergegeven op een externe 
monitor).

Functies in het hoofdmenu

Knop MENU (pagina 5)
Indrukken en vasthouden om het 
hoofdmenu weer te geven. Nogmaals 
indrukken als het hoofdmenu wordt 
weergegeven om het menu te verbergen.

Keuzeschakelaar (8-voudig D-pad en 
toepassingsknop) (pagina 7)

Druk op de knoppen van het 8-richtings-
D-pad om de cursor omhoog/omlaag/
naar links/naar rechts te verplaatsen om 
menu-onderdelen of instellingen te 
selecteren.
Druk op de toepassingsknop van de 
keuzeschakelaar om het geselecteerde 
onderdeel toe te passen.

Multifunctionele regelaar (pagina 5)
Draai de multifunctionele regelaar om de 
cursor omhoog/omlaag te verplaatsen 
om menu-onderdelen of instellingen te 
selecteren.
Druk op de multifunctionele regelaar om 
het geselecteerde onderdeel toe te 
passen.

Knop CANCEL/BACK (pagina 5)
Indrukken om naar het vorige menu terug 
te gaan. Een wijziging die niet compleet is 
wordt geannuleerd.

[Opmerkingen]
ˎˎ Het hoofdmenu kan niet worden bediend in de 

modus scherpstellingsvergroting (pagina 37).
ˎˎ Sommige onderdelen kunnen niet worden 

geselecteerd, afhankelijk van de staat waarin het 
menu werd weergegeven.

Menu-onderdelen instellen

Druk op de knoppen van het 8-richtings-D-
pad of draai aan de multifunctionele regelaar 
om de cursor naar het menu-onderdeel te 
verplaatsen dat moet worden ingesteld. 
Druk daarna op de toepassingsknop of de 
multifunctionele regelaar om het onderdeel te 
selecteren.
ˎˎ Het selectiegebied voor menu-onderdelen 
geeft maximaal acht regels weer. Als alle 
beschikbare opties voor een onderdeel niet 
tegelijkertijd kunnen worden weergegeven, 
verschuif dan het display door de cursor 
omhoog en omlaag te verplaatsen.
ˎˎ Voor de subonderdelen met een groot 
instelbereik (bijvoorbeeld –99 tot +99) 
wordt het instelgebied niet weergegeven. 
De huidige instelling wordt gemarkeerd om 
aan te geven dat de waarde kan worden 
gewijzigd.
ˎˎ Door [Execute] te selecteren voor een 
functie wordt de betreffende functie 
uitgevoerd.
ˎˎ Een onderdeel selecteren dat moet 
worden bevestigd vóór uitvoering, 
verbergt het menu tijdelijk en geeft een 
bevestigingsmelding weer. Controleer de 
melding en kies of de functie moet worden 
uitgevoerd of niet.

Een reeks tekens invoeren

Als u een onderdeel selecteert waarvoor 
tekens moeten worden ingevoerd, 
zoals een bestandsnaam, verschijnt het 
tekeninvoerscherm.

1

2 3

1	 Druk op de knoppen van het 8-richtings-
D-pad of draai aan de multifunctionele 
regelaar om een teken te selecteren en 
pas vervolgens de instelling toe.
ABC: hoofdletters
abc: kleine letters
123: numerieke tekens
!#$: speciale tekens

2	 Selecteer een teken van het gekozen 
tekentype en pas vervolgens de instelling 
toe.
De cursor gaat naar het volgende veld.

Space: voert een spatie in op de 
cursorpositie.

/: verplaatst de positie van de cursor.
BS: verwijdert het teken links van de cursor 

(backspace).

3	 Als u klaar bent selecteert u [Done] en 
past u de instelling toe.
De tekenreeks is bevestigd en het 
tekeninvoerscherm verdwijnt.

Het menu vergrendelen en 
ontgrendelen

U kunt het hoofdmenu vergrendelen, zodat 
alleen het menu User wordt weergegeven.
In deze situatie kunnen geen instellingen 
worden gewijzigd met de statusschermen.

Het menu vergrendelen

1	 Houd de multifunctionele regelaar 
ingedrukt en houd ook de knop MENU 
ingedrukt.

2	 Selecteer Menu Settings >User Menu with 
Lock in het menu Technical.

	 [Opmerking]
Als u alleen de knop MENU ingedrukt houdt om 
het normale hoofdmenu weer te geven, wordt User 
Menu Only weergegeven bij Menu Settings in het 
menu Technical. Houd de multifunctionele regelaar 
ingedrukt en houd ook de knop MENU ingedrukt om 
User Menu with Lock op te roepen.

3	 Stel in op On, en druk op de 
toepassingsknop of multifunctionele 
regelaar.
Het zoekerscherm schakelt over naar het 
scherm voor invoer van de cijfercode.

4	 Voer een willekeurig getal in.
Voer een viercijferig nummer in het bereik 
van 0000 t/m 9999 in. De 
standaardwaarde is 0000.
Voer een cijfer in en druk op de 
toepassingsknop of de multifunctionele 
regelaar om de cursor naar het volgende 
cijfer te verplaatsen.
Als alle cijfers zijn ingevoerd, verplaats de 
cursor dan naar SET.
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5	 Druk op de toepassingsknop of de 
multifunctionele regelaar.
Het onderdeel is toegepast.
Er verschijnt een bevestigingsmelding en 
het scherm schakelt over naar weergave 
van het menu User.

Het menu ontgrendelen

1	 Houd de multifunctionele regelaar 
ingedrukt en houd ook de knop MENU 
ingedrukt.

2	 Selecteer Menu Settings >User Menu with 
Lock in het menu User.

	 [Opmerking]
Als u alleen de knop MENU ingedrukt houdt om 
het normale hoofdmenu weer te geven, wordt User 
Menu Only weergegeven bij Menu Settings in het 
menu Technical. Houd de multifunctionele regelaar 
ingedrukt en houd ook de knop MENU ingedrukt 
om User Menu with Lock op te roepen.

3	 Stel in op Off, en druk op de 
toepassingsknop of multifunctionele 
regelaar.
Het zoekerscherm schakelt over naar het 
scherm voor invoer van de cijfercode.

4	 Voer de cijfercode in die is gebruikt om 
het menu te vergrendelen.
Voer een cijfer in en druk op de 
toepassingsknop of de multifunctionele 
regelaar om de cursor naar het volgende 
cijfer te verplaatsen.
Als alle cijfers zijn ingevoerd, verplaats de 
cursor dan naar SET.

5	 Druk op de toepassingsknop of de 
multifunctionele regelaar.
Het onderdeel is toegepast.
Als de ingevoerde cijfercode overeenkomt 
met de cijfercode die werd gebruikt om 

het menu te vergrendelen, wordt het 
menu ontgrendeld en weer weergegeven.

[Opmerkingen]
ˎˎ Als de ingevoerde cijfercode niet overeenkomt met 

de cijfercode die werd gebruikt om het menu te 
vergrendelen, wordt het menu niet ontgrendeld.
ˎˎ Het wordt geadviseerd om een notitie van de 

cijfercode bij de hand te houden, voor het geval u 
deze vergeet. Als u de cijfercode vergeet, neem dan 
contact op met uw Sony servicevertegenwoordiger.
ˎˎ Als het menu wordt vergrendeld zonder dat 

onderdelen uit het hoofdmenu in de volgende tabel 
in het menu User worden geregistreerd, kunnen deze 
functies niet worden toegewezen aan toewijsbare 
knoppen.
ˎˎ Als deze functies zijn toegewezen aan toewijsbare 

knoppen wordt de toewijsbare functie geforceerd 
uitgeschakeld als het menu wordt vergrendeld.

Onderdeel 
hoofdmenu

Selectie 
toewijsbare knop

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Iris >Bokeh 
Control

Bokeh Control

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Onderdeel 
hoofdmenu

Selectie 
toewijsbare knop

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal  
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Onderdeel 
hoofdmenu

Selectie 
toewijsbare knop

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Menu User
Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.

User

Onderdeel Beschrijving

Base Setting Menu-onderdeel Project >Base Setting

Focus Menu-onderdeel Shooting >Focus

S&Q Motion Menu-onderdeel Shooting >S&Q Motion

LUT On/Off Menu-onderdeel Shooting >LUT On/Off

Simul Rec Menu-onderdeel Project >Simul Rec

Proxy Rec Menu-onderdeel Project >Proxy Rec

Interval Rec Menu-onderdeel Project >Interval Rec

Assignable Button Menu-onderdeel Project >Assignable Button

Assignable Dial Menu-onderdeel Project >Assignable Dial

Multi Function Dial Menu-onderdeel Project >Multi Function Dial

All File Menu-onderdeel Project >All File

Clip Name Format Menu-onderdeel TC/Media >Clip Name Format

Format Media Menu-onderdeel TC/Media >Format Media

VF Setting Menu-onderdeel Monitoring >VF Setting

Zebra Menu-onderdeel Monitoring >Zebra

Zoom Menu-onderdeel Technical >Zoom

Menu Settings Menu-onderdeel Technical >Menu Settings

Edit User Menu Geeft het menuscherm Edit User weer.

[Opmerking]
U kunt menu-onderdelen toevoegen en verwijderen in het menu User met behulp van het menu Edit User. Er kunnen 
maximaal 20 onderdelen worden geconfigureerd.
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Menu Edit User
Het menu Edit User wordt weergegeven als bovenste niveau als Edit User Menu wordt 
geselecteerd in het menu User.

Edit User

Onderdeel Instelling subonderdeel Beschrijving

Add Item
Een onderdeel aan het 
menu User toevoegen

Voegt een menu-onderdeel aan het 
menu User toe.

Customize Reset
Reset de onderdelen in 
het menu User

Herstelt de menu-onderdelen die 
zijn geregistreerd in het menu User 
naar de fabrieksinstellingen.

Het tijdens bewerking 
geselecteerde menu-
onderdeel

Delete Wist het geregistreerde menu-
onderdeel uit het menu User.

Move Herschikt de geregistreerde menu-
onderdelen binnen het menu User.

Edit Sub Item Bewerkt (registreren/wissen) het 
geregistreerde menu-subonderdeel 
in het menu User.
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Menu Shooting
Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Shooting >ISO/Gain/EI
Versterkingsinstellingen maken.

Onderdeel Instelling subonderdeel Beschrijving

Mode ISO/dB Selecteert de instellingsmodus voor 
versterking.

ISO/Gain<H> Zie voor details over instellingen 
"Instellingen ISO/Gain en 
standaardwaarden" (pagina 108).

Stelt de presetwaarde voor <H> gain in.

ISO/Gain<M> Zie voor details over instellingen 
"Instellingen ISO/Gain en 
standaardwaarden" (pagina 108).

Stelt de presetwaarde voor <M> gain in.

ISO/Gain<L> Zie voor details over instellingen 
"Instellingen ISO/Gain en 
standaardwaarden" (pagina 108).

Stelt de presetwaarde voor <L> gain in.

Exposure 
Index<H>

Als Base ISO is ingesteld is op ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Als Base ISO is ingesteld is op ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Stelt de <H> belichtingsindexwaarde in.
Alleen beschikbaar in de modus Cine EI 
mode.

Shooting >ISO/Gain/EI
Versterkingsinstellingen maken.

Onderdeel Instelling subonderdeel Beschrijving

Exposure 
Index<M>

(Dezelfde instellingen als Exposure 
Index<H>)
Als Base ISO is ingesteld is op ISO 800:

1000EI / 6.3E
Als Base ISO is ingesteld is op ISO 12800:

16000EI / 6.3E

Stelt de <M> belichtingsindexwaarde in.

Exposure 
Index<L>

(Dezelfde instellingen als Exposure 
Index<H>)
Als Base ISO is ingesteld is op ISO 800:

800EI / 6.0E
Als Base ISO is ingesteld is op ISO 12800:

12800EI / 6.0E

Stelt de <L> belichtingsindexwaarde in.

Shockless 
Gain

On / Off Schakelt de functie naadloze 
versterkingsomschakeling in of uit.

Base 
Sensitivity

High / Low Stelt de basisgevoeligheid in voor de 
modus Custom.

Base ISO ISO 12800 / ISO 800 Stelt de basis-ISO-gevoeligheid in voor 
de modus Cine EI.

Shooting >ND Filter
Stelt de presetwaarden in voor het ND-filter.

Onderdeel Instelling subonderdeel Beschrijving

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Stelt de preset 1-waarde in voor het 
ND-filter.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Stelt de preset 2-waarde in voor het 
ND-filter.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Stelt de preset 3-waarde in voor het 
ND-filter.

Shooting >Shutter
Stelt de elektronische sluiter in.

Onderdeel Instelling subonderdeel Beschrijving

Mode Speed / Angle Selecteert de werkmodus van de 
elektronische sluiter.
Wordt gebruikt voor het duidelijk filmen 
van snel bewegende objecten. Selecteert 
de modus voor instelling van de 
sluitertijd in seconden (Speed) of als een 
sluiterhoek (Angle).
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Shooting >Shutter
Stelt de elektronische sluiter in.

Onderdeel Instelling subonderdeel Beschrijving

Shutter 
Speed  
On/Off

On / Off Stelt in of de belichtingstijd bij actieve 
Speed-modus de sluitertijd volgt of is 
ingesteld op volledige belichting.

Shutter 
Speed

64F t/m 1/8000
De beschikbare instellingen variëren 
afhankelijk van de systeemfrequentie van 
de geselecteerde opname-indeling.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Stelt de sluitertijd in als Mode is ingesteld 
op Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° /  
270.0° / 240.0° / 216.0° / 210.0° /  
180.0° / 172.8° / 150.0° / 144.0° /  
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 
30.0° / 22.5° / 11.25° / 5.6°

Stelt de sluiterhoek in als Mode is 
ingesteld op Angle.

ECS On/Off On / Off Schakelt de functie Extended Clear Scan 
in of uit.

Shooting >Shutter
Stelt de elektronische sluiter in.

Onderdeel Instelling subonderdeel Beschrijving

ECS 
Frequency

23.99 t/m 8000
De beschikbare instellingen variëren 
afhankelijk van de systeemfrequentie van 
de geselecteerde opname-indeling.
De standaardwaarden worden hieronder 
vermeld.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Stelt de ECS-frequentie in als Mode is 
ingesteld op ECS.

Shooting > Iris
Stelt functie-instellingen voor Bokeh Control in.

Onderdeel Instelling subonderdeel Beschrijving

Bokeh 
Control

On / Off Schakelt de functie Bokeh Control in en 
uit.

Shooting >Auto Exposure
Regelt de instellingen voor automatische belichtingsaanpassingen.

Onderdeel Instelling subonderdeel Beschrijving

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Stelt het helderheidniveau in voor de 
automatische gedetecteerde belichting.

Mode Backlight / Standard / Spotlight Stelt de werkmodus in van de auto-
belichtingsaanpassing.
Backlight: 

Modus Backlight (modus voor minder 
donker worden van een onderwerp 
als het onderwerp met tegenlicht 
wordt gefilmd)

Standard: 
Standaardmodus

Spotlight: 
Modus Spotlight (modus voor minder 
overbelichting als het onderwerp 
wordt verlicht door spotlights)

Speed –99 t/m +99 (±0) Stelt de aanpassingssnelheid in van auto-
belichtingsaanpassing.
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Shooting >Auto Exposure
Regelt de instellingen voor automatische belichtingsaanpassingen.

Onderdeel Instelling subonderdeel Beschrijving

AGC On / Off Schakelt de functie AGC (auto gain 
control) in of uit.

AGC Limit Zie voor details over instellingen "AGC 
Limit-instellingen en standaardwaarden" 
(pagina 110).

Stelt de maximale versterking van de 
functie AGC in.

AGC Point F2.8 / F4 / F5.6 Stelt de F-stopwaarde van het diafragma 
in waar AGC-werking begint als de 
functie AGC is ingesteld op On.

Auto Shutter On / Off Schakelt de automatische sluiterfunctie 
in of uit.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Stelt de snelste sluitertijd in voor de 
automatische sluiterfunctie.

A.SHT Point F5.6 / F8 / F11 / F16 Stelt de F-stopwaarde van het diafragma 
in waar de werking van de automatische 
sluiterfunctie begint.

Clip High 
light

On / Off Schakelt de functie in of uit die de meest 
heldere gebieden negeert voor een 
vlakkere respons bij hoge helderheid.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Stelt het lichtmetingsbereik voor 
automatische belichtingsaanpassing in 
op basis van de helderheid van het 
onderwerp. (Niet beschikbaar als de 
belichting handmatig wordt ingesteld)

Detect 
Window 
Indication

On / Off Schakelt de indicatie van de lichtmeting 
in of uit.

Custom 
Width

40 t/m 999 (500) Stelt de breedte van het 
lichtmetingsbereik in.

Custom 
Height

70 t/m 999 (500) Stelt de hoogte van het 
lichtmetingsbereik in.

Custom H 
Position

–479 t/m +479 (±0) Stelt de horizontale positie van het 
lichtmetingsbereik in.

Custom V 
Position

–464 t/m +464 (±0) Stelt de verticale positie van het 
lichtmetingsbereik in.

Shooting >White
Regelt de witbalansinstelling.

Onderdeel Instelling subonderdeel Beschrijving

Preset White 2000K t/m 15000K (3200K) Stelt de presetwaarde van de witbalans 
in.

Color Temp 
<A>

2000K t/m 15000K (3200K) Stelt de kleurtemperatuur van de 
witbalans in, die wordt opgeslagen in 
geheugen A.

[Opmerking]
Omdat Color Temp wordt beperkt tot 2000K 
en 15000K tijdens R/B Gain-werking, kan de 
correcte waarde voor Color Temp mogelijk 
niet worden weergegeven voor de R/B Gain-
waarde.

Tint<A> –99 t/m +99 (±0) Stelt de tint van de witbalans in die wordt 
opgeslagen in witgeheugen A.

[Opmerking]
Omdat Tint wordt beperkt tot ±99 tijdens R/B 
Gain-werking, kan de correcte waarde voor Tint 
mogelijk niet worden weergegeven voor de 
R/B Gain-waarde.

R Gain <A> –99.0 t/m +99.0 (±0.0) Stelt de witbalans R-versterkingswaarde 
in die wordt opgeslagen in geheugen A.

B Gain <A> –99.0 t/m +99.0 (±0.0) Stelt de witbalans B-versterkingswaarde 
in die wordt opgeslagen in geheugen A.

Color Temp 
<B>

2000K t/m 15000K (3200K) Stelt de kleurtemperatuur van de 
witbalans in, die wordt opgeslagen in 
geheugen B.

[Opmerking]
Omdat Color Temp wordt beperkt tot 2000K 
en 15000K tijdens R/B Gain-werking, kan de 
correcte waarde voor Color Temp mogelijk 
niet worden weergegeven voor de R/B Gain-
waarde.

Tint<B> –99 t/m +99 (±0) Stelt de tint van de witbalans in die wordt 
opgeslagen in witgeheugen B.

[Opmerking]
Omdat Tint wordt beperkt tot ±99 tijdens R/B 
Gain-werking, kan de correcte waarde voor Tint 
mogelijk niet worden weergegeven voor de 
R/B Gain-waarde.

R Gain <B> –99.0 t/m +99.0 (±0.0) Stelt de witbalans R-versterkingswaarde 
in die wordt opgeslagen in geheugen B.

B Gain <B> –99.0 t/m +99.0 (±0.0) Stelt de witbalans B-versterkingswaarde 
in die wordt opgeslagen in geheugen B.
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Shooting >White Setting
Past de witbalansinstelling aan.

Onderdeel Instelling subonderdeel Beschrijving

Shockless 
White

Off / 1 / 2 / 3 Stelt de reactiesnelheid in van de 
witbalans als wordt overgeschakeld van 
witbalansmodus.
Off: schakelt onmiddellijk.
1 t/m 3: hogere nummers schakelen 

langzamer.

ATW Speed 1 / 2 / 3 / 4 / 5 Stelt de reactiesnelheid van de ATW-
modus in.
1: Snelste reactietijd

White 
Switch<B>

Memory / ATW Selecteert de aanpassingsmodus van de 
witbalans die is geselecteerd als de 
schakelaar WHT BAL is ingesteld op B.

Filter White 
Memory

On / Off Schakelt de functie die het 
geheugengebied voor de witbalans voor 
elk ND Filter instelt in of uit.
On: stelt het witbalansgeheugen voor elk 

ND-Filter in.

	 [Tip]
In presetmodus zijn er vier instellingen 
(CLEAR/1/2/3). In variabele modus zijn er 
twee instellingen (CLEAR/On).

Off: stelt het witbalansgeheugen globaal 
voor alle ND-Filters in.

Shooting >Offset White
Regelt de offsetinstelling voor witbalans.

Onderdeel Instelling subonderdeel Beschrijving

Offset White 
<A>

On / Off Selecteert of er wel (On) of niet (Off) een 
offsetwaarde aan de witbalans in 
geheugen A moet worden toegevoegd.

Offset Color 
Temp<A>

–99 t/m +99 (±0) Stelt de offset van de kleurtemperatuur 
in, die aan de witbalans moet worden 
toegevoegd in geheugen A als Offset 
White <A> is ingesteld op On.

Offset 
Tint<A>

–99 t/m +99 (±0) Stelt de offset van de tintwaarde in, die 
aan de witbalans moet worden 
toegevoegd in geheugen A als Offset 
White <A> is ingesteld op On.

Offset White 
<B>

On / Off Selecteert of er wel (On) of niet (Off) een 
offsetwaarde aan de witbalans in 
geheugen B moet worden toegevoegd.

Shooting >Offset White
Regelt de offsetinstelling voor witbalans.

Onderdeel Instelling subonderdeel Beschrijving

Offset Color 
Temp<B>

–99 t/m +99 (±0) Stelt de offset van de kleurtemperatuur 
in, die aan de witbalans moet worden 
toegevoegd in geheugen B als Offset 
White <B> is ingesteld op On.

Offset 
Tint<B>

–99 t/m +99 (±0) Stelt de offset van de tintwaarde in, die 
aan de witbalans moet worden 
toegevoegd in geheugen B als Offset 
White <B> is ingesteld op On.

Offset White 
<ATW>

On / Off Selecteert of er wel (On) of niet (Off) een 
offsetwaarde aan de ATW-witbalans 
moet worden toegevoegd.

Offset Color 
Temp<ATW>

–99 t/m +99 (±0) Stelt de offset van de kleurtemperatuur 
in, die aan de ATW-witbalans moet 
worden toegevoegd als Offset White 
<ATW> is ingesteld op On.

Offset 
Tint<ATW>

–99 t/m +99 (±0) Stelt de offset van de tintwaarde in, die 
aan de ATW-witbalans moet worden 
toegevoegd als Offset White <ATW> is 
ingesteld op On.

Shooting >Focus
Regelt de scherpstelling.

Onderdeel Instelling subonderdeel Beschrijving

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Stelt de snelheid in van de 
scherpstellingsaandrijving als het 
onderwerp verandert tijdens 
automatische scherpstelling.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Stelt de gevoeligheid in voor wijziging 
van onderwerpscherpstelling tijdens 
automatische scherpstelling.
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Shooting >Focus
Regelt de scherpstelling.

Onderdeel Instelling subonderdeel Beschrijving

Focus Area Wide / Zone / Flexible Spot Stelt het gebied in voor automatische 
scherpstelling en automatische 
scherpstelling door knop indrukken (AF) 
(pagina 38).
Wide: 

de zoekt naar een onderwerp in hun 
brede hoek van het beeld tijdens het 
scherpstellen.

Zone: 
zoekt automatisch naar een 
scherpstellingspunt binnen de 
gespecificeerde zone.

Flexible Spot: 
stelt scherp op een specifieke plaats 
in het beeld.

Focus Area 
(AF-S)

Flexible Spot Stelt het doelgebied in voor 
scherpstelling door knop indrukken 
(AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Schakelt gezichtsherkenning voor AF in 
of uit.

Push AF 
Mode

AF / Single-shot AF(AF-S) Stelt de automatische scherpstelmodus 
door knop indrukken in tijdens 
handmatig scherpstellen.

Touch 
Function in 
MF

Tracking AF / Spot Focus Stelt de actie in die wordt uitgevoerd 
wanneer u op het aanraakscherm tikt 
tijdens handmatige scherpstelling.

AF Assist On / Off Als dit op On is ingesteld kunt u tijdelijk 
automatische scherpstelling opheffen en 
handmatig scherpstellen.

Shooting >S&Q Motion
Regelt de modusinstelling voor Slow & Quick Motion (pagina 50).

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de Slow & Quick motion-modus 
in of uit.
Als dit is ingesteld op On zijn de 
volgende functies uitgeschakeld.

ˎˎ Automatisch diafragma
ˎˎ Automatische scherpstelling

Frame Rate 1fps t/m 60fps / 100fps / 120fps / 150fps / 
180fps / 200fps / 240fps

Stelt de beeldsnelheid in voor het filmen 
met Slow & Quick Motion.

[Opmerking]
De beschikbare instellingen kunnen 
variëren afhankelijk van de geselecteerde 
systeemfrequentie, codec en video-indeling.

Shooting >LUT On/Off
Regelt LUT-instellingen.

Onderdeel Instelling subonderdeel Beschrijving

SDI/HDMI MLUT On / MLUT Off Selecteert of er monitor LUT op de SDI- 
en HDMI-uitvoervideo moet worden 
toegepast.

VF/Proxy/
Stream

MLUT On / MLUT Off Selecteert of er monitor LUT op de 
zoeker, proxy, en stream-uitvoervideo 
moet worden toegepast.

Internal Rec MLUT On / MLUT Off Selecteert of er monitor LUT op de intern 
opgenomen video moet worden 
toegepast.

Shooting >Noise Suppression
Regelt de ruisonderdrukkingsinstellingen.

[Tip]
De instellingen Setting(Custom) en Level(Custom) worden weerspiegeld in de instelling voor Target Display 
(pagina 112).

Onderdeel Instelling subonderdeel Beschrijving

Setting 
(Custom)

On / Off Schakelt de functie ruisonderdrukking in 
of uit in de modus Custom.

Level 
(Custom)

Low / Mid / High Stelt de ruisonderdrukking in de modus 
Custom in.

Setting 
(Cine EI)

On / Off Schakelt de functie ruisonderdrukking in 
of uit in de modus Cine EI.

Level 
(Cine EI)

Low / Mid / High Stelt het ruisonderdrukkingsniveau in de 
modus Cine EI in.
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Shooting >Flicker Reduce
Regelt de instellingen voor flikkercorrectie.

Onderdeel Instelling subonderdeel Beschrijving

Mode Auto / On / Off Stelt de flikkercorrectiemodus is.

Frequency 50Hz / 60Hz Stelt de frequentie van de stroombron 
van de verlichting in die het flikkeren 
veroorzaakt.

Shooting >SteadyShot
Regelt de beeldstabilisatie-instellingen.

Onderdeel Instelling subonderdeel Beschrijving

Setting Active / Standard / Off Stelt de functie beeldstabilisatie in.

[Opmerking]
Ingeschakeld als er een compatibel objectief is 
bevestigd.
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Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Project >Base Setting
Regelt basisinstellingen.

Onderdeel Instelling subonderdeel Beschrijving

Shooting 
Mode

Custom / Cine EI Regelt de opnamemodus (pagina 24).

Target 
Display

SDR(BT.709) / HDR(HLG) Stelt de kleurruimte in van de opname/
uitvoer in de modus Custom.

Project >Rec Format
Regelt de instellingen voor opname-indeling.

Onderdeel Instelling subonderdeel Beschrijving

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Selecteert de systeemfrequentie.

Imager Scan 
Mode

FF / S35 Selecteert het imagerformaat.

Codec RAW / RAW & XAVC-I / RAW(HDMI) / 
RAW(HDMI) & XAVC-I / XAVC-I / XAVC-L

Stelt de clip-opname-/-
afspeelmoduscodec in.

RAW Output 
Format

De beschikbare instellingen kunnen 
variëren, afhankelijk van de instellingen 
voor Frequency en Codec.

Stelt de beeldgrootte van de RAW-uitvoer 
in.

[Opmerking]
Als Codec is ingesteld op RAW & XAVC-I, 
schakelt de instelling voor Video Format 
synchroon over met de instellingen voor RAW 
Output Format.

Frequency Codec Selectie-opties

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & 
XAVC-I

4096×2160

3840×2160

RAW(HDMI) 4240×2392

RAW(HDMI) 
& XAVC-I

4240×2392

24 RAW 4096×2160

RAW & 
XAVC-I

4096×2160

Project >Rec Format
Regelt de instellingen voor opname-indeling.

Onderdeel Instelling subonderdeel Beschrijving

Video Format De beschikbare instellingen kunnen 
variëren, afhankelijk van de instellingen 
voor Frequency en Codec.

Stelt de beeldgrootte en bitsnelheid in.

Frequency Codec Selectie-opties

59.94 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Menu Project
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Project >Rec Format
Regelt de instellingen voor opname-indeling.

Onderdeel Instelling subonderdeel Beschrijving

Video Format 29.97 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

25 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Project >Rec Format
Regelt de instellingen voor opname-indeling.

Onderdeel Instelling subonderdeel Beschrijving

Video Format 23.98 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

Project >Cine EI Setting
Regelt de instellingen voor de modus Cine EI.

Onderdeel Instelling subonderdeel Beschrijving

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Stelt het kleurbereik in de modus Cine EI 
in.
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Project > HDR Setting
Stelt instellingen voor de HDR-modus in.

Onderdeel Instelling subonderdeel Beschrijving

VF SDR 
Preview

On / Off In HDR-modus schakelt dit de functie in 
of uit die het beeld in de zoeker 
converteert van HDR naar SDR wanneer 
Gamma Display Assist is ingeschakeld.

[Tip]
Wanneer dit is ingesteld op On, wordt SDR 
Gain toegepast op het beeld in de zoeker.

SDR Gain 0dB t/m –15dB (–6dB) In HDR-modus stelt dit de instelling voor 
SDR Gain in die wordt toegepast op de 
zoeker wanneer VF SDR Preview is 
ingesteld op On.

Project >Simul Rec
Regelt de instellingen voor simultane opnamemodus (pagina 52).

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de functie simultane opname in 
of uit en stelt de doelmedia voor 
opnamen in.

Rec Button 
Set

Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] / Rec Button:[SlotA] 
Handle Rec Button:[SlotB] / Rec 
Button:[SlotB] Handle Rec Button:[SlotA]

Wijst de opnameknoppen in waarmee de 
verschillende opnamemedia worden 
bediend.

Project >Proxy Rec
Regelt de instellingen voor proxy-opname.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt proxy-opname in of uit.

Audio 
Channel

CH1/CH2 / CH3/CH4 Selecteert het audiokanaal dat naar 
proxydata moet opnemen.

Chunk 30s / 1min / 2min Selecteert het opname-interval voor 
segmenten in voor proxybestanden.

Project >Interval Rec
Regelt instellingen voor intervalopname (pagina 50).

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt intervalopname in of uit. (Als 
deze modus op On wordt gezet, worden 
alle andere speciale modi uitgeschakeld.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Stelt het interval in tussen opname in de 
modus Interval Rec (als Interval Rec op 
On staat).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
De beschikbare instellingen variëren 
afhankelijk van de framefrequentie van de 
geselecteerde video-indeling.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Stelt het aantal frames in dat per take 
moet worden opgenomen in de modus 
Interval Rec (als Interval Rec op On staat).

Pre-Lighting Off / 2 s / 5 s / 10 s Stelt het aantal seconden in dat het 
videolicht aangaat, alvorens opname 
start in de modus Interval Rec.

[Tip]
Alleen beschikbaar bij gebruik van de HVL-
LBPC (optie).

Project > Picture Cache Rec
Stelt de instellingen in voor de opnamemodus Picture Cache (pagina 51).

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de opnamemodus Picture Cache 
in of uit.

Cache Size Short / Medium / Long / Max Stelt de tijd in voor het verzamelen van 
beelden in het beeld-cachegeheugen 
(opnametijd voor beeld-cache).

Cache Rec 
Time

Geeft de tijd weer voor het verzamelen 
van beelden in het beeld-
cachegeheugen (opnametijd voor 
beeld-cache).
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Project >SDI/HDMI Rec Control
Regelt de bedieningsinstellingen voor SDI/HDMI-opname.

Onderdeel Instelling subonderdeel Beschrijving

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Stelt start/stop-bediening in van een 
extern apparaat via het SDI/HDMI 
uitgangssignaal.
Off: 

Geen afstandsbediening gebruiken.
SDI/HDMI Remote I/F: 

Bediening van stop/start van een 
extern aangesloten apparaat, als er 
geen medium in de camcorder is 
geplaatst. Niet gesynchroniseerd met 
frame-nauwkeurigheid aan 
camcordermedia.

Parallel Rec: 
Bediening van stop/start van een 
extern aangesloten apparaat, als er 
een medium in de camcorder is 
geplaatst. Gesynchroniseerd met 
frame-nauwkeurigheid aan 
camcordermedia.

[Opmerking]
Als het HDMI uitgangssignaal moet worden 
gebruikt voor besturing, stel HDMI TC Out 
>Setting (pagina 92) in het menu  
TC/Media van het hoofdmenu dan in op On.

Project >Assignable Button
Stelt functietoewijzing aan toewijsbare knoppen in.

Onderdeel Instelling subonderdeel Beschrijving

<1> t/m <9>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Bokeh Control / Auto Shutter / Auto 
Exposure Level / Backlight / Spotlight / 
Preset White Select / ATW / ATW Hold / AF 
Speed/Sens. / Focus Setting / Focus Area / 
Focus Area(AF-S) / Face/Eye Detection AF / 
Push AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Picture Cache 
Rec / Rec Review / Clip Flag OK / Clip Flag 
NG / Clip Flag Keep / Color Bars / Tally 
[Front] / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / Handle 
Zoom / NFC / Auto Upload (Proxy) / Direct 
Menu / User Menu / Menu

Wijst functies aan toewijsbare knoppen 
toe.
Base ISO/Sensitivity: 

Schakelt de basisgevoeligheid van de 
beeldsensor om.

AGC: 
Schakelt de functie AGC in of uit.

Push AGC: 
Schakelt de functie AGC in zolang de 
knop wordt ingedrukt.

ND Filter Position: 
Schakelt ND-filters om.

Auto ND Filter: 
Schakelt de functie auto ND filter in 
of uit.

Push Auto ND: 
Schakelt de functie auto ND filter in 
zolang de knop wordt ingedrukt.

Auto Iris: 
Schakelt de diafragmafunctie in of 
uit.

Push Auto Iris: 
Schakelt de functie autodiafragma in 
zolang de knop wordt ingedrukt.

Bokeh Control: 
Schakelt de modus Bokeh Control in 
en uit.

Auto Shutter: 
Schakelt de automatische 
sluiterfunctie in of uit.

Auto Exposure Level: 
Opent of sluit het menu Auto 
Exposure Level.

Backlight: 
Schakelt over tussen Backlight en 
Standard.

Spotlight: 
Schakelt over tussen Spotlight en 
Standard.

Preset White Select: 
Schakelt de presetmodus van de 
witbalanswaarde over.
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Project >Assignable Button
Stelt functietoewijzing aan toewijsbare knoppen in.

Onderdeel Instelling subonderdeel Beschrijving

<1> t/m <9>, 
Focus Hold 
Button

ATW: 
Schakelt de functie ATW in of uit.

ATW Hold: 
Pauzeert werking van de functie ATW.

AF Speed/Sens.: 
Schakelt de AF-snelheidsinstelling en 
gevoeligheid van de AF-
onderwerpverplaatsing om.

Focus Setting: 
Stelt het scherpstellingsgebied in. 

Focus Area: 
Stelt het scherpstellingsgebied in 
voor AF en push AF.

Focus Area(AF-S): 
Stelt het scherpstellingsgebied in 
voor scherpstelling per knopdruk 
(AF-S).

Face/Eye Detection AF: 
Schakelt de AF-instellingen voor 
gezichts/oogherkenning om.

Push AF Mode: 
Schakelt de modusinstelling voor 
scherpstelling per knopdruk om.

Push AF/Push MF: 
Activeert in de modus MF 
scherpstelling de AF automatische 
scherpstelling, zolang de knop wordt 
ingedrukt. 
Activeert MF in de modus AF 
scherpstelling zolang de knop wordt 
ingedrukt.

Focus Hold: 
In de modus AF scherpstelling wordt 
de scherpstelling gefixeerd, zolang 
deze knop is ingedrukt.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Schakelt de functie 
scherpstellingsvergroting in of uit.

S&Q Motion: 
Schakelt Slow & Quick Motion in of 
uit. 
Stelt de opnamebeeldsnelheid in bij 
indrukken en vasthouden.

Project >Assignable Button
Stelt functietoewijzing aan toewijsbare knoppen in.

Onderdeel Instelling subonderdeel Beschrijving

<1> t/m <9>, 
Focus Hold 
Button

SteadyShot: 
schakelt over tussen Active, Standard, 
en Off.

Rec: 
start/stopt opname.

Picture Cache Rec: 
Schakelt de opnamemodus Picture 
Cache in of uit.

Rec Review: 
Schakelt de functie Rec Review in of 
uit.

Clip Flag OK: 
Voert de functie Add OK uit. 
Twee keer indrukken om de functie 
Delete Clip Flag uit te voeren.

Clip Flag NG: 
Voert de functie Add NG uit. 
Twee keer indrukken om de functie 
Delete Clip Flag uit te voeren.

Clip Flag Keep: 
Voert de functie Add Keep uit. 
Twee keer indrukken om de functie 
Delete Clip Flag uit te voeren.

Color Bars: 
Schakelt de kleurbalken in of uit.

Tally [Front]: 
Schakelt de functie opnemen/tally 
lamp/knipperen in of uit.

DURATION/TC/U-BIT: 
Schakelt over tussen Time Code, 
Users Bit, en Duration.

Display: 
Schakelt de schermindicatoren in of 
uit.

Lens Info: 
Schakelt de scherptediepte-indicator 
om.

Video Signal Monitor: 
Schakelt de videosignaalmonitor om 
(zoals een golfvormmonitor).

Marker: 
Schakelt de markerfunctie in of uit.

VF Adjust: 
Geeft de niveaubalken weer voor het 
aanpassen van de helderheid van het 
zoekerscherm.
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Project >Assignable Button
Stelt functietoewijzing aan toewijsbare knoppen in.

Onderdeel Instelling subonderdeel Beschrijving

<1> t/m <9>, 
Focus Hold 
Button

VF Mode: 
Schakelt de zoeker om tussen kleur 
en zwart-wit.

Gamma Display Assist: 
Schakelt de functie 
gammaweergave-assist om.

Peaking: 
Schakelt de functie 
beeldomtrekversterking in of uit.

Zebra: 
Schakelt de functie Zebra-patroon in 
of uit.

Volume: 
Regelt het monitoraudioniveau naar 
de hoofdtelefoonuitgang en 
ingebouwde luidspreker.

Thumbnail: 
Opent of sluit het 
pictogrammenscherm.

Touch Operation: 
Schakelt aanraakbediening in of uit.

Handle Zoom: 
Schakelt de zoombediening via de 
draaggreep in of uit.

NFC: 
Voert de functie NFC uit.

Auto Upload (Proxy): 
Schakelt automatisch uploaden van 
proxy-bestanden in of uit en stelt de 
segmentmodus in.

Direct Menu: 
Opent of sluit het directmenu.

User Menu: 
Opent of sluit het menu User.

Menu: 
Opent of sluit het hoofdmenu.

Project >Assignable Dial
Stelt functietoepassingen in voor de toewijsbare regelaar en stelt de draairichting in.

Onderdeel Instelling subonderdeel Beschrijving

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS / 
Auto Exposure Level / Audio Input Level / 
Multi Function Dial

Wijst functies toe aan de toewijsbare 
regelaar van de greep.
ISO/Gain/EI: 

Past de versterking of EI aan.
ND Filter: 

Past het ND filter aan.
IRIS: 

Past de iris aan.
Auto Exposure Level: 

Past het niveau voor automatische 
belichting aan.

Audio Input Level: 
Past het audio-opnameniveau aan.

Multi Function Dial: 
Functioneert als een multifunctionele 
regelaar.

Grip Dial 
Direction

Normal / Opposite Stelt de draairichting in voor de 
toewijsbare regelaar van de handgreep.
Normal: In normale richting draaien.
Opposite: In tegenovergestelde richting 

draaien.

Handle Dial Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level / Multi 
Function Dial

Wijst functies toe aan de toewijsbare 
regelaar van de draaggreep.
ISO/Gain/EI: 

Past de versterking of EI aan.
ND Filter: 

Past het ND filter aan.
IRIS: 

Past de iris aan.
Auto Exposure Level: 

Past het niveau voor automatische 
belichting aan.

Audio Input Level: 
Past het audio-opnameniveau aan.

Multi Function Dial: 
Functioneert als een multifunctionele 
regelaar.

Handle Dial 
Direction

Normal / Opposite Stelt de draairichting in voor de 
toewijsbare regelaar van de draaggreep.
Normal: In normale richting draaien.
Opposite: In tegenovergestelde richting 

draaien.
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Project >Multi Function Dial
Wijst functies toe aan de multifunctionele regelaar.

Onderdeel Instelling subonderdeel Beschrijving

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Wijst de standaardfunctie toe aan de 
multifunctionele regelaar.
IRIS: 

Past de iris aan.
ISO/Gain/EI: 

Past de versterking of EI aan.
Auto Exposure Level: 

Past het niveau voor automatische 
belichting aan.

Audio Input Level: 
Past het audio-opnameniveau aan.

Project >User File
Regelt instellingen voor bewerkingen van gebruikersbestanden.

Onderdeel Instelling subonderdeel Beschrijving

Load from 
Media(B)

Execute / Cancel Laadt instellingen voor 
gebruikersbestanden van een 
geheugenkaart die is geplaatst in een 
CFexpress Type A/SD kaartsleuf (B).
Execute: functie uitvoeren.

Save to 
Media(B)

Execute / Cancel Slaat instellingen voor 
gebruikersbestanden van een 
geheugenkaart op die is geplaatst in een 
CFexpress Type A/SD kaartsleuf (B).
Execute: functie uitvoeren.

File ID Opent een scherm voor weergegeven/
bewerken van de bestands-ID van 
gebruikersbestanden.

Load 
Customize 
Data

On / Off Stelt in of er aangepaste informatie voor 
het menu User moet worden geladen als 
Load from Media(B) wordt uitgevoerd.

Load White 
Data

On / Off Stelt in of er informatie voor witbalans 
moet worden geladen als Load from 
Media(B) wordt uitgevoerd.

Project >All File
Regelt instellingen voor ALL-bestanden.

Onderdeel Instelling subonderdeel Beschrijving

Load from 
Media(B)

Execute / Cancel Laadt instellingen voor ALL-bestanden 
van een geheugenkaart die is geplaatst 
in een CFexpress Type A/SD-kaartsleuf 
(B).
Execute: functie uitvoeren.

Load from 
Cloud(Private)

Execute / Cancel Laadt een geüpload ALL-bestand vanuit 
de C3 Portal-clouddienst (privé)
Execute: functie uitvoeren.

Load from 
Cloud(Share)

Execute / Cancel Laadt een geüpload ALL-bestand vanuit 
de C3 Portal-clouddienst (gedeeld)
Execute: functie uitvoeren.

Save to 
Media(B)

Execute / Cancel Slaat instellingen voor ALL-bestanden 
naar een geheugenkaart die is geplaatst 
in een CFexpress Type A/SD-kaartsleuf 
(B).
Execute: functie uitvoeren.

Save to 
Cloud(Private)

Execute / Cancel Slaat instellingen voor ALL-bestanden op 
naar de C3 Portal-clouddienst (privé).
Execute: functie uitvoeren.

Save to 
Cloud(Share)

Execute / Cancel Slaat instellingen voor ALL-bestanden-
bestand op naar de C3 Portal-clouddienst 
(gedeeld).
Execute: functie uitvoeren.

File ID Kent een naam toe aan een bestand.

Load Network 
Data

On / Off Stelt in of er informatie voor instellingen 
voor het menu Network moet worden 
geladen als Load from Media(B), Load 
from Cloud(Private) of Load from 
Cloud(Share) wordt uitgevoerd.
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Menu Paint/Look
Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Paint/Look >Scene File
Regelt instellingen voor scene-bestanden.

Onderdeel Instelling subonderdeel Beschrijving

Recall Laadt een scene-bestand dat is 
opgeslagen in het interne geheugen en 
past de instellingen toe als de huidige 
beeldkwaliteitsinstellingen.

Store Slaat de huidige staat van de 
beeldkwaliteit op als een scene-bestand 
in het interne geheugen.

Delete Verwijdert een scene-bestand dat is 
opgeslagen in het interne geheugen.

Preset Recall Als Shooting Mode is ingesteld op Custom 
en Target Display is ingesteld op 
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709
Als Shooting Mode is ingesteld op Custom 
en Target Display is ingesteld op 
HDR(HLG):

HLG Live / HLG Natural

Past preset beeldkwaliteitsinstellingen 
(niet overschrijfbaar) toe als de huidige 
beeldkwaliteitsinstellingen.

Paint/Look >Base Look
Regelt instellingen voor het basisuiterlijk.

Onderdeel Instelling subonderdeel Beschrijving

Select Als Shooting Mode is ingesteld op Custom 
en Target Display is ingesteld op 
SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 / 
User1 tot User16

Als Shooting Mode is ingesteld op Custom 
en Target Display is ingesteld op 
HDR(HLG):

HLG Live / HLG Natural / User1 tot 
User16

Als Shooting Mode is ingesteld Cine EI:
s709 / 709(800) / S-Log3 / User1 tot 
User16

Selecteert een basisuiterlijk.

Delete Verwijdert het geselecteerde 
basisuiterlijk.

Delete All Verwijdert alle basisuiterlijken.

Paint/Look >Base Look
Regelt instellingen voor het basisuiterlijk.

Onderdeel Instelling subonderdeel Beschrijving
Import from 
Media(B)

Execute / Cancel Importeert een basisuiterlijk-bestand van 
een geheugenkaart die is geplaatst in een 
CFexpress Type A/SD-kaartsleuf (B).
Execute: functie uitvoeren.

Import from 
Cloud(Private)

Execute / Cancel Importeert een geüpload basisuiterlijk-
bestand vanuit de C3 Portal-clouddienst 
(privé).
Execute: functie uitvoeren.

Import from 
Cloud(Share)

Execute / Cancel Importeert een geüpload basisuiterlijk-
bestand vanuit de C3 Portal-clouddienst 
(gedeeld).
Execute: functie uitvoeren.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Stelt het invoerkleurbereik voor het 
geselecteerde basisuiterlijk in.

Output BT.709 / HLG Stelt het uitvoerkleurbereik voor het 
geselecteerde basisuiterlijk in.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Stelt de belichtingsreferentiewaarde voor 
het geselecteerde basisuiterlijk in.

Paint/Look >Reset Paint Settings
Herstelt de instellingen voor het menu Paint/Look, met uitzondering van het basisuiterlijk.

Onderdeel Instelling subonderdeel Beschrijving
Reset without 
Base Look

Execute / Cancel Herstelt de instellingen voor het menu 
Paint/Look, met uitzondering van het 
basisuiterlijk.
Execute: functie uitvoeren.

Paint/Look >Black
Regelt de zwartinstellingen.

Onderdeel Instelling subonderdeel Beschrijving

Master Black –99.0 t/m +99.0 (±0.0) Stelt het masterniveau zwart in.

R Black –99.0 t/m +99.0 (±0.0) Stelt het zwartniveau voor R-signalen in.

B Black –99.0 t/m +99.0 (±0.0) Stelt het zwartniveau voor B-signalen in.
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Paint/Look >Knee
Regelt kniecorrectie-instellingen.

Onderdeel Instelling subonderdeel Beschrijving

Setting Als Target Display is ingesteld op 
SDR(BT.709):

On / Off / ---
Als Target Display is ingesteld op 
HDR(HLG):

On / Off / ---

Schakelt de kniecorrectiefunctie in of uit.

[Tip]
Alleen ingeschakeld als Base Look >Select is 
ingesteld op Standard, ITU709, HLG Live of HLG 
Natural.

Auto Knee Als Target Display is ingesteld op 
SDR(BT.709):

On / Off / ---
Als Target Display is ingesteld op 
HDR(HLG):

On / Off / ---

Schakelt de functie auto knee in of uit.

[Tip]
Alleen ingeschakeld als de instelling voor 
kniecorrectie is ingesteld op On en Base 
Look >Select is ingesteld op Standard of 
ITU709. 

Point 75% t/m 109% (90%) Stelt het kniepunt in.

Slope –99 t/m +99 (±0) Stelt de compressieverhouding in.

Paint/Look >Detail
Regelt instellingen voor detailaanpassingen.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de detailfunctie in of uit.

Level –7 t/m +7 (±0) Stelt het detailniveau in.

Manual 
Setting

On / Off / --- Schakelt de functie handmatige 
detailaanpassing in of uit.

V/H Balance –2 t/m +2 (±0) Stelt de balans in tussen verticaal (V) en 
horizontaal (H) detail voor handmatige 
detailaanpassing.

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Stelt de balans in tussen zwart (B) detail 
voor gebieden met lage helderheid en 
wit (W) detail voor gebieden met hoge 
helderheid voor handmatige 
detailaanpassingen.

Limit 0 t/m 7 Stelt het limietniveau in voor het detail 
voor handmatige detailaanpassingen.

Crispening 0 t/m 7 Stelt het niveau in voor aanscherpen voor 
handmatige detailaanpassingen.

High Light 
Detail

0 t/m 4 Stelt het detailniveau in van heldere 
gebieden voor handmatige 
detailaanpassingen.

Paint/Look >Matrix
Regelt matrix correctie-instellingen.

Onderdeel Instelling subonderdeel Beschrijving

User Matrix On / Off Schakelt de functie user matrix-correctie 
in of uit.

User Matrix 
Level

–99 t/m +99 (±0) Past de kleurverzadiging van het totale 
beeld aan.

User Matrix 
Phase

–99 t/m +99 (±0) Past de kleurtoon (fase) van het totale 
beeld aan.

User Matrix 
R-G

–99 t/m +99 (±0) Stelt een door de gebruiker aangepaste 
R-G user matrix in.

User Matrix 
R-B

–99 t/m +99 (±0) Stelt een door de gebruiker aangepaste 
R-B user matrix in.

User Matrix 
G-R

–99 t/m +99 (±0) Stelt een door de gebruiker aangepaste 
G-R user matrix in.

User Matrix 
G-B

–99 t/m +99 (±0) Stelt een door de gebruiker aangepaste 
G-B user matrix in.

User Matrix 
B-R

–99 t/m +99 (±0) Stelt een door de gebruiker aangepaste 
B-R user matrix in.

User Matrix 
B-G

–99 t/m +99 (±0) Stelt een door de gebruiker aangepaste 
B-G user matrix in.

Paint/Look >Multi Matrix
Regelt multi matrix-correctie-instellingen.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de functie multi matrix-correctie 
in of uit.

Reset Execute / Cancel Reset de tint en verzadiging van alle 
askleuren naar de standaardwaarden.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Seleteert de as.

Hue –99 t/m +99 (±0) Stelt de tint in van de voor multi matrix-
correctie gebruikte kleur.

Saturation –99 t/m +99 (±0) Stelt de verzadiging in van de voor multi 
matrix-correctie gebruikte kleur.
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Menu TC/Media
Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

TC/Media >Timecode
Regelt tijdcode-instellingen.

Onderdeel Instelling subonderdeel Beschrijving

Mode Preset / Regen / Clock Stelt de uitvoermodus voor de tijdcode 
in.
Preset: 

Begint met uitvoeren vanaf een 
presetwaarde.

Regen: 
Begint met uitvoeren van de tijdcode 
vanaf het eind van de vorige clip.

Clock: 
Gebruikt de interne klok als tijdcode.

Run Rec Run / Free Run Rec Run: De tijdcode loopt alleen tijdens 
opname.

Free Run: De tijdcode loopt altijd, 
onafhankelijk van de 
camcorderwerking.

Setting Stelt de tijdcode in op een willekeurige 
waarde.
SET: stelt de waarde in.

Reset Execute / Cancel Reset de tijdcode naar 00:00:00:00.
Execute: functie uitvoeren.

TC Format DF / NDF Stelt de tijdcode-indeling in.
DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display
Regelt de instellingen voor weergave van de tijdgegevens.

Onderdeel Instelling subonderdeel Beschrijving

Display Select Timecode / Users Bit / Duration Schakelt de weergave van tijdgegevens 
om.

TC/Media >Users Bit
Regelt instellingen met betrekking tot user bits.

Onderdeel Instelling subonderdeel Beschrijving

Mode Fix / Time Stelt de modus voor user bits in.
Fix: Gebruikt een willekeurige vaste 

waarde in user bits.
Time: gebruikt de huidige uren, minuten 

en seconden in gebruikersbits.

TC/Media >Users Bit
Regelt instellingen met betrekking tot user bits.

Onderdeel Instelling subonderdeel Beschrijving

Setting Stelt de user bits in op een willekeurige 
waarde.

TC/Media >HDMI TC Out
Regelt instellingen met betrekking tot tijdcode-uitvoer bij gebruik van HDMI.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Regelt of er tijdcode naar apparaten voor 
andere doeleinden moet worden 
verzonden met HDMI.
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TC/Media >Clip Name Format
Regelt instellingen met betrekking tot naamgeving en verwijdering van clips.

Onderdeel Instelling subonderdeel Beschrijving

Title Prefix nnn_ (nnn is tenminste 3 cijfers van het 
serienummer)

Stelt het titelgedeelte (4 - 46 tekens) voor 
de clipnaam in.
Opent een invoerscherm voor 
tekenreeksen.

Schermopbouw invoerscherm 
tekenreeksen
Tekenselectiegebied (3 regels): 

Selecteert de tekens die in het vak 
Title Prefix moeten worden 
ingevoerd.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Cursorbedieningsdeel (1 regel): 
Space: voegt een spatie in op de 
plaats van de cursor.  
: Verplaatst de cursor naar links.  
: Verplaatst de cursor naar rechts.  
BS: Verwijdert het teken links van de 
cursor.

Gedeelte Title Prefix (1 regel): 
Gedeelte voor invoeren van de titel.

Zo voert u de titel in
1.	 Selecteer met de keuzeschakelaar het 

teken dat op de plaats van de cursor 
moet worden ingevoerd in het 
gedeelte Title Prefix van het 
tekenselectiegebied (pagina 7), 
en druk op de toepassingsknop van 
de keuzeschakelaar. (Het 
geselecteerde teken wordt ingevoerd 
en de cursor beweegt naar rechts.)

2.	 Herhaal stap 1 om de titel in te 
stellen. (Gebruik BS indien nodig.)

3.	 Selecteer na het invoeren van de titel 
Done om het tekeninvoerscherm te 
sluiten.

Number Set 0001 t/m 9999 Stelt het 4-cijferige achtervoegsel van de 
clipnaam in.

TC/Media >Update Media
Updatet het beheerbestand op geheugenkaarten.

Onderdeel Instelling subonderdeel Beschrijving

Media(A) Execute / Cancel Updatet het beheerbestand op de 
geheugenkaart in sleuf A.
Execute: functie uitvoeren.

Media(B) Execute / Cancel Updatet het beheerbestand op de 
geheugenkaart in sleuf B.
Execute: functie uitvoeren.

TC/Media >Format Media
Initialiseert geheugenkaarten.

Onderdeel Instelling subonderdeel Beschrijving

Media(A) Full Format / Quick Format / Cancel Formatteert de geheugenkaart in sleuf A.

Media(B) Full Format / Quick Format / Cancel Formatteert de geheugenkaart in sleuf B.
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Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Monitoring >Output On/Off
Regelt de video-uitvoerinstelling.

Onderdeel Instelling subonderdeel Beschrijving

SDI On / Off Schakelt de SDI-uitvoer in of uit.

HDMI On / Off Schakelt HDMI-uitvoer in of uit.

Monitoring >Output Format
Regelt de uitvoerindeling.

Onderdeel Instelling subonderdeel Beschrijving

SDI Zie voor details over instellingen 
"Uitvoerindelingen en beperkingen" 
(pagina 119).

Regelt de uitvoerresolutie voor SDI en 
HDMI.HDMI

Monitoring >Output Display
Regelt de uitvoerinstellingen van de schermweergave.

Onderdeel Instelling subonderdeel Beschrijving

SDI On / Off Stelt in of het menu, de status en de 
schermweergave worden opgenomen in 
het SDI-uitgangssignaal.

HDMI On / Off Stelt in of het menu, de status en de 
schermweergave worden opgenomen in 
het HDMI-uitgangssignaal.

Monitoring >Display On/Off
Regelt instellingen voor weergave-onderdelen.

Onderdeel Instelling subonderdeel Beschrijving

Network 
Status

On / Off Selecteert de onderdelen die moeten 
worden weergegeven in de zoeker.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off

Menu Monitoring
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Monitoring >Display On/Off
Regelt instellingen voor weergave-onderdelen.

Onderdeel Instelling subonderdeel Beschrijving

Base Look/
LUT

On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Regelt instellingen voor markerweergave.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de weergave van alle markers in 
of uit.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Selecteert de kleur van het 
markerssignaal.

Center 
Marker

1 / 2 / 3 / 4 / Off Selecteert de centrale marker.

Safety Zone On / Off Schakelt de veiligheidszonemarker in of 
uit.

Safety Area 80% / 90% / 92.5% / 95% Selecteert de grootte van de 
veiligheidszonemarker (als een 
percentage van de totale schermgrootte).

Aspect 
Marker

Line / Mask / Off Selecteert het type 
beeldindelingsmarkering.

Aspect Mask 0 t/m 15 (12) Stelt het niveau van het videosignaal 
buiten de markering in.

Aspect Safety 
Zone

On / Off Schakelt de veiligheidsmarkering voor 
beeldindeling in of uit.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Selecteert de grootte van de 
veiligheidsmarkering voor beeldindeling 
(als een percentage van de totale 
schermgrootte).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Stelt de modus in bij weergave van de 
beeldindelingsmarkering.

Custom 
Aspect Ratio

Voer een willekeurig waarde in 
(01.00:01.00)

Stelt de beeldindelingsverhouding in op 
een willekeurige waarde.

[Opmerking]
Deze instelling is actief als Aspect Select is 
ingesteld op Custom.

Guide Frame On / Off Schakelt de weergave van het hulpkader 
in of uit.

100% Marker On / Off Schakelt de 100%-marker in of uit.

User Box On / Off Schakelt de weergave van de 
indelingsmarkering in of uit.

User Box 
Width

3 t/m 479 (240) Stelt de breedte in van de 
indelingsmarkering (afstand van het 
midden tot de linker en rechter randen).
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Monitoring >Marker
Regelt instellingen voor markerweergave.

Onderdeel Instelling subonderdeel Beschrijving

User Box 
Height

3 t/m 269 (135) Stelt de hoogte in van de 
indelingsmarkering (afstand van het 
midden tot de bovenste en onderste 
randen).

User Box H 
Position

–476 t/m +476 (0) Stelt de horizontale positie van het 
midden van de beeldindelingsmarkering 
in.

User Box V 
Position

–266 t/m +266 (0) Stelt de verticale positie van het midden 
van de beeldindelingsmarkering in.

Monitoring >VF Setting
Regelt de instellingen voor de zoeker.

Onderdeel Instelling subonderdeel Beschrijving

Brightness 1 t/m 15 (8) Past de helderheid van het zoekerbeeld 
aan.

Color Mode Color / B&W Selecteert de weergavemodus van de 
zoeker in E-E/opname-modus.

Monitoring >Gamma Display Assist
Regelt de instellingen van de gammaweergave-assistent.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de functie gammaweergave-
assistent in of uit in Custom-modus als 
Target Display is ingesteld op HDR(HLG).

Monitoring >Peaking
Regelt de instellingen voor beeldomtrekversterking.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de functie 
beeldomtrekversterking in of uit.

Peaking Level High / Mid / Low Stelt de kleur van het 
beeldomtrekversterkingssignaal in.

Color B&W / Red / Yellow / Blue Selecteert de kleur van het 
beeldomtrekversterkingssignaal.

Monitoring >Zebra
Regelt de instellingen voor zebra-patroon.

Onderdeel Instelling subonderdeel Beschrijving

Setting Off / Zebra1 / Zebra2 Selecteert het type zebra-patroon (Off, 
Zebra 1, Zebra 2).

Zebra1 Level 0% t/m 109% (70%) Stelt het weergaveniveau van Zebra 1 in.

Zebra1 
Aperture 
Level

2% t/m 20% (10%) Stelt het diafragmaniveau van Zebra 1 in.

Zebra2 Level 0% t/m 109% (100%) Stelt het weergaveniveau van Zebra 2 in.
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Menu Audio
Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).
Raadpleeg "Blokschema's" (pagina 134).

Audio >Audio Input
Regelt instellingen voor audio-invoer.

Onderdeel Instelling subonderdeel Beschrijving

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Schakelt de ingangsbron om voor 
opname op kanaal 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Schakelt de ingangsbron om voor 
opname op kanaal 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Schakelt de ingangsbron om voor 
opname op kanaal 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Schakelt de ingangsbron om voor 
opname op kanaal 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Stelt het referentie-opnameniveau in 
voor XLR-microfooninvoer van INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Stelt het referentie-opnameniveau in 
voor XLR-microfooninvoer van INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Stelt het referentie-ingangsniveau in als 
de schakelaar INPUT1/INPUT2 op LINE 
staat.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Selecteert het opnameniveau van de  
1 kHz referentietoon.

CH1 Wind 
Filter

On / Off Schakelt het windreductiefilter voor 
opname via kanaal 1 in of uit.

CH2 Wind 
Filter

On / Off Schakelt het windreductiefilter voor 
opname via kanaal 2 in of uit.

CH3 Wind 
Filter

On / Off Schakelt het windreductiefilter voor 
opname via kanaal 3 in of uit.

CH4 Wind 
Filter

On / Off Schakelt het windreductiefilter voor 
opname via kanaal 4 in of uit.

CH3 Level 
Control

Auto / Manual Selecteert automatische ingangsniveau-
aanpassing of handmatige aanpassing 
voor opname via kanaal 3.

[Opmerking]
Als zowel CH3 Input Select als CH4 Input 
Select zijn ingesteld op Internal MIC, wordt 
CH4 automatisch/handmatig ingesteld, in 
combinatie met deze instelling.

Audio >Audio Input
Regelt instellingen voor audio-invoer.

Onderdeel Instelling subonderdeel Beschrijving

CH4 Level 
Control

Auto / Manual Selecteert automatische ingangsniveau-
aanpassing of handmatige aanpassing 
voor opname via kanaal 4.

[Opmerking]
Als zowel CH3 Input Select als CH4 Input 
Select zijn ingesteld op Internal MIC, wordt 
CH4 op automatisch/handmatig ingesteld, in 
combinatie met de instelling voor CH3 Level 
Control.

CH3 Input 
Level

0 t/m 99 (49) Stelt het ingangsniveau in voor opname 
van kanaal 3.

CH4 Input 
Level

0 t/m 99 (49) Stelt het ingangsniveau in voor opname 
van kanaal 4.

Audio Input 
Level

0 t/m 99 Stelt het audio-ingangsniveau in.
Kan worden gebruikt als mastervolume, 
afhankelijk van de instellingen van CH1 
Level t/m CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Selecteert de limiterkarakteristiek voor 
hoge ingangsignalen als het audio-
ingangsniveau handmatig wordt 
ingesteld.

CH1&2 AGC 
Mode

Mono / Stereo Stelt de modus in voor automatische 
niveau-aanpassing voor opname van 
kanaal 1 en kanaal 2. Bij instelling op 
Stereo is de AGC tussen de kanalen 
gekoppeld.

CH3&4 AGC 
Mode

Mono / Stereo Stelt de modus in voor automatische 
niveau-aanpassing voor opname van 
kanaal 3 en kanaal 4. Bij instelling op 
Stereo is de AGC tussen de kanalen 
gekoppeld.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Selecteert de AGC-karakteristiek.

1kHz Tone on 
Color Bars

On / Off Schakelt de 1 kHz referentietoon in of uit 
bij het weergeven van kleurbalken.

[Opmerking]
Als dit is ingesteld op On, wordt de 1 kHz 
referentietoon ingesteld voor opname van 
kanaal 3 en kanaal 4, zelfs als CH3 Input Select 
en CH4 Input Select zijn ingesteld op Off.
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Audio >Audio Input
Regelt instellingen voor audio-invoer.

Onderdeel Instelling subonderdeel Beschrijving

CH1 Level Invoer zonder XLR-adapter
Audio Input Level / Side / Level+Side

Invoer met XLR-adapter (pagina 48)
Audio Input Level / Through

Stelt de combinatie van audio-
ingangsniveau-aanpassing in op actief 
voor opnemen via kanaal 1.

[Opmerking]
"Side" heeft betrekking op de regelaar 
AUDIO LEVEL (CH1) aan de zijkant van de 
camcorder. Als Level+Side is geselecteerd, 
wordt het audio-opnameniveau bepaald door 
de combinatie van Audio Input Level en de 
regelaarinstellingen (pagina 134).

CH2 Level Invoer zonder XLR-adapter
Audio Input Level / Side / Level+Side

Invoer met XLR-adapter (pagina 48)
Audio Input Level / Through

Stelt de combinatie van audio-
ingangsniveau-aanpassing in op actief 
voor opnemen via kanaal 2.

[Opmerking]
"Side" heeft betrekking op de regelaar 
AUDIO LEVEL (CH2) aan de zijkant van de 
camcorder. Als Level+Side is geselecteerd, 
wordt het audio-opnameniveau bepaald door 
de combinatie van Audio Input Level en de 
regelaarinstellingen (pagina 134).

CH3 Level Invoer zonder XLR-adapter
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Invoer met XLR-adapter (pagina 48)
Audio Input Level / Through

Stelt de combinatie van audio-
ingangsniveau-aanpassing in op actief 
voor opnemen van kanaal 3.

CH4 Level Invoer zonder XLR-adapter
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Invoer met XLR-adapter (pagina 48)
Audio Input Level / Through

Stelt de combinatie van audio-
ingangsniveau-aanpassing in op actief 
voor opnemen van kanaal 4.

Audio >Audio Output
Regelt instellingen voor audio-uitvoer.

Onderdeel Instelling subonderdeel Beschrijving

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Selecteert de audiokanaalingang voor de 
hoofdtelefoonaansluiting en ingebouwde 
luidspreker.

[Opmerking]
Als audio voor meerdere kanalen is 
ingesteld op gelijktijdige uitvoer, wordt het 
uitgangsniveau van de audio voor elk kanaal 
gereduceerd om clippen te voorkomen.

Volume 0 t/m 50 Past het audio-uitgangsniveau naar de 
hoofdtelefoonuitgang en interne 
luidspreker aan.

Headphone 
Out

Mono / Stereo Selecteert of de hoofdtelefoonuitgang 
mono of stereo signaal weergeeft.

Alarm Level 0 t/m 7 (4) Past het volume van het alarm aan.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Stelt de combinatie van audiokanalen in 
op de HDMI-uitvoer.
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Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Thumbnail

Onderdeel Instelling subonderdeel Beschrijving

Display Clip 
Properties

Geeft het scherm weer voor 
clipeigenschappen.

Thumbnail >Set Clip Flag
Regelt instellingen voor clipvlag.

Onderdeel Instelling subonderdeel Beschrijving

Add OK Voegt een OK-vlag toe.

Add NG Voegt een NG-vlag toe.

Add KEEP Voegt een Keep-vlag toe.

Delete Clip 
Flag

Verwijdert alle vlaggen.

Thumbnail >Lock/Unlock Clip
Regelt instellingen voor clipbescherming.

Onderdeel Instelling subonderdeel Beschrijving

Select Clip Selecteert en vergrendelt/ontgrendelt 
een clip.

Lock All Clips Vergrendelt alle clips.

Unlock All 
Clips

Ontgrendelt alle clips.

Thumbnail >Delete Clip
Verwijdert clips.

Onderdeel Instelling subonderdeel Beschrijving

Select Clip Verwijdert de geselecteerde clip.

All Clips Verwijdert alle clips.

Thumbnail >Transfer Clip
Verzendt clips.

[Opmerking]
Transfer Clip kan niet worden geconfigureerd als er geen wachtwoord is geconfigureerd met Access 
Authentication in het menu Network.

Onderdeel Instelling subonderdeel Beschrijving

Select Clip Verzendt geselecteerde clips.

All Clips Verzendt alle clips.

[Opmerking]
Er kunnen maximaal 200 clips worden 
verzonden.

Thumbnail >Transfer Clip (Proxy)
Verzendt proxy-clips.

[Opmerking]
Transfer Clip (Proxy) kan niet worden geconfigureerd als er geen wachtwoord is geconfigureerd met Access 
Authentication in het menu Network.

Onderdeel Instelling subonderdeel Beschrijving

Select Clip Verzendt proxy-clips corresponderend 
met de geselecteerde clips.

All Clips Verzendt proxy-clips corresponderend 
met alle clips.

[Opmerking]
Er kunnen maximaal 200 clips worden 
verzonden.

Thumbnail >Filter Clips
Regelt instellingen voor weer te geven clips.

Onderdeel Instelling subonderdeel Beschrijving

OK Geeft alleen clips weer die een OK-vlag 
hebben.

NG Geeft alleen clips weer die een NG-vlag 
hebben.

KEEP Geeft alleen clips weer die een Keep-vlag 
hebben.

None Geeft alleen clips weer die geen vlag 
hebben.

All Geeft alle clips weer, ongeacht of er een 
vlag is.

Thumbnail >Customize View
Schakelt het pictogrammenscherm om.

Onderdeel Instelling subonderdeel Beschrijving

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Schakelt de onder de pictogrammen 
weergegeven informatie om.

Menu Thumbnail
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Menu Technical
Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Technical >Color Bars
Regelt instellingen voor kleurbalk.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de kleurbalken in of uit.

Type ARIB / 100% / 75% / SMPTE Selecteert het type kleurbalk.

Technical >ND Dial
Regelt instellingen met betrekking tot regelaarbediening van ND VARIABLE.

Onderdeel Instelling subonderdeel Beschrijving

CLEAR with 
Dial

On / Off Stelt in of ND statusomschakeling (CLEAR 
 On) moet worden geactiveerd door 
bediening van de regelaar ND VARIABLE.

Technical >Tally
Regelt instellingen van opname/tally-lampje.

Onderdeel Instelling subonderdeel Beschrijving

Front On / Off Schakelt het opname/tally-lampje (voor) 
in of uit.

Rear On / Off Schakelt het opname/tally-lampje 
(achter) in of uit.

Technical >HOLD Switch Setting
Regelt instellingen voor HOLD-schakelaar.

Onderdeel Instelling subonderdeel Beschrijving

with Rec 
Button

On / Off Stelt in of de opnameknop START/STOP 
moet worden vergrendeld.

with Hand 
Grip Remote

On / Off Stelt in of de bediening van de 
afstandsbedieningsgreep moet worden 
vergrendeld.

Technical >HOLD Switch Setting
Regelt instellingen voor HOLD-schakelaar.

Onderdeel Instelling subonderdeel Beschrijving

Handle HOLD 
Switch

Normal / Rec Button Only Stelt in of het vergrendelingsdoel van de 
HOLD-schakelaar op de draaggreep 
alleen de knop Record START/STOP op 
de draaggreep is.
Normal: 

Alle bedieningsknoppen op de 
draaggreep zijn doel van de 
vergrendeling.  
Alleen de Record START/STOP-knop 
op de draaggreep volgt de instelling 
"with Rec Button".

Rec Button Only: 
Alleen de knop Record START/STOP 
op de draaggreep is doel van de 
vergrendeling.

Technical >Touch Operation
Regelt instellingen met betrekking tot aanraakbediening.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt aanraakbediening in of uit.

Technical >Rec Review
Regelt instellingen voor opname controleren.

Onderdeel Instelling subonderdeel Beschrijving

Setting 3 s / 10 s / Clip Selecteert de afspeeltijd van clips die 
zojuist zijn opgenomen voor het 
controleren.

Technical >Zoom
Regelt instellingen voor zoom.

Onderdeel Instelling subonderdeel Beschrijving

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Stelt het zoomtype in.
Optical Zoom Only: 

Optische zoom wordt aangepast 
door bediening van het objectief.

On(Clear Image Zoom): 
Elektronische zoom met weinig of 
geen aantasting van de 
beeldkwaliteit.
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Technical >Handle Zoom
Regelt de zoominstellingen van de draaggreep.

Onderdeel Instelling subonderdeel Beschrijving

Setting Off / Low / High / Variable Regelt de snelheid van de 
draaggreepzoom.

High 1 t/m 8 (8) Stelt de zoomsnelheid in van de 
zoomregelaar van de draaggreep als de 
snelheid High is geselecteerd.

Low 1 t/m 8 (3) Stelt de zoomsnelheid in van de 
zoomregelaar van de draaggreep als de 
snelheid Low is geselecteerd.

[Opmerking]
Onregelmatig zoomen kan zich voordoen als 
de zoomsnelheid laag is ingesteld.

Technical >Menu Settings
Regelt instellingen met betrekking tot het menu.

Onderdeel Instelling subonderdeel Beschrijving

User Menu 
Only

On / Off Stelt in of alleen het menu User moet 
worden weergegeven (On) of de 
menulijst (Off) als de camcorder het 
menu weergeeft.

User Menu 
with Lock

On / Off Stelt in of de menuweergave moet 
worden vergrendeld, waardoor alleen het 
menu User wordt weergegeven.

[Opmerking]
Bij normale menuweergavebediening wordt dit 
onderdeel niet weergegeven. Zie voor details 
over menuweergavebediening pagina 73.

Technical >Menu Page On/Off
Configureert instellingen die te maken hebben met de weergave van het statusscherm.

Onderdeel Instelling subonderdeel Beschrijving

Main On / Off Schakelt de weergave van het scherm 
Main Status uit.

Camera On / Off Schakelt de weergave van het scherm 
Camera Status uit.

Audio On / Off Schakelt de weergave van het scherm 
Audio Status uit.

Project On / Off Schakelt de weergave van het 
statusscherm Project uit.

Monitoring On / Off Schakelt de weergave van het scherm 
Monitoring Status uit.

Technical >Menu Page On/Off
Configureert instellingen die te maken hebben met de weergave van het statusscherm.

Onderdeel Instelling subonderdeel Beschrijving

Assignable 
Button

On / Off Schakelt de weergave van het scherm 
Assignable Button Status uit.

Battery On / Off Schakelt de weergave van het scherm 
Battery Status uit.

Media On / Off Schakelt de weergave van het scherm 
Media Status uit.

Network On / Off Schakelt de weergave van het scherm 
Network Status uit.

File Transfer On / Off Schakelt de weergave van het scherm 
File Transfer Status uit.

Technical >Fan Control
Regelt instellingen voor de ventilator.

Onderdeel Instelling subonderdeel Beschrijving

Setting Auto / Minimum / Off in Rec Stelt de besturingsmodus voor de 
camcorderventilator in.

[Opmerking]
Zelfs als Off in Rec is geselecteerd, gaat de 
ventilator werken als de interne temperatuur 
van de camcorder boven een bepaalde grens 
komt.

Technical >Lens
Regelt instellingen met betrekking tot lenzen.

Onderdeel Instelling subonderdeel Beschrijving

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Stelt de richting in van de 
zoomringbediening.

[Opmerking]
Alleen inschakelen bij gebruik van een 
objectief met E-bevestiging die overschakeling 
van zoomringrichting ondersteunt.

Shading 
Compensation

Auto / Off Stelt de automatische 
schaduwcompensatie in.

Chroma 
Aberration 
Comp.

Auto / Off Stelt de automatische chromatische 
aberratie in.

Distortion 
Comp.

Auto / Off Stelt de automatische 
vervormingscompensatie in.

Breathing 
Compensation

Auto / Off Stelt de ademcompensatie voor het 
objectief in.
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Technical >Lens
Regelt instellingen met betrekking tot lenzen.

Onderdeel Instelling subonderdeel Beschrijving

Distance 
Display

Meter / Feet Stelt de weergave-eenheid in voor 
objectiefinformatie en 
scherpstellingspositie.

Zoom 
Position 
Display

Focal Length / Number / Bar Stelt de weergave-indeling voor de 
zoompositie in.

Technical >Video Light Set
Stelt de belichtingsbesturingsmodus in voor de verlichting. Alleen beschikbaar bij gebruik van de 
HVL-LBPC (optie).

Onderdeel Instelling subonderdeel Beschrijving

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Stelt de belichtingsbesturingsmodus in 
voor de videolamp die is bevestigd aan 
de multi-interfaceschoen.
Power Link: 

Schakelt de videolamp in of uit als de 
camcorder wordt in- of uitgeschakeld.

Rec Link: 
Schakelt de videolamp in of uit als de 
camcorder start of stopt met opnemen.

Rec Link + Stby: 
Schakelt de videolamp in of op 
standby als de camcorder start of 
stopt met opnemen.

Technical >APR
Voert APR uit.

Onderdeel Instelling subonderdeel Beschrijving

APR Execute / Cancel Voert APR (Automatic Pixel Restoration) 
uit voor automatische aanpassing van de 
beeldsensor.
Execute: functie uitvoeren.

[Opmerking]
Bevestig altijd de objectiefdop voordat APR 
wordt uitgevoerd.

Technical >Camera Battery Alarm
Regelt instellingen voor accu-alarmmeldingen.

Onderdeel Instelling subonderdeel Beschrijving

Low Battery 5% / 10% / 15% / … / 45% / 50% Stelt de resterende accucapaciteit in (in 
stappen van 5%) vanaf waar een melding 
van laag accuniveau wordt weergegeven.

Technical >Camera Battery Alarm
Regelt instellingen voor accu-alarmmeldingen.

Onderdeel Instelling subonderdeel Beschrijving

Battery 
Empty

3% t/m 7% Stelt de resterende accucapaciteit in 
vanaf waar een melding van lege accu 
wordt weergegeven.

Technical >Camera DC IN Alarm
Regelt instellingen voor voedingsvoltage.

Onderdeel Instelling subonderdeel Beschrijving

DC Low 
Voltage1

16.0V tot 19.0V (16.5V) Stelt het voltage in waarbij een melding 
voor laag ingangsvoltage (DC IN) wordt 
weergegeven.

DC Low 
Voltage2

15.5V tot 18.5V Stelt het voltage in waarbij een melding 
voor onvoldoende ingangsvoltage (DC 
IN) wordt weergegeven.
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Menu Network
Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Network >Setup for Mobile App
Voert het hulpmiddel voor netwerkinstelling uit.

Onderdeel Instelling subonderdeel Beschrijving

Setup Start het hulpmiddel voor 
netwerkinstelling.

Network >Access Authentication
Regelt instellingen voor toegangsverificatie.

Onderdeel Instelling subonderdeel Beschrijving

User Name Stelt de gebruikersnaam in voor 
toegangsverificatie.

Input 
Password

Stelt het wachtwoord in voor 
toegangsverificatie.

[Opmerking]
Vanuit beveiligingsstandpunt kunt u het beste 
een wachtwoord instellen met een voldoende 
lange tekenreeks die moeilijk te raden is voor 
anderen. Bewaar dit op een veilige plaats.

Generate 
Password

Execute / Cancel Genereert automatisch een wachtwoord 
voor toegangsverificatie.
Execute: functie uitvoeren.

Show 
Settings

Geeft informatie weer voor 
toegangverificatie.
Geeft het wachtwoord, de vingerafdruk, 
het serienummer, het serienummer en de 
modelnaam weer als tekst en als QR-
code.

[Opmerking]
Let erop dat andere mensen het wachtwoord 
niet kunnen zien en de QR-code niet kunnen 
kopiëren.

Network >Wireless LAN
Regelt instellingen met betrekking tot draadloze LAN-verbindingen.

Onderdeel Instelling subonderdeel Beschrijving

Setting Access Point Mode / Station Mode / Off Selecteert de werkmodus van de 
draadloze LAN-verbinding.

WPS Execute / Cancel Brengt een verbinding tot stand met WPS 
(Wi-Fi Protected Setup).
Execute: functie uitvoeren.

Network >Wireless LAN
Regelt instellingen met betrekking tot draadloze LAN-verbindingen.

Onderdeel Instelling subonderdeel Beschrijving

NFC Execute / Cancel Brengt een verbinding tot stand met NFC 
(Near Field Communication).
Execute: functie uitvoeren.

MAC Address Geeft het MAC-addres weer van de 
draadloze LAN-interface van de 
camcorder.

Network >AP Mode Settings
Regelt instellingen met betrekking tot verbindingen met toegangspunt.

Onderdeel Instelling subonderdeel Beschrijving

Channel Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Stelt het draadloze LAN-kanaal in.
Auto(5GHz) is alleen beschikbaar op de 
ILME‑FX6V/VK.

Camera SSID 
& Password

Geeft de SSID en wachtwoord van de 
camcorder weer.

Regenerate 
Password

Execute / Cancel Maakt een nieuw wachtwoord aan.
Execute: functie uitvoeren.

IP Address Geeft het IP-adres van de camcorder in 
toegangspuntmodus weer.

Subnet Mask Geeft het subnetmasker-adres van de 
camcorder in toegangspuntmodus weer.
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Network >ST Mode Settings
Regelt instellingen met betrekking tot verbindingen met stationmodus.

Onderdeel Instelling subonderdeel Beschrijving

Camera 
Remote 
Control

Enable / Disable Stelt in of de camcorder kan worden 
bediend vanaf een apparaat dat via 
draadloos LAN in stationmodus is 
verbonden.

Connected 
Network

Geeft het verbonden draadloze LAN-
netwerk (toegangspunt) weer.

SSID Geeft de SSID weer voor het 
toegangspunt waarmee verbinding moet 
worden gemaakt.

Security Geeft het type beveiliging weer voor het 
toegangspunt waarmee verbinding moet 
worden gemaakt.

Password Geeft het wachtwoord weer voor het 
toegangspunt waarmee verbinding moet 
worden gemaakt.
Als Security is ingesteld op WEP of  

WPA: *******
Als Security is ingesteld op None:  

(leeg)

DHCP Geeft aan of DHCP is in- of uitgeschakeld.

IP Address Geeft het IP-adres weer van de 
camcorder als DHCP is ingesteld op Off.

Subnet Mask Geeft het subnetmasker weer van de 
camcorder als DHCP is ingesteld op Off.

Gateway Geeft de standaard gateway van de 
camcorder aan als DHCP is ingesteld op 
Off.

DNS Auto Geeft aan of DNS-acquisitie is in- of 
uitgeschakeld.

Primary DNS Server Geeft de primaire DNS-server van de 
camcorder weer als DNS Auto is ingesteld 
op Off.

Secondary DNS Server Geeft de secundaire DNS-server van de 
camcorder weer als DNS Auto is ingesteld 
op Off.

Network >ST Mode Settings
Regelt instellingen met betrekking tot verbindingen met stationmodus.

Onderdeel Instelling subonderdeel Beschrijving

Scan 
Networks

Detecteert draadloze LAN-netwerken 
(toegangspunten) en geeft een lijst weer.
Kies een bestemming in de lijst om 
verbinding mee te maken.

SSID Geeft de SSID weer voor het 
toegangspunt waarmee verbinding moet 
worden gemaakt.

Security Geeft het type beveiliging weer voor het 
toegangspunt waarmee verbinding moet 
worden gemaakt.

Password Voer het wachtwoord voor het 
toegangspunt in om verbinding te 
maken.

DHCP 
On / Off

Schakelt DHCP in of uit.

IP Address Voer het IP-adres in van de camcorder als 
DHCP is ingesteld op Off.

Subnet Mask Voer het subnetmasker in van de 
camcorder als DHCP is ingesteld op Off.

Gateway Voer de standaard gateway in van de 
camcorder als DHCP is ingesteld op Off.

DNS Auto 
On / Off

Schakelt automatische DNS-acquisitie in 
of uit.

Primary DNS Server Voer de primaire DNS-server van de 
camcorder in als DNS Auto is ingesteld 
op Off.

Secondary DNS Server Voer de secundaire DNS-server van de 
camcorder in als DNS Auto is ingesteld 
op Off.
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Network >ST Mode Settings
Regelt instellingen met betrekking tot verbindingen met stationmodus.

Onderdeel Instelling subonderdeel Beschrijving

Manual 
Register

Registreert instellingen voor handmatige 
verbinding met een toegangspunt.

SSID Voer de SSID in voor het toegangspunt 
waarmee verbinding moet worden 
gemaakt.

Security 
None / WEP / WPA

Stel het type beveiliging in voor het 
toegangspunt waarmee verbinding moet 
worden gemaakt. Selecteer WPA als het 
type beveiliging voor het 
bestemmingstoegangspunt WPA of 
WPA2 is.

Password Voer het wachtwoord voor het 
toegangspunt in om verbinding te 
maken.

DHCP 
On / Off

Schakelt DHCP in of uit.

IP Address Voer het IP-adres in van de camcorder als 
DHCP is ingesteld op Off.

Subnet Mask Voer het subnetmasker in van de 
camcorder als DHCP is ingesteld op Off.

Gateway Voer de standaard gateway in van de 
camcorder als DHCP is ingesteld op Off.

DNS Auto 
On / Off

Schakelt automatische DNS-acquisitie in 
of uit.

Primary DNS Server Voer de primaire DNS-server in als DNS 
Auto is ingesteld op Off.

Secondary DNS Server Voer de secundaire DNS-server in als DNS 
Auto is ingesteld op Off.

Network >Wired LAN
Regelt instellingen met betrekking tot bekabelde LAN-verbindingen.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de bekabelde LAN-functie in of 
uit.

Camera 
Remote 
Control

Enable / Disable Stelt in of de camcorder kan worden 
bediend vanaf een apparaat dat via 
draadloos LAN modus is verbonden.

Detail 
Settings

Configureert de eigenschappen van de 
bekabelde LAN-verbinding.

DHCP 
On / Off

Schakelt DHCP in of uit.

IP Address Voer het IP-adres in van de camcorder als 
DHCP is ingesteld op Off.

Subnet Mask Voer het subnetmasker in van de 
camcorder als DHCP is ingesteld op Off.

Gateway Voer de standaard gateway in van de 
camcorder als DHCP is ingesteld op Off.

DNS Auto 
On / Off

Schakelt automatische DNS-acquisitie in 
of uit.

Primary DNS Server Voer de primaire DNS-server in als DNS 
Auto is ingesteld op Off.

Secondary DNS Server Voer de secundaire DNS-server in als DNS 
Auto is ingesteld op Off.

Network >Modem
Regelt instellingen met betrekking tot USB-tethering.

Onderdeel Instelling subonderdeel Beschrijving

Setting On / Off Schakelt de smartphoneverbinding in of 
uit.

Camera 
Remote 
Control

Enable / Disable Stelt de rechten in voor 
afstandsbediening via USB-tethering met 
een smartphone-app, bijvoorbeeld CBM 
(Content Browser Mobile) of C3 Portal 
App.

Device Name Geeft de apparaatnaam van de 
smartphone weer.

IP Address Geeft het IP adres van de smartphone 
weer.

Subnet Mask Geeft het subnetmasker van de 
smartphone weer.
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Network >File Transfer
Regelt instellingen met betrekking tot de bestandsoverdracht.

Onderdeel Instelling subonderdeel Beschrijving

Auto Upload On / Off Hiermee schakelt u het automatisch 
uploaden van originele bestanden in en 
uit.

[Opmerking]
Wanneer Simul Rec >Setting (pagina 85) in 
het menu Project is ingesteld op On, worden 
de clips die worden opgenomen op het 
medium in sleuf B niet automatisch geüpload.

Auto Upload 
(Proxy)

On / Off / Chunk On:
Schakelt automatisch uploaden van 
proxybestanden in.

Off:
Schakelt automatisch uploaden van 
proxybestanden uit.

Chunk:
Uploadt automatisch een 
proxybestand dat is opgenomen in 
segmenten.

[Opmerking]
Wanneer Simul Rec >Setting (pagina 85) in 
het menu Project is ingesteld op On, worden 
de clips die worden opgenomen op het 
medium in sleuf B niet automatisch geüpload. 
Bovendien is Chunk grijs gemaakt en kan niet 
worden geselecteerd.

Default 
Upload 
Server

Selecteert de uploadserver voor 
bestanden. De hier geselecteerde server 
wordt de automatische 
uploadbestemming voor origineel 
bestanden en proxy-bestanden en de 
uploadbestemming voor bestanden van 
het pictogrammenscherm.
Geeft de weergavenaam mee die is 
geconfigureerd in Server Settings 1 t/m 3.

Clear 
Completed 
Jobs

Execute / Cancel Verwijdert voltooide overdrachtstaken uit 
de lijst.
Execute: functie uitvoeren.

Clear All Jobs Execute / Cancel Verwijdert alle overdrachtstaken uit de 
lijst.
Execute: functie uitvoeren.

View Job List Geeft de lijst met overdrachtstaken weer.

Network >File Transfer
Regelt instellingen met betrekking tot de bestandsoverdracht.

Onderdeel Instelling subonderdeel Beschrijving

Server 
Settings1

Display Name Stelt de weergavenaam in die in het 
configuratiemenu voor 
overdrachtsbestemming wordt 
weergegeven.

Service 
FTP

Geeft het type server weer.

Host Name Stelt de hostnaam van de 
transmissiebestemmingsserver in.

Port (1 t/m 65535 (21)) Stelt het poortnummer in van de 
transmissiebestemmingsserver.

User Name Stelt de gebruikersnaam in voor 
verificatie van de verbinding met de 
transmissiebestemmingsserver.

Password Stelt het verificatiewachtwoord in voor 
de verbinding met de 
transmissiebestemmingsserver.

Passive Mode 
On / Off

Schakelt PASV-modus in of uit.

Destination Directory Voer de naam in van de 
transmissiebestemmingsmap.

Using Secure Protocol 
On / Off

Stelt in of veilige FTP-overdracht wel (On) 
of niet (Off) moet worden gebruikt (FTPS 
Explicit Mode: FTPES).

Root Certificate 
Load / Clear / None

Laadt een root certificate voor veilige 
FTP-overdracht en wist instellingen.

Root Certificate Status 
Loaded / No Certificate

Geeft de laadstatus van het root 
certificate voor veilige FTP-overdracht 
weer.

Reset 
Execute / Cancel

Herstelt de instellingen voor Server 
Settings naar de fabrieksinstellingen.
Execute: functie uitvoeren.

Server 
Settings2

Identiek aan Server Settings1.

Server 
Settings3

Identiek aan Server Settings1.

Network >Network Reset
Herstelt de netwerkinstellingen.

Onderdeel Instelling subonderdeel Beschrijving

Reset Execute / Cancel Herstelt de netwerkinstellingen.
Execute: functie uitvoeren.
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Dit gedeelte beschrijft de functie en instelling van alle menu-onderdelen.
Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld 18dB).

Maintenance >Language
Stelt de weergavetaal in.

Onderdeel Instelling subonderdeel Beschrijving

Select Stelt de weergavetaal in.
SET: taal instellen.

Maintenance >Clock Set
Regelt instellingen voor de interne klok.

Onderdeel Instelling subonderdeel Beschrijving

Time Zone UTC – 12:00 tot UTC + 14:00 Stelt het tijdsverschil met UTC in 
eenheden van 30 minuten in.

Date Mode YYMMDD / MMDDYY / DDMMYY Selecteert de weergave-indeling voor 
datums.
YYMMDD: jaar, maand, dag
MMDDYY: maand, dag, jaar
DDMMYY: dag, maand, jaar

12h/24h 12h / 24h Selecteert de weergave-indeling voor de 
klok.
12h: 12-uursmodus
24h: 24-uursmodus

Date Stelt de huidige datum in.
SET: stelt de waarde in.

Time Stelt de huidige tijd in.
SET: stelt de waarde in.

Maintenance >All Reset
Herstelt instellingen naar de standaard fabrieksinstellingen.

Onderdeel Instelling subonderdeel Beschrijving

Reset Execute / Cancel Herstelt alle instellingen naar de 
standaard fabrieksinstellingen.
Execute: functie uitvoeren.

[Opmerking]
Een 3D LUT-bestand dat is geïmporteerd met 
Base Look >Import from Media(B), Import from 
Cloud(Private) of Import from Cloud(Share) 
(pagina 90) in het menu Paint/Look kan niet 
worden verwijderd. Om alle geïmporteerde 
3D LUT-bestanden te verwijderen selecteert u 
Base Look >Delete All in het menu Paint/Look 
(pagina 90).

Maintenance >All Reset
Herstelt instellingen naar de standaard fabrieksinstellingen.

Onderdeel Instelling subonderdeel Beschrijving

Reset without 
Network

Execute / Cancel Herstelt de menu-instellingen, met 
uitzondering van de instellingen van het 
menu Network, naar de standaard 
fabrieksinstellingen.

Maintenance >Hours Meter
Geeft de geaccumuleerde looptijd weer.

Onderdeel Instelling subonderdeel Beschrijving

Hours 
(System)

Geeft de geaccumuleerde gebruiksuren 
weer (kan niet worden gereset).

Hours(Reset) Geeft de geaccumuleerde gebruiksuren 
weer (kan worden gereset).

Reset Execute / Cancel Stelt de weergave Hours(Reset) terug 
naar 0.
Execute: functie uitvoeren.

Maintenance >Version
Geeft versie-informatie weer.

Onderdeel Instelling subonderdeel Beschrijving

Version 
Number

Vx.xx Geeft de software-versie van de 
camcorder weer.

Version Up Execute / Cancel Updatet de camcorder.*

Execute: functie uitvoeren.
*	 Deze functie updatet de camcordersoftware.

Lens Version 
Number

Vxx Geeft het software-versienummer van 
een objectief met E-bevestiging weer.

Menu Maintenance
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Instellingen en standaardwaarden menu Shooting

Instellingen ISO/Gain en standaardwaarden

Het bereik van ISO/Gain-instellingen (pagina 77) en standaardwaarden variëren afhankelijk van de instellingen voor Mode, Target Display, Base Look >Select, en Base Sensitivity. De beschikbare 
opties worden grijs gemarkeerd.

Als Mode is ingesteld op ISO

Target Display SDR(BT.709) HDR(HLG) SDR(BT.709) en HDR(HLG) algemeen

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live / HLG Natural User1 t/m User16

Base Sensitivity Low High Low High Low High

ISO 320 ISO/Gain<L> standaard

ISO 400

ISO 500

ISO 640 ISO/Gain<M> standaard

ISO 800 ISO/Gain<L> standaard ISO/Gain<L> standaard

ISO 1000

ISO 1250 ISO/Gain<H> standaard

ISO 1600 ISO/Gain<M> standaard ISO/Gain<M> standaard

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H> standaard ISO/Gain<H> standaard

ISO 4000

ISO 5000 ISO/Gain<L> standaard

ISO 6400

ISO 8000

ISO 10000 ISO/Gain<M> standaard

ISO 12800 ISO/Gain<L> standaard ISO/Gain<L> standaard

ISO 16000

ISO 20000 ISO/Gain<H> standaard

ISO 25600 ISO/Gain<M> standaard ISO/Gain<M> standaard

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H> standaard ISO/Gain<H> standaard

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Als Mode is ingesteld op dB

Instelbereik

–3dB

–2dB

–1dB

0dB ISO/Gain<L> standaard

1dB

2dB

3dB

4dB

5dB

6dB ISO/Gain<M> standaard

7dB

8dB

9dB

10dB

11dB

12dB ISO/Gain<H> standaard

13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28 dB

29 dB

30dB
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AGC Limit-instellingen en standaardwaarden

Het bereik van AGC Limit-instellingen (pagina 79) en standaardwaarden variëren afhankelijk van de instellingen voor Mode, Target Display, Base Look >Select, en Base Sensitivity. De beschikbare 
opties worden grijs gemarkeerd.

Als Mode is ingesteld op ISO

Target Display SDR(BT.709) HDR(HLG) HDR(HLG) SDR(BT.709) en HDR(HLG) algemeen

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live HLG Natural User1 t/m User16

Base Sensitivity Low High Low High Low High Low High

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000 Standaard

ISO 2500

ISO 3200

ISO 4000

ISO 5000 Standaard Standaard Standaard

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000 Standaard

ISO 40000

ISO 51200

ISO 64000

ISO 80000 Standaard Standaard Standaard

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Als Mode is ingesteld op dB

Instelbereik

3dB

6dB

9dB

12dB

15dB Standaard

18dB

21dB

24dB

27dB

30dB
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Beeldkwaliteitsinstellingen opgeslagen voor elke opnamemodus
De huidige status van configuratie-onderdelen met betrekking tot beeldkwaliteit wordt opgeslagen voor elk van de volgende opnamemodi (pagina 24). Als u de opnamemodus wijzigt, worden de 
corresponderende instellingen die zijn opgeslagen toegepast voor de doelopnamemodus.
ˎˎ Custommodus SDR(BT.709)
ˎˎ Custommodus HDR(HLG)
ˎˎ Cine EI-modus

De configuratie-onderdelen met betrekking tot beeldkwaliteit die worden opgeslagen voor elk van de opnamemodi worden hieronder weergegeven.
Ja: het menu-onderdeel wordt opgeslagen.
Nee: het menu-onderdeel wordt niet opgeslagen.

Configuratie-onderdeel Opnamemodus

Custom modus Cine EI-modus

SDR(BT.709) HDR(HLG)

Menu Shooting ISO/Gain/EI ISO/Gain Ja1) Nee

Exposure Index Nee Ja

Base Sensitivity Ja Nee

Base ISO Nee Ja

White Preset White Ja Ja

Anders dan bovenstaand Ja

White Setting Ja

Offset White Ja Nee

LUT On/Off Nee Ja

Noise Suppression Setting(Custom) Ja Ja Nee

Level(Custom) Ja Ja Nee

Setting(Cine EI) Nee Ja

Level(Cine EI) Nee Ja

Menu Paint/Look Base Look Select Ja Ja Ja

Input2) Ja

Output2) Ja

AE Level Offset2) Ja

Black Ja Ja Nee

Knee Auto Knee Ja Nee Nee

Anders dan bovenstaand Ja Ja Nee

Detail Ja Ja Nee

Matrix Ja Ja Nee

Multi Matrix Ja Ja Nee

1)	 Afzonderlijke ISO-gevoeligheidsinstellingen worden opgeslagen voor zowel Custommodus SDR(BT.709) als HDR(HLG).
2)	 Instellingen worden opgeslagen voor elke Base Look en zijn niet afhankelijk van de opnamemodus.
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Configuratiegegevens

U kunt de instelling van het hoofdmenu 
opslaan op een geheugenkaart die is 
geplaatst in CFexpress Type A/SD kaartsleuf 
(B). U kunt een ALL-bestand ook opslaan 
naar een clouddienst. Hiermee kunt snel 
een geschikte set menu-instellingen voor de 
huidige situatie oproepen.
Configuratiegegevens worden opgeslagen in 
de volgende categorieën.

Gebruikersbestanden
Gebruikersbestanden slaan de instellingen en 
gegevens van het aanpasbare menu User op.
U kunt 64 bestanden op een geheugenkaart 
opslaan.
Door dit bestand in het geheugen van de 
camcorder te laden kunt u de configuratie van 
het menu User aanpassen.

ALL (all settings)-bestanden
ALL-bestanden slaan de configuratiegegevens 
van alle menu's op. U kunt 64 bestanden 
op een geheugenkaart opslaan. U kunt 
120 bestanden opslaan naar C3 Portal 
(clouddienst), onderverdeeld als 60 
privébestanden en 60 gedeelde bestanden.

[Opmerking]
Voor nadere gegevens over wat er in een ALL-bestand 
is opgeslagen raadpleegt u "Menu-onderdelen die in 
bestanden worden opgeslagen" (pagina 126).

Een gebruikersbestand/ALL-
bestand opslaan

Opslaan naar een geheugenkaart

1	 Plaats een geheugenkaart in de CFexpress 
Type A/SD kaartsleuf (B) (pagina 6).
ˎˎ Bij CFexpress-kaarten wijst het etiket 
naar links.
ˎˎ Voor SD-kaarten wijst het etiket naar 
rechts met de schuin afgeplatte hoek 
aan de onderkant.

2	 Selecteer voor een gebruikersbestand 
User File >Save to Media(B) (pagina 89) 
>Execute in het menu Project van het 
hoofdmenu.
Selecteer voor een ALL-bestand All File 
>Save to Media(B) (pagina 89) >Execute 
in het menu Project van het hoofdmenu.
Er verschijnt een doelscherm voor 
bestanden opslaan.

3	 Selecteer een regel met "No File" in het 
doelscherm voor bestanden.
Het selecteren van een regel met een 
Bestands-ID overschrijft het betreffende 
bestand.
De bestands-id die wordt toegewezen bij 
het opslaan kan worden gewijzigd met 
het menu. Zie voor details over 
configuratie "De File ID wijzigen" 
(pagina 114).

4	 Selecteer Execute in het 
bevestigingsscherm.

Een ALL-bestand opslaan naar een 
clouddienst

1	 Maak verbinding met het apparaat vanuit 
de smartphone-app "C3 Portal App" 
(pagina 67).

2	 Selecteer All File >Save to Cloud(Private) 
of Save to Cloud(Share) (pagina 89) 
>Execute in het menu Project van het 
hoofdmenu.
Er verschijnt een doelscherm voor 
bestanden opslaan.

3	 Selecteer een regel met "No File" in het 
doelscherm voor bestanden.
Het selecteren van een regel met een 
Bestands-ID overschrijft het betreffende 
bestand.
De bestands-id die wordt toegewezen bij 
het opslaan kan worden gewijzigd met 
het menu. Zie voor details over 
configuratie "De File ID wijzigen" 
(pagina 114).

4	 Selecteer Execute in het 
bevestigingsscherm.

Een gebruikersbestand/ALL-
bestand laden

Laden vanaf een geheugenkaart

1	 Plaats een geheugenkaart waarop een 
bestand is opgeslagen in de CFexpress 
Type A/SD-kaartsleuf (B) (pagina 6).
ˎˎ Bij CFexpress-kaarten wijst het etiket 
naar links.
ˎˎ Voor SD-kaarten wijst het etiket naar 
rechts met de schuin afgeplatte hoek 
aan de onderkant.

2	 Selecteer voor een gebruikersbestand 
User File >Load from Media(B) 
(pagina 89) >Execute in het menu 
Project van het hoofdmenu.
Selecteer voor een ALL-bestand All File 
>Load from Media(B) (pagina 89) 
>Execute in het menu Project van het 
hoofdmenu.
Er verschijnt een scherm met een 
bestandslijst.

3	 Selecteer een te laden bestand.
Er verschijnt een bevestigingsscherm.

4	 Selecteer Execute.

[Opmerkingen]
ˎˎ Het apparaat start automatisch opnieuw na het laden 

van de configuratiegegevens.
ˎˎ Als All File >Load Network Data in het menu Project 

van het hoofdmenu is ingesteld op Off, worden alle 
instellingen in het ALL-bestand geladen, behalve de 
instellingen voor het menu Network.

Configuratiegegevens opslaan en laden
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Een ALL-bestand laden van een 
clouddienst

1	 Maak verbinding met het apparaat vanuit 
de smartphone-app "C3 Portal App" 
(pagina 67).

2	 Selecteer All File >Load from 
Cloud(Private) of Load from Cloud(Share) 
(pagina 89) >Execute in het menu 
Project van het hoofdmenu.
Er verschijnt een scherm met een 
bestandslijst.

3	 Selecteer een te laden bestand.
Er verschijnt een bevestigingsscherm.

4	 Selecteer Execute.

[Opmerkingen]
ˎˎ Het apparaat start automatisch opnieuw na het laden 

van de configuratiegegevens.
ˎˎ Als All File >Load Network Data in het menu Project 

van het hoofdmenu is ingesteld op Off, worden alle 
instellingen in het ALL-bestand geladen, behalve de 
instellingen voor het menu Network.

De File ID wijzigen

1	 Selecteer voor een gebruikersbestand 
User File >File ID (pagina 89) in het 
menu Project van het hoofdmenu.
Selecteer voor een ALL-bestand All File 
>File ID (pagina 89) in het menu Project 
van het hoofdmenu.
Er verschijnt een scherm voor het 
bewerken van de File ID.

2	 Selecteer een teken met de 
keuzeschakelaar (pagina 7) of de 
multifunctionele regelaar (pagina 5) 
en druk vervolgens op de 
toepassingsknop van de keuzeschakelaar 
of multifunctionele regelaar.

3	 Herhaal zo nodig stap 2.

4	 Selecteer Done als u klaar bent met het 
invoeren van tekens.
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Aansluiting externe monitors en opname-apparaten
Om opgenomen/af te spelen beelden op een 
externe monitor af te spelen, selecteert u het 
camcorder-uitgangssignaal en gebruikt u de 
juiste kabel om de monitor aan te sluiten.
U kunt ook opnameapparaten aansluiten, 
zoals een videorecorder en het 
uitgangssignaal van de camcorder opnemen.
U kunt op een externe monitor dezelfde 
informatie weergeven als zichtbaar is in de 
zoeker, zoals statusinformatie en menu's. 
Zet Info. Disp. (pagina 15) op het scherm 
Monitoring Status of Output Display 
(pagina 94) in het menu Monitoring van het 
hoofdmenu op On, afhankelijk van het signaal 
dat naar de monitor moet worden verzonden.

[Opmerking]
Houd rekening met het volgende als u een externe 
monitor of extern opnameapparaat aansluit op het 
apparaat. Anders kunnen de interne stroomkringen van 
het apparaat beschadigd raken.
–– Gebruik een gelijkstroomkabel met een lage GND-

lijnimpedantie om een externe monitor of extern 
opnameapparaat aan te sluiten.

–– Voordat u een 75 Ω-coaxkabel of HDMI-kabel aansluit, 
controleert u of er geen potentiaalverschil bestaat 
tussen het apparaat en de behuizing van de externe 
monitor of opnameapparaat.

–– Voordat u een 75 Ω-coaxkabel of HDMI-kabel aansluit, 
controleert u dat het apparaat en de externe monitor 
of opnameapparaat zijn uitgeschakeld. Sluit alle 
kabels aan en schakel dan de apparaten in.

Neem contact op met een Sony-
servicevertegenwoordiger voor meer informatie.

SDI OUT-aansluiting (BNC type)

Stel de instelling on/off voor de uitgang en 
de uitvoerindeling in het menu Monitoring in 
(pagina 94).
Gebruik voor de aansluiting een commercieel 
verkrijgbare 75 Ω coaxkabel.

Opnemen op de camcorder en het 
externe apparaat tegelijkertijd starten

Stel met SDI signaaluitvoer ingeschakeld 
de instelling SDI/HDMI Rec Control 
(pagina 86) >Setting in het menu Project 
van het hoofdmenu op SDI/HDMI Remote 
I/F of Parallel Rec om uitvoer van een REC 
triggersignaal naar het op de SDI OUT 
aangesloten externe apparaat in te schakelen. 
Dit synchroniseert opname van het externe 
apparaat met de camcorder.

[Opmerkingen]
ˎˎ Als een aangesloten extern apparaat geen 

ondersteuning biedt voor een REC triggersignaal, kan 
het apparaat niet worden bediend.
ˎˎ Als er geen medium is geplaatst wordt alleen het REC 

triggersignaal verzonden.

HDMI OUT-aansluiting (Type A 
aansluiting)

Stel de instelling On/Off voor de uitgang en 
de uitvoerindeling in het menu Monitoring 
(pagina 94) of in het hoofdmenu in.

Opnemen op de camcorder en het 
externe apparaat tegelijkertijd starten

Stel met HDMI signaaluitvoer ingeschakeld 
HDMI TC Out >Setting (pagina 92) in het 
menu TC/Media van het hoofdmenu in op 
On, en stel SDI/HDMI Rec Control >Setting 
(pagina 86) in het menu Project in op 
SDI/HDMI Remote I/F of Parallel Rec, om 
uitvoer van een REC triggersignaal naar het 
op de HDMI OUT aangesloten apparaat in te 
schakelen. Dit synchroniseert opname van het 
externe apparaat met de camcorder.

[Opmerkingen]
ˎˎ Als een aangesloten extern apparaat geen 

ondersteuning biedt voor een REC triggersignaal, kan 
het apparaat niet worden bediend.
ˎˎ Wanneer dit is ingesteld op SDI/HDMI Remote I/F 

wordt alleen het REC-triggersignaal verzonden 
wanneer er geen medium is geplaatst.
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U kunt de tijdcode van het apparaat met 
andere apparaten synchroniseren.

De tijdcode met die van andere 
apparaten vergrendelen

Stel het apparaat dat de tijdcode verzendt in 
op een modus waarin de tijdcodeverzending 
actief blijft (zoals Free Run of Clock).

1	 Stel Timecode (pagina 92) in het menu 
TC/Media van het hoofdmenu als volgt in.
Mode: Preset
Run: Free Run

2	 Druk op de toewijsbare knop 
(pagina 49) die is toegewezen aan de 
functie DURATION/TC/U-BIT om de 
tijdcode op het scherm weer te geven.

3	 Controleer of de selectieschakelaar TC IN/
OUT (pagina 4) is ingesteld op de 
IN-stand, en lever daarna een 
referentietijdcode voor synchronisatie van 
de systeemfrequentie van de camcorder 
naar de TC IN/TC OUT-aansluiting.

De tijdcodegenerator van de camcorder 
verkrijgt vergrendeling met de 
referentietijdcode en "EXT-LK" verschijnt op 
het scherm.
Als er ongeveer tien seconden zijn verstreken 
nadat de tijdcode is vergrendeld, wordt de 
externe vergrendelingsstaat behouden, zelfs 
als de bron van de externe referentietijdcode 
wordt losgekoppeld.

[Opmerkingen]
ˎˎ Bij gebruik met externe vergrendeling ontvangt de 

tijdcode onmiddellijk vergrendeling met de externe 
tijdcode en de waarde van de externe tijdcode 
verschijnt in het gegevensweergavegebied. Start 
de opname echter niet onmiddellijk. Wacht een 
paar seconden tot de tijdcodegenerator stabiliseert, 
alvorens op te nemen.
ˎˎ Als de frequentie van de referentietijdcode en de 

framefrequentie op de camcorder niet hetzelfde zijn, 
kan geen vergrendeling worden ontvangen en zal de 
camcorder niet goed werken. Als dit zich voordoet, 
ontvangt de tijdcode geen succesvolle vergrendeling 
met de externe tijdcode.
ˎˎ De tijdcode mag één frame per uur verspringen ten 

opzichte van de referentietijdcode.

Externe vergrendeling vrijgegeven

Verander de instelling Timecode in het menu 
TC/Media van het hoofdmenu.
Externe synchronisatie wordt ook vrijgegeven 
als de systeemfrequentie wordt gewijzigd 
en als opname wordt gestart in een speciale 
opnamemodus (Slow & Quick Motion of 
Interval Rec).

De tijdcode van een ander 
apparaat synchroniseren met de 
tijdcode van de camcorder

Stel het apparaat dat de tijdcode verzendt in 
op een modus waarin de tijdcodeverzending 
actief blijft (zoals Free Run of Clock).

1	 Stel de tijdcode van de camcorder in met 
Timecode (pagina 92) in het menu TC/
Media van het hoofdmenu.

2	 Controleer of de selectieschakel TC IN/
OUT (pagina 4) is ingesteld op de 
OUT-stand, en sluit de TC IN/TC OUT-
aansluiting aan op de tijdcode-ingang van 
het apparaat dat u wilt synchroniseren.

Tijdcodes synchroniseren
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Aansluiten met behulp van een 
USB-kabel

Een kaartlezer gebruiken (optie)

Sluit een CFexpress-kaartlezer of een SD-
kaartlezer aan op een computer met een 
USB-kabel en plaats een geheugenkaart in 
de sleuf van de kaartlezer. De geheugenkaart 
wordt herkend als een extern station van de 
computer. Op computers die dit ondersteunen 
kunnen clips op hoge snelheid worden 
geïmporteerd in de massaopslagmodus van 
de camcorder.

Massaopslagmodus gebruiken

[Opmerking]
Massa-opslag modus kan niet worden gebruikt 
als Modem >Setting in het menu Network van het 
hoofdmenu is ingesteld op On, of als Wired LAN >Setting 
in het menu Network is ingesteld op On. Zet deze beide 
op Off.

Sluit de camcorder aan met een USB-kabel en 
plaats een geheugenkaart in kaartsleuf A of 
B. De geheugenkaart wordt door de computer 
herkend als een extern station.

1	 Sluit de USB-C-aansluiting (pagina 7) 
of USB/multi-aansluiting (pagina 7) 
aan op de computer met een USB-kabel.

2	 Zet de POWER-knop van de camcorder in 
de ON-stand.
Er verschijnt een melding op het 
zoekerscherm waarin wordt gevraagd of 
er een USB-verbinding tot stand moet 
worden gebracht.

	 [Opmerking]
De USB-bevestigingsmelding wordt 
niet weergegeven als er een andere 
bevestigingsmelding of voortgangsmelding wordt 
weergegeven, bijvoorbeeld bij het formatteren of 
herstellen van een geheugenkaart.
De bevestigingsmelding wordt weergegeven als 
het formatteren of herstellen is beëindigd. De 
USB-bevestigingsmelding wordt ook weergegeven 
als het scherm voor clipeigenschappen wordt 
weergegeven. De melding wordt weergegeven als 
de bewerking eindigt of als u teruggaat naar het 
pictogrammenscherm.

3	 Draai aan de multifunctionele regelaar om 
Execute te selecteren.

4	 Controleer onder Windows of de kaart is 
toegevoegd als een verwisselbare schijf in 
het venster "Deze Computer".
Controleer op Mac of er een folder met de 
naam “NO NAME” of “Untitled” 
(bewerkbaar) is toegevoegd op het 
bureaublad.

[Opmerkingen]
ˎˎ Voer de volgende handelingen niet uit als de 

toegangsindicator rood brandt.
–– De stroom uitschakelen of het netsnoer losmaken
–– De geheugenkaart verwijderen
–– De USB-kabel losmaken

ˎˎ De werking is niet gegarandeerd op alle computers.

Een non-lineair 
bewerkingssysteem gebruiken

In en non-lineair bewerkingssysteem is 
bewerkingssoftware (optie) vereist die de 
door de camcorder opgenomen indelingen 
ondersteunt.
Gebruik speciale toepassingssoftware om de 
clips die u wilt bewerken eerst op te slaan op 
de harde schijf van de computer.

Clips beheren/bewerken met behulp van een computer
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Voorzorgsmaatregelen voor gebruik
Over condensatie

Als het apparaat rechtstreeks van een koude 
in een warme omgeving wordt gebracht of 
als de omgevingstemperatuur plots stijgt, kan 
er zich vocht vormen op de buitenzijde en/
of in het toestel. Dit wordt condensvorming 
genoemd. Schakel in geval van 
condensvorming het toestel uit en gebruik het 
niet opnieuw tot de condens verdwenen is. Als 
u het toestel toch gebruikt terwijl er condens 
aanwezig is, kan het toestel beschadigd raken.

Op LCD-panelen

Het lcd-paneel van dit apparaat is met behulp 
van een hoogwaardige precisietechnologie 
vervaardigd, waardoor een werkende 
pixelratio ontstaat van minimaal 99,99%. 
Hieruit volgt dat een zeer klein gedeelte van 
de pixels vast staat; altijd uit (zwart), altijd aan 
(rood, groen of blauw) of knippert. Bovendien 
kunnen gedurende een lange gebruiksperiode 
als gevolg van de fysieke eigenschappen 
van de lcd dergelijke vaste pixels spontaan 
verschijnen. Bovenstaande punten zijn geen 
defecten. Merk op dat dergelijke problemen 
geen invloed hebben op opgenomen 
gegevens.

Camera CMOS beeldsensor-
verschijnselen

[Opmerking]
De volgende verschijnselen die kunnen voorkomen in 
afbeeldingen zijn specifiek voor beeldsensoren. Dit wijst 
niet op een storing.

Witte vlekjes
Hoewel de beeldsensors worden 
geproduceerd met hoogwaardige 
precisietechnologieën, kunnen er in zeldzame 
gevallen kleine witte vlekjes worden 
gegenereerd op het scherm, veroorzaakt door 
kosmische straling, etc.
Dit is inherent aan het principe van 
beeldsensoren en is geen defect.

De witte vlekjes kunnen vooral te zien zijn in 
de volgende gevallen:
ˎˎ Bij werken in een hoge omgevingstemperatuur
ˎˎ Als u de versterking heeft verhoogd 
(sensitivity)

Flikkering
Bij het filmen onder belichting van 
fluorescerend licht, natriumlampen, 
kwiklampen of LEDs, kan het scherm flikkeren 
of kunnen kleuren variëren.

Op verbruiksartikelen

ˎˎ De ventilator en batterij zijn 
verbruiksartikelen die af en toe vervangen 
moeten worden.  
Wanneer u het apparaat bij 
kamertemperatuur gebruikt, moeten 
deze onderdelen ongeveer elke 5 jaar 
vervangen worden. Merk op dat deze 
termijn een algemene richtlijn is en geen 
garanties biedt aangaande de levensduur 
van deze onderdelen. Neem contact op 
met een onderhoudsdienst van Sony of uw 
leverancier voor meer informatie over het 
vervangen van onderdelen.
ˎˎ De verwachte levensduur van de 
AC-adapter en de elektrolytische 
condensator is ongeveer 5 jaar bij normale 
werkingstemperaturen en normaal gebruik 
(8 uur per dag, 25 dagen per maand). Als 
het gebruik de normale gebruiksfrequentie 
overschrijdt, kan de levensduur 
dienovereenkomstig verkorten.
ˎˎ De accuaansluiting van dit apparaat (de 
aansluiting voor accusets en netadapters) is 
een verbruiksartikel.  
Het apparaat krijgt mogelijk geen stroom 
als de pennen van de accu-aansluiting 
zijn vervormd door schokken of trillingen, 
of als ze gecorrodeerd zijn als gevolg van 
langdurig gebruik in de buitenlucht.  
Periodieke inspecties worden geadviseerd 
om het apparaat goed werkend te houden 
en de bruikbare levensduur te verlengen. 
Neem contact op met een Sony service- of 
verkoopvertegenwoordiging voor meer 
informatie over inspecties.

Over de ingebouwde oplaadbare batterij

De camcorder heeft een ingebouwde 
oplaadbare batterij voor het opslaan van 
datum, tijd en andere instellingen, zelfs 
als de camcorder wordt uitgeschakeld. De 
ingebouwde oplaadbare batterij wordt 
opgeladen na 24 uur als het apparaat 
is aangesloten op een stopcontact met 
de netadapter, of als er een volledig 
opgeladen accuset is bevestigd, ongeacht 
of de camcorder is in- of uitgeschakeld. De 
oplaadbare batterij wordt volledig ontladen 
in ongeveer 2 maanden als de netadapter 
niet is aangesloten of als de camcorder 
wordt gebruikt zonder bevestigde accuset. 
Gebruik uw camcorder na het opladen van de 
batterij. Als de oplaadbare batterij echter niet 
worden opgeladen, wordt de werking van de 
camcorder niet beïnvloed zolang u de datum 
niet hoeft op te nemen.

Gebruiks- en opslaglocaties

Opslaan op een vlakke geventileerde plaats.
Vermijd gebruik of opslag op de volgende 
plaatsen.
ˎˎ In uitzonderlijke hitte of kou 
(bedrijfstemperatuurbereik: 0 °C tot 40 °C)  
Bedenk dat in de zomer in warme klimaten 
de temperatuur in een auto met gesloten 
ramen makkelijk boven de 50 °C kan komen.
ˎˎ In vochtige of stofrijke omgevingen. Locaties 
waar het apparaat blootstaat aan regen
ˎˎ Plaatsen met sterke trillingen
ˎˎ Bij sterke magnetische velden
ˎˎ Dichtbij radio- of tv-ontvangers die sterke 
elektromagnetische velden produceren.
ˎˎ Langere periodes in direct zonlicht of 
dichtbij verwarming

Opmerking over laserstralen

Laserstralen kunnen de CMOS beeldsensor 
beschadigen. Als u een scene filmt waarin 
een laserstraal voorkomt, pas dan op dat de 
laserstraal niet op de lens van het apparaat 
wordt gericht. Vooral ultrasterke laserstralen 
van medische apparatuur of andere apparaten 

kunnen schade veroorzaken, als gevolg van 
reflecterend en verstrooid licht.

Elektromagnetische interferentie van 
draagbare communicatieapparatuur 
voorkomen

Gebruik van draagbare telefoons en andere 
communicatieapparaten in de buurt van 
deze camera kan resulteren in storingen en 
interferentie met audio- en videosignalen. 
Geadviseerd wordt om de draagbare 
communicatieapparatuur in de buurt van deze 
camera uit te schakelen.

Veiligheidsmaatregelen

ˎˎ SONY IS NIET AANSPRAKELIJK VOOR 
WELKE SCHADE DAN OOK DIE 
VOORTKOMT UIT HET NIET NEMEN VAN 
VOLDOENDE BEVEILIGINGSMAATREGELEN 
OP TRANSMISSIEAPPARATEN, 
ONVERMIJDBARE GEGEVENSLEKKEN 
DOOR TRANSMISSIESPECIFICATIES OF 
BEVEILIGINGSPROBLEMEN VAN WELKE 
AARD DAN OOK.
ˎˎ Afhankelijk van de gebruiksomgeving 
kunnen onbevoegden via het netwerk 
toegang krijgen tot het apparaat. Wanneer u 
het apparaat verbinding laat maken met het 
netwerk, zorg er dan voor dat het netwerk 
goed is beveiligd.
ˎˎ De inhoud van communicatie kan zonder 
dat u dat weet worden onderschept 
door onbevoegden in de buurt van 
het signaal. Wanneer u draadloze LAN-
communicatie gebruikt, pas dan correcte 
beveiligingsmaatregelen toe om de inhoud 
van uw communicatie te beschermen.
ˎˎ Wanneer u dit product aansluit op een 
netwerk, maak dan verbinding via een 
systeem dat beveiliging biedt, zoals een 
router of firewall. Als u verbinding maakt 
zonder dergelijke bescherming kunnen 
beveiligingsproblemen ontstaan.
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Standaard fabrieksinstellingen worden vet weergegeven (bijvoorbeeld, 1920×1080P (Level A)).

[Opmerkingen]
ˎˎ De resolutie van de uitvoerindeling wordt beperkt door de instellingen Rec Format >Frequency, Video Format en 

Codec in het menu Project van het hoofdmenu (pagina 83).
ˎˎ De resolutie van de uitvoerindeling wordt bovendien beperkt door de combinatie met de S&Q-beeldsnelheid. 

Naast de tabel met uitvoerindelingen vanaf de aansluitingen SDI OUT/HDMI OUT wijzigt de HDMI-uitvoer naar Full 
HD of lager wanneer aan al de volgende voorwaarden is voldaan.
–– S&Q Motion >Setting in het menu Shooting is op On ingesteld
–– S&Q Motion >Frame Rate in het menu Shooting is hoger dan 60fps
–– Rec Format >Codec in het menu Project is ingesteld op RAW of RAW & XAVC-I, of Output On/Off >SDI in het 

menu Monitoring staat op On
ˎˎ Als aan bovenstaande voorwaarden is voldaan, worden de selectieopties HDMI-uitvoer 4096×2160P en 3840×2160P 

voor Output Format >SDI/HDMI (pagina 94) in het menu Monitoring grijs weergegeven en kunnen niet worden 
geselecteerd.
ˎˎ Het beeld wordt niet uitgevoerd als een hogere resolutie dan die van het afspeelbeeld is geconfigureerd.

Uitvoerindelingen SDI OUT/HDMI OUT-aansluitingen

Instelling voor 
systeemfrequentie
(Rec Format > 
Frequency in het 
menu Project)

Codec-instelling
(Rec Format 
>Codec in het 
menu Project)

Instelling van RAW-/
opname-indeling
(Rec Format > RAW 
Output Format/Video 
Format in het menu 
Project)

Uitvoerindeling (Output Format in 
het menu Monitoring)

SDI HDMI

50/59.94Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P 
(Level A)

(4240×2392 HDMI 
RAW)

1920×1080P 
(Level B)

1920×1080i

Instelling voor 
systeemfrequentie
(Rec Format > 
Frequency in het 
menu Project)

Codec-instelling
(Rec Format 
>Codec in het 
menu Project)

Instelling van RAW-/
opname-indeling
(Rec Format > RAW 
Output Format/Video 
Format in het menu 
Project)

Uitvoerindeling (Output Format in 
het menu Monitoring)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

4096×2160P 1920×1080i

3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

Uitvoerindelingen en beperkingen
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Instelling voor 
systeemfrequentie
(Rec Format > 
Frequency in het 
menu Project)

Codec-instelling
(Rec Format 
>Codec in het 
menu Project)

Instelling van RAW-/
opname-indeling
(Rec Format > RAW 
Output Format/Video 
Format in het menu 
Project)

Uitvoerindeling (Output Format in 
het menu Monitoring)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

1920×1080(Video) 1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

(Uitvoer 
onderbroken)

720×480P1) 2)

720×576P1) 3)

25/29.97Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)1920×1080PsF

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

1920×1080(Video) 1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

Instelling voor 
systeemfrequentie
(Rec Format > 
Frequency in het 
menu Project)

Codec-instelling
(Rec Format 
>Codec in het 
menu Project)

Instelling van RAW-/
opname-indeling
(Rec Format > RAW 
Output Format/Video 
Format in het menu 
Project)

Uitvoerindeling (Output Format in 
het menu Monitoring)

SDI HDMI

23.98Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080(Video) 1920×1080P 1920×1080P

24Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

1920×1080P

XAVC-I 4096×2160(Video) 4096×2160P1) 4096×2160P

1920×1080P 1920×1080P

1)	 De schermweergave kan niet worden opgenomen.
2)	Wanneer de systeemfrequentie 59.94 is
3)	Wanneer de systeemfrequentie 50 is
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Stroomvoorziening

Symptoom Oorzaak Oplossing

De camcorder schakelt niet 
in.

Er is geen accuset bevestigd 
en er wordt geen stroom 
geleverd via de DC IN-
aansluiting.

Bevestig een accuset (pagina 17) of 
sluit aan op netstroom met een 
netadapter (pagina 18).

De accuset is volledig 
uitgeput.

Vervang de accuset door een volledig 
opgeladen set (pagina 17).

De stroomvoorziening stopt 
tijdens gebruik.

De accuset raakt uitgeput. Vervang de accuset door een volledig 
opgeladen set (pagina 17).

De accuset raakt snel 
uitgeput.

De omgevingstemperatuur is 
erg laag.

Dit komt door de accu-eigenschappen 
en is geen defect.

De accuset is onjuist 
opgeladen.

Laad de accuset opnieuw op 
(pagina 17).
Als de accuset snel leeg is, zelfs na 
volledig opladen, is de accuset mogelijk 
aan het eind van zijn levensduur. 
Vervang door een nieuwe.

Opnemen/afspelen

Symptoom Oorzaak Oplossing

Bij het indrukken van de 
knop START/STOP wordt 
opname niet gestart.

De geheugenkaart is vol. Vervang de geheugenkaart door een 
kaart met voldoende vrije opslagruimte.

De geheugenkaart moet 
worden hersteld.

Herstel de geheugenkaart 
(pagina 33).

Audio-opname is niet 
mogelijk.

De AUDIO LEVEL (CH1/
CH2)-regelaars zijn op het 
minimumniveau ingesteld.

Pas de audio-opnameniveaus aan met 
de regelaars AUDIO LEVEL (CH1/CH2) 
(pagina 47).

Het opgenomen geluid klinkt 
vervormd.

Het audioniveau is te hoog. Pas de audio-opnameniveaus aan met 
de regelaars AUDIO LEVEL (CH1/CH2) 
(pagina 47).

Symptoom Oorzaak Oplossing

Het opgenomen geluid heeft 
een hoog ruisniveau.

Het audioniveau is te laag. Pas de audio-opnameniveaus aan met 
de regelaars AUDIO LEVEL (CH1/CH2) 
(pagina 47).
Als er een externe microfoon is 
geselecteerd, pas dan ook de instelling 
van INPUT MIC Reference aan bij Audio 
Input in het menu Audio (pagina 97).

Clips kunnen niet worden 
afgespeeld.

De clip wordt momenteel 
bewerkt.

Clips kunnen niet worden afgespeeld 
als u de bestandsnamen of mappen 
heeft gewijzigd, of als de clip in gebruik 
is op een computer. Dit is geen defect.

De clip wordt opgenomen 
op een ander apparaat.

Clips die zijn opgenomen op andere 
apparaten kunnen mogelijk niet worden 
afgespeeld of weergegeven op de 
correcte grootte. Dit is geen defect.

Externe apparaten

Symptoom Oplossing

De computer herkent de 
camcorder niet.

Koppel de USB-kabel van de computer los en steek deze er daarna 
weer stevig in.

Koppel de USB-kabel los van de computer, start de computer 
opnieuw en doorloop daarna de stappen nogmaals in de juiste 
volgorde.

Verbind de computer met de camcorder door een USB-kabel in de 
USB-C-aansluiting of de USB/multi-aansluiting te plaatsen.

Clips kunnen niet in de computer 
worden geladen.

Koppel de USB-kabel van de computer los, herstart de camcorder 
en maak opnieuw verbinding.

Om clips in de computer te kunnen importeren moet er 
toepassingssoftware op de computer zijn geïnstalleerd 
(pagina 117).

Problemen oplossen
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Draadloze LAN-verbinding

[Opmerking]
Obstakels en elektromagnetische interferentie tussen de camcorder en het draadloze LAN-toegangspunt of het 
eindapparaat of de omgeving (zoals muurmaterialen) kunnen het communicatiebereik verkorten of verbindingen in 
het geheel blokkeren. Als u deze problemen ervaart, controleer dan de verbindings-/communicatiestatus nadat u de 
camcorder naar een nieuwe locatie heeft verplaatst of de camcorder en het toegangspunt/terminalapparaat dichter 
bij elkaar heeft gebracht.

Symptoom Oplossing

Een terminal kan geen toegang 
krijgen tot de camcorder.

ˎˎ Controleer de draadloze LAN-verbinding (een IP-adres, etc.).
ˎˎ De communicatie-instellingen tussen het toegangspunt en de 
client kunnen mogelijk ongeldig zijn. Raadpleeg voor details de 
gebruiksaanwijzing van het toegangspunt.

U kunt niet op de camcorder 
inloggen.

Controleer de gebruikersnaam en het wachtwoord dat u heeft 
ingesteld.

Internetverbinding

Symptoom Oplossing

Het uploaden van een bestand 
mislukt.

De gebruikersnaam en het wachtwoord van de server zijn mogelijk 
niet correct.
Voer de correcte gebruikersnaam en wachtwoord in.

Het uploaden van bestanden is 
niet beschikbaar.

De signaalverbinding is mogelijk slecht.
Ga naar een andere locatie en probeer het opnieuw.

Bij gebruik van het ND-filter

Symptoom Oplossing

Het ND-filter beweegt niet. U kunt het filter op de volgende manier naar de Clear-stand 
verplaatsen.

1	 Zet de schakelaar POWER van de camcorder op Off.

2	 Verwijder de ronde dop aan de onderkant.

3	 Steek een schroevendraaier in de opening en draai deze naar links.
ˎˎ Het ND-filter wordt verplaatst naar de Clear-stand door het draaien naar links. Blijf draaien 
tot de Clear-stand is bereikt.
ˎˎ Gebruik een schroevendraaier met een diameter van 2,4 mm of minder. De 
schroevendraaier moet ongeveer 3,0 cm in de opening kunnen verzinken.

Schroefgat
(met dop verwijderd)

4	 Zet de schakelaar ND PRESET/VARIABLE (pagina 5) in de stand PRESET, en zet de 
omhoog/omlaag-knoppen voor ND FILTER POSITION (pagina 5) op de stand CLEAR.

[Opmerkingen]
ˎˎ Gebruik de bovenstaande procedure niet tijdens normaal gebruik. Gebruik deze procedure alleen als het ND-filter 

niet wil bewegen. Het ND-filter kan beschadigd raken als deze procedure wordt gebruikt tijdens normaal gebruik.
ˎˎ Neem na het gebruiken van bovenstaande procedure contact op met een Sony service center om de camcorder te 

laten repareren.
ˎˎ Als er na het uitvoeren van de bovenstaande procedure nog steeds een foutmelding verschijnt, kan er nog wel 

worden gefilmd.
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Als op de camcorder een waarschuwing of bedieningssituatie optreedt die moet worden 
bevestigd, wordt een bericht weergegeven in de zoeker, begint het opname/tally-controlelampje 
te knipperen en klinkt er een waarschuwingsgeluid.
Het waarschuwingsgeluid wordt weergegeven via de hoofdtelefoon die is aangesloten op de 
hoofdtelefoonaansluiting.

Foutmeldingen

De camcorder stopt met werken als de volgende schermen worden weergegeven.

Zoekermelding Waarschu-
wingsgeluid

Opname/
tally-lampje

Oorzaak en oplossing

E + foutcode Continu Snel 
knipperen

Geeft een abnormale situatie in de camcorder 
aan. Opname stopt, zelfs als REC wordt 
weergegeven in de zoeker.
Schakel de camcorder uit en controleer op 
problemen met aangesloten apparaten, kabels of 
media. Als de fout aanhoudt als de camcorder 
weer opnieuw wordt ingeschakeld, neem dan 
contact op met uw Sony 
servicevertegenwoordiger.
(Als de camcorder niet uitschakelt als de knop 
POWER op OFF wordt gezet, verwijder dan de 
accu of koppel de netadapter los.)
Afhankelijk van de status van de camcorder wordt 
er mogelijk geen weergave van de fout of 
waarschuwingsgeluid weergegeven.

Waarschuwingsmeldingen

Volg de instructies als het volgende scherm wordt weergegeven.

Zoekermelding Waarschu-
wingsgeluid

Opname/
tally-lampje

Oorzaak en oplossing

Battery Near End Periodiek Knippert De resterende capaciteit van de accuset wordt 
minder.
Zo snel mogelijk opladen.

Battery End Continu Snel 
knipperen

De accuset is leeg. Opname is uitgeschakeld.
Stop gebruik en vervang de accuset.

Temperature High Periodiek Knippert De interne temperatuur is hoog.
Schakel de camcorder uit en laat deze afkoelen 
voordat u hem opnieuw gebruikt.

Zoekermelding Waarschu-
wingsgeluid

Opname/
tally-lampje

Oorzaak en oplossing

Media Temperature 
High

Periodiek Knippert De temperatuur van de CFexpress geheugenkaart 
is hoog.
Vervang de kaart of laat deze afkoelen, alvorens 
opnieuw te gebruiken.

Voltage Low Periodiek Knippert Het ingangsvoltage (DC IN) is laag (level 1). 
Controleer de stroombron.

Insufficient Voltage Continu Snel 
knipperen

Het ingangsvoltage (DC IN) is laag (level 2). 
Opname is uitgeschakeld.
Sluit een andere stroombron aan.

Media Near Full Periodiek Knippert De resterende capaciteit van de geheugenkaart 
wordt lager.
Zo snel mogelijk vervangen.

Media Full Continu Snel 
knipperen

Clips konden niet worden opgenomen of 
gekopieerd omdat de resterende capaciteit op de 
geheugenkaart onvoldoende is.
Onmiddellijk vervangen.

Clips Near Full Periodiek Knippert Het aantal aanvullende clips dat kan worden 
opgenomen op de geheugenkaart wordt minder.
Zo snel mogelijk vervangen.

Clips Full Continu Snel 
knipperen

Het maximale aantal clips dat kan worden 
opgenomen op de geheugenkaart is bereikt.
Opnemen of kopiëren van meer clips is niet 
mogelijk. Onmiddellijk vervangen.

Last Clip Recording Periodiek Knippert De clip die momenteel wordt opgenomen is de 
laatste clip die kan worden opgenomen, omdat 
het maximale aantal clips is bereikt.
Prepareer een nieuwe geheugenkaart.

Media(A)1) Life Near 
End

Periodiek Knippert De levensduur van de geheugenkaart is bijna 
verstreken. Zo snel mogelijk vervangen.

Media(A)1) Life End Continu Snel 
knipperen

De levensduur van de geheugenkaart is 
verstreken. Onmiddellijk vervangen.

Media(A)1) Near Full Periodiek Knippert Bij gebruik van de functie Simul Rec

Media(A)1) Full Continu Snel 
knipperen

Bij gebruik van de functie Simul Rec

Media(A)1) Clips Near 
Full

Periodiek Knippert Bij gebruik van de functie Simul Rec

Media(A)1) Clips Full Continu Snel 
knipperen

Bij gebruik van de functie Simul Rec

Media(A)1) Last Clip 
Rec

Periodiek Knippert Bij gebruik van de functie Simul Rec

Transfer Jobs Near 
Full

– – Het aantal FTP-bestandsoverdrachtstaken dat kan 
worden vastgelegd begint krap te worden.

Fout-/waarschuwingsmeldingen
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Zoekermelding Waarschu-
wingsgeluid

Opname/
tally-lampje

Oorzaak en oplossing

Transfer Jobs Full – – Het aantal FTP-bestandsoverdrachtstaken dat kan 
worden vastgelegd heeft de bovenste grens 
bereikt. Wilt u nog een taak vastleggen, verwijder 
dan eerst ongewenste taken.2)

1)	 “(B)” wordt weergegeven voor de kaart in kaartsleuf B.
2)	U kunt taken selecteren en verwijderen met File Transfer >View Job List (pagina 106) in het menu Network van 

het hoofdmenu. U kunt ook taken verwijderen uit de CBM-takenlijst.

Waarschuwings- en systeemmeldingen

De volgende waarschuwings- en systeemmeldingen kunnen op het scherm verschijnen. 
Volg de vermelde aanwijzingen om het probleem op te lossen.

Melding op het scherm Oorzaak en oplossing

Battery Error
Please Change Battery

Er is een fout gedetecteerd in de accuset.
Vervangen door een normale accuset.

Backup Battery End
Please Change

De resterende capaciteit van de back-upaccu is onvoldoende.
Laad de back-upaccu op.

Unknown Media (A) 1)

Please Change
Er is een geheugenkaart geplaatst die is gepartitioneerd of 
een geheugenkaart die meer clips bevat dan door de 
camcorder wordt ondersteund.
De kaart kan niet worden gebruikt in de camcorder en moet 
worden vervangen.

Cannot Use Media (A) 1)

Unsupported File System
Er is een niet-geformatteerde kaart geplaatst of een kaart die 
een ander bestandsysteem ondersteunt.
De kaart kan niet worden gebruikt door de camcorder en 
moet worden vervangen of worden geformatteerd met de 
camcorder.

Media Error
Media (A) 1) Needs to be Restored

Er heeft zich een fout voorgedaan op de geheugenkaart en de 
kaart moet worden hersteld.
Herstel de geheugenkaart.

Media Error
Cannot Record to Media (A) 1)

De geheugenkaart is mogelijk beschadigd en kan niet langer 
worden gebruikt voor opname.
Afspelen is mogelijk, dus maak een kopie. Vervangen van de 
geheugenkaart wordt geadviseerd.

Media Error
Cannot Use Media (A) 1)

De geheugenkaart is mogelijk beschadigd en kan niet langer 
worden gebruikt voor opname of afspelen.
De kaart kan niet worden gebruikt in de camcorder en moet 
worden vervangen.

Media (A) 1) Error
Recording Halted
Playback Halted

Opnemen en afspelen is gestopt omdat zich een fout heeft 
voorgedaan bij gebruik van de geheugenkaart.
Als het probleem aanhoudt, vervang dan de geheugenkaart.

Media Reached Rewriting Limit
Change Media (A) 1)

De levensduur van de geheugenkaart is verstreken.
Maak een backup en vervang de geheugenkaart onmiddellijk. 
Als u de kaart blijft gebruiken kan er mogelijk niet meer 
worden opgenomen of afgespeeld.
Raadpleeg voor details de gebruiksaanwijzing van de 
geheugenkaart.

The specified address is invalid. Het opgegeven adres is ongeldig.
Controleer of de instelling correct is.

Cannot Use Specified Port Number Het aangegeven poortnummer is ongeldig.
Controleer of de instelling correct is.



8. Appendix: Fout-/waarschuwingsmeldingen125

Melding op het scherm Oorzaak en oplossing

Fan Stopped De ingebouwde ventilator is gestopt.
Vermijd gebruik op hoge temperaturen, koppel de stroom los 
en neem contact op met uw Sony servicevertegenwoordiger.

Lens I/F Error(xx:xx) Er is een objectieffout gedetecteerd bij de I/F-communicatie 
van het objectief bij bevestiging van een objectief met 
E-bevestiging.
Controleer de status van de verbinding met het objectief met 
E-bevestiging.
Als het probleem aanhoudt, neem dan contact op met uw 
Sony servicevertegenwoordiger en vermeld de foutcode (vijf 
tekens tussen haakjes).

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Er is een incompatibel accessoire gedetecteerd.
Het enige Multi Terminal-accessoire dat door het apparaat 
wordt ondersteund is de meegeleverde 
afstandsbedieningsgreep.

Failed Deze fout verschijnt mogelijk als een adres niet kan worden 
bereikt met DHCP op On.
Controleer de DHCP serverinstellingen.

Addition of auto upload job failed. Het maximale aantal overdrachten is bereikt.
Wis niet gewenste overdrachten. De instelling voor 
automatische uploadbestemming voor origineel bestanden of 
voor proxybestanden is mogelijk ook incorrect. Controleer of 
de instelling correct is.

<SSID>Not found. Netwerk (toegangspunten) met de gespecificeerde <SSID> 
kon niet worden gevonden.
Controleer of de instelling correct is.

<SSID>Authentication Failed Verificatie van de verbinding op het netwerk (toegangspunt) 
met de gespecificeerde <SSID> is mislukt.
Controleer of het wachtwoord en andere instellingen correct 
zijn.

An IP address conflict has occurred. 
Please check the network settings.

Er is een conflict tussen netwerkadressen van draadloos LAN, 
bekabeld LAN of USB-tethering.
Wijzig het adres handmatig of wijzig de instellingen voor de 
netwerkrouter.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

Het IP-adres van het draadloze LAN-toegangspunt is 
gewijzigd als gevolg van een conflict in de netwerkadressen 
van de draadloze LAN-toegangspuntmodus, het draadloze 
LAN of de USB-tethering.
Controleer de instelling van het IP-adres.

1)	 "(B)" wordt weergegeven voor de kaart in kaartsleuf B.
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Onderdelen die in het hoofdmenu zijn geconfigureerd

Ja: het menu-onderdeel wordt opgeslagen.
Nee: het menu-onderdeel wordt niet opgeslagen.
–: Niet opgeslagen (tijdelijke instelling)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Ja Nee

ISO/Gain<H> Ja Nee

ISO/Gain<M> Ja Nee

ISO/Gain<L> Ja Nee

Exposure Index<H> Ja Nee

Exposure Index<M> Ja Nee

Exposure Index<L> Ja Nee

Shockless Gain Ja Nee

Base Sensitivity Ja Nee

Base ISO Ja Nee

ND Filter Preset1 Ja Nee

Preset2 Ja Nee

Preset3 Ja Nee

Shutter Mode Ja Nee

Shutter Speed On/Off Ja Nee

Shutter Speed Ja Nee

Shutter Angle Ja Nee

ECS On/Off Ja Nee

ECS Frequency Ja Nee

Iris Bokeh Control Nee Nee

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Ja Nee

Mode Ja Nee

Speed Ja Nee

AGC Ja Nee

AGC Limit Ja Nee

AGC Point Ja Nee

Auto Shutter Ja Nee

A.SHT Limit Ja Nee

A.SHT Point Ja Nee

Clip High light Ja Nee

Detect Window Ja Nee

Detect Window Indication Ja Nee

Custom Width Ja Nee

Custom Height Ja Nee

Custom H Position Ja Nee

Custom V Position Ja Nee

White Preset White Ja Nee

Color Temp <A> Ja Nee

Tint<A> Ja Nee

R Gain <A> Ja Nee

B Gain <A> Ja Nee

Color Temp <B> Ja Nee

Tint<B> Ja Nee

R Gain <B> Ja Nee

B Gain <B> Ja Nee

White Setting Shockless White Ja Nee

ATW Speed Ja Nee

White Switch<B> Ja Nee

Filter White Memory Ja Nee

Menu-onderdelen die in bestanden worden opgeslagen
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Ja Nee

Offset Color Temp<A> Ja Nee

Offset Tint<A> Ja Nee

Offset White <B> Ja Nee

Offset Color Temp<B> Ja Nee

Offset Tint<B> Ja Nee

Offset White<ATW> Ja Nee

Offset Color Temp<ATW> Ja Nee

Offset Tint<ATW> Ja Nee

Focus AF Transition Speed Ja Nee

AF Subj. Shift Sens. Ja Nee

Focus Area Ja Nee

Focus Area (AF-S) Ja Nee

Face/Eye Detection AF Ja Nee

Push AF Mode Ja Nee

Touch Function in MF Ja Nee

AF Assist Ja Nee

S&Q Motion Setting Ja Nee

Frame Rate Ja Nee

LUT On/Off SDI/HDMI Ja Nee

VF/Proxy/Stream Ja Nee

Internal Rec Ja Nee

Noise Suppression Setting(Custom) Ja Nee

Level(Custom) Ja Nee

Setting(Cine EI) Ja –

Level(Cine EI) Ja –

Flicker Reduce Mode Ja Nee

Frequency Ja Nee

SteadyShot Setting Ja Nee

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Ja –

Target Display Ja –

Rec Format Frequency Ja Nee

Imager Scan Mode Ja Nee

Codec Ja Nee

RAW Output Format Ja Nee

Video Format Ja Nee

Cine EI Setting Color Gamut Ja –

HDR Setting VF SDR Preview Ja Nee

SDR Gain Ja Nee

Simul Rec Setting Ja Nee

Rec Button Set Ja Nee

Proxy Rec Setting Ja Nee

Audio Channel Ja Nee

Chunk Ja Nee

Interval Rec Setting Nee Nee

Interval Time Ja Nee

Number of Frames Ja Nee

Pre-Lighting Ja Nee

Picture Cache Rec Setting Ja Nee

Cache Size Ja Nee

Cache Rec Time – –

SDI/HDMI Rec Control Setting Ja Nee

Assignable Button <1> Ja Nee

<2> Ja Nee

<3> Ja Nee

<4> Ja Nee

<5> Ja Nee

<6> Ja Nee

<7> Ja Nee

<8> Ja Nee

<9> Ja Nee

Focus Hold Button Ja Nee

Assignable Dial Grip/Remote Dial Ja Nee

Grip Dial Direction Ja Nee

Handle Dial Ja Nee

Handle Dial Direction Ja Nee

Multi Function Dial Default Function Ja Nee
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project User File Load from Media(B) – –

Save to Media(B) – –

File ID Nee Nee

Load Customize Data Ja Nee

Load White Data Ja Nee

All File Load from Media(B) – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Save to Media(B) – –

Save to Cloud(Private) – –

Save to Cloud(Share) – –

File ID Ja Nee

Load Network Data Nee Nee

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Ja Ja

Delete – –

Delete All – –

Import from Media(B) – –

Import from Cloud(Private) – –

Import from Cloud(Share) – –

Input Ja Ja

Output Ja Ja

AE Level Offset Ja Ja

Reset Paint Settings Reset without Base Look – –

Black Master Black Ja Ja

R Black Ja Ja

B Black Ja Ja

Knee Setting Ja Ja

Auto Knee Ja Ja

Point Ja Ja

Slope Ja Ja

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Detail Setting Ja Ja

Level Ja Ja

Manual Setting Ja Ja

V/H Balance Ja Ja

B/W Balance Ja Ja

Limit Ja Ja

Crispening Ja Ja

High Light Detail Ja Ja

Matrix User Matrix Ja Ja

User Matrix Level Ja Ja

User Matrix Phase Ja Ja

User Matrix R-G Ja Ja

User Matrix R-B Ja Ja

User Matrix G-R Ja Ja

User Matrix G-B Ja Ja

User Matrix B-R Ja Ja

User Matrix B-G Ja Ja

Multi Matrix Setting Ja Ja

Reset – –

Axis Nee Ja

Hue Ja Ja

Saturation Ja Ja

TC/Media Timecode Mode Ja Nee

Run Ja Nee

Setting Nee Nee

Reset – –

TC Format Ja Nee

TC Display Display Select Ja Nee

Users Bit Mode Ja Nee

Setting Nee Nee

HDMI TC Out Setting Ja Nee

Clip Name Format Title Prefix Ja Nee

Number Set Nee Nee

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Output On/Off SDI Ja Nee

HDMI Ja Nee

Output Format SDI Ja Nee

HDMI Ja Nee

Output Display SDI Ja Nee

HDMI Ja Nee

Display On/Off Network Status Ja Nee

File Transfer Status Ja Nee

Rec/Play Status Ja Nee

RAW Output Control Status Ja Nee

Tally Ja Nee

Battery Remain Ja Nee

Focus Mode Ja Nee

Focus Position Ja Nee

Focus Area Indicator Ja Nee

Focus Area Ind.(AF-S) Ja Nee

Face/Eye Detection Frame Ja Nee

Lens Info Ja Nee

Imager Scan Mode Ja Nee

Rec Format Ja Nee

Frame Rate Ja Nee

Zoom Position Ja Nee

UWP RF Level Ja Nee

SteadyShot Ja Nee

Base Look/LUT Ja Nee

SDI/HDMI Rec Control Ja Nee

Gamma Display Assist Ja Nee

Proxy Status Ja Nee

Base ISO/Sensitivity Ja Nee

Media Status Ja Nee

Video Signal Monitor Ja Nee

Clip Name Ja Nee

White Balance Ja Nee

Scene File Ja Nee

Focus Indicator Ja Nee

Auto Exposure Mode Ja Nee

Auto Exposure Level Ja Nee

Timecode Ja Nee

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off ND Filter Ja Nee

Iris Ja Nee

ISO/Gain/EI Ja Nee

Shutter Ja Nee

Level Gauge Ja Nee

Audio Level Meter Ja Nee

Video Level Warning Ja Nee

Clip Number Ja Nee

Notice Message Ja Nee

Marker Setting Ja Nee

Color Ja Nee

Center Marker Ja Nee

Safety Zone Ja Nee

Safety Area Ja Nee

Aspect Marker Ja Nee

Aspect Mask Ja Nee

Aspect Safety Zone Ja Nee

Aspect Safety Area Ja Nee

Aspect Select Ja Nee

Custom Aspect Ratio Ja Nee

Guide Frame Ja Nee

100% Marker Ja Nee

User Box Ja Nee

User Box Width Ja Nee

User Box Height Ja Nee

User Box H Position Ja Nee

User Box V Position Ja Nee

VF Setting Brightness Ja Nee

Color Mode Ja Nee

Gamma Display Assist Setting Ja Nee

Peaking Setting Ja Nee

Peaking Level Ja Nee

Color Ja Nee

Zebra Setting Ja Nee

Zebra1 Level Ja Nee

Zebra1 Aperture Level Ja Nee

Zebra2 Level Ja Nee
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Ja Nee

CH2 Input Select Ja Nee

CH3 Input Select Ja Nee

CH4 Input Select Ja Nee

INPUT1 MIC Reference Ja Nee

INPUT2 MIC Reference Ja Nee

Line Input Reference Ja Nee

Reference Level Ja Nee

CH1 Wind Filter Ja Nee

CH2 Wind Filter Ja Nee

CH3 Wind Filter Ja Nee

CH4 Wind Filter Ja Nee

CH3 Level Control Ja Nee

CH4 Level Control Ja Nee

CH3 Input Level Ja Nee

CH4 Input Level Ja Nee

Audio Input Level Ja Nee

Limiter Mode Ja Nee

CH1&2 AGC Mode Ja Nee

CH3&4 AGC Mode Ja Nee

AGC Spec Ja Nee

1kHz Tone on Color Bars Ja Nee

CH1 Level Ja Nee

CH2 Level Ja Nee

CH3 Level Ja Nee

CH4 Level Ja Nee

Audio Output Monitor CH Ja Nee

Volume Nee Nee

Headphone Out Ja Nee

Alarm Level Ja Nee

HDMI Output CH Ja Nee

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Ja –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Color Bars Setting Nee Nee

Type Ja Nee

ND Dial CLEAR with Dial Ja Nee

Tally Front Ja Nee

Rear Ja Nee

HOLD Switch Setting with Rec Button Ja Nee

with Hand Grip Remote Ja Nee

Handle HOLD Switch Ja Nee

Touch Operation Setting Ja Nee

Rec Review Setting Ja Nee

Zoom Zoom Type Ja Nee

Handle Zoom Setting Ja Nee

High Ja Nee

Low Ja Nee

Menu Settings User Menu Only Ja Nee

User Menu with Lock Nee Nee

Menu Page On/Off Main Ja Nee

Camera Ja Nee

Audio Ja Nee

Project Ja Nee

Monitoring Ja Nee

Assignable Button Ja Nee

Battery Ja Nee

Media Ja Nee

Network Ja Nee

File Transfer Ja Nee

Fan Control Setting Ja Nee

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Lens Zoom Ring Direction Ja Nee

Shading Compensation Ja Nee

Chroma Aberration Comp. Ja Nee

Distortion Comp. Ja Nee

Breathing Compensation Ja Nee

Distance Display Ja Nee

Zoom Position Display Ja Nee

Video Light Set Video Light Set Ja Nee

APR APR – –

Camera Battery Alarm Low Battery Ja Nee

Battery Empty Ja Nee

Camera DC IN Alarm DC Low Voltage1 Ja Nee

DC Low Voltage2 Ja Nee

Network Setup for Mobile App Setup – –

Access Authentication User Name Nee Nee

Input Password Nee Nee

Generate Password – –

Show Settings – –

Wireless LAN Setting Ja Nee

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Ja Nee

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Ja Nee

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Nee Nee

DHCP Ja Nee

IP Address Ja Nee

Subnet Mask Ja Nee

Gateway Ja Nee

DNS Auto Ja Nee

Primary DNS Server Ja Nee

Secondary DNS Server Ja Nee

Manual Register

SSID Ja Nee

Security Ja Nee

Password Nee Nee

DHCP Ja Nee

IP Address Ja Nee

Subnet Mask Ja Nee

Gateway Ja Nee

DNS Auto Ja Nee

Primary DNS Server Ja Nee

Secondary DNS Server Ja Nee

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Ja Nee

Camera Remote Control Ja Nee

Detail Settings

DHCP Ja Nee

IP Address Ja Nee

Subnet Mask Ja Nee

Gateway Ja Nee

DNS Auto Ja Nee

Primary DNS Server Ja Nee

Secondary DNS Server Ja Nee

Modem Setting Ja Nee

Camera Remote Control Ja Nee

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload Ja Nee

Auto Upload (Proxy) Ja Nee

Default Upload Server Ja Nee

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Ja Nee

Service Ja Nee

Host Name Ja Nee

Port Ja Nee

User Name Nee Nee

Password Nee Nee

Passive Mode Ja Nee

Destination Directory Ja Nee

Using Secure Protocol Ja Nee

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Ja Nee

Clock Set Time Zone Ja Nee

Date Mode Ja Nee

12h/24h Ja Nee

Date Nee Nee

Time Nee Nee

All Reset Reset – –

Reset without Network – –

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –

Menu-onderdelen door toewijsbare knoppen geconfigureerd

Ja: het menu-onderdeel wordt opgeslagen.
Nee: het menu-onderdeel wordt niet opgeslagen.
–: Niet opgeslagen (tijdelijke instelling)

Assignable button selection All File Scene File

ND Filter Position Ja Nee

Auto Iris Ja Nee

ATW Ja Nee

Focus Setting Ja Nee

Display Ja –

VF Adjust Ja –

Menu-onderdelen door de toewijsbare regelaar geconfigureerd

Ja: het menu-onderdeel wordt opgeslagen.
Nee: het menu-onderdeel wordt niet opgeslagen.
–: Niet opgeslagen (tijdelijke instelling)

Selectie toewijsbare regelaar All File Scene File

IRIS Ja Nee

ND Filter Ja Nee

Audio Input Level Ja Nee
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Zie voor meer informatie “De audio voor opname instellen” (pagina 47) en “Menu User” (pagina 75).

Audio Input (CH1&CH2)

Hieronder wordt het blokschema weergegeven met bevestigde draaggreep.

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Op Manual instellen als audio wordt ontvangen via XLR-adapter.

Blokschema's
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Audio Input (CH3&CH4)

Hieronder wordt het blokschema weergegeven met bevestigde draaggreep.

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ~ 99

CH4

[CH4 Input Level]
0 ~ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Op Manual instellen als audio wordt ontvangen via XLR-adapter.
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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U kunt de software van een objectief met 
E-bevestiging met de camcorder updaten.
Raadpleeg de website voor het objectief om 
te zien welke objectieven kunnen worden 
geüpdatet en voor de bijbehorende software.

De versie controleren

1	 Bevestig een objectief met E-bevestiging 
aan de camcorder (pagina 22).

2	 Selecteer Version in het menu 
Maintenance van het hoofdmenu om Lens 
Version Number (pagina 107) weer te 
geven.
Aan de zijkant wordt de softwareversie 
van het objectief met E-bevestiging 
weergegeven.

Software updaten

Zet de camcorder in de modus Massaopslag 
(pagina 117).
Update de software volgens dezelfde 
procedure als bij de objectiefsoftware.

E-mount objectiefsoftware updaten
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MPEG-4 AVC Patent Portfolio-
licentie

DIT PRODUCT IS GELICENSEERD ONDER 
DE AVC PATENT PORTFOLIO-LICENTIE 
VOOR PERSOONLIJK GEBRUIK VOOR EEN 
CONSUMENT OF ANDER GEBRUIK WAARBIJ 
GEEN VERGOEDING VOOR
(i)	 VIDEO ENCODEREN OVEREENKOMSTIG DE 

AVC-STANDAARD (“AVC-VIDEO”) EN/OF
(ii)	DECODEREN VAN AVC-VIDEO DIE IS 

GECODEERD DOOR EEN CONSUMENT DIE 
BEZIG IS MET PERSOONLIJKE ACTIVITEITEN 
EN/OF IS ONTVANGEN VAN EEN 
VIDEOLEVERANCIER DIE IS GELICENSEERD 
VOOR HET LEVEREN VAN AVC-VIDEO.

VOOR ANDER GEBRUIK IS GEEN LICENTIE 
INGESLOTEN EN WORDT DEZE NIET VERLEEND. 
AANVULLENDE INFORMATIE IS VERKRIJGBAAR 
BIJ MPEG LA, L.L.C. ZIE  
HTTP://WWW.MPEGLA.COM

Software verkrijgen onder de 
GPL/LGPL-licentie

Dit product gebruikt software waarop de GPL/
LGPL-licentie van toepassing is. Hierin wordt 
vermeld dat u het recht heeft tot toegang, 
modificeren en herdistribueren van de 
broncode voor deze softwareprogramma's 
onder de voorwaarden van de GPL/LGPL.
De broncode is beschikbaar op internet. 
Gebruik de volgende URL en volg de 
downloadinstructies.
https://oss.sony.net/Products/Linux/

Wij vragen u vriendelijk geen contact met ons 
op te nemen betreffende de inhoud van de 
broncode.

Licenties (in het Engels) zijn opgenomen in het 
interne geheugen van het product.
Breng een massaopslagverbinding tot stand 
tussen het product en een computer om 
licenties te lezen in de mappen "PMHOME" - 
"LICENSE".

Als u een Mac gebruikt, kan het zijn dat de 
map "PMHOME" - "LICENSE" niet toegankelijk 
is.
Wilt u de bestanden bekijken, gebruik dan een 
andere computer (geen Mac) of ga naar het 
volgende webadres:
https://oss.sony.net/License/ILME-FX6/

LICENTIEOVEREENKOMST 
EINDGEBRUIKERS

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).
Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 

agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 
distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 

or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

Licenties

https://oss.sony.net/Products/Linux/
https://oss.sony.net/License/ILME-FX6/


8. Appendix: Licenties139

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 

THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 

collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 
of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
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knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 
Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 

enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 

BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Licenties open source software

Dit product gebruikt open source software op 
basis van de contracten opgemaakt tussen 
Sony en de auteursrechthebbenden van de 
software.
Sony is verplicht u te informeren over de 
inhoud van deze licenties om aan de eisen van 
de auteursrechthebbenden van de software te 
voldoen.
Licenties (in het Engels) zijn opgenomen in het 
interne geheugen van het product.
Breng een massaopslagverbinding tot stand 
tussen het product en een computer om 
licenties te lezen in de mappen "PMHOME" - 
"LICENSE".

Als u een Mac gebruikt, kan het zijn dat de 
map "PMHOME" - "LICENSE" niet toegankelijk 
is.
Wilt u de bestanden bekijken, gebruik dan een 
andere computer (geen Mac) of ga naar het 
volgende webadres:
https://oss.sony.net/License/ILME-FX6/

https://oss.sony.net/License/ILME-FX6/
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Algemeen

Massa

	 Ca. 890 g (alleen hoofdbody)

	 Ca. 2,59 kg (inclusief SEL24105G objectief, 

objectiefkap, accu (BP-U35), 

zoeker, draaggreep, handgreep)

Afmetingen

	 Zie pagina 144.

Netvoedingsvereisten

	 19,5 V DC (18,0 V tot 20,5 V)

Stroomverbruik

	 Ca. 18,0 W (body, objectief, XAVC-I QFHD 

59.94P opname, zoeker aan, 

zonder aangesloten externe 

apparatuur)

	 Ca. 36,0 W (body, objectief, XAVC-I QFHD 

59.94P opname (S&Q 120 fps), 

zoeker aan, HDMI, SDI, extern 

apparaat verbonden)

Bedrijfstemperatuur

	 0 °C tot 40 °C

Opslagtemperatuur

	 –20 °C tot +60 °C

Doorlopende bedrijfstijd

	 Ca. 105 minuten (bij gebruik van BP-U35) 

(body, objectief, XAVC-I QFHD 

59.94P opname, zoeker aan, 

zonder aangesloten externe 

apparatuur)

Opname-indeling (video)

	 XAVC Intra

		  XAVC-I 4K/QFHD modus: 

VBR, 600 Mbps (max) bitrate, 

MPEG-4 AVC/H.264

		  XAVC-I HD modus: 

CBG, 223 Mbps (max) bitrate, 

MPEG-4 AVC/H.264

	 XAVC Long

		  XAVC-L QFHD modus: 

VBR, 150 Mbps (max) bitrate, 

MPEG-4 H.264/AVC

		  XAVC-L HD 50 modus: 

VBR, 50 Mbps (max) bitrate, 

MPEG-4 H.264/AVC

		  XAVC-L HD 35 modus: 

VBR, 35 Mbps (max) bitrate, 

MPEG-4 H.264/AVC

Opname-indeling (audio)

	 LPCM 24-bit, 48 kHz, 4-kanaals

Beeldsnelheid opname

	 XAVC Intra

		  XAVC-I 4K modus: 

4096×2160/59.94P, 50P, 29.97P, 

25P, 24P, 23.98P

		  XAVC-I QFHD modus: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-I HD modus: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

	 XAVC Long

		  XAVC-L QFHD modus: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-L HD 50 modus: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-L HD 35 modus: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

Opname/afspelen tijd

	 XAVC Intra

		  XAVC-I QFHD modus:

			   59.94P

			   Ca. 30 minuten  

(bij gebruik van CEA-G160T)

		  XAVC-I HD modus:

			   59.94P

			   Ca. 78 minuten  

(bij gebruik van CEA-G160T)

	 XAVC Long

		  XAVC-L QFHD modus:

			   59.94P

			   Ca. 115 minuten  

(bij gebruik van CEA-G160T)

		  XAVC-L HD 50 modus:

			   59.94P

			   Ca. 155 minuten  

(bij gebruik van CEA-G80T)

		  XAVC-L HD 35 modus:

			   59.94P

			   Ca. 210 minuten  

(bij gebruik van CEA-G80T)

[Opmerking]
De opname/afspeeltijd kan variëren afhankelijk van 
gebruikscondities en geheugeneigenschappen. 
De opname- en afspeeltijden gelden voor een 
aaneengesloten opname als enkelvoudige clip. De 
werkelijke tijden kunnen korter zijn, afhankelijk van het 
aantal opgenomen clips.

Camerasectie

Beeldapparaat (type)

	 CMOS beeldsensor met enkelvoudige chip en 

equivalent van volledig 35 mm-

beeld

Aantal pixels

	 12,9M (totaal)

	 10,2M (effectief)

Automatische scherpstelling

	 Detectiemodus: fasedetectie/

contrastdetectie

Interne ND-filters

	 CLEAR: OFF

	 1: 1/4ND

	 2: 1/16ND

	 3: 1/64ND

	 Lineair variabel ND-filter: 1/4ND t/m 1/128ND

ISO-gevoeligheid

	 ISO 800/12800 (modus Cine EI, D55 lichtbron)

Objectiefbevestiging

	 E-bevestiging

Breedtegraad

	 15+ diafragma's

Sluitertijd

	 64F t/m 1/8000 sec. (23.98P)

Sluiterhoek

	 5,6° t/m 360°, 2 t/m 64 frames

Slow & Quick Motion

	 XAVC QFHD: 1 fps t/m 120 fps

	 XAVC HD: 1 fps t/m 240 fps

	 XAVC 4K: 1 fps t/m 60 fps

	 XAVC HD (S35): 1 fps t/m 120 fps

Witbalans

	 2000 K t/m 15000 K

Versterking

	 –3 dB t/m +30 dB (stappen van 1 dB)

Basisuiterlijk

	 S-Cinetone, Standard, Still, ITU709, s709, 
709(800%), S-Log3, HLG Live, HLG 
Natural

Audiosectie

Samplingfrequency

	 48 kHz

Kwantisering

	 24-bit

Frequentiebereik

	 XLR-ingang MIC-modus: 20 Hz tot 20 kHz  

(±3 dB of minder)

	 XLR-ingang LINE-modus: 20 Hz tot 20 kHz  

(±3 dB of minder)

Dynamiekbereik

	 XLR-ingang MIC-modus: 80 dB (normaal)

	 XLR-ingang LINE-modus: 90 dB (normaal)

Specificaties
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Vervorming

	 XLR-ingang MIC-modus: 0,08% of lager 

(–40 dBu ingangsniveau)

	 XLR-ingang LINE-modus: 0,08% of lager 

(+14 dBu ingangsniveau)

Interne luidspreker

	 Mono

Interne microfoon 

	 Mono

Interne microfoon draaggreep

	 Omnidirectionele stereo elektretmicrofoon

[Opmerking]
De interne microfoon in de draaggreep wordt alleen 
actief als de draaggreep is bevestigd.

Ingangs/uitgangssectie

Ingangen
INPUT 1/2:

	 XLR type, 3-pins, vrouwelijk

	 LINE / MIC / MIC+48V omschakelbaar

	 MIC: referentie –30 dBu t/m –80 dBu

TC IN:

	 BNC type

Uitgangen
SDI OUT:

	 BNC type, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI

Hoofdtelefoons (stereo mini-jack):

	 –16 dBu (referentieniveau uitgang, maximum 

monitorvolume, 16 Ω belasting)

HDMI:

	 Type A, 19-pins

TC OUT:

	 BNC type

Overig
DC IN:

	 EIAJ compatibel, 18 V t/m 20,5 V DC

Multi-interfaceschoen:

	 Toepassingsgericht (21-pins)

REMOTE:

	 2,5 mm, 3-polig sub-mini-aansluiting

Aansluiting afstandsbedieningsgreep:

	 3,5 mm 4-polige stereo mini-jack 

(meegeleverde aansluiting voor 

afstandsbedieningsgreep)

USB-C:

	 USB 3.2 Gen 1

USB/multi:

	 Compatibel met USB 2.0-standaard, micro B 

type voor massa-opslag (1)

VF:

	 Toepassingsgericht (40-pins)

Displaysectie

Zoeker (LCD)
Schermgrootte

	 8,8 cm (3,5 inch) diagonaal

Beeldverhouding

	 16:9

Aantal pixels

	 1280 (H) × 720 (V)

Sectie mediasleuven

CFexpress Type A/SD kaartsleuf (2)

Draadloos LAN

Ondersteunde normen

	 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

	 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Frequentieband

	 2,4 GHz

	 5 GHz (alleen ILME-FX6V/VK)

Ondersteunde beveiligingsprotocollen

	 WEP/WPA-PSK/WPA2-PSK

Verbindingsmethode

	 Wi-Fi Protected Setup™ (WPS)/handmatig

Toegangsmethode

	 Infrastructuurmodus

Acculader (BC-CU1)

Massa

	 Ca. 60 g

Afmetingen

	 Ca. 57 × 26 × 101 mm 

(breedte/hoogte/diepte)

Input

	 19,5 V DC, 26 W

Output

	 16,4 V DC, 1,4 A

Bedrijfstemperatuur

	 0 °C tot 40 °C

Opslagtemperatuur

	 –20 °C tot +60 °C

Meegeleverde accessoires

Netadapter (1)

Netsnoer (1) 

Acculader (1) 

Accuset (1)

Draaggreep (1)

LCD-monitor (1)

USB-C-kabel (1)

Afstandsbedieningsgreep (1)

LCD-kap (1)

Koude schoen (1) 

(Koude schoen (1), schoenveer (1), schroeven (4))

Kap objectiefbevestiging (1)

Beschermkap draaggreepaansluiting (1)

Voordat u het apparaat gebruikt (1)

Garantieboekje (1)

Ontwerp en specificaties kunnen zonder 
voorafgaande kennisgeving worden gewijzigd.
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Opmerkingen
ˎˎ Maak altijd een proefopname en 
controleer of deze correct is opgenomen. 
SONY KAN NIET AANSPRAKELIJK WORDEN 
GESTELD VOOR SCHADE AAN HET 
APPARAAT EN LEVERT GEEN COMPENSATIE 
OF VERGOEDING ALS GEVOLG VAN 
DEFECTEN AAN HET APPARAAT OF DE 
OPNAMEMEDIA, OF ANDERE MEDIA OF 
OPSLAGSYSTEMEN VOOR HET OPNEMEN 
VAN WILLEKEURIG MATERIAAL.
ˎˎ Controleer altijd of het apparaat correct 
werkt voordat u dit gaat gebruiken. 
SONY KAN OM GEEN ENKELE REDEN ALS 
GEVOLG VAN SCHADE AAN HET APPARAAT 
AANSPRAKELIJK WORDEN GESTELD EN 
COMPENSEERT OF VERGOEDT NIET HET 
VERLIES VAN HUIDIGE OF TOEKOMSTIGE 
INKOMSTEN DOOR DEFECTEN AAN HET 
APPARAAT (TIJDENS DE GARANTIEPERIODE 
OF NA VERLOOP VAN DE GARANTIE).
ˎˎ SONY KAN NIET AANSPRAKELIJK WORDEN 
GESTELD VOOR WELKE AANSPRAKEN 
DAN OOK DOOR GEBRUIKERS VAN HET 
APPARAAT OF DOOR DERDEN.
ˎˎ SONY IS NIET AANSPRAKELIJK VOOR 
VERLIES, REPARATIE OF REPRODUCTIE VAN 
GEGEVENS DIE ZIJN OPGENOMEN OP HET 
INTERNE OPSLAGSYSTEEM, OPSLAGMEDIA 
OF WELKE MEDIA OF OPSLAGSYSTEMEN 
DAN OOK.
ˎˎ SONY IS NIET AANSPRAKELIJK VOOR HET 
BEËINDIGEN OF NIET DOORGAAN VAN 
ENIGE DIENST MET BETREKKING TOT DIT 
APPARAAT DIE HET GEVOLG IS VAN WELKE 
OMSTANDIGHEID DAN OOK.
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Externe afmetingen

Eenheid: mm

UNC 1/4-20, Diepte: 6

UNC 3/8-16, Diepte: 5,5

2-UNC 1/8-20, Diepte: 6

UNC 1/4-20, Diepte: 6 UNC 1/4-20, Diepte: 6

UNC 1/4-20, Diepte: 5,5

98,6

11,9
8-UNC 1/4-20, Diepte: 6

143 60

98,6 89,8

82,5

114

62,8

60,6

258

90,1 60,6

25
25

25

4,9

25

117
228

74
116

15326,1

6,9 28

UNC 1/4-20, Diepte: 6

Afmetingen zijn bij benadering.
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Handelsmerken

ˎˎ  is een handelsmerk van Sony 
Corporation.
ˎˎ XAVC en  zijn gedeponeerde 
handelsmerken van Sony Corporation.
ˎˎ De begrippen HDMI, HDMI High-Definition 
Multimedia Interface en het HDMI-logo 
zijn handelsmerken of geregistreerde 
handelsmerken van HDMI Licensing 
Administrator, Inc. in de Verenigde Staten en 
andere landen.
ˎˎ Microsoft en Windows zijn handelsmerken 
of gedeponeerde handelsmerken van de 
Microsoft Corporation in de Verenigde 
Staten en/of andere landen.
ˎˎ Mac en macOS zijn gedeponeerde 
handelsmerken van Apple Inc. in de V.S. en 
andere landen.
ˎˎ "Catalyst Browse," "Content Browser 
Mobile," en het "Content Browser Mobile"-
logo zijn handelsmerken of gedeponeerde 
handelsmerken van Sony Corporation.
ˎˎ iOS is een gedeponeerd handelsmerk of 
handelsmerk van Cisco Systems, Inc. en/of 
gelieerde bedrijven in de Verenigde Staten 
en bepaalde andere landen.
ˎˎ Android, Google Play zijn handelsmerken 
van Google Inc.
ˎˎ Wi-Fi, het Wi-Fi logo en Wi-Fi PROTECTED 
SETUP zijn handelsmerken of gedeponeerde 
handelsmerken van de Wi-Fi Alliance.
ˎˎ Het N-teken is een handelsmerk of 
gedeponeerd handelsmerk van NFC Forum, 
Inc. in de Verenigde Staten en in andere 
landen.
ˎˎ Het SDXC-logo is een handelsmerk van SD-
3C, LLC.
ˎˎ CFexpress en het CFexpress Type A-logo 
zijn handelsmerken van de CompactFlash 
Association.
ˎˎ QR Code is een handelsmerk van Denso 
Wave Inc.

Alle andere bedrijfsnamen en productnamen 
zijn gedeponeerde handelsmerken of 
handelsmerken van de betreffende eigenaren. 
Onderdelen die handelsmerk zijn, worden 
niet gekenmerkt door ™ of ®-symbolen in dit 
document.
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